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 Notes, Cautions, and Warnings
 
NOTE: A NOTE indicates important information that helps you make better use of your printer. 

CAUTION: A CAUTION indicates potential damage to hardware or loss of data if instructions are not followed. 

WARNING: A WARNING indicates a potential for property damage, personal injury, or death. 

Information in this document is subject to change without notice. 

© 2012 Dell Inc. All rights reserved. 

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden. 

Trademarks used in this text: Dell and the DELL logo are trademarks of Dell Inc.; Microsoft, Windows, Windows Server, Windows Vista, and 
Active Directory are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries; Apple, 
Bonjour, iPad, iPhone, iPod touch, Macintosh, Mac OS, and TrueType are trademarks of Apple Inc., registered in the U.S. and other countries. 
AirPrint and the AirPrint logo are trademarks of Apple Inc.; Android, Google Chrome, Gmail, Google, Google Cloud Print, and Google Drive are 
either registered trademarks or trademarks of Google Inc.; Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries; Wi-Fi is a registered trademark of the Wi-Fi Alliance; Wi-Fi Protected Setup, WPA, and 
WPA2 are trademarks of the Wi-Fi Alliance; Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat. Inc. in the U.S. and 
other countries; SUSE is a registered trademark of Novell, Inc., in the United States and other countries. 

XML Paper Specification (XPS): This product may incorporate intellectual property owned by Microsoft Corporation. The terms and conditions 
upon which Microsoft is licensing such intellectual property may be found at http://go.microsoft.com/fwlink/?LinkId=52369; DES: This product 
includes software developed by Eric Young (eay@mincom.oz.au); AES: Copyright (c) 2003, Dr Brian Gladman, Worcester, UK. All rights 
reserved. This product uses published AES software provided by Dr Brian Gladman under BSD licensing terms; TIFF (libtiff): Copyright (c) 
1988-1997 Sam Leffler and Copyright (c) 1991-1997 Silicon Graphics, Inc.; ICC Profile (Little cms): Copyright (c) 1998-2004 Marti Maria. 

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. 
Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own. 

The printer software uses some of the codes defined by the Independent JPEG Group. 

WSD stands for Web Services on Devices. 

As for RSA BSAFE 
This printer includes RSA BSAFE® Cryptographic software from EMC Corporation. 

UNITED STATES GOVERNMENT RESTRICTED RIGHTS 

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in 
applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA. 

November 2012 Rev. A02 
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1 
Dell™ C3760n/C3760dn Color Laser Printer User's 
Guide 
Click the links to the left for information on the features, options, and operation of your Dell C3760n/C3760dn 
Color Laser Printer. For information on other documentation included with your Dell C3760n/C3760dn Color Laser 
Printer, see "Finding Information." 

NOTE: In this manual, Dell C3760n/C3760dn Color Laser Printer is referred to as the "printer." 

Conventions 
The following describe the meaning of the symbols and fonts used in this manual: 

Bold texts : • Names of hardware button on the operator panel. 

• Screen names on the LCD panel. 

• Menus, commands, windows, or dialog boxes displayed on the computer screen. 

Texts in Courier New font : • Menus and messages displayed on the LCD panel. 

• Characters entered from the computer. 

• Directory paths. 

< > : • Key on the keyboard of the computer. 

→ : • Indicates a path to a certain item within a procedure on a computer. 

" " : • Cross references in this manual. 

• Characters entered from the operator panel. 

• Messages displayed on the computer screen. 

Dell™ C3760n/C3760dn Color Laser Printer User's Guide 19 



Dell™ C3760n/C3760dn Color Laser Printer User's Guide 20 



  

 

 
  

 

  

 

2 
Finding Information 

NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

What are you looking for? 

• Drivers for my printer 

• My  User's Guide 

Find it here 

Software and Documentation disc 

• How to use my printer 

The Software and Documentation disc contains setup video, documentation, 
and drivers for your printer. You can use the Software and Documentation disc to 
install drivers or access your setup video and documentation. 

Readme files may be included on your Software and Documentation disc to 
provide last-minute updates about technical changes to your printer or advanced 
technical reference material for experienced users or technicians. 

Quick Reference Guide 

Quick Reference Guide 

About Your Printer 

1 

2 

4 

311 

12 

Service Tag  Express Service Code 
xxxxxxx 000 000 000 00 

111  2  3  4  5  6  7  8  9  10  

61 51 41 213191 7 81 6  712022 12

Service Tag 

NOTE: Quick Reference Guide may not be included in the package for some 
regions. 
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What are you looking for? Find it here 

• Safety information Product Information Guide 

• Warranty information 

WARNING: Read and follow all safety instructions in the Product 
Information Guide prior to setting up and operating your printer. 

• How to set up my printer Setup diagram 

Setting Up Your Printer 

1 2 3 

a1 
5 

a2 

b 

• Express Service Code and Service Tag 

Service Tag Express Service Code 
xxxxxxx 000 000 000 00 

The Express Service Code and Service Tag are located inside the front cover of 
your printer. 

• Latest drivers for my printer Go to support.dell.com. 

• Documentation for my printer 
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What are you looking for? Find it here 

• Answers to technical service and support 
questions 

support.dell.com provides several online tools, including: 

• Solutions — Troubleshooting hints and tips, articles from technicians, and 
online courses 

• Upgrades — Upgrade information for components, such as the printer drivers 

• Customer Care — Contact information, order status, warranty, and repair 
information 

•  Downloads —  Drivers  

• Manuals— Printer documentation and product specifications 

Go to support.dell.com. Select your region, and fill in the requested details to 
access help tools and information. 
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3 
Product Features 
This chapter describes the product features and indicates their links. 

Duplex Printing (Duplex Print) 

You can print two or more pages on both sides of a sheet of 
paper. For printers with the duplex unit, automatic duplex 
printing is available. Manual duplex printing is available for 
printers without the duplex unit. 

Using the Stored Print Feature (Stored Print) 

The Stored Print feature allows you to temporarily store 
your print data in the printer memory or hard disk, so you 
can print it later. When printing confidential jobs, use the 
number pad to enter the password. You can effectively 
manage your time when you print confidential data or 
large-volume data at off-peak hours. 

Multiple Up in the Layout tab (N-up Print) 

The Multiple Up feature enables you to print documents as 
reduced-size documents containing multiple pages on a 
single sheet of paper by setting from the printer driver. This 
feature helps save paper. 

Printing from USB Memory (USB Direct Print) 

The USB Direct Print feature enables you to print files 
directly from a USB memory without requiring you to start 
your computer and an application. 
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4 
About the Printer

This chapter provides an overview of your Dell™ C3760n/C3760dn Color Laser Printer.

 NOTE: The images used in this manual are those of the Dell C3760dn Color Laser Printer unless otherwise mentioned. 

Front and Rear View 

Front View 

1


13 14

12


11 2


9 10

3


4


8 5

7 6


1 Transfer Belt Unit 8 Multipurpose Feeder (MPF) 

2 Drum Cartridges 9 Toner Cartridges 

3 Waste Toner Box 10 Front Cover 

4 Right Side Cover 11 Operator Panel 

5 Power Switch 12 Output Tray Extension 

6 Tray1 13 Front USB Port 

7 Optional 550-Sheet Feeder (Tray2) 14 Top Cover 

About the Printer 27 



Rear View 

1 
10 

2 

9 

8 
3 

4 
7 

56 

1 Control Board 6 Duplex Unit (C3760dn only) 

2 Left Side Cover 7 2nd Belt Transfer Roller (2nd BTR) 

3 Ethernet Port 8 Fusing Unit 

4 Wireless Adapter Socket 9 Power Connector 

5 USB Port 10 Rear Cover 
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Space Requirements 
Provide enough room to open the printer trays, covers, and optional accessories, and for proper ventilation. 

200 mm/7.87 inches 

379 mm/14.92 inches 

400 mm/15.75 inches 

485 mm/19.09 inches 

600 mm/23.62 inches 

400 mm/15.75 inches 

439 mm/17.28 inches 

400 mm/15.75 inches 

Operator Panel
 

For more information on the operator panel, see "About the Operator Panel." 
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Additional Components 

Optional Accessories 
The following optional accessories are available for the printer.

 NOTE: Each accessory can be purchased separately except for the wireless adapter and the hard disk, which can only be 
purchased together as a bundled kit. 

• Wireless adapter 

• 512MB memory module 

• Hard disk 

• Optional 550-sheet feeder 

Non-bundled Items 
The following items are required for connecting the printer to a computer or a network. Please purchase them as 
needed. 

•  USB cable  

• Ethernet cable 

Securing the Printer 
To protect your printer from theft, you can use the optional Kensington lock. 

Attach the Kensington lock to the security slot on your printer. 

Security Slot 

Security Slot 

For details, see the operating instructions supplied with the Kensington lock. 
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1 

2 

Ordering Supplies 
You can order consumables from Dell online when using a networked printer. Enter the IP address of your printer in 
your web browser, launch the Dell Printer Configuration Web Tool, and click the web address under Order Supplies 
at: to order toner or supplies for your printer. 

You can also order replacement toner cartridges or supplies from Dell by using the Dell Supplies Management 
System: 

NOTE: For Macintosh, start the Status Monitor Widget, and then select Order Supplies button to open Order window. 

Double-click the icon on your desktop. 

If you cannot find the icon on your desktop:
 

a Right-click DLRMM.EXE under x:\abc\Dell Printers\Additional Color Laser 

Software\Reorder, where x:\abc is the location where the printer software is installed.
 

b Choose Send To from the drop-down menu, and then click Desktop (create shortcut) on the submenu.
 

The Dell Supplies Management System window appears.
 

You can also launch the Dell Supplies Management System by clicking Start → All Programs → Dell Printers →
 
Additional Color Laser Software → Dell Supplies Management System.
 

Click the Visit Dell printer supplies ordering web site link (www.dell.com/supplies), or order Dell printer supplies
 
by phone.
 

To ensure that you get the best service, have your Dell printer’s Service Tag ready.
 

For information regarding locating your Service Tag, see "Express Service Code and Service Tag."
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Preparing Printer Hardware 

Removing Tape 
Remove tapes from the printer. 
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Installing Optional Accessories 
You can make the printer more functional by installing the optional accessories. This chapter describes how to install 
the printer's options such as the 512 MB memory module, optional 550-sheet feeder (tray2), wireless adapter, and 
hard disk.

 NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

Installing the Optional Memory Module 
1 Ensure that the printer is turned off.


2 Turn the screw on the left side cover counterclockwise.


3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 

6 
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5 Hold the edge of the memory module and face its connector toward the slot with the notch on the connector 
positioned on left. 

notch 

6 Align the connector of the memory module with the slot and insert the memory module into the slot. 

7 Push the memory module firmly into the slot.

 NOTE: Ensure that the memory module is firmly fixed in the slot and does not move easily. 

Installing Optional Accessories 38 



8 Close the left side cover, and then slide it towards the front of the printer. 

9 Turn the screw clockwise. 

10 Turn on the printer. 

11 Print the printer settings report to confirm that the newly installed memory is detected by the printer. 

For details about how to print a printer settings report, see "Report / List." 

12 Confirm the amount of Memory Capacity listed in the printer settings report under General. 

If the memory capacity has not increased, turn off the printer, unplug the power cable, and re-install the memory 
module. 

13 If you installed the optional memory module after installing the printer driver, update your driver by following the 
instructions for the operating system you are using. If the printer is on a network, update the driver for each client. 

Updating Your Driver to Detect Memory Module

 NOTE: When you use XPS driver, driver updating is not required. 

When Using PCL Driver 

Microsoft® Windows® 8/ 1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Windows 8 x64/ Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
Windows Server® 2012 and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 
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Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 

Windows Vista®/Vista x64	 1 Click Start → Control Panel → Hardware and Sound → Printers. 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Windows Server 2008/ 
Server 2008 x64 

1 Click Start → Control Panel → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Windows XP/XP x64/
 
Server 2003/
 
Server 2003 x64
 

1 Click start → Printers and Faxes.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers and Faxes dialog box. 

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps: 

1 Click the Options tab, and then select Memory Capacity in the Items list box. 

2 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu in Change 
Setting for. 

3 Click Apply, and then click OK. 

4 Close the Printers and Faxes(Printers, or Devices and Printers) dialog box. 

When Using PS Driver 

Windows 8/ 
Windows 8 x64/ 
Windows Server 2012 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Devices and Printers dialog box. 
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Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Devices and Printers dialog box. 

Windows Vista/Vista x64	 1 Click Start → Control Panel → Hardware and Sound → Printers. 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers dialog box. 

Windows Server 2008/ 
Server 2008 x64 

1 Click Start → Control Panel → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers dialog box. 

Windows XP/XP x64/
 
Server 2003/
 
Server 2003 x64
 

1 Click Start → Printers and Faxes.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers and Faxes dialog box. 

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps: 

1 Click the Configuration tab, and then select Installable Options. 

2 Select Memory Capacity in the Items list box. 

3 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu under Setting 
for. 

4 Click OK. 

5 Click Apply, and then click OK. 

6 Close the Printers and Faxes (Printers, or Devices and Printers) dialog box. 

Mac OS X® 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences. 
2 Select the printer in Printers list, and click Options & Supplies. 
3 Select Driver, select the options that have been installed on the printers, and then click OK. 

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences. 
2 Select the printer in Printers list, and click Options & Supplies. 
3 Select Driver, select the options that have been installed on the printers, and then click OK. 
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Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup Utility). 
2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show 

Info. 
3 Select Installable Options, and select the options that have been installed on the printer, 

and then click Apply Changes. 

Installing the Optional 550-Sheet Feeder 
WARNING: If you install the optional 550-sheet feeder after setting up the printer, be sure to turn off the printer, unplug the 
power cable, and disconnect all cables from the back of the printer before starting this task. 

1 Ensure that the printer is turned off, and then disconnect all cables from the back of the printer. 

2 Remove the tape and the bag holding the screws. 

NOTE: Do not lose the screws because you will need them later. 

3 Place the optional 550-sheet feeder in the same location that the printer is located. 

4 Pull tray1 out of the printer about 200 mm. 

5 Hold tray1 with both hands, and remove it from the printer. 

Installing Optional Accessories 42 



6 Lift the printer and align the five guide pins of the optional 550-sheet feeder with the holes at the bottom of the 
printer. Gently lower the printer onto the optional 550-sheet feeder.

 WARNING: Two people are required to lift the printer. 

 WARNING: Be careful not to pinch your fingers when lowering the printer onto the optional 550-sheet feeder. 

7	 Secure the optional 550-sheet feeder to the printer by tightening the two screws provided with the feeder, using a 
coin or similar object. 

8	 Insert tray1 into the printer, and push until it stops. 

9 Re-connect all cables into the back of the printer, and turn on the printer.

 NOTE: The printer will automatically detect the attached tray but will not detect the paper type. 
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10 Print the printer settings report to confirm that the optional 550-sheet feeder is installed correctly. 

For details about how to print a printer settings report, see "Report / List." 

11 Confirm Tray2 (550 Sheet Feeder) is listed in the printer settings report under Printer Options. 

If the feeder is not listed, turn off the printer, unplug the power cable, and re-install the optional 550-sheet feeder. 

12 After loading paper in the optional 550-sheet feeder, specify the paper type from the operator panel. 

a Press the (Menu) button.
 

b Press the 
 button until Tray Settings is highlighted, and then press the (Set) button. 

c Press the button until Tray 2 is highlighted, and then press the (Set) button.
 

d Press the 
 button until Paper Type is highlighted, and then press the (Set) button.
 

e Press the 
  button until the paper type for the optional 550-sheet feeder is displayed, and then press the 
(Set) button. 

f	 Confirm that the selected paper type is highlighted, and then press the (Menu) button. 

13	 If you installed the optional 550-sheet feeder after installing the printer driver, update your driver by following the 
instructions for each operating system. If the printer is on a network, update the driver for each client. 

Updating Your Driver to Detect 550-Sheet Feeder 

When Using PCL Driver 

Windows 8/ 
Windows 8 x64/ 
Windows Server 2012 

Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 

Windows Vista/Vista x64	 1 Click Start → Control Panel → Hardware and Sound → Printers. 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Windows Server 2008/ 
Server 2008 x64 

1 Click Start → Control Panel → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 
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Windows XP/XP x64/
 
Server 2003/
 
Server 2003 x64
 

1 Click start → Printers and Faxes.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers and Faxes dialog box. 

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps: 

1 Click the Options tab, and then select Paper Tray Configuration in the Items list box. 

2 Select Tray2 in the Paper Tray Configuration drop-down menu in Change Setting for. 

3 Click Apply, and then click OK. 

4 Close the Printers and Faxes(Printers, or Devices and Printers) dialog box. 

When Using PS Driver 

Windows 8/ 
Windows 8 x64/ 
Windows Server 2012 

Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Devices and Printers dialog box. 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Devices and Printers dialog box. 

Windows Vista/Vista x64	 1 Click Start → Control Panel → Hardware and Sound → Printers. 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers dialog box. 

Windows Server 2008/ 
Server 2008 x64 

1 Click Start → Control Panel → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers dialog box. 
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Windows XP/XP x64/
 
Server 2003/
 
Server 2003 x64
 

1 Click Start → Printers and Faxes.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers and Faxes dialog box. 

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps: 

1 Click the Configuration tab, and then select Installable Options. 

2 Select Paper Tray Configuration in the Items list box. 

3 Select Tray2 in the Paper Tray Configuration drop-down menu in Setting for. 

4 Click OK. 

5 Click Apply, and then click OK. 

6 Close the Printers and Faxes (Printers, or Devices and Printers) dialog box. 

Mac OS X 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences. 
2 Select the printer in Printers list, and click Options & Supplies. 
3 Select Driver, select the options that have been installed on the printers, and then click OK. 

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences. 
2 Select the printer in Printers list, and click Options & Supplies. 
3 Select Driver, select the options that have been installed on the printers, and then click OK. 

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup Utility). 
2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show 

Info. 
3 Select Installable Options, and select the options that have been installed on the printer, 

and then click Apply Changes. 

When Using XPS Driver 

NOTE: The XPS driver does not support Windows XP, XP x64, and Windows Server 2003. 

Windows 8/ 
Windows 8 x64/ 
Windows Server 2012 

Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 
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Windows Vista/Vista x64	 1 Click Start → Control Panel → Hardware and Sound → Printers. 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Windows Server 2008/ 
Server 2008 x64 

1 Click Start → Control Panel → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Installing the Optional Wireless Adapter 
The wireless adapter allows you to use the printer with wireless network connection. 

The specifications of the wireless adapter are described below. 

Item Specification 

Connectivity Technology Wireless 

Compliant Standards IEEE 802.11b, 802.11g, and 802.11n 

Bandwidth 2.4 GHz 

Data Transfer Rate IEEE 802.11n: 65 Mbps 
IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps 
IEEE 802.11b: 11, 5.5, 2, and 1 Mbps 

Security 64 (40-bit key)/128 (104-bit key) WEP, 
WPA- PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES)*1*2 , 
WPA2-Enterprise (AES)*1*2 

Wi-Fi Protected Setup® (WPS)*3 Push-Button Configuration (PBC), 
Personal Identification Number (PIN) 

*1 This item is available only when the optional hard disk is installed.
 
*2 EAP method supports PEAPv0, EAP-TLS, EAP-TTLS PAP, and EAP-TTLS CHAP.
 
*3 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, 


WPA-PSK AES, WPA2-PSK AES, WPA-PSK TKIP, Open (No Security) 

NOTE: When the wireless adapter is installed, you cannot use IEEE 802.1x authentication and/or the Ethernet port for a wired 
connection. 
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Verifying the Contents of the Box 

Installing the Optional 
Wireless Adapter 

Wireless Adapter 

NOTE: To complete wireless installation, you require the corresponding Software and Documentation disc that comes with your 
printer, which can also be downloaded from support.dell.com. 

Installing the Wireless Adapter Using Video Instructions (Recommended) 
To install the wireless adapter, perform the following method. 

1 Insert the Software and Documentation disc in your computer. The Easy Setup Navigator file launches 
automatically. 

2 Select Optional Accessories Setup on the Easy Setup Navigator window. 
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3 Click Wireless adapter. 

The instruction video starts.
 

Follow the on-screen instructions to configure wireless settings.
 

Installing the Optional Wireless Adapter 

NOTE: You can also install the wireless adapter by following the instructions described in Installing the Optional Wireless 
Adapter provided with the wireless adapter. 

1 Ensure that the printer is turned off. 


2 Align the connector and the three protrusions of the wireless adapter with the four holes and insert the adapter.
 

NOTE: Ensure that the adapter is fully inserted and secured. 

3 Turn on the printer. 

NOTE: If a message displays telling you to make initial setup on the LCD panel, always do as instructed. 

4	 Print the printer settings report to confirm that the wireless adapter is installed correctly. 

For details about how to print a printer settings report, see "Report / List." 
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5 

6 

Confirm that the Network (Wireless) section exists. 

Configure the wireless adapter to connect to a wireless network. For details, see "Configuring the Optional 
Wireless Adapter." 

Determining the Wireless Network Settings 
You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, 
contact your network administrator. 

Wireless Settings SSID Specifies the name that identifies the wireless network with up to 32 
alphanumeric characters. 

Network Mode Specifies the network mode from Ad-hoc or Infrastructure. 

Security Settings Security Selects the encryption type from No Security, Mixed mode PSK*, WPA-PSK­
TKIP, WPA2-PSK-AES, and WEP. 

Transmit Key Specifies the transmit key from the list. 

WEP Key Specifies the WEP key used through the wireless network only when WEP is 
selected as the encryption type. 

Pass Phrase	 Specifies the pass phrase of alphanumeric characters from 8 to 63 bytes long 
only when Mixed mode PSK*, WPA-PSK-TKIP, or WPA2-PSK-AES is 
selected as the encryption type. 

* Mixed mode PSK automatically selects an available encryption type from WPA-PSK-TKIP, WPA-PSK-AES, or WPA2-PSK-AES. 
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Configuring the Optional Wireless Adapter 
This section describes how to configure a wireless adapter through Easy Setup Navigator. 

You can select a method to configure a wireless adapter from the following: 

Wizard Setup through USB Cable(recommended) 

WPS-PBC*1*3 

WPS-PIN*2*3 

Advanced Setup through Operator Panel 

Ethernet Cable 

Dell Printer Configuration Web Tool 

*1	 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for wireless 
configuration, by pressing the button provided on the access point via wireless routers, and then performing WPS-PBC setting on the 
operator panel. This setting is available only when the access point supports WPS. 

*2	 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required for wire
less configuration, by entering PIN assignments in the printer and computer. This setting, performed through access point, is available 
only when the access points of your wireless router supports WPS. 

*3	 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK AES, 
WPA2-PSK AES, WPA-PSK TKIP, Open (No Security) 

­

NOTE: The optional wireless adapter must be installed on the printer. For information on how to install a wireless adapter, see 
"Installing the Optional Wireless Adapter." 

NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu. 

NOTE: For details about using WPA-Enterprise-AES, WPA2-Enterprise-AES, or WPA-Enterprise-TKIP, see "Using Digital 
Certificates." 

Using Wizard Setup to Configure a Wireless Adapter 
1 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 

Navigator file launches automatically. 

2 Click Start Setup. 
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Click Connect Your Printer. 

Click Wireless Connection. 

Click Wizard. 

Follow the on-screen instructions to configure wireless settings. 
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Using Advanced Setup to Configure a Wireless Adapter 
You can configure the wireless adapter with the following connection methods: 

•  WPS-PBC  

•  WPS-PIN  

•  Operator Panel  

• Ethernet Cable 

•	 Dell Printer Configuration Web Tool 

1 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 
Navigator file launches automatically. 

2 Click Start Setup. 

3 Click Connect Your Printer. 

Click Wireless Connection. 
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5 Select Advanced, and then select a connection method from WPS-PBC, WPS-PIN, Operator Panel, Ethernet 
Cable, or Dell Printer Configuration Web Tool. 

For Ethernet Cable: 

a Select Ethernet Cable, and then click Next. 

Follow the on-screen instructions to configure wireless settings, and then click Next. 

The Advanced Configuration Tool starts. 

b Select the printer, and then click Next. 

Wireless Network Settings screen appears. 

NOTE: If the printer is not listed, click Enter IP Address and enter the IP address of your printer, and then click OK. 

c	 Set the wireless network settings, and then click Next.
 

IP Address Settings screen appears.
 

NOTE: For details on each item, see "Assigning an IP Address."
 

d Set the IP address settings of the printer, and then click Next.
 

Confirm the settings screen appears.
 

e Confirm the settings, and then click Apply.
 

Complete configuration screen appears.
 

f Click Next.
 

For WPS-PBC, WPS-PIN, Operator Panel, and Dell Printer Configuration Web Tool, follow the on-screen 
instructions to configure wireless settings. 

To configure wireless settings without using the video instructions, see the following instructions. 

WPS-PIN 

The PIN code of WPS-PIN can only be configured from the operator panel. 

NOTE: WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices 
required for wireless configuration by entering PIN assignments to a printer and computer. This setting, performed through an 
access point, is available only when the access points of your wireless router supports WPS. 

1	 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Network is highlighted, and then press the (Set) button.
 

4 Press the 
 button until WPS Setup is highlighted, and then press the (Set) button.
 

5 Ensure that PIN Code is highlighted, and then press the 
 (Set) button.
 

6 Write down the displayed 8-digit PIN code or select Print PIN Code. The PIN code is printed.
 

7 Ensure that Start Configuration is highlighted, and then press the 
 (Set) button. 

8	 Ensure that the message Please wait WPS Setting is displayed, and enter the PIN code displayed on step 
6 into the wireless LAN access point (Registrar). 

NOTE: For WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN access 
point. 

9 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed. 
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WPS-PBC 

You can start Push Button Control only from the operator panel. 

NOTE: WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required 
for wireless configuration by pressing the button provided on the access point via wireless routers, and then performing WPS­
PBC setting on the operator panel. This setting is available only when the access point supports WPS. 

NOTE: Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless LAN access 
point. For information about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless 
LAN access point. 

1	 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Network is highlighted, and then press the (Set) button.
 

4 Press the 
 button until WPS Setup is highlighted, and then press the (Set) button.
 

5 Ensure that Push Button Control is highlighted, and then press the 
 (Set) button.
 

6 Ensure that Start is highlighted, and then press the 
 (Set) button.
 

Ensure that the message Please wait WPS Setting is displayed, and start the WPS-PBC on the wireless 

LAN access point (Registrar) within two minutes. 

7 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed. 

Operator Panel 

Auto SSID Setup 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Network is highlighted, and then press the (Set) button.
 

4 Press the 
 button until Wireless Setup is highlighted, and then press the (Set) button. 

The printer automatically searches the access points on wireless network.
 

5 Press the 
  button until the desired access point  is highlighted, and then press the (Set) button. 

If the desired access point does not appear,  go to "Manual SSID Setup." 

NOTE: Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the router. 

6	 Enter the WEP key or pass phrase.
 

When the encryption type of the selected access point is WEP in step 5:
 

•	 Enter the WEP key, and then press the (Set) button.
 

When the encryption type of the selected access point is WPA, WPA2 or Mixed in step 5:
 

•	 Enter the pass phrase, and then press the (Set) button.
 

7 The Restart System screen appears. 


8 Turn off the printer, and turn it on again to apply the settings.
 

Wireless LAN connection setting is complete. 

Installing Optional Accessories 55 



 

 

 

 

 

 

   

 
 

   

 

  

 

 

 

 

  

 

 

	 
 


 
 


 
 


 
 


 
 




	 

 


 


 

	 


 




 


 


 


 
 


 
 




 


 

	 
 


 


 


 
 


 
 




 


 


 

Manual SSID Setup 

1	 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Network is highlighted, and then press the (Set) button.
 

4 Press the 
 button until Wireless Setup is highlighted, and then press the (Set) button.
 

5 Press the 
 button until Manual Setup is highlighted, and then press the (Set) button.
 

6 Enter the SSID, and then press the 
 (Set) button. 

7	 Select the network mode from Infrastructure and Ad-hoc depending on your environment, and then press 
the (Set) button.
 

If you select Infrastructure, proceed to step 8.
 

If you select Ad-hoc, proceed to step 9.
 

8	 Select the encryption type from No Security, Mixed mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or 
WEP. 

If you do not set security for your wireless network: 

• 	  Press the  button until No Security is highlighted, and then press the (Set) button. 

To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:
 

a Press the 
 button until Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES is highlighted, and 
then press the (Set) button.
 

b Enter the pass phrase, and then press the
 (Set) button. 

To use WEP encryption:
 

a Press the 
 button until WEP is highlighted, and then press the (Set) button.
 

b Enter the WEP key, and then press the 
 (Set) button.
 

c Press the 
  button to highlight the desired transmit key from Auto or WEP Key 1 to WEP Key 4, and 
then press the (Set) button.
 

Proceed to step 10.
 

9	 Select the encryption type from No Security or WEP.
 

If you do not set security for your wireless network:
 

• Ensure that No Security is highlighted, and then press the (Set) button. 

To use WEP encryption:
 

a Press the 
 button until WEP is highlighted, and then press the (Set) button.
 

b Enter the WEP key, and then press the 
 (Set) button.
 

c Press the 
  button to highlight the desired transmit key from WEP Key 1 to WEP Key 4, and then press 
the (Set) button.
 

10 The Restart System screen appears.
 

11 Turn off the printer, and turn it on again to apply the settings.
 

Wireless LAN connection setting is complete. 

Installing Optional Accessories 56 



 

  

 

 

  

 

 
 

   

  

  

   

 


 


 

	 


 


 


 

	 
 


 

Dell Printer Configuration Web Tool 

NOTE: For details about using WPA-Enterprise-AES, WPA2-Enterprise-AES, or WPA-Enterprise-TKIP, see "Using Digital 
Certificates." 

1 Ensure that the printer is turned off and the wireless adapter is connected to the printer.
 

2 Connect the printer to the network with an Ethernet cable.
 

For details about how to connect the Ethernet cable, see "Connecting Printer to Computer or Network." 

3 Turn on the printer. 

4 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser. 

5 Click Print Server Settings. 

6 Click Print Server Settings tab. 

7 Click Wireless LAN. 

8 Enter the SSID in the SSID text box. 

9 Select Ad-Hoc or Infrastructure in the Network Type drop-down list box. 

10	 Select the encryption type from No Security, WEP, WPA-PSK-TKIP, WPA-PSK-AES/WEP2-PSK AES, and Mixed 
Mode PSK in the Encryption drop-down list box, and then set each item for the encryption type selected. 

NOTE: For details on each item, see "Dell™ Printer Configuration Web Tool."
 

11 Click Apply New Settings to apply the settings.
 

12 Turn off the printer, disconnect the Ethernet cable and turn it on again.
 

Wireless LAN connection setting is complete. 

Reconfiguring the Wireless Setting 
To change the wireless setting through an Ethernet or wireless connection from your computer, perform the 
following. 

NOTE: To change the wireless setting through wireless connection, ensure that the wireless connection setting is completed in 
"Configuring the Optional Wireless Adapter." 

NOTE: The following settings are available when the network mode is set to infrastructure in "Configuring the Optional Wireless 
Adapter." 

1	 Check the IP address of the printer.
 

For details about how to check the IP address of the printer, see "Verifying the IP Settings."
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2 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser. 

3 Click Print Server Settings. 

4 Click Print Server Settings tab. 

5 Click Wireless LAN. 

6 Change the wireless setting of the printer. 

7 Reboot the printer. 

8 Change the wireless settings on your computer or access point accordingly. 

NOTE: To change the wireless settings on your computer, refer to the manuals provided with the wireless adapter or if 
your computer provides a wireless adapter tool, change the wireless settings using that tool. 

Installing the Optional Hard Disk 
1 Ensure that the printer is turned off. 

2 Turn the screw on the control board counterclockwise. 
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3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 

5 Insert the two plastic pins on the hard disk into the metal casing holes. 

6 Attach the plastic pin and the connector to the control board, and push the hard disk firmly into place. 
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7 Close the left side cover, and then slide it towards the front of the printer. 

8 Turn the screw clockwise. 

9 Turn on the printer. 

10 Print the printer settings report to confirm that the newly installed hard disk is detected by the printer. 

For details about how to print a printer settings report, see "Report / List." 

11 Confirm the amount of Hard Disk listed in the printer settings report under Printer Options. 

If the hard disk is not listed, turn off the printer, unplug the power cable, and re-install the hard disk. 

12	 If you installed the hard disk after installing the printer driver, update your driver by following the instructions for 
the operating system you are using. If the printer is on a network, update the driver for each client. 

Hard disk can be specified on the printer driver only when hard disk or RAM disk is available on the printer driver. 

Updating Your Driver to Detect Hard Disk

 NOTE: When you use XPS driver, driver updating is not required. 

When Using PCL Driver 

Windows 8/ 1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Windows 8 x64/ Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
Windows Server 2012 and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 
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Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Devices and Printers dialog box. 

Windows Vista/ 
Vista x64 

1 Click Start → Control Panel → Hardware and Sound → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Windows Server 2008/ 
Server 2008 x64 

1 Click Start → Control Panel → Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers dialog box. 

Windows XP/XP x64/
 
Server 2003/
 
Server 2003 x64
 

1 Click start → Printers and Faxes.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Options tab, and then select Get Information from Printer. 
4 Click Apply, and then click OK. 
5 Close the Printers and Faxes dialog box. 

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps: 

1 Click the Options tab, and then select Hard Disk in the Items list box. 

2 Select Available in the Hard Disk drop-down menu in Change Setting for. 

3 Click Apply, and then click OK. 

4 Close the displayed active dialog box. 

When Using PS Driver 

Windows 8/ 
Windows 8 x64/ 
Windows Server 2012 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers. 

2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 
select Printer properties. 

3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Devices and Printers dialog box. 

Installing Optional Accessories 61 



 

  

 

 

 

 

 
   

  

  

      
   

  

 

    
   

  

 

  
   

  

 

 
 

  
 


 

 


 


 


 

	    

  

 
 


 

Windows 7/
 
7 x64/
 
Server 2008 R2 x64
 

1 Click Start → Devices and Printers.
 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Printer properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Devices and Printers dialog box. 

Windows Vista/Vista x64	 1 Click Start → Control Panel → Hardware and Sound → Printers. 
2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers dialog box. 

Windows Server 2008/Server 2008 1 Click Start → Control Panel → Printers. 
x64 2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers dialog box. 

Windows XP/XP x64/Server 1 Click Start → Printers and Faxes.
 
2003/Server 2003 x64 2 Right-click the printer icon of the Dell C3760n/C3760dn Color Laser Printer, and then
 

select Properties. 
3 Click the Configuration tab, and then select Bi-Directional Setup. 
4 Select Get Information from Printer and then click OK. 
5 Click Apply, and then click OK. 
6 Close the Printers and Faxes dialog box. 

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps: 

1 Click the Configuration tab, and then select Installable Options. 

2 Select Hard Disk in the Items list box. 

3 Select Available in the Hard Disk drop-down menu in Setting for. 

4 Click OK. 

5 Click Apply, and then click OK. 

6 Close the Printers and Faxes (Printers, or Devices and Printers) dialog box. 

Mac OS X 10.7.x/10.8.x 1  Select the Print & Scan in System Preferences. 
2 Select the printer in Printers list, and click Options & Supplies. 
3 Select Driver, select the options that have been installed on the printers, and then click OK. 

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences. 
2 Select the printer in Printers list, and click Options & Supplies. 
3 Select Driver, select the options that have been installed on the printers, and then click OK. 
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Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup Utility). 
2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show 

Info. 
3 Select Installable Options, and select the options that have been installed on the printer, 

and then click Apply Changes. 
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7 
Connecting Your Printer 
Your Dell™ C3760n/C3760dn Color Laser Printer interconnection cable must meet the following requirements: 

Connection type Connection specifications 

Ethernet 10 Base-T/100 Base-TX/1000 Base-T 

Wireless (optional) IEEE 802.11b/802.11g/802.11n 

USB USB 2.0 

NOTE: The images used in this manual are those of the Dell C3760dn Color Laser Printer unless otherwise mentioned. 

2 

3 

1 

1 Ethernet port 

2 Wireless adapter socket 

3 USB port 
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Connecting Printer to Computer or Network 

Direct Connection 
A local printer is a printer which is directly connected to your computer using the USB cable. If your printer is 
connected to a network instead of your computer, skip this section and go to "Network Connection." 

To connect the printer to a computer: 

Connect the smaller USB connector into the USB port at the back of the printer. 

1 

1 

1 USB port 

NOTE: Ensure that you match the USB symbol on the cable to the USB symbol on the printer. 

2 Connect the other end of the cable into a USB port of the computer. 

CAUTION: Do not connect the printer USB cable to the USB port available on the keyboard. 
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Network Connection 
To connect the printer to a network: 

1 Connect the Ethernet cable. 

To connect the printer to the network, connect one end of an Ethernet cable into the Ethernet port on the rear of 
the printer, and the other end to a LAN drop or hub. To setup a wireless connection, insert the wireless adapter into 
the wireless adapter socket on the back of the printer. 

For a wireless connection, see "Installing the Optional Wireless Adapter." 

1 Ethernet port 

1 

1 

NOTE: To use the wireless adapter, be sure to disconnect the Ethernet cable. 
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1 

Turning on the Printer 
WARNING: Do not use extension cords or power strips.
 

WARNING: The printer should not be connected to an Uninterruptible Power Supply (UPS) system.
 

Connect the power cable to the power connector on the rear of the printer, and then to a power source. 

2	 Turn on the printer. When the printer is connected via a USB (Uninterruptible Power Supply) cable, the USB
 
driver is automatically installed.
 

Setting Initial Settings on the Operator Panel 
You need to set the printer language, time zone, clock date, and time when you turn on printer for the first time. 

When you turn the printer on, the wizard screen to perform the initial setup appears on the operator panel. Follow 
the steps below to set the initial settings. 

NOTE: If you do not start configuring the initial settings, the printer automatically restarts in three minutes. After that, you can 
set the following initial setup by enabling Power on Wizard on the operator panel or Dell Printer Configuration Web Tool 
if needed. 

For more information on operator panel, see "Operator Panel."
 

For more information on Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration Web Tool."
 

1 The Please Select Language appears. Press the 
 button until the desired language is highlighted, and then 
press the (Set) button. 

English 

Français 

Italiano 

Deutsch 

Español 

Dansk 

Nederlands 

Norsk 

Svenska 
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2 The Please Select Time Zone appears. Press the  button until the desired time zone is highlighted, and then 
press the (Set) button. 

UTC -12:00 

UTC -11:00 Midway Island, Niue, Samoa 

UTC -10:00 Adak, Hawaii, Tahiti, Cook Islands 

UTC -09:00 Alaska, Gambier Islands 

UTC -08:00 Pacific Time (US & Canada), Pitcairn Islands, Tijuana 

UTC -07:00 Arizona, Chihuahua, Dawson Creek, Mazatlan, Sonora, Mountain Time (US & Canada) 

UTC -06:00 Cancun, Central America, Central Time (US & Canada), Easter Island, Galapagos Islands, Mexico City, 
Monterrey, Saskatchewan 

UTC -05:00 Atikokan, Bogota, Cayman Islands, Eastern Time (US & Canada), Grand Turk, Jamaica, Lima, Panama, Port-au-
Prince, Quito, Resolute, Havana 

UTC -04:00 Asuncion, Atlantic Time (Canada), Bermuda, Blanc-Sablon, Caribbean Islands, Cuiaba, Georgetown, La Paz, 
Manaus, Palmer Archipelago, Santiago, Stanley, Thule 

UTC -03:30 St. John's 

UTC -03:00 Brasilia, Buenos Aires, Cayenne, Greenland, Miquelon, Montevideo, Paramaribo, Rothera 

UTC -02:00 Noronha, South Georgia Island 

UTC -01:00 Azores, Scoresbysund, Cape Verde 

UTC 00:00 Accra, Bamako, Casablanca, Dakar, Dublin, Edinburgh, Lisbon, London, Nouakchott, Reykjavik 

UTC +01:00 Algiers, Amsterdam, Belgrade, Berlin, Bratislava, Brussels, Budapest, Copenhagen, Douala, Libreville, Luanda, 
Madrid, Paris, Prague, Rome, Sarajevo, Skopje, Stockholm, Tunis, Vienna, Warsaw, Zagreb, Windhoek 

UTC +02:00 Amman, Athens, Beirut, Bucharest, Cairo, Damascus, Harare, Helsinki, Istanbul, Jerusalem, Johannesburg, 
Kaliningrad, Kiev, Kinshasa, Minsk, Nicosia, Riga, Sofia, Tripoli, Palestine 

UTC +03:00 Addis Ababa, Aden, Antananarivo, Baghdad, Comoro Islands, Khartoum, Mayotte, Mogadishu, Moscow, 
Nairobi, Qatar, Riyadh, Syowa 

UTC +03:30 Tehran 

UTC +04:00 Baku, Dubai, Mahe, Mauritius, Muscat, Reunion, Samara, Tbilisi, Yerevan 

UTC +04:30 Kabul 

UTC +05:00 Aqtau, Aqtobe, Ashgabat, Ekaterinburg, Karachi, Maldives, Samarkand, Kerguelen 

UTC +05:30 Colombo, Kolkata 

UTC +05:45 Kathmandu 

UTC +06:00 Almaty, Bishkek, Chagos, Dhaka, Mawson, Omsk, Thimphu, Vostok, Novosibirsk 

UTC +06:30 Cocos Islands, Yangon (Rangoon) 

UTC +07:00 Bangkok, Christmas Island, Davis, Ho Chi Minh, Hovd, Jakarta, Krasnoyarsk 

UTC +08:00 Casey, Chongqing, Hong Kong, Irkutsk, Kuala Lumpur, Makassar, Manila, Perth, Shanghai, Singapore, Taipei, 
Ulaan Baatar 

UTC +09:00 Dili, Jayapura, Palau, Pyongyang, Seoul, Tokyo, Yakutsk 

UTC +09:30 Adelaide, Darwin 

UTC +10:00 Brisbane, Dumont d'Urville, Guam, Hobart, Lindeman, Melbourne, Port Moresby, Saipan, Sydney, Vladivostok, 
Sakhalin, 

UTC +11:00 Efate, Guadalcanal, Kosrae, Magadan 

UTC +12:00 Anadyr, Auckland, Fiji, Kamchatka, Marshall Islands, McMurdo 

UTC +13:00 Tongatapu 
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3 Please Enter Date appears. Specify the date, and then press the (Set) button. 

4 Please Enter Time appears. Specify the time, and then press the (Set) button. 

The printer automatically restarts after selecting the (Set) button. 
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8 
Setting the IP Address 

Assigning an IP Address 
An IP address is a unique number that consists of four sections that are delimited by a period and can include up to 
three digits in each section, for example, 111.222.33.44. 

You can select the IP mode from Dual Stack, IPv4, and IPv6. If your network supports both IPv4 and IPv6, select 
Dual Stack. 

Select the IP mode of your environment, and then set IP address, subnet mask (for IPv4 only), and gateway address. 

CAUTION: Assigning an IP address that is already in use can cause network performance issues. 

NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator. 

NOTE: When you assign an IP address manually in IPv6 mode, use the Dell™ Printer Configuration Web Tool. To display the Dell 

Printer Configuration Web Tool, use the link-local address. To confirm the link-local address, print a printer settings report and 

check the Link-Local Address under Network (Wired) or Network (Wireless). 

For details about how to print a printer settings report, see "Report / List."
 

NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 

Settings menu.
 

NOTE: The images used in this manual are those of the Dell C3760dn Color Laser Printer unless otherwise mentioned. 

When Using the Easy Setup Navigator 
1	 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 


Navigator file launches automatically.
 

2	 Click Advanced Tools on the Easy Setup Navigator window.
 
The Advanced Tools window opens.
 

3 Click IP Configuration.
 

4 Follow the instructions displayed on the screen.
 

When Using the Operator Panel 
For more information on using the operator panel, see "Operator Panel." 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button. 
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3 Press the button until Network is highlighted, and then press the (Set) button.
 

4 Press the 
 button until TCP/IP is highlighted, and then press the (Set) button.
 

5 Press the 
 button until IPv4 is highlighted, and then press the (Set) button.
 

6 Press the 
 button until Get IP Address is highlighted, and then press the (Set) button.
 

7 Press the 
 button until Panel is highlighted, and then press the (Set) button. 

NOTE: If the message This Setting Becomes Effective after Restart is displayed, press the 
(Back) button. 

8 Press the (Back) button.
 

9 Press the 
 button until IP Address is highlighted, and then press the (Set) button. 

The cursor is located at the first octet of the IP address. 

10 Use the number pad to enter the first octet of the IP address, and then Press the  button.
 

The cursor moves to the next digit.
 

NOTE: You can only enter one octet at a time and must press the  button after entering each octet. 

11 Enter the rest of the octets, and then press the (Set) button. 

NOTE: If the message This Setting Becomes Effective after Restart is displayed, press the 
(Back) button. 

12 Press the (Back) button.
 

13 Press the 
 button until Subnet Mask is highlighted, and then press the (Set) button. 

14 Repeat steps 11 and 12 to set Subnet Mask. 

NOTE: If the message This Setting Becomes Effective after Restart is displayed, press the 
(Back) button. 

15 Press the (Back) button.
 

16 Press the 
 button until Gateway Address is highlighted, and then press the (Set) button.
 

17 Repeat steps 11 and 12 to set the Gateway Address.
 

18 Turn off the printer and then turn it on again.
 

When Using the Tool Box 
1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer→ Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box." 

The Tool Box opens.
 

2 Click the Printer Maintenance tab.
 

3 Select TCP/IP Settings from the list at the left side of the page.
 

The TCP/IP Settings page appears.
 

4 Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway 

Address.
 

5 Click Apply New Settings to take effect.
 

You can also assign the IP address to the printer when installing the printer drivers with the installer. When you use the 
Network Installation feature, and the Get IP Address is set to AutoIP or DHCP on the printer, you can set the IP 
address from 0.0.0.0 to the desired IP address on the printer selection window. 
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Verifying the IP Settings 
You can confirm the settings by using the operator panel, printing the printer settings report, or using the ping 
command. 

Verifying the Settings Using Operator Panel 
1 Press the (Menu) button. 

2 Press the button until Admin Settings is highlighted, and then press the (Set) button. 

3 Press the button until Network is highlighted, and then press the (Set) button. 

4 Press the button until TCP/IP is highlighted, and then press the (Set) button. 

5 Press the button until IPv4 is highlighted, and then press the (Set) button. 

Check the IP address displayed on the operator panel. 

Verifying the Settings Using Printer Settings Report 
1 Print the printer settings report. 

For details about how to print a printer settings report, see "Report / List." 

2 Verify the correct IP address, subnet mask, and gateway address are listed in the printer settings report under 
Network (Wired) or Network (Wireless). 

If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your 
printer, see "Assigning an IP Address." 

Verifying the Settings Using Ping Command 
Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping 
followed by the new IP address (for example, 192.168.0.11): 

ping 192.168.0.11 

If the printer is active on the network, you will receive a reply. 
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9 
1 

Loading Paper 
NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

NOTE: To avoid paper jams, do not remove the tray while printing is in progress. 

Pull the tray out of the printer about 200 mm. 

2 Hold the tray with both hands, and remove it from the printer. 

3 Adjust the paper guides. 

NOTE: Extend the front side of the tray when you load Legal size paper. 

Loading Paper 75 



 

  

   
   

   

4 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level surface. 

5 Load the print media into the tray with the recommended print side facing up. 

NOTE: Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams. 

6 Align the width guides against the edges of the paper. 

NOTE: When loading user-specified print media, adjust the width guides and slide the extendable part of the tray by 
pinching the length guide and sliding it until it rests lightly against the edge of the paper. 

7 After confirming that the guides are securely adjusted, insert the tray into the printer. 

NOTE: If the front side of the tray is extended, the tray protrudes when it is inserted into the printer. 
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8 On the operator panel, press the or button until the desired paper size is highlighted, and then press the 
(Set) button. 

9 Press the or button until the desired paper type is highlighted, and then press the (Set) button. 
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Installing Printer Drivers on Windows® Computers 

Identifying Printer Driver Pre-install Status 
Before installing the printer driver on your computer, check the IP address of your printer by performing one of the 
procedures in "Verifying the IP Settings." 

Changing the firewall settings before installing your printer 
If you are running one of the following operating systems, you must change the firewall settings before installing the 
Dell printer software: 

• 	  Microsoft® Windows XP 

• 	  Windows Vista® 

• 	  Windows 7  

• 	  Windows 8  

• 	  Windows Server® 2008 

•	 Windows Server 2008 R2 

•	 Windows Server 2012 

NOTE: For Windows XP, Service Pack 2 or 3 must be installed. 

The following procedure uses Windows 7 as an example. 

1 Insert the Software and Documentation disc into your computer. 

2	 Click Start → Control Panel. 

3 Select System and Security. 

4 Click Allow a program through Windows Firewall. 

5 Click Change settings → Allow another program. 

6	 Check Browse. 

7 D:\setup_assist.exe (where D is the drive letter of the optical drive) in the File name text box, and then 
click Open.
 

8 Click Add, and then click OK.
 

Inserting the Software and Documentation Disc 
1	 Insert the Software and Documentation disc into your computer and click setup_assist.exe to start Easy Setup 

Navigator. 

NOTE: If the Software and Documentation disc does not launch automatically, follow the procedure below. 

For Windows XP, Windows Server® 2008, and Windows Server 2008 R2 

Click start→ Run, enter D:\setup_assist.exe (where D is the drive letter of the optical drive) in the Run dialog 
box, and then click OK. 

For Windows Vista® and Windows 7 

Click Start → All Programs → Accessories → Run, enter D:\setup_assist.exe (where D is the drive letter of 
the optical drive) in the Run dialog box, and then click OK. 
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For Windows 8 and Windows Server 2012 

Point to the top or bottom right corner of the screen, and then click Search → Type Run in the search box, click Apps, and 
then click Run → Type D:\setup_assist.exe (where D is the drive letter of the optical drive), and then click 
OK. 

Direct Connection Setup 

For installing PCL and PS printer driver 

1 In the Easy Setup Navigator window, click Installing Driver and Software to launch the installation software. 

2 Select Personal Installation, and then click Next. 

3 Follow the on-screen instructions to connect the computer and the printer with a USB cable, and then turn the 
printer on.
 

The Plug and Play installation starts and the installation software proceeds to the next page automatically.
 

NOTE: If the installation software does not automatically proceed to the next page, click Install.
 

4 Select either Typical Installation (recommended) or Custom Installation from the installation wizard, and then 

click Install. If you select Custom Installation, you can select the specific software you want to install.
 

5 Click Finish to exit the wizard when the Congratulations! screen appears.
 

Personal Installation 

A personal printer is a printer connected to your computer or a print server using a USB. If your printer is connected 
to a network and not your computer, see "Network Connection Setup." 

For installing XML Paper Specification (XPS) printer driver 

NOTE: XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, and Windows Server 2012. 

NOTE: If you are using Windows Vista or Windows Server 2008, you need to install Service Pack 2 or later, and then the 
Windows Platform Update (KB971644). The update (KB971644) is available for download from Windows Update. 

Windows Vista or Windows Vista 64-bit Edition 

1 Extract the following zip file to your desired location. 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.
 

3 Click Add a printer.
 

4 Click Add a local printer.
 

5 Select the port connected to this product, and then click Next.
 

6 Click Have Disk to display the Install From Disk dialog box.
 

7 Click Browse, and then select the extracted folder in step 1.
 

8 Click OK.
 

9 Select your printer name and click Next. 


10	 To change the printer name, enter the printer name in the Printer name box, and then click Next. To use this 
printer as the default printer, select the check box displayed under the Printer name, and then click Next. 

Installation starts. 

If the User Account Control dialog box appears, click Continue. 
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NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

11 As the driver installation is completed, click Print a test page to print a test page.
 

12 Click Finish.
 

Windows Server 2008 or Windows Server 2008 64-bit Edition 

NOTE: You must log in as an administrator.
 

1 Extract the following zip file to your desired location.
 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.
 

3 Click Add a printer.
 

4 Click Add a local printer.
 

5 Select the port connected to this product, and then click Next.
 

6 Click Have Disk to display the Install From Disk dialog box.
 

7 Click Browse, and then select the extracted folder in step 1.
 

8 Click OK.
 

9 Select your printer name and click Next. 


10 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box, and then click Next. 

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. 

12 Click Next. 

Installation starts. 

13 As the driver installation is completed, click Print a test page to print a test page. 

14 Click Finish. 

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2 

1 Extract the following zip file to your desired location. 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Devices and Printers.
 

3 Click Add a printer.
 

When you use Windows Server 2008 R2, click Add a local or network printer as an administrator. 

If the User Account Control dialog box appears, click Yes. 

NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action. 

4 Click Add a local printer.
 

5 Select the port connected to this product, and then click Next.
 

6 Click Have Disk to display the Install From Disk dialog box.
 

7 Click Browse, and then select the extracted folder in step 1.
 

8 Click OK.
 

9 Select your printer name and click Next. 


Installing Printer Drivers on Windows® Computers 81 



 

 

 

  

 

    

 

 

 
 

 

    

 

 

 

 

    


 


 

  
 


 


 


 


 







 


 

 

10 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box, and then click Next. 

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. 

12 Click Next. 

Installation starts. 

13 As the driver installation is completed, click Print a test page to print a test page. 

14 Click Finish. 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Extract the zip file you downloaded to your desired location.
 

2 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel.
 

3 Click Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers → Add a printer.
 

4 Click Have Disk to display the Install From Disk dialog box.
 

5 Click Browse, and then select the extracted folder in step 1.
 

6 Click OK.
 

7 Select your printer name and click Next.
 

8 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation 

starts. 

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

11 Click Finish. 

Network Connection Setup 
NOTE: To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to install and 
use these, see "Installing Printer Drivers on Linux Computers (CUPS)." 

Network Printer Setup on a Local Network 

For installing PCL and PS printer driver 

1 In the Easy Setup Navigator window, click Installing Driver and Software to launch the installation software. 

2 Select Network Installation, and then click Next. 

3 Select Local Installation, and then click Next. 

4 Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed 
on the list, click Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify 

the IP address and port name at this point.
 

If you have installed this printer on the server computer, select the I am setting up this printer on a server check
 
box.
 

NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP 
address. 
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NOTE: In some cases, Windows Security Alert is displayed in this step when you use Windows Vista, Windows Vista 64­
bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64­
bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2012. In this case, select Unblock (Allow access for 
Windows Server 2008 R2 and Windows 7), and then continue the procedure. 

5	 Specify the printer settings, and then click Next. 

a Enter the printer name. 

b If you want other users on the network to access the printer, select Share this printer with other computers on 
the network, and then enter a share name that users can identify. 

c If you want to set the printer as the default printer, select the Set this printer as default check box. 

d If you want to restrict color printing, select the appropriate Dell™ ColorTrack option. Enter the password 
when Color-Password Enabled is selected for Dell ColorTrack.
 

e If you want to install the PostScript printer driver, select the PostScript Driver check box.
 

6 Select the software and documentation you want to install, and then click Next. If you want to change the 

installation destination, click Browse and specify a new location.
 

7 Click Install.
 

8 Click Finish to exit the wizard when the Congratulations! screen appears.
 

For installing XML Paper Specification (XPS) printer driver 

NOTE: XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, and Windows Server 2012. 

Windows Vista or Windows Vista 64-bit Edition 

1 Extract the following zip file to your desired location. 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.
 

3 Click Add a printer.
 

4 Click Add a network, wireless or Bluetooth printer.
 

5 Select printer or click The printer that I want isn't listed.
 

6 Select Add a printer using a TCP/IP address or host name, and then click Next.
 

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click
 
Next.
 

If the User Account Control dialog box appears, click Continue.
 

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

8 Click Have Disk to display the Install From Disk dialog box. 

9 Click Browse, and then select the extracted folder in step 1. 

10 Click OK. 

11 Select your printer name and click Next. 

12 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box, and then click Next. 

Installation starts. 

13 As the driver installation is completed, click Print a test page to print a test page. 
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14 Click Finish. 


Windows Server 2008 or Windows Server 2008 64-bit Edition 


NOTE: You must log in as an administrator.
 

1 Extract the following zip file to your desired location.
 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.
 

3 Click Add a printer.
 

4 Click Add a network, wireless or Bluetooth printer.
 

5 Select printer or click The printer that I want isn't listed.
 

When you select your printer, go to step 8.
 

When you click The printer that I want isn't listed, go to step 6.
 

6 Select Add a printer using a TCP/IP address or host name, and then click Next.
 

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 

Next.
 

If the User Account Control dialog box appears, click Continue.
 

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

8 Click Have Disk to display the Install From Disk dialog box. 

9 Click Browse, and then select the extracted folder in step 1. 

10 Click OK. 

11 Select your printer name and click Next. 

12 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box, and then click Next. 

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. 

14 Click Next. 

Installation starts. 

15 As the driver installation is completed, click Print a test page to print a test page. 

16 Click Finish. 

Windows Server 2008 R2 

1	 Extract the following zip file to your desired location.
 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Devices and Printers.
 

3 Click Add a printer.
 

4 Click Add a network, wireless or Bluetooth printer.
 

5 Select printer or click The printer that I want isn't listed.
 

NOTE: When you click The printer that I want isn't listed, Find a printer by name or TCP/IP address screen appears. Find your 
printer on the screen. 

If the User Account Control dialog box appears, click Continue. 

Installing Printer Drivers on Windows® Computers 84 



    

 

 

 

  

 

 

 

    

 

 

 

  

 

 

 

  


 


 


 


 


 

 
 


 


 


 


 


 


 


 

 


 

NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action. 

6 Click Have Disk to display the Install From Disk dialog box.
 

7 Click Browse, and then select the extracted folder in step 1.
 

8 Click OK.
 

9 Select your printer name and click Next.
 

10 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box, and then click Next. 

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. 

12 Click Next. 

Installation starts. 

13 As the driver installation is completed, click Print a test page to print a test page. 

14 Click Finish. 

Windows 7 or Windows 7 64-bit Edition 

1 Extract the following zip file to your desired location. 

D:\Drivers\XPS\Win_7Vista\XPS_3760.zip (where D is the drive letter of the optical drive)
 

2 Click Start→ Devices and Printers.
 

3 Click Add a printer.
 

4 Click Add a network, wireless or Bluetooth printer.
 

5 Select printer or click The printer that I want isn't listed.
 

When you select your printer, go to step 8.
 

When you click The printer that I want isn't listed, go to step 6.
 

6 Select Add a printer using a TCP/IP address or host name, and then click Next.
 

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click
 
Next.
 

If the User Account Control dialog box appears, click Yes.
 

NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action. 

8 Click Have Disk to display the Install From Disk dialog box. 

9 Click Browse, and then select the extracted folder in step 1. 

10 Click OK. 

11 Select your printer name and click Next. 

12 To change the printer name, enter the printer name in the Printer name box, and then click Next. 

To use this printer as the default printer, select the Set as the default printer check box, and then click Next. 

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. 

14 Click Next. 

Installation starts. 

15 As the driver installation is completed, click Print a test page to print a test page. 
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16 Click Finish. 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Extract the zip file you downloaded to your desired location. 


2 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel. 


3 Click Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers → Add a printer. 


4 Click Have Disk to display the Install From Disk dialog box. 


5 Click Browse, and then select the extracted folder in step 1. 


6 Click OK. 


7 Select your printer name and click Next. 


8 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation 

starts. 

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next. 

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box. 

11 Click Finish. 

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your 
desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering 
replacement consumables. You can click the Dell supplies link for ordering supplies. 

NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print 
server. 

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer 

configuration appears on the screen. 


You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or 

intervention. 


To set up e-mail alerts: 


1 Launch the Dell Printer Configuration Web Tool. 

2 Click E-Mail Alert link. 

3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail 
address in the e-mail list box. 

4 Click Apply New Settings. 

NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs. 

Network Printer Setup on a Remote Network 

Before Installation 

Before you start remote installation, perform the following procedures. 

Allow Print Spooler to Accept Client Connections 

NOTE: This procedure is required for Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition, 
Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 
R2, Windows 7, and Windows 7 64-bit Edition. 

For Windows XP, Windows Server 2003, Windows Vista, and Windows Server 2008: 
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1	 Open the Run dialog box. 

For Windows XP, Windows Server 2003, Windows Server 2008, click start→ All Programs → Accessories → Run. 

For Windows Vista, click Start→ Run.
 

2 Type gpedit.msc, and then click OK.
 

3 Click Computer Configuration→ Administrative Templates→ Printers.
 

4 Right-click Allow Print Spooler to accept client connections and select Properties.
 

5 On the Setting tab, select Enabled, and then click OK.
 

6 Restart the computer.
 

For Windows Server 2008 R2 and Windows 7: 

1 Open the Run dialog box. 

For Windows Server 2008 R2, click Start→ Run. 

For Windows 7, click Start→ All Programs→ Accessories→ Run.
 

2 Type gpedit.msc, and then click OK.
 

3 Click Computer Configuration→ Administrative Templates→ Printers.
 

4 Right-click Allow Print Spooler to accept client connections and select Edit.
 

5 Select Enabled, and then click OK.
 

6 Restart the computer.
 

Change the Firewall Setting to Share File and Printer 

NOTE: This procedure is required for Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, 
Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 64-bit Edition. 

For Windows XP: 

1 Click start→ Control Panel. 

2 Select Security Center. 

3 Click Windows Firewall. 

4 On the Exceptions tab, select the File and Printer Sharing check box, and then click OK. 

For Windows Vista: 

1 Click Start→ Control Panel. 

2 Select Security. 

3 Click Windows Firewall. 

4 Click Change settings. 

5 Click Continue. 

6 On the Exceptions tab, select the File and Printer Sharing check box, and then click OK. 

For Windows Server 2008: 

1 Click Start→ Control Panel. 

2 Double-click Windows Firewall. 

3 Click Change settings. 

4 On the Exceptions tab, select the File and Printer Sharing check box, and then click OK. 

For Windows Server 2008 R2 and Windows 7: 

1 Click Start→ Control Panel. 
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2 Select System and Security.
 

3 Click Windows Firewall.
 

4 Click Allow a program or feature through Windows Firewall.
 

5 If the check boxes under Allowed programs and features: are dimmed, click Change settings.
 

6 Select the File and Printer Sharing check box. Home/Work (Private) or Public check box is automatically selected 

according to your settings.
 

If the File and Printer Sharing Properties dialog box appears, click OK.
 

7 Click OK.
 

Start Remote Registry 

NOTE: This procedure is required for Windows Vista, Windows Vista 64-bit Edition, Windows 7, and Windows 7 64-bit Edition.
 

1 Click Start→ Control Panel.
 

2 Select System and Maintenance (System and Security for Windows 7).
 

3 Click Administrative Tools.
 

4 Double-click Services.
 

5 Click Continue (for Windows Vista only).
 

6 Right-click Remote Registry and select Start.
 

7 Right-click Remote Registry and select Properties.
 

8 Change Startup type to Automatic, and then click OK.
 

Disable User Account Control 

CAUTION: Disabling the User Account Control might leave the system vulnerable to virus attacks. 

NOTE: This procedure is required for Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 
64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 64-bit Edition. 

For Windows Vista: 

1 Click Start→ Control Panel. 

2 Select User Accounts and Family Safety. 

3 Click User Accounts. 

4 Click Turn User Account Control on or off. 

5 Click Continue. 

6 Clear the Use User Account Control (UAC) to help protect your computer check box. 

7 Restart the computer. 

For Windows Server 2008: 

1 Click Start→ Control Panel. 

2 Double-click User Accounts. 

3 Click Turn User Account Control on or off. 

4 Clear the Use User Account Control (UAC) to help protect your computer check box. 

5 Click OK. 

6 Restart the computer. 

For Windows Server 2008 R2: 

1 Click Start→ Control Panel. 
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2 Select User Accounts.
 

3 Click Change User Account Control Settings.
 

4 Move the slider to the bottom, and then click OK.
 

5 Restart the computer.
 

For Windows 7: 

1 Click Start→ Control Panel. 

2 Select User Accounts and Family Safety. 

3 Click User Accounts. 

4 Click Change User Account Control Settings. 

5 Move the slider to the bottom, and then click OK. 

6 Click Yes in the User Account Control dialog box. 

7 Restart the computer. 

Enable Network Discovery and File Sharing for all Public Networks 

NOTE: This procedure is required when you use Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows 
Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 64-bit Edition for the server computer. 

1 Click Start→ Network (Start→ your user name→ Network for Windows 7).
 

2 Click Network discovery and file sharing are turned off. Network computers and devices are not visible. Click to 

change.
 

3 Click Turn on network discovery and file sharing.
 

4 Click Yes, turn on network discovery and file sharing for all public networks.
 

Disable Simple File Sharing 

NOTE: This procedure is required for Windows XP, and Windows XP 64-bit Edition.
 

1 Click start→ Control Panel.
 

2 Select Appearance and Themes.
 

3 Select Folder Options.
 

4 On the View tab, clear the Use simple file sharing (Recommended) check box, and then click OK.
 

5 Click Start→ Control Panel.
 

6 Select Performance and Maintenance.
 

7 Select Administrative Tools.
 

8 Click Local Security Policy.
 

9 Click Local Policies→ Security Options.
 

10 Right-click Network access: Sharing and security model for local accounts and select Properties.
 

11 Ensure Classic - local users authenticate as themselves is selected.
 

Installing the Printer Driver 

NOTE: Installation is not supported on Windows XP Home Edition, Windows Vista Home Basic, Windows Vista Home Premium, 
Windows Vista Home Basic 64-bit Edition, Windows Vista Home Premium 64-bit Edition, Windows 7 Starter, Windows 7 Home 
Basic, Windows 7 Home Premium, Windows 7 Home Basic 64-bit Edition, Windows 7 Home Premium 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, Windows 8 Pro, Windows 8 Pro 64-bit Edition, and Windows Server 2012. 

1 In the Easy Setup Navigator window, click Software Installation to launch the installation software. 
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2 Select Network Installation, and then click Next.
 

3 Select Remote Installation, and then click Next.
 

a Enter the computer name, user ID, and password, and then click Add.
 

b Click Next.
 

NOTE: Windows Security Alert may appear on Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, 
Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, or Windows 7 64-bit Edition. In this case, select 
Unblock (Allow access for Windows Server 2008 R2 and Windows 7), and then continue the procedure. 

4	 Select a printer from the printer list, and then click Next. If the target printer is not displayed on the list, click 
Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify the IP address 
and port name at this point. 

NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you continue, you must enter a valid IP address. 

5	 Specify the printer settings, and then click Next.
 

a Enter the printer name.
 

b If you want other users on the network to access this printer, select the Share this printer with other 

computers on the network, and then enter a share name that users can identify. 

c If you want to set the printer as default, select the Set this printer as default check box. 

d If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when 
Color-Password Enabled is selected for Dell ColorTrack.
 

6 Select the software and documentation you want to install, and then click Next.
 

If you want to change the installation destination, click Input and specify a new location.
 

7 Click Install.
 

8 Click Finish to exit the wizard when the Congratulations! screen appears.
 

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your 
desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering 
replacement consumables. You can click the Dell supplies link for ordering supplies. 

NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print 
server. 

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer 
configuration appears on the screen. 

You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or 
intervention. 

To set up e-mail alerts: 

1 Launch the Dell Printer Configuration Web Tool. 

2 Click E-Mail Alert link. 

3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail 
address in the e-mail list box. 

4 Click Apply New Settings. 

NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs. 
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Setting Up for Shared Printing 
You can share your new printer on the network using the Software and Documentation disc that comes with your 
printer, or using Microsoft® point-and-print or peer-to-peer method. However, if you use one of the Microsoft 
methods, some features, such as the status monitor and other printer utilities, installed with the Software and 
Documentation disc, may not be available. 

If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network. 

NOTE: You need to purchase an Ethernet cable for shared printing. 

Specifying the Shared Settings of the Printer 

Windows XP, Windows XP 64-bit Edition, Windows Server 2003, or Windows Server 2003 x64 Edition 

1 Click start→ Printers and Faxes. 

2 Right-click the printer icon and select Properties. 

3 On the Sharing tab, select the Share this printer check box, and then type a name in the Share name text box. 

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer. 

5 Click OK. 

If you are missing files, you are prompted to insert the server operating system CD. 

Windows Vista or Windows Vista 64-bit Edition 

1 Click Start→ Control Panel→ Hardware and Sound→ Printers. 

2 Right-click the printer icon and select Sharing. 

3 Click Change sharing options. 

The message Windows needs your permission to continue appears.
 

4 Click Continue.
 

5 Select the Share this printer check box, and then type a name in the Share name text box.
 

6 Click Additional Drivers and select the operating systems of all network clients that print to the printer.
 

7 Click OK.
 

Windows Server 2008 or Windows Server 2008 64-bit Edition 

1 Click Start→ Control Panel→ Printers. 

2 Right-click the printer icon and select Sharing. 

3 Click Change Sharing Options if exists. 

4 Select the Share this printer check box, and then type a name in the Share name text box. 

5 Click Additional Drivers and select the operating systems of all network clients that print to the printer. 

6 Click OK. 

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2 

1 Click Start→ Devices and Printers. 

2 Right-click the printer icon and select Printer properties. 

3 On the Sharing tab, click Change Sharing Options if exists. 

Select the Share this printer check box, and then type a name in the Share name text box. 
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4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.
 

5 Click Apply, and then click OK.
 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → Hardware 
and Sound (Hardware for Windows Server 2012) → Devices and Printers.
 

2 Right-click the printer icon and select Printer properties.
 

3 On the Sharing tab, click Change Sharing Options if exists.
 

4 Select the Share this printer check box, and then type a name in the Share name text box.
 

5 Click Additional Drivers and select the operating systems of all network clients using this printer.
 

6 Click Apply, and then click OK.
 

To confirm that the printer is properly shared: 

•	 Ensure that the printer object in the Printers, Printers and Faxes, or Devices and Printers folder is shared. The 

shared icon is shown under the printer icon.
 

• 	  Browse  Network or My Network Places. Find the host name of the server and the shared name you assigned to the 
printer. 

Now that the printer is shared, you can install the printer on network clients using the point and print method or the 
peer-to-peer method. 

NOTE: If the OS bit editions (32/64 bit edition) differ between a print server and a client computer, you need to manually add the 
printer driver for the client computer edition on the server. Otherwise, the printer driver cannot be installed on the client 
computer using the point and print or peer-to-peer method. For example, if the print server runs on Windows XP 32-bit edition, 
while the client computer runs on Windows 7 64-bit edition, follow the procedures below to additionally install the printer driver 
for 64-bit client on the 32-bit server. 

a	 Click Additional Drivers on the screen for sharing printers. 

For details about how to display this screen, see "Specifying the Shared Settings of the Printer."
 

b Select the x64 check box, and then click OK.
 

c Insert the Software and Documentation disc into your computer.
 

d Click Browse to specify the folder that contains the 64-bit OS driver, and then click OK.
 

Installation starts. 

Point and Print 
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the printer driver. 

Windows XP, Windows XP 64-bit Edition, Windows Server 2003, or Windows Server 2003 x64 Edition 

1 On the Windows desktop of the client computer, double-click My Network Places. 

2 Locate the host name of the server computer, and then double-click the host name. 
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3 Right-click the shared printer name, and then click Connect. 

Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers and Faxes folder. The copy time varies, based on network traffic and other 
factors. 

4 Close My Network Places. 

5 Print a test page to verify installation. 

a Click start→ Printers and Faxes. 

b Select the printer you just created. 

c Click File→ Properties. 

d On the General tab, click Print Test Page. 

When a test page prints successfully, installation is complete. 

Windows Vista or Windows Vista 64-bit Edition 

1 On the Windows desktop of the client computer, click Start→ Network. 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5 Click Continue in the User Account Control dialog box. 

6 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers folder. The time this takes varies, based on network traffic and other factors. 

7 Print a test page to verify installation. 

a Click Start→ Control Panel→ Hardware and Sound. 

b Select Printers. 

c Right-click the printer you just created and click Properties. 

d On the General tab, click Print Test Page. 

When a test page prints successfully, installation is complete. 
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Windows Server 2008 or Windows Server 2008 64-bit Edition 

1 On the Windows desktop of the client computer, click Start→ Network. 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers folder. The time this takes varies, based on network traffic and other factors. 

6	 Print a test page to verify installation.
 

a Click Start→ Control Panel.
 

b Select Printers.
 

c Right-click the printer you just created and select Properties.
 

d On the General tab, click Print Test Page.
 

When a test page prints successfully, installation is complete. 

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2 

1 On the Windows desktop of the client computer, click Start→ your user name→ Network (Start→ Network for 
Windows Server 2008 R2). 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5	 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Devices and Printers folder. The time this takes varies, based on network traffic and other 
factors. 

6	 Print a test page to verify installation.
 

a Click Start→ Devices and Printers.
 

b Right-click the printer you just created and select Printer properties.
 

c On the General tab, click Print Test Page.
 

When a test page prints successfully, installation is complete. 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Point to the top or bottom right corner of the screen, and then click Search → Type Network in the search box, 
click Apps, and then click Network. 

2 Locate the host name of the server computer, and then double-click the host name. 

3 Right-click the shared printer name, and then click Connect. 

4 Click Install driver. 

5	 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Devices and Printers folder. The time this takes varies, based on network traffic and other 
factors. 

6 Print a test page to verify installation.
 

a Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel →
 
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.
 

b Right-click the printer you just created and select Printer properties.
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c On the General tab, click Print Test Page.
 

When a test page is printed successfully, installation is complete.
 

Peer-to-Peer 
If you use the peer-to-peer method, the printer driver is fully installed on each client computer. Network clients 
retain control of driver modifications. The client computer handles the print job processing. 

Windows XP, Windows XP 64-bit Edition, Windows Server 2003, or Windows Server 2003 x64 Edition 

1 Click start→ Printers and Faxes. 

2 Click Add a Printer. 

3 Click Next. 

4 Select A network printer, or a printer attached to another computer, and then click Next. If the printer is not 
listed, type the path to the printer in the text box. 

For example:\\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process. 

5	 Click Browse for a printer, and then click Next. 

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to available drivers. 

6 Select Yes if you want this printer to be set as the default printer, and then click Next. 

If you want to verify installation, click Yes to print a test page. 

7 Click Finish. 

When a test page prints successfully, installation is complete. 
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Windows Vista or Windows Vista 64-bit Edition 

1 Click Start→ Control Panel→ Hardware and Sound→ Printers. 

2 Click Add a Printer to launch the Add Printer wizard. 

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a 
shared printer by name text box and click Next. 

For example:\\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it on the network. The shared printer 

name is the name assigned during the server installation process.
 

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 

specify the path to available drivers.
 

4 Select Yes if you want this printer to be set as the default printer, and then click Next.
 

5 If you want to verify installation, click Print a test page.
 

6 Click Finish.
 

When a test page prints successfully, installation is complete. 

Windows Server 2008 or Windows Server 2008 64-bit Edition 

1 Click Start→ Control Panel→ Printers. 

2 Click Add a Printer. 

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type the path to the printer in the Select a shared 
printer by name text box and click Next. 

For example: \\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it on the network. The shared printer 

name is the name assigned during the server installation process.
 

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will
 
need to provide a path to available drivers.
 

4 Select Yes if you want this printer to be set as the default printer, and then click Next.
 

5 Click Print a test page if you want to verify installation.
 

6 Click Finish.
 

When a test page prints successfully, installation is complete. 

Installing Printer Drivers on Windows® Computers 96 



  

 

 

   

 

  
 

 

  
  

 

 

   

 

 


 

 


 

 


 


 


 


 

 
 


 

 


 

 


 


 


 


 

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2 

1 Click Start → Devices and Printers. 

2 Click Add a Printer. 

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer and click Next, or 
select The printer that I want isn't listed. Click Select a shared printer by name and type in the path of the printer 
in the text box, and then click Next. 

For example: \\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it to the network. The shared printer name
 
is the name assigned during the server installation process.
 

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will
 
need to provide the path to the available driver.
 

4 Confirm the printer name, and then click Next.
 

5 Select Yes if you want this printer to be set as the default printer, and then click Next.
 

6 Click Print a test page if you want to verify installation.
 

7 Click Finish.
 

When a test page prints successfully, installation is complete. 

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012 

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → Hardware 
and Sound (Hardware for Windows Server 2012) → Devices and Printers. 

2 Click Add a Printer to launch the Add Printer wizard. 

3 If the printer is listed, select the printer and click Next, or select The printer that I want isn't listed. Click Select a 
shared printer by name and type in the path of the printer in the text box, and then click Next. 

For example: \\<server host name>\<shared printer name> 

The server host name is the name of the server computer that identifies it to the network. The shared printer name
 
is the name assigned during the server installation process.
 

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will
 
need to provide the path to the available driver.
 

4 Confirm the printer name, and then click Next.
 

5 Select Yes if you want this printer to be set as the default printer, and then click Next.
 

6 Click Print a test page if you want to verify installation.
 

7 Click Finish.
 

When a test page is printed successfully, installation is complete. 
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Installing Printer Drivers on Macintosh Computers 

Installing the Drivers and Software 
1 Run the Software and Documentation disc on the Macintosh computer.
 

2 Double-click the Dell C3760 Installer icon, and then click Continue.
 

3 When the popup dialog box prompts you for confirming the program included in the installation package, click
 
Continue.
 

4 Click Continue on the Important Information screen.
 

5 Select a language for the Software License Agreement.
 

6 After reading the Software License Agreement, click Continue.
 

7 If you agree to the terms of the Software License Agreement, click Agree to continue the installation process.
 

8 Confirm the installation location.
 

9 Click Install to perform the standard installation.
 

If you want to select a custom installation, click Customize to select items that you want to install. 

• Dell C3760 Printer Driver 

• Dell Printer Status Monitor 

10 Type the administrator's name and password, and then click OK (Install Software for Mac OS X 10.7 and Mac OS 
X 10.8). 

11 When the installation is complete, click Close. 

Adding a Printer on Mac OS X 10.5, 10.6, 10.7, or 10.8 

When Using a USB connection 

1 Turn on the printer. 

2 Connect the USB cable between the printer and the Macintosh computer. 

The printer is automatically added to your Macintosh computer. 

When Using IP Printing 

1 Turn on the printer. 

2 Ensure that Macintosh computer and the printer are connected. 

If you use wired connection, connect the LAN cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer. 

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8). 

4 Click the Plus (+) sign, and click IP. 

5 Select Line Printer Daemon - LPD for Protocol. 

6 Type the IP address for the printer in the Address area. 

7 Select Dell C3760dn Color Laser for Print Using. 

NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it. 
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8 Click Add. 

9 Specify the options that have been installed on the printer, and then click Continue. 

10 Confirm that the printer is displayed in the Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8) 
dialog box. 

When Using Bonjour 

1 Turn on the printer. 

2 Ensure that Macintosh computer and the printer are connected. 

If you use wired connection, connect the LAN cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer. 

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8). 

4 Click the Plus (+) sign, and click Default. 

5 Select the printer connected via Bonjour from the Printer Name list. 

6 Name and Print Using (Use for Mac OS X 10.8) are automatically entered. 

7 Click Add. 

8 Specify the options that have been installed on the printer, and then click Continue. 

9 Confirm that the printer is displayed in the Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8) 
dialog box. 

Adding a Printer on Mac OS X 10.4.11 

When Using a USB Connection 

1 Turn on the printer. 

2 Connect the USB cable between the printer and the Macintosh computer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add.
 

5 Click Default Browser in the Printer Browser dialog box.
 

6 Select the printer connected via USB from the Printer list.
 

7 Name and Print Using are automatically entered.
 

8 Click Add.
 

When Using IP Printing 

1 Turn on the printer. 

2 Ensure that Macintosh computer and the printer are connected. 

If you use wired connection, connect the LAN cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add.
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5 Click IP Printer in the Printer Browser dialog box.
 

6 Select Line Printer Daemon - LPD for Protocol.
 

7 Type the IP address for the printer in the Address area.
 

8 Select Dell C3760dn Color Laser for Print Using.
 

NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it. 

NOTE: Entry of Location is optional.
 

9 Click Add.
 

When Using Bonjour 

1 Turn on the printer. 

2 Ensure that Macintosh computer and the printer are connected. 

If you use wired connection, connect the LAN cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer. 

3 Start the Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add.
 

5 Click Default Browser in the Printer Browser dialog box.
 

6 Select the printer connected via Bonjour from the Printer Name list.
 

7 Name and Print Using are automatically entered.
 

8 Click Add.
 

9 Specify the options installed to the printer, and then click Continue.
 

10 Confirm that the printer is displayed on the Printer list dialog box. 

Adding a Printer on Mac OS X 10.3.9 

When Using a USB connection 

1 Turn on the printer. 

2 Connect the USB cable between the printer and the Macintosh computer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add.
 

5 Select USB from the menu.
 

The Printer Model is automatically selected.
 

6 Click Add.
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When Using IP Printing 

1 Turn on the printer. 

2 Ensure that Macintosh computer and the printer are connected. 

If you use wired connection, connect the LAN cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add in the Printer List dialog box.
 

5 Select IP Printing from the menu.
 

6 Select LPD/LPR for Printer Type.
 

7 Type the IP address for the printer in the Address area.
 

8 Select Dell for Printer Model, and select Dell C3760dn Color Laser.
 

NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.
 

9 Click Add.
 

When Using Rendezvous (Bonjour) 

1 Turn on the printer. 

2 Ensure that Macintosh computer and the printer are connected. 

If you use wired connection, connect the LAN cable between the printer and the network. 

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer. 

3 Start Printer Setup Utility. 

NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.
 

4 Click Add in the Printer List dialog box.
 

5 Select Rendezvous from the menu.
 

6 Select Dell for Printer Model, and select Dell C3760dn Color Laser.
 

7 Click Add.
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Configuring Settings 
All the optional accessories are verified as installed. 

Mac OS X 10.5, 10.6, 10.7, or 10.8 

1 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8). 

2 Select the printer in the Printer Name list, and click Options & Supplies. 

3 Select Driver, and select the options that have been installed in the printer, and then click OK. 

Mac OS X 10.3.9 or 10.4.11 

1 Start Printer Setup Utility. 

2 Select the printer in the Printer List dialog box, and click Show Info. 

3 Select Installable Options, and select the options that have been installed in the printer, and then click Apply 
Changes. 
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Installing Printer Drivers on Linux Computers (CUPS) 
This section provides information for installing or setting up the printer driver with CUPS (Common UNIX Printing 
System) on Red Hat® Enterprise Linux® 5/6 Desktop or SUSE® Linux Enterprise Desktop 10/11. 

Operation on Red Hat Enterprise Linux 5/6 Desktop 

Setup Overview 
Red Hat Enterprise Linux 5/6 Desktop: 

1 Install the printer driver. 

2 Set up the print queue. 

3 Specify the default queue. 

4 Specify the printing options. 

Installing the Printer Driver 

CAUTION: Before you install the printer driver on Red Hat Enterprise Linux 5, confirm that Update 6 or higher is applied to your 
operating system. Consult your Linux distributor for the upgrade of your system. 

1 Select Applications→ System Tools (Accessories for Red Hat Enterprise Linux 5 Desktop)→ Terminal. 

2 Type the following command in the terminal window. 

su 

(Type the administrator password) 
rpm -ivh (Type the file path)/Dell-C3760-Color-
Laser-x.x-x.noarch.rpm 

The printer driver is installed. 

Setting Up the Queue 
To execute printing, you must set up the print queue on your workstation. 

For Red Hat Enterprise Linux 5 Desktop: 

1 Open the URL "http://localhost:631" using a web browser. 

2 Click Administration. 

3 Click Add Printer. 

Type the name of the printer in the Name box in the Add New Printer window, and click Continue.
 

You can optionally specify the location and description of the printer for further information.
 

For network connections:
 

a Select LPD/LPR Host or Printer from the Device menu, and click Continue.
 

b	 Type the IP address of the printer in Device URI, and click Continue. 

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer) 
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For USB connections: 

a Select Dell C3760dn Color Laser USB #1, Dell C3760dn Color Laser, Dell C3760n Color Laser USB #1, or 
Dell C3760n Color Laser from the Device menu, and click Continue. 

4 Select Dell C3760dn Color Laser PS vx.x (en) or Dell C3760n Color Laser PS vx.x (en) from the Model menu, 
and click Add Printer. 

5 	 Type root as the user name, type the administrator password, and click OK. 


The message Printer xxx has been added successfully. appears. 


The setup is complete. 


For Red Hat Enterprise Linux 6 Desktop: 

1 Open the URL "http://localhost:631" using a web browser. 

2 Click Administration. 

3 Click Add Printer. 

4 Type root as the user name, type the administrator password, and click OK. 

For network connections: 


a Select LPD/LPR Host or Printer from the Other Network Printers menu, and click Continue. 


b Type the IP address of the printer in Connection, and click Continue. 


Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer) 

For USB connections: 

a Select Dell C3760dn Color Laser or Dell C3760n Color Laser from the Local Printers menu, and click 
Continue. 


5 Type the name of the printer in the Name box in the Add Printer window, and click Continue. 


You can optionally specify the location and description of the printer for further information. 


6 	 Select Dell C3760dn Color Laser PS vx.x (en) or Dell C3760n Color Laser PS vx.x (en) from the Model menu, 
and click Add Printer. 

The setup is complete. 

Printing From the Applications 

When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the 

application, and specify the queue in the print dialog box. 


However, sometimes you can print only from the default queue depending on the application (for example Mozilla). 

In these cases, before you start printing, set queue you want to print to as the default queue. For information on 

specifying the default queue, see "Setting the Default Queue."
 

Setting the Default Queue 
1 Select Applications→ System Tools (Accessories for Red Hat Enterprise Linux 5 Desktop)→ Terminal. 

2 Type the following command in the terminal window. 

su 

(Type the administrator password)
 

lpadmin -d (Type the queue name)
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Specifying the Printing Options 
You can specify the printing options such as color mode. 

For Red Hat Enterprise Linux 5 Desktop: 

1 Open the URL "http://localhost:631" using a web browser. 

2 Click Administration. 

3 Click Manage Printers. 

4 Click Set Printer Options of the printer for which you want to specify the printing options. 

5 Specify the required settings, and click Set Printer Options. 

6 Type root as the user name, and type the administrator password. 

The message Printer xxx has been configured successfully. appears. 

The setting is complete. 

For Red Hat Enterprise Linux 6 Desktop: 

1 Open the URL "http://localhost:631" using a web browser. 

2 Click Administration. 

3 Click Manage Printers. 

4 Click the queue name for which you want to specify the printing options. 

5 Select Set Default Options from the Administration menu. 

6 Click the desired setting item, specify the required settings, and click Set Default Options. 

The message Printer xxx default options have been set successfully. appears. 

The setting is complete. 

Uninstalling the Printer Driver 
1 Select Applications→ System Tools (Accessories for Red Hat Enterprise Linux 5 Desktop)→ Terminal. 

2 Type the following command in the terminal window to delete the print queue. 

su 

(Type the administrator password)
 

/usr/sbin/lpadmin -x (Type the print queue name)
 

3 Repeat the command above for all queues for the same model.
 

4 Type the following command in the terminal window.
 

su 

(Type the administrator password) 

rpm -e Dell-C3760-Color-Laser 

The printer driver is uninstalled. 
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Operation on SUSE Linux Enterprise Desktop 10 

Setup Overview 
SUSE Linux Enterprise Desktop 10: 

1 Install the printer driver. 

2 Set up the print queue. 

3 Specify the default queue. 

4 Specify the printing options. 

Installing the Printer Driver 
1 Select Computer→ More Applications... and select Gnome Terminal on the Application Browser. 

2 Type the following command in the terminal window. 

su 

(Type the administrator password) 
rpm -ivh (Type the file path)/Dell-C3760-Color-
Laser-x.x-x.noarch.rpm
 

The printer driver is installed. 

Setting Up the Queue 
To execute printing, you must set up the print queue on your workstation. 

1 Select Computer→ More Applications... and select YaST on the Application Browser. 

2 Type the administrator password, and click Continue. 

YaST Control Center is activated. 

3 Select Hardware on YaST Control Center, and select Printer. 

The Printer Configuration dialog box appears. 

For network connections: 

a Click Add. 

b Select Network Printers as Printer Type, and click Next. 

c Select Print via LPD-Style Network Server as Network Printers, and click Next. 

d Type the IP address of the printer in Hostname of Print Server. 

e Type the name of the printer queue in Remote Queue Name, and click Next. 

f Type the printer name in Name for Printing. 

NOTE: Printer Description and Printer Location do not have to be specified.
 

g Select the Do Local Filtering check box, and click Next.
 

h Select DELL as Manufacturer. Select C3760dn Color Laser or C3760n Color Laser as Model, and click Next.
 

i Confirm the settings in Configuration, and click OK.
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For USB connections: 


a Click Add.
 

b Select Directly Connected Printers as Printer Type, and click Next.
 

c Select USB Printer as Directly Connected Printers, and click Next.
 

d Select //Dell/C3760dn Color Laser or //Dell/C3760n Color Laser as Device, and click Next.
 

e Type the printer name in Name for Printing.
 

NOTE: Printer Description and Printer Location do not have to be specified.
 

f Select the Do Local Filtering check box, and click Next.
 

g Select DELL as Manufacturer. Select C3760dn Color Laser or C3760n Color Laser as Model, and click Next.
 

h Confirm the settings in Configuration, and click OK.
 

4	 Click Finish. 

Printing From the Applications 

When you have finished setting up the queue you can print jobs from the applications. Start the print job from the 
application, and specify the queue in the print dialog box. 


However, sometimes you can print only from the default queue depending on the application (for example Mozilla). 

In these cases, before you start printing, set queue you want to print to as the default queue. For information on 

specifying the default queue, see "Setting the Default Queue."
 

Setting the Default Queue 
1	 To activate the Printer setup: Autodetected printers, do the following.
 

a Select Computer→ More Applications... and select YaST on the Application Browser.
 

b Type the administrator password, and click Continue.
 

YaST Control Center is activated. 

c Select Hardware on YaST Control Center, and select Printer. 

2 Select the printer you want to set to default on the Printer Configuration, and select Set Default in the Other 
button menu. 

3 Click Finish. 

Specifying the Printing Options 
You can specify the printing options such as color mode. 

1 Open a web browser. 

2 Type http://localhost:631/admin in Location, and press <Enter>. 

3 Type root as the user name, and type the administrator password. 

The CUPS window appears. 

NOTE: Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 
"Setting the Password for Authority as the Printer Administrator." 

4 Click Manage Printers.
 

5 Specify the required settings, and click Continue.
 

The message Printer xxx has been configured successfully. appears.
 

The setting is complete. Execute printing from the application.
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Setting the Password for Authority as the Printer Administrator 
You must set the password for authority as the printer administrator to do operations as the printer administrator. 

1 Select Computer→ More Applications... and select Gnome Terminal on the Application Browser. 

2 Type the following command in the terminal window. 

su 

(Type the administrator password) 

lppasswd -g sys -a root 

(Type the password for authority as the printer administrator after 
the Enter password prompt.) 

(Retype the password for authority as the printer administrator after 
the Enter password again prompt.) 

Uninstalling the Printer Driver 
1 Select Computer→ More Applications... and select Gnome Terminal on the Application Browser. 

2 Type the following command in the terminal window to delete the print queue. 

su 

(Type the administrator password)
 

/usr/sbin/lpadmin -x (Type the printer queue name)
 

3 Repeat the command above for all queues for the same model. 

4 Type the following command in the terminal window. 

su 

(Type the administrator password) 
rpm -e Dell-C3760-Color-Laser 

The printer driver is uninstalled. 

Operation on SUSE Linux Enterprise Desktop 11 

Setup Overview 
SUSE Linux Enterprise Desktop 11: 

1 Install the printer driver. 

2 Set up the print queue. 

3 Specify the default queue. 

4 Specify the printing options. 
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Installing the Printer Driver 
1 Select Computer→ More Applications... and select GNOME Terminal on the Application Browser. 

2 Type the following command in the terminal window. 

su 

(Type the administrator password) 
rpm -ivh (Type the file path)/Dell-C3760-Color-
Laser-x.x-x.noarch.rpm 


The printer driver is installed. 

Setting Up the Queue 
To execute printing, you must set up the print queue on your workstation. 

1 Select Computer→ More Applications..., and select YaST on the Application Browser. 

2 Type the administrator password, and click Continue. 

YaST Control Center is activated. 

3 Select Hardware on YaST Control Center, and select Printer. 

The Printer Configurations dialog box opens. 

For network connections: 

a Click Add. 

The Add New Printer Configuration dialog box opens. 

b Click Connection Wizard. 

The Connection Wizard dialog box opens. 

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver Box via. 

d Type the IP address of the printer in IP Address or Host Name:. 

e Select Dell in the Select the printer manufacturer: drop-down menu. 

f Click OK. 

The Add New Printer Configuration dialog box appears. 

g Select Dell C3760dn Color Laser PS vx.x [Dell/Dell_C3760dn_Color_Laser.ppd.gz] or Dell C3760n Color 
Laser PS vx.x [Dell/Dell_C3760n_Color_Laser.ppd.gz] from the Assign Driver list. 

NOTE: You can specify the printer name in Set Name:.
 

h Confirm the settings, and click OK.
 

For USB connections:
 

a Click Add. 

The Add New Printer Configuration dialog box opens. 

The printer name is displayed in the Determine Connection list. 

b Select Dell C3760dn Color Laser PS vx.x [Dell/Dell_C3760dn_Color_Laser.ppd.gz] or Dell C3760n Color 
Laser PS vx.x [Dell/Dell_C3760n_Color_Laser.ppd.gz] from the Assign Driver list. 

NOTE: You can specify the printer name in Set Name:.
 

c Confirm the settings, and click OK.
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Printing From the Applications 

When you have finished setting up the queue you can print jobs from the applications. Start the print job from the 

application, and specify the queue in the print dialog box. 


However, sometimes you can print only from the default queue depending on the application (for example Mozilla). 

In these cases, before you start printing, set queue you want to print to as the default queue. For information on 

specifying the default queue, see "Setting the Default Queue."
 

Setting the Default Queue 
You can set the default queue when you add the printer. 

1 Select Computer→ More Applications..., and select YaST on the Application Browser. 

2 Type the administrator password, and click Continue. 

YaST Control Center is activated.
 

3 Select Hardware on YaST Control Center, and select Printer.
 

The Printer Configurations dialog box opens.
 

4 Click Edit.
 

A dialog box to modify the specified queue opens.
 

5 Confirm that the printer you want to set is selected in the Connection list.
 

6 Select the Default Printer check box.
 

7 Confirm the settings, and click OK.
 

Specifying the Printing Options 
You can specify the printing options such as color mode. 

1 Open a web browser. 

2 Type http://localhost:631/admin in Location, and press <Enter>. 

3 Click Manage Printers. 

4 Click Set Printer Options of the printer for which you want to specify the printing options. 

5 Specify the required settings, and click Set Printer Options. 

6 Type root as the user name, type the administrator password, and click OK. 

NOTE: Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 
"Setting the Password for Authority as the Printer Administrator." 

The message Printer xxx has been configured successfully. appears.
 

The setting is complete. Execute printing from the application.
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Setting the Password for Authority as the Printer Administrator 
You must set the password for authority as the printer administrator to do operations as the printer administrator. 

1 Select Computer→ More Applications... and select GNOME Terminal on the Application Browser. 

2 Type the following command in the terminal window. 

su 

(Type the administrator password) 

lppasswd -g sys -a root 

(Type the password for authority as the printer administrator after 

the Enter password prompt.)
 

(Retype the password for authority as the printer administrator after 

the Enter password again prompt.)
 

Uninstalling the Printer Driver 
1 Select Computer→ More Applications... and select GNOME Terminal on the Application Browser. 

2 Type the following command in the terminal window to delete the print queue. 

su 

(Type the administrator password)
 

/usr/sbin/lpadmin -x (Type the printer queue name)
 

3 Repeat the command above for all queues for the same model.
 

4 Type the following command in the terminal window.
 

su 

(Type the administrator password) 
rpm -e Dell-C3760-Color-Laser 

The printer driver is uninstalled. 
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Operator Panel 

About the Operator Panel 
The operator panel has a 4-line LCD panel, a status LED, control buttons, and a number pad, which allows you to 
control the printer. 

1 

2 

310


4 4



39


8

 5 

6 

7 

1 Status LED (Ready / Error) 

•	 Shows a green light when the printer is ready and a blinking green light when data is being received. 

•	 Shows an amber light when an error occurs and a blinking amber light when an unrecoverable print error 
occurs. 

2 LCD Panel 

•	 Displays various settings, instructions, and error messages. 

3 button 

•	 Moves the cursor or highlight up or down. 

4 button 

•	 Moves the cursor or highlight right or left. 

5 (Cancel) button 

• Cancels active or pending jobs. 


6 Number Pad
 

•	 Enters numbers and characters. 

7 (Power Saver) button 

•	 Enters or exits the Power Saver mode. When the machine is not used for a while, it enters the Power Saver 
mode to reduce power consumption. When the Power Saver mode is active, the Power Saver button blinks. 
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8 (Back) button 

• Returns to the previous screen. 

9 (Menu) button 

• Moves to the top level of the menu. 

10 (Set) button 

• Confirms the entry of values. 

NOTE: Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to press the 
(Set) button to save the current entry or setting. 

Using the Number Pad 
As you perform various tasks, you may need to enter characters and numbers. For example, when you enter the 
password or when you setup wireless network. 

Number Pad Letters and Numbers 

Key Assigned numbers, letters or characters 

1 1 @ . _ - (space) \ & ( ) ! " # $ % ' ~ ^ | ` ; : ? , + * / = [ ] { } < > 

2 a b c A B C 2 

3  d e f D  E  F  3  

4 g h i G H I 4 

5  j k l J K L 5  

6  m n  o M  N O  6  

7  p q r  s P Q  R  S  7  

8  t u v T U V 8  

9 w x y z W X Y Z 9 

0 0 

∗ @ . _ ­

#  (space) \ & (  )  

Changing Numbers or Names 
If you make a mistake while entering a number, press the  (Cancel) button to delete the last digit or character. 
Then enter the correct number or character. 
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Printing a Panel Settings Report 
The panel settings report shows current settings for the printer menus. For details about how to print a panel settings 
report, see "Report / List." 

Changing the Language 
To change the language used on the LCD panel: 

When Using the Operator Panel 
1 Press the (Menu) button. 

2 Press the button until Panel Language is highlighted, and then press the (Set) button. 

3 Press the  button until the desired language is highlighted, and then press the (Set) button. 

When Using the Tool Box 
1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer→ Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box." 

The Tool Box opens. 

2 Click the Printer Maintenance tab. 

3 Select Panel Language from the list at the left side of the page. 

The Panel Language page appears. 

4 Select the desired language from Panel Language, and then click Apply New Settings. 

Setting the Power Saver Timer Option 
You can set the power saver timer for the printer. The printer enters the power saver mode when the printer is not 
used for a certain period of time. If the Auto-Off Timer is set to On, the printer automatically turns off after a 
specified period of time passes in deep sleep mode. 

NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu. 

NOTE: Auto-Off Timer feature is available only in certain regions. 

To set the power saver timer: 

1 Press the (Menu) button. 

2 Press the button until Admin Settings is highlighted, and then press the (Set) button. 

3 Press the button until System Settings is highlighted, and then press the (Set) button. 

4 Ensure that Power Saver Timer is highlighted, and then press the (Set) button. 

5 Press the  button until the desired setting is highlighted, and then press the (Set) button. 

6 Press the or  button or enter the desired value using the number pad, and then press the (Set) 
button.
 

You can specify from 1 to 60 minutes for Sleep or 1 to 60 minutes for Deep Sleep.
 

You can specify from 60 to 1440 minutes for Auto-Off Timer, if you set Auto-Off Timer to On. 


To return to the top menu, press the 
 (Menu) button. 
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Dell™ Printer Configuration Web Tool 

Overview 
NOTE: This web tool is available only when the printer is connected to a network using an Ethernet cable or the wireless printer 
adapter. 

NOTE: The images used in this manual are those of the Dell C3760dn Color Laser Printer unless otherwise mentioned. 

One of the features of the Dell Printer Configuration Web Tool is E-Mail Alert Setup, which sends e-mail to you or 
the key operator when the printer needs supplies or intervention. 

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the Printer 
Information feature in the Dell Printer Configuration Web Tool. Enter the IP address of each printer on the 
network to display the asset tag number. 

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of 
printing trends. If you are a network administrator, you can copy the printer settings to one or all printers on the 
network using your web browser. 
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Setting Up the Dell Printer Configuration Web Tool 
Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool. 

Follow the procedures below to configure both the environment settings of your web browser and the EWS setting 
on the operator panel before using the Dell Printer Configuration Web Tool. 

NOTE: The Dell Printer Configuration Web Tool pages may be displayed unreadable if the pages were configured by the 
language different from the language of your web browser. 

Setting Up From Web Browser 

For Internet Explorer® 

Setting Up the Display Language 

1 Select Internet Options from Tools on the menu bar. 

2 Select Languages in the General tab. 

3 Specify the display language in order of preference in the Language list. 

For example: 

• 	 Italian (Italy) [it-IT] 

• 	 Spanish (Traditional Sort) [es-ES tradnl] 

• 	 German (Germany) [de-DE] 

• 	 French (France) [fr-FR] 

• 	 English (United States) [en-US] 

• 	 Danish [da-DK] 

• 	 Dutch (Netherlands) [nl-NL] 

• 	 Norwegian (Bokmal) [no] 

• 	 Swedish [sv-SE] 

Setting the IP Address of the Printer to Non-Proxy 

1 Select Internet Options from the Tools menu. 

2 Click LAN Settings under Local Area Network (LAN) Settings in the Connections tab. 

3 Do either of the following: 

• 	  Clear the  Use a proxy server for your LAN check box under Proxy server. 

• 	  Click  Advanced, and then specify the IP address of the printer in the Do not use proxy server for addresses 
beginning with field under Exceptions. 

For Firefox 2.0 or Later 

Setting Up the Display Language 

1 Select Options from the Tools menu. 

2 Click Advanced. 

3 If you are using Firefox 2.0, click Choose in the General tab. If you are using Firefox 3.0, click Choose in the 
Content tab. 
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4	 Specify the display language in order of preference in the Languages in order of preference list menu.
 

For example:
 

•	 English [en] or English/United States [en-us] 

•	 Italian [it] 

•	 Spanish [es] 

•	 German [de] 

•	 French [fr] 

•	 Dutch [nl] 

•	 Norwegian [no] 

•	 Swedish [sv] 

•	 Danish [da] 

Setting the IP Address of the Printer to Non-Proxy 

1	 Select Options from the Tools menu. 

2	 Click Advanced tab. 

3	 Click Network on the Options dialog box. 

4	 Click Connection → Settings. 

5	 If you are using Firefox 2.0, do one of the following: 

•	 Select the Direct connection to the Internet check box. 

•	 Select the Auto-detect proxy settings for this network check box. 

•	 Select the Manual proxy configuration check box, and then enter the IP address of the printer in the No Proxy 
for edit box. 

• Select the Automatic proxy configuration URL check box.
 

If you are using Firefox 3.0, do one of the following:
 

•	 Select the No Proxy check box, if you do not want to use a proxy. 

•	 Select the Auto-detect proxy settings for this network check box. 

•	 Select the Manual proxy configuration check box, and then enter a hostname and a port number if you have a 
list of one or more proxy servers. If you have an IP address that does not use a proxy, enter the IP address of the 
printer in the No Proxy for edit box. 

•	 Select the Automatic proxy configuration URL check box. 

Setting Up From Operator Panel 
You can launch the Dell Printer Configuration Web Tool only when EWS is set to Enable (the factory default) on 
the operator panel. Confirm the operator panel setting if you cannot launch the Dell Printer Configuration Web 
Tool. For more information, see "Understanding the Printer Menus." 
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Starting the Dell Printer Configuration Web Tool 
To launch the Dell Printer Configuration Web Tool, enter the IP address of your printer in your web browser. 

If you do not know the IP address of your printer, print the printer settings report or display the TCP/IP Settings 
page, which lists the IP address. For details about how to find your printer's IP address, see "Verifying the IP 
Settings." 

Overview of the Menu Items 
The Dell Printer Configuration Web Tool consists of the following menus: 

• Printer Status 

• Printer Jobs 

• Printer Settings 

• Print Server Settings 

• Copy Printer Settings 

•  Print Volume  

• Printer Information 

• Tray Settings 

• E-Mail Alert 

•  Set Password  

•  Online Help  

• Order Supplies at: 

• Contact Dell Support at: 

Printer Status 
Use the Printer Status menu to get immediate feedback on the printer supply status. When a toner cartridge is 
running low, click the order supplies link on the first screen to order a new toner cartridge. 

Printer Jobs 
Use the Printer Jobs menu to contain information on the Job List page and Completed Jobs page. 

These pages show the details of the status regarding each print job. 

Printer Settings 
Use the Printer Settings menu to change the printer settings and to view the settings in the operator panel remotely. 

Print Server Settings 
Use the Print Server Settings menu to change the type of printer interface and the necessary conditions for 
communications. 
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Copy Printer Settings 
Use the Copy Printer Settings menu to copy the printer settings to another printer or printers on the network by 
typing the IP address of each printer. 

NOTE: You must log in as an administrator to use this feature. 

Print Volume 
Use the Print Volume menu to check the history of printing, such as paper usage, the types of jobs being printed, 
limit to which users can use the color mode, and the maximum number of pages they can print. 

Printer Information 
Use the Printer Information menu to get information on service calls, inventory reports, or the status of current 
memory and engine code levels. 

Tray Settings 
Use the Tray Settings menu to get information about the paper type and size for each tray. 

E-Mail Alert 
Use the E-Mail Alert menu to receive e-mail when the printer needs supplies or intervention. To be notified, type 
your name or the name of the key operator in the e-mail list box. 

Set Password 
Use the Set Password menu to lock the Dell Printer Configuration Web Tool with a password so that other users do 
not inadvertently change the printer settings that you have selected. 

NOTE: You must log in as an administrator to use this feature. 

Online Help 
Click Online Help to visit the Dell Support website. 

Order Supplies at: 
www.dell.com/supplies 

Contact Dell Support at: 
support.dell.com 
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Page Display Format 
The layout of the page is divided into three sections listed below: 

•  Top Frame  

•  Left Frame  

•  Right Frame  

Top Frame 
The top frame is located at the top of all pages. When the Dell Printer Configuration Web Tool is activated, the 

current status and specifications of the printer are displayed in the top frame on every page. 


The following items are displayed in the top frame.
 

1 2 3 4 5 6 

1 Dell C3760dn Color 
Laser 

Displays the product name of the printer. 

2  IPv4  Displays the IP address of the printer. 

IPv6 

3 Location Displays location of the printer. The location can be changed in the Basic Information section on 
the Print Server Settings page. 

4 Contact Person Displays the name of the printer administrator. The name can be changed in the Basic 
Information section on the Print Server Settings page. 

5 Event Panel Displays the indicator for the condition of the printer. 

6 Machine image Shows the bitmap image of the printer. The Printer Status menu appears in the right frame when 
you click on the image. 
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Left Frame 
The left frame is located on the left side of all the pages. The menu titles displayed in the left frame are linked to 

corresponding menus and pages. You can go to the corresponding page by clicking their characters.
 

The following menus are displayed in the left frame.
 

1 
2 
3 
4 
5 
6 

8 
9 

10 
11 
12 

13 

7 

1  Printer Status  Links to the Printer Status menu. 

2  Printer Jobs  Links to the Printer Jobs menu. 

3 Printer Settings Links to the Printer Settings Report menu. 

4 Print Server Settings Links to the Print Server Reports menu. 

5 Copy Printer Settings Links to the Copy Printer Settings menu. 

6  Print Volume  Links to the Print Volume menu. 

7  Printer Information  Links to the Printer Status menu. 

8  Tray Settings  Links to the Tray Settings menu. 

9 E-Mail Alert Links to the Print Server Settings menu. 

10 Set Password Links to the Security menu. 

11 Online Help Links to the Dell Support website. 

12 Order Supplies at: Links to the Dell web page. 

13 Contact Dell Support at: Links to the Dell support page web address: http://support.dell.com 

Dell™ Printer Configuration Web Tool 127 

http://support.dell.com


   
   

  

  
  

   

   

Right Frame 
The right frame is located on the right side of all the pages. The contents of the right frame correspond to the menu 
that you select in the left frame. For details on the items displayed in the right frame, see "Details of the Menu 
Items." 

Buttons in the Right Frame 

1 2 3 

1  Refresh Button Receives the current printer configuration and updates the latest information in the right frame. 

2 Apply New Settings 
Button 

Submits new settings made on the Dell Printer Configuration Web Tool to the printer. The new 
settings replace the old settings of the printer. 

3 Restore Settings Button Restores the old settings that existed before any changes were made. New settings will not be 
submitted to the printer. 

Changing the Settings of the Menu Items 
Some menus allow you to change the printer settings through the Dell Printer Configuration Web Tool. When you 
access these menus, the authentication window appears on the screen. Type a user name and password for the 
printer administrator by following the prompts displayed in the dialog box. 

The default user name is admin, and the default password is left blank (NULL). You can change only the password in 
the Set Password page in the Security menu. The user name cannot be changed. See "Set Password" for more 
information. 

Details of the Menu Items 

"Printer Status" "Printer Status" "Printer Status" 

"Printer Events" 

"Printer Information" 

"Printer Jobs" "Printer Jobs" "Job List" 

"Completed Jobs" 
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"Printer Settings" "Printer Settings Report" "Menu Settings" 

"Reports" 

"Printer Settings" "System Settings" 

"Network Settings" 

"USB Settings" 

"PCL Settings" 

"PostScript Settings" 

"PDF Settings" 

"Secure Settings" 

"USB Direct Print Defaults" 

"Printer Maintenance" "Paper Density" 

"Adjust Transfer Belt Unit" 

"Adjust 2nd BTR" 

"Adjust Fusing Unit" 

"Auto Registration Adjustment" 

"Color Registration Adjustments" 

"Reset Defaults" 

"Initialize PrintMeter" 

"Storage"*1 

"Non-Dell Toner" 

"Adjust Altitude" 

"Clock Settings" 

"Web Link Customization" 

"Print Server Settings" "Print Server Reports" "Print Server Setup Page" 

"E-Mail Alert Setup Page" 

"Print Server Settings" "Basic Information" 

"Port Settings" 

"TCP/IP" 

"SMB" 

"E-Mail Alert" 

"Bonjour (mDNS)" 

"SNMP" 

"SNTP" 

"Wireless LAN"*2 

"AirPrint" 

"Google Cloud Print" 

"Proxy Server" 

"Reset Print Server" 
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	 "Print Server Settings" "Security"	 "Set Password" 

"Authentication System" 

"Kerberos Server" 

"LDAP Server" 

"LDAP Authentication" 

"SSL/TLS" 

"IPsec" 

"802.1x"*3 

"IP Filter (IPv4)" 

"Copy Printer Settings" "Copy Printer Settings" "Copy Printer Settings" 

"Copy Printer Settings Report" 

"Print Volume" "Print Volume" "Print Volume" 

"Dell ColorTrack" 

"Tray Settings" "Tray Settings" 
*1 This item is available only when RAM Disk is enabled with the optional 512MB memory module installed or the optional hard disk is 

installed. 
*2 This item is available only when the printer is connected using the wireless network. 
*3 This item is available only when the printer is connected using an Ethernet cable. 

Printer Status 
Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer. 

The following pages are displayed in the Printer Status menu. 

Printer Status 

Purpose: 

To check the status of the consumables, trays, and covers. 

Values: 

Cyan Toner Cartridge OK Indicates that there is enough amount of toner for use. 

Magenta Toner Cartridge Replace Soon Indicates that the toner needs to be replaced soon. 

Yellow Toner Cartridge Replace Now Indicates that the toner needs to be replaced now. 

Black Toner Cartridge 

Consumables Status OK Indicates that the status of the drum cartridge and/or waste toner 
box is OK for use. 

Replace Soon Indicates that the drum cartridge and/or waste toner box needs to be 
replaced soon. 

Replace Now Indicates that the drum cartridge and/or waste toner box needs to be 
replaced now. 

Paper Trays Status OK Indicates that there is some paper in the tray but the quantity is 
unknown. 

Add Paper Indicates that there is no paper in the tray. 

Capacity Displays the maximum capacity of the paper tray. 

Size Displays the size of paper in the tray. 
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Output Tray Status OK Indicates that the tray is available. 

Full Indicates that the tray is not available. 

Capacity Displays the maximum capacity of the paper tray. 

Cover Status Closed Indicates that the cover is closed. 

Open Indicates that the cover is open. 

Printer Type Displays the type of the printer. Color Laser is displayed normally. 

Printing Speed Displays the printing speed. 

Printer Events 

Purpose: 

When faults occur, such as Out of Paper or Cover is open, the details of all alerts or indications of faults are displayed 

in the Printer Events page.
 

Values:
 

Location Displays the location where a fault occurred. 

Details Displays the details of the fault. 

Printer Information 

Purpose: 

To verify the printer details such as the hardware configuration and software version. This page can also be displayed 
by clicking on the Printer Information tab in the left frame. 

Values: 

Dell Service Tag Number Displays Dell service tag number. 

Express Service Code Displays Dell express service code. 

Asset Tag Number Displays the asset tag number of the printer. 

Printer Serial Number Displays the serial number of the printer. 

Memory Capacity Displays the memory capacity. 

Hard Disk*1 Displays information on the printer's hard disk. 

Processor Speed Displays the processing speed. 

Printer Revision Levels Firmware Version Displays the revision date (revision level). 

Network Firmware Version Displays the revision date (revision level). 

*1 This item is available only when the optional hard disk drive is installed. 

Printer Jobs 
The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the 
details of the status regarding each print job. 

Job List 

Purpose:
 

To confirm the jobs that are being processed. Click the Refresh button to update the screen.
 

Values:
 

ID Displays the job ID. 
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Job Name Displays the file name of the job being processed. 

Owner Displays the name of the job owner. 

Host Name Displays the name of the host computer. 

Job Status Displays the status of the job being processed. 

Host I/F Displays the status of the host interface. 

Job Submitted Time Displays the date when the job was submitted. 

Completed Jobs 

Purpose:
 

To check the completed jobs. Up to the last 20 jobs are displayed. Click the Refresh button to update the screen.
 

Values:
 

ID Displays the job ID. 

Job Name Displays the file name of the completed job. 

Owner Displays the name of the job owner. 

Host Name Displays the name of the host computer. 

Output Result Displays the status of the completed job. 

Impression Number Displays the total number of pages for the job. 

No. of Sheets Displays the total number of sheets for the job. 

Host I/F Displays the status of the host interface. 

Job Submitted Time Displays the date when the job was submitted. 

Printer Settings 
Use the Printer Settings menu to display the Printer Settings Report, Printer Settings, and Printer Maintenance
 
tabs and to configure the printer settings.
 

The following tabbed pages are displayed at the top of the right frame.
 

Printer Settings Report 

The Printer Settings Report tab includes the Menu Settings and Reports pages. 

Menu Settings 

Purpose: 

To display the current settings of the printer menus. 

Values: 

System Settings Power Saver Time - Sleep Displays the time taken by the printer to enter Sleep mode after it 
finishes a job. 

Power Saver Time - Deep Displays the time taken by the printer to enter Deep Sleep mode after 
Sleep it has entered Sleep mode. 

Power Saver Time - Auto-
Off Timer*1 

Displays the time taken by the printer to be turned off after it has 
entered Deep Sleep mode. 

mm / inch Displays the measurement unit that is used on the LCD panel. 

Control Panel Tone Displays the volume of the tone that is emitted when the operator 
panel input is correct. Off indicates that the tone is disabled. 
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Invalid Key Tone Displays the volume of the tone that is emitted when the operator 
panel input is incorrect. Off indicates that the tone is disabled. 

Machine Ready Tone Displays the volume of the tone that is emitted when the printer 
becomes ready. Off indicates that the tone is disabled. 

Job Completed Tone Displays the volume of the tone that is emitted when a print job is 
complete. Off indicates that the tone is disabled. 

Fault Tone Displays the volume of the tone that is emitted when a job ends 
abnormally. Off indicates that the tone is disabled. 

Alert Tone Displays the volume of the tone that is emitted when a problem occurs. 
Off indicates that the tone is disabled. 

Out of Paper Tone Displays the volume of the tone that is emitted when the printer runs 
out of paper. Off indicates that the tone is disabled. 

Low Toner Alert Tone Displays the volume of the tone that is emitted when the toner is low. 
Off indicates that the tone is disabled. 

Auto Clear Alert Tone Displays the volume of the tone that is emitted 5 seconds before the 
printer performs auto clear. Off indicates that the tone is disabled. 

All Tones Displays the volume of all the alert tones. Off indicates that all the 
tones are disabled. 

Low Toner Alert Message Displays whether to show the alert message when the toner is low. 

Auto Log Print Displays whether to automatically print a job history report after every 
20 jobs. 

RAM Disk*2 Displays whether to allocate RAM for the file system for the Secure 
Print, Proof Print, Private Mail Box Print, and Public Mail Box Print 
features. 

Panel Language Displays the language used on the LCD panel. 

Auto Reset Displays the amount of time before the printer automatically resets its 
settings to the defaults when no additional settings are made. 

Fault Time-out Displays the amount of time the printer waits before canceling a job 
that stops abnormally. 

Job Time-out Displays the amount of time the printer waits for data to arrive from 
the computer. 

Default Paper Size Displays the default print paper size. 

Print ID Displays where to print a user ID on the output paper. 

Print Text Displays whether the printer outputs PDL (Page Description 
Language) data (which is not supported by the printer) as text when 
the printer receives it. 

Banner Sheet Insert Displays where to insert a banner sheet in the output paper. 
Position 

Banner Sheet Specify Tray Displays the tray to feed a banner sheet. 

Substitute Tray Displays if paper of another size has to be used when the paper that is 
loaded in the specified tray does not match the paper size setting for 
the current job. 

Letterhead 2 Sided*3 Displays whether to print both sides on letterhead. 

A4<>Letter Switch Displays whether to print A4 size jobs on Letter size paper if A4 is not 
available in the paper trays and vice versa (Letter size job on A4 size 
paper). 

Report 2 Sided Print*3 Displays whether to print reports on both sides a sheet of paper. 
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Use Another Tray Displays whether to show a message to select another tray when the 
specified paper is not available in the paper tray. 

Network Settings Adobe Protocol Displays PostScript communication protocol for each interface. 

USB Settings USB Port Displays whether to enable the USB interface. 

Adobe Protocol Displays PostScript communication protocol for each interface. 

PCL Settings Paper Tray Displays the paper input tray. 

Paper Size Displays the paper size setting. 

Custom Paper Size - Y Displays the length of custom size paper. 

Custom Paper Size - X Displays the width of custom size paper. 

Orientation Displays how text and graphics are oriented on the page. 

2 Sided Print*3 Displays whether to print on both sides of a sheet of paper. 

Font Displays the selected font from the list of registered fonts. 

Symbol Set Displays a symbol set for the specified font. 

Font Size Displays the font size for scalable typographic fonts. 

Font Pitch Displays the font pitch for scalable mono spaced fonts. 

Form Line Displays the number of lines in a page. 

Quantity Displays the number of copies to print. 

Image Enhance Displays whether to enable the Image Enhancement feature. 

Hex Dump Displays whether to enable the Hex Dump feature. 

Draft Mode Displays whether to print in the draft mode. 

Line Termination Displays whether to set the line termination. 

Default Color Displays the color mode setting. 

Ignore Form Feed Displays whether to ignore blank pages that only contain Form Feed 
control codes. 

PostScript Settings PS Error Report Displays whether the printer outputs error contents for a PostScript 
error. 

PS Job Time-out Displays the execution time for one PostScript job. 

Paper Select Mode Displays the tray that is selected in the PostScript printing. 

Default Color Displays the color mode setting. 

PDF Settings Quantity Displays the number of copies to print. 

2 Sided Print*3 Displays whether to print on both sides of a sheet of paper. 

Print Mode Displays the print mode setting. 

Collation Displays whether to sort a job. 

Output Size Displays the output paper size. 

Layout Displays the output layout. 

Default Color Displays the color mode setting. 

Secure Settings Panel Lock Control Displays whether to lock Admin Settings with a password. 

USB Direct Print Displays whether to lock the USB Direct Print function with a password. 

Software Download Displays whether to enable download of firmware updates. 

Encryption Displays whether to encrypt the data. 

Hard Disk Over Write*4 Displays whether to overwrite the hard disk drive. 

Login Error Displays how many times an administrator can attempt to log in to 
Panel Lock and Function Enabled. 
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Expiration Mode*5 Displays whether to set the date to delete the files stored as Secure 
Print in the optional 512MB memory module or the optional hard disk 
drive. 

Expiration Time*5 Displays the time to delete the files stored as Secure Print in the 
optional 512MB memory module or the optional hard disk drive. 

Recurrence*5 Displays the period to repeat the setting. 

Weekly Settings*5 Displays the day of the week to repeat the setting. 

Monthly Settings*5 Displays the day of the month to repeat the setting. 

Secure Settings - Print Set Available Time Displays whether to set the available time period for the Print function. 

Start Time Displays the start time of the available time period for the Print 
function. 

End Time Displays the end time of the available time period for the Print 
function. 

Recurrence Displays the day of the week to repeat the setting. 

USB Direct Print Output Color Displays whether to print in color or in black and white. 
Defaults Select Tray Displays the default input tray. 

2 Sided Printing*3 Displays whether to print on both sides of a sheet of paper. 

Multiple-Up Displays whether to print two or more pages on one side of a sheet of 
paper. 

Collation*4 Displays whether to sort a job. 

Paper Density Plain Displays the paper density of plain paper. 

Label Displays the paper density of labels. 

Adjust Transfer Belt Unit K Offset Displays the value for black ghost image. 

YMC Offset Displays the value for color ghost image. 

Adjust 2nd BTR Plain Displays the voltage setting of the transfer roller (-5 to 10) for plain 
paper. 

Plain Thick*6 Displays the voltage setting of the transfer roller (-5 to 10) for thick 
plain paper. 

Covers (106-163g/m2) Displays the voltage setting of the transfer roller (-5 to 10) for cover 
paper. 

Covers Thick*6 

(164-216g/m2) 
Displays the voltage setting of the transfer roller (-5 to 10) for thick 
cover paper. 

Coated (106-163g/m2) Displays the voltage setting of the transfer roller (-5 to 10) for coated 
paper. 

Coated Thick*6 

(164-216g/m2) 
Displays the voltage setting of the transfer roller (-5 to 10) for thick 
coated paper. 

Label Displays the voltage setting of the transfer roller (-5 to 10) for labels. 

Envelope Displays the voltage setting of the transfer roller (-5 to 10) for 
envelopes. 

Recycled Displays the voltage setting of the transfer roller (-5 to 10) for recycled 
paper. 
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Adjust Fusing Unit Plain Displays the temperature setting of the fusing unit (-3 to 3) for plain 
paper. 

Plain Thick*6 Displays the temperature setting of the fusing unit (-3 to 3) for thick 
plain paper. 

Covers (106-163g/m2) Displays the temperature setting of the fusing unit (-3 to 3) for cover 
paper. 

Covers Thick*6 Displays the temperature setting of the fusing unit (-3 to 3) for thick 
(164-216g/m2) cover paper. 

Coated (106-163g/m2) Displays the temperature setting of the fusing unit (-3 to 3) for coated 
paper. 

Coated Thick*6 Displays the temperature setting of the fusing unit (-3 to 3) for thick 
(164-216g/m2) coated paper. 

Label Displays the temperature setting of the fusing unit (-3 to 3) for labels. 

Envelope Displays the temperature setting of the fusing unit (-3 to 3) for 
envelopes. 

Recycled Displays the temperature setting of the fusing unit (-3 to 3) for recycled 
paper. 

Auto Registration Adjustment Displays whether to automatically perform color registration 
adjustment. 

Adjust Altitude Displays the altitude of the location where the printer is installed. 

Non-Dell Toner Displays whether to use toner cartridge of another manufacturer. 

Clock Settings Date Format Displays the default date format. 

Time Format Displays the default time format; 24H or 12H. 

Time Zone Displays the default time zone. 

Set Date Displays the date setting. 

Set Time Displays the time setting. 

Web Link Customization Select Reorder URL Displays a link used for ordering consumables, which can be accessed 
from Order Supplies at: in the left frame. 

Regular Displays the regular URL (http://accessories.us.dell.com/sna) that can 
be linked to Order Supplies at:. 

Premier Displays the premier URL (http://premier.dell.com) that can be linked 
to Order Supplies at:. 

Dell ColorTrack ColorTrack Mode Displays whether to enable the ColorTrack. 

Non Registered User Displays whether to permit the printing of data without authentication 
information. 

Auto Color To Mono Print Displays whether to print all print jobs in black and white even when 
color print is specified. 

ColorTrack Error Report Displays whether to print the error report on the ColorTrack mode. 

Dell™ Printer Configuration Web Tool 136 

http://accessories.us.dell.com/sna
http://premier.dell.com


  

 

 

     

   

  

    

     

   

  
   

   
 
 
 

    

 
   

	

	

	

	

	 


 


 


 


 


 


 


 


 

Tray Settings MPF Mode Displays whether to use the printer driver settings for the size and type 
of paper loaded in the multipurpose feeder (MPF). 

MPF Paper Size*7 Displays the paper size setting of the MPF. 

MPF Paper Type*7 Displays the paper type setting of the MPF. 

MPF Custom Paper Size - 	 Displays the length of custom size paper loaded in the MPF. 
Y*7 

MPF Custom Paper Size - 	 Displays the width of custom size paper loaded in the MPF. 
X*7 

MPF Display Popup*7 Displays whether to show a popup menu that prompts the user to set 
the paper size and type when the paper is loaded in the MPF. 

Tray 1 Paper Size Displays the paper size setting of tray1. 

Tray 1 Paper Type Displays the paper type setting of tray1. 

Tray 1 Custom Paper Size - Displays the length of custom size paper loaded in tray1. 
Y 

Tray 1 Custom Paper Size - Displays the width of custom size paper loaded in tray1. 
X 

Tray 1 Display Popup Displays whether to show a popup menu that prompts the user to set 
the paper size and type when the paper is loaded in tray1. 

Tray 2 Paper Size*8 Displays the paper size setting of the optional 550-sheet feeder (tray2). 

Tray 2 Paper Type*8 Displays the paper type setting of the optional 550-sheet feeder. 

Tray 2 Custom Paper Size -	 Displays the length of custom size paper loaded in the optional 550­
Y*8 sheet feeder. 

Tray 2 Custom Paper Size -	 Displays the width of custom size paper loaded in the optional 550­
X*8 sheet feeder. 

Tray 2 Display Popup*8	 Displays whether to show a popup menu that prompts the user to set 
the paper size and type when the paper is loaded in the optional 550­
sheet feeder. 

1st Priority Displays the paper source to be used as the first priority. 

2nd Priority Displays the paper source to be used as the second priority. 

3rd Priority*8 Displays the paper source to be used as the third priority. 
*1 Auto-Off Timer feature is available only in certain regions.
 
*2 This item is available only when the optional 512MB memory module is installed and the optional hard disk is not installed.
 
*3 This item is available only for Dell C3760dn Color Laser Printer.
 
*4 This item is available only when the optional hard disk is installed.
 
*5 This item is available only when RAM Disk is enabled or the optional hard disk is installed.
 
*6 For paper weight specifications, see "Paper Type Specifications."
 
*7 This item is available only when Panel Specified in MPF Mode is selected.
 
*8 This item is available only when the optional 550-sheet feeder is installed.
 

Reports 

Purpose: 

To print various types of reports and lists. 

Values: 

Printer Settings Click Start to print the Printer Settings page. 

Panel Settings Click Start to print the Panel Settings page. 
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PCL Fonts List Click Start to print the PCL (Hewlett-Packard Printer Control Language) Fonts List. 

PCL Macros List Click Start to print the PCL Macro List. 

PS Fonts List Click Start to print the PS Fonts List. 

PDF Fonts List Click Start to print the PDF Fonts List. 

Job History Click Start to print the Job History report. 

Error History Click Start to print the Error History report. 

Print Meter Click Start to print the Print Meter report. 

Color Test Page Click Start to print the Color Test Page. 

Stored Documents*1 Click Start to print the Stored Documents list. 
*1 This item is available only when RAM Disk is enabled with the optional 512MB memory module installed or the optional hard disk is 

installed. 

Printer Settings 

The Printer Settings tab includes System Settings, Network Settings, USB Settings, PCL Settings, PostScript 
Settings, PDF Settings, Secure Settings, and USB Direct Print Defaults pages. 

System Settings 

Purpose: 

To configure the basic printer settings. 

Values: 

Power Saver Time - Sleep Sets the time taken by the printer to enter Sleep mode after it finishes a job. 

Power Saver Time - Deep Sleep Sets the time taken by the printer to enter Deep Sleep mode after it has 
entered Sleep mode. 

Power Saver Time - Auto-Off Timer*1 Sets the time taken by the printer to be turned off after it has entered Deep 
Sleep mode. 

mm / inch Sets the measurement unit to be used on the LCD panel as either mm or 
inches. 

Control Panel Tone Sets the volume of the tone that is emitted when the operator panel input is 
correct, or disables the tone. 

Invalid Key Tone Sets the volume of the tone that is emitted when the operator panel input is 
incorrect, or disables the tone. 

Machine Ready Tone Sets the volume of the tone that is emitted when the printer becomes ready, 
or disables the tone. 

Job Completed Tone Sets the volume of the tone that is emitted when a print job is complete, or 
disables the tone. 

Fault Tone Sets the volume of the tone that is emitted when a job ends abnormally, or 
disables the tone. 

Alert Tone Sets the volume of the tone that is emitted when a problem occurs, or 
disables the tone. 

Out of Paper Tone Sets the volume of the tone that is emitted when the printer runs out of 
paper, or disables the tone. 

Low Toner Alert Tone Sets the volume of the tone that is emitted when the toner is low, or 
disables the tone. 

Auto Clear Alert Tone Sets the volume of the tone that is emitted 5 seconds before the printer 
performs auto clear, or disables the tone. 
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All Tones Sets the volume of all the alert tones, or disables all the tones. 

Low Toner Alert Message Alerts you if the toner is low. 

Auto Log Print Sets if a job history needs to be printed after every 20 jobs. 

RAM Disk*2 Sets whether to allocate RAM for the file system for the Secure Print, Proof 
Print, Private Mail Box Print, and Public Mail Box Print features. 

Panel Language Used to set the language on the LCD panel. 

Auto Reset Sets the amount of time before the printer automatically resets its settings 
to the defaults when no additional settings are made. 

Fault Time-out Sets the amount of time the printer waits before canceling a job that stops 
abnormally. 

Job Time-out Sets the amount of time the printer waits for data to arrive from the 
computer. 

Default Paper Size Sets the default print paper size. 

Print ID Sets where to print the user ID on the output paper. 

Print Text Sets whether the printer outputs PDL data (which is not supported by the 
printer) as text when the printer receives it. 

Banner Sheet Insert Position Sets where to insert a banner sheet in the output. 

Banner Sheet Specify Tray Sets from which tray a banner sheet is fed. 

Substitute Tray Sets whether to use another size paper when the paper that is loaded in the 
specified tray does not match the paper size settings for the current job. 

Letterhead 2 Sided*3 Sets whether to print on both sides of letterhead. 

A4<>Letter Switch Sets whether to print A4 size jobs on Letter size paper if A4 is not available 
in the paper trays and vice versa (Letter size job on A4 size paper). 

Report 2 Sided Print*3 Sets whether to print reports on both sides a sheet of paper. 

Use Another Tray Sets whether to show a message to select another tray when the specified 
paper is not available in the paper tray. 

*1 Auto-Off Timer feature is available only in certain regions.
 
*2 This item is available only when the optional 512MB memory module is installed and the optional hard disk is not installed.
 
*3 This item is available only for Dell C3760dn Color Laser Printer.
 

Network Settings 

Purpose: 

To Specify the PostScript communication protocol for this printer. 

Values: 

Adobe Protocol Sets PostScript communication protocol for each interface. 

USB Settings 

Purpose: 

To change USB settings on your printer. 

Values: 

USB Port Enables the USB interface on your printer. 

Adobe Protocol Sets PostScript communication protocol for each interface. 
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PCL Settings 

Purpose: 

To change the PCL settings. 

Values: 

Paper Tray Sets the paper input tray. 

Paper Size Sets the paper size. 

Custom Paper Size - Y Sets the length of custom size paper. The available range is from 127 mm (5.0 inch) to 355 mm (14.0 
inch). 

Custom Paper Size - X Sets the width of custom size paper. The available range is from 77 mm (3.0 inch) to 215 mm (8.5 
inch). 

Orientation Sets how text and graphics are oriented on the page. 

2 Sided Print*1 Sets duplexing as the default for all print jobs. 

Font	 Sets the font from the list of registered fonts. 

Symbol Set Sets a symbol set for the specified font. 

Font Size Sets the font size for scalable typographic fonts. 

Font Pitch Sets the font pitch for scalable mono spaced fonts. 

Form Line Sets the number of lines in a page. 

Quantity Sets the number of copies to print. 

Image Enhance Sets whether to enable the Image Enhancement feature. 

Hex Dump	 Sets whether to help isolate the source of a print job problem. With Hex Dump selected, all data 
sent to the printer is printed in hexadecimal and character representation. Control codes are not 
executed. 

Draft Mode Sets whether to print in the draft mode. 

Line Termination Sets how to handle line terminations. 

Default Color Sets the print color mode as Color or Black. This setting is used for print jobs without a specified 
color print mode. 

Ignore Form Feed Sets whether to ignore blank pages that only contain Form Feed control codes. 
*1 This item is available only for Dell C3760dn Color Laser Printer. 

PostScript Settings 

Purpose: 

To change printer settings that only affect jobs using the PostScript emulation printer language. 

Values: 

PS Error Report Sets whether the printer outputs error contents for a PostScript error. 

PS Job Time-out Sets the execution time for one PostScript job. 

Paper Select Mode Sets the way to select the tray for the PostScript mode. 

Default Color Sets the default color mode for the PostScript mode. 

PDF Settings 

Purpose: 

To change the PDF settings. 
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Values: 

Quantity Sets the number of copies. 

2 Sided Print*1 Sets whether to print on both sides of a sheet of paper. 

Print Mode Sets a print mode. 

PDF Password Sets a password. 

Re-enter PDF Password Confirms the set password. 

Collation Sets whether to sort the output. 

Output Size Sets the output paper size. 

Layout Sets the output layout. 

Output Color Sets the output color. 
*1 This item is available only for Dell C3760dn Color Laser Printer. 

Secure Settings 

Panel Lock 

Purpose: 

To set a limited access to Admin Settings with a password, and to set or change the password. 

Values: 

Panel Lock Control*1 Enables/Disables password protection for the Admin Settings. 

New Password Sets a password that is required to access the Admin Settings. 

Re-enter Password Confirms the set password. 
*1 Some setting items in the Secure Settings are displayed only when this setting item is enabled. 

NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.
 

Function Enabled
 

Purpose:
 

To specify whether to lock the USB Direct Print function with a password, and to set or change the password.
 

Values:
 

USB Direct Print Sets whether to lock the USB Direct Print function with a password. 

New Password Sets a password that is required to access the USB Direct Print function. 

Re-enter Password Confirms the set password. 

NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.
 

Software Download
 

Purpose:
 

To set whether to enable download of firmware updates.
 

Data Encryption 

Purpose: 

To set whether to encrypt the data. 
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Values: 

Data Encryption Encryption Sets whether to encrypt the data. 

Encryption Key Sets a key that is required to encrypt. 

Re-enter Encryption Key Enter the new key again to confirm. 

NOTE: You can enter only characters from 0 to 9, a to z, A to Z, and NULL values for encryption key. 

Hard Disk Over Write 

NOTE: HDD Disk Over Write feature is available only when the optional hard disk is installed. 

Purpose: 

To set whether to overwrite the hard disk drive. 

Values: 

Hard Disk Over Write Sets whether to overwrite the hard disk drive. 

Login Error
 

Purpose:
 

To specify how many times an administrator can attempt to log in to Panel Lock and Function Enabled.
 

Values:
 

Login Error Displays how many times an administrator can attempt to log in to Panel Lock and Function 
Enabled. 

Set Available Time - Print 

Purpose: 

To specify the time to enable the secure setting for the Print function. 

Values: 

Set Available Time Allows you to set the available time period for the Print function. 

Start Time Sets the start time of the available time period for the Print function. 

End Time Sets the end time of the available time period for the Print function. 

Recurrence Sets the day of the week to repeat the setting. 

Secure Job Expiration 

NOTE: Secure Job Expiration feature is available only when RAM Disk is enabled with the optional 512MB memory module 
installed or the optional hard disk is installed. 

Purpose: 

To specify the date and time to delete the files stored as Secure Print in the optional 512MB memory module or the 
optional hard disk drive. 

Values: 

Expiration Mode	 Allows you to set the date to delete the files stored as Secure Print in the optional 512MB memory 
module or the optional hard disk drive. 
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Expiration Time Sets the time to delete the files stored as Secure Print in the optional 512MB memory module or the 
optional hard disk drive. 

Recurrence Sets the period to repeat the setting. 

Weekly Settings Sets the day of the week to repeat the setting. 

Monthly Settings Sets the day of the month to repeat the setting. 

USB Direct Print Defaults 

Purpose:
 

To create your own USB Direct Print Defaults setting.
 

Values:
 

Output Color Sets whether to print in color or in black and white. 

Select Tray Sets the default input tray. 

2 Sided Printing Sets whether to print on both sides of a sheet of paper. 

Multiple-Up Sets whether to print two or more pages on one side of a sheet of paper. 

Collation Sets whether to sort the output. 

PDF Password Sets a password. 

Re-enter PDF Password Confirms the set password. 

Printer Maintenance 

The Printer Maintenance tab includes the Paper Density, Adjust Transfer Belt Unit, Adjust 2nd BTR, Adjust 
Fusing Unit, Auto Registration Adjustment, Color Registration Adjustments, Reset Defaults, Initialize 
PrintMeter, Storage, Non-Dell Toner, Adjust Altitude, Clock Settings, and Web Link Customization pages. 

Paper Density 

Purpose: 

To specify the paper density. 

Values: 

Plain Sets the density of plain paper to Light or Normal. 

Label Sets the density of labels to Light or Normal. 

Adjust Transfer Belt Unit 

Purpose: 

To adjust the transfer bias when ghosting occur. (The ghost image may be the image of the previous page, or a part of 
the page currently printing.) 

Values: 

K Offset If faint black colored ghosts appear, try to decrease the value. 

YMC Offset If faint ghosts in color (yellow, magenta, or cyan) appear, try to decrease the value. 

Adjust 2nd BTR 

Purpose: 
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To specify the optimum voltage settings for printing for the 2nd Belt Transfer Roller (2nd BTR). To lower the 

voltage, set negative values. To increase, set positive values.
 

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 

increase the voltage. If you see white spots on the print output, try to decrease the voltage.
 

CAUTION: The print quality changes depending on the setting values you select for this item. 

Values: 

Plain Sets the reference voltage setting for the transfer roller for plain paper within the range of -5 to 10. 

Plain Thick Sets the reference voltage setting for the transfer roller for thick plain paper within the range of -5 to 
10. 

Covers Sets the reference voltage setting for the transfer roller for cover paper within the range of -5 to 10. 

Covers Thick Sets the reference voltage setting for the transfer roller for thick cover paper within the range of -5 to 
10. 

Coated Sets the reference voltage setting for the transfer roller for coated paper within the range of -5 to 10. 

Coated Thick Sets the reference voltage setting for the transfer roller for thick coated paper within the range of -5 to 
10. 

Label Sets the reference voltage setting for the transfer roller for labels within the range of -5 to 10. 

Envelope Sets the reference voltage setting for the transfer roller for envelopes within the range of -5 to 10. 

Recycled Sets the reference voltage setting for the transfer roller for recycled paper within the range of -5 to 10. 

Adjust Fusing Unit 

Purpose: 

To specify the optimum temperature settings for printing for the fusing unit. To lower the temperature, set negative 
values. To increase, set positive values.
 

The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower 

the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.
 

NOTE: The print quality changes depending on the setting values you select for this item. 

Values: 

Plain Sets the temperature settings for the fusing unit for plain paper within the range of -3 to 3. 

Plain Thick Sets the temperature settings for the fusing unit for thick plain paper within the range of -3 to 3. 

Covers Sets the temperature settings for the fusing unit for cover paper within the range of -3 to 3. 

Covers Thick Sets the temperature settings for the fusing unit for thick cover paper within the range of -3 to 3. 

Coated Sets the temperature settings for the fusing unit for coated paper within the range of -3 to 3. 

Coated Thick Sets the temperature settings for the fusing unit for thick coated paper within the range of -3 to 3. 

Label Sets the temperature settings for the fusing unit for labels within the range of -3 to 3. 

Envelope Sets the temperature settings for the fusing unit for envelopes within the range of -3 to 3. 

Recycled Sets the temperature settings for the fusing unit for recycled paper within the range of -3 to 3. 

Auto Registration Adjustment 

Purpose: 

To specify whether to automatically perform color registration adjustment. 
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Color Registration Adjustments 

Purpose: 

To specify whether to manually perform color registration adjustment. 

Manual Color Registration Adjustments are required such as when the printer is initially installed and after the 
printer is moved. 

NOTE: The Color Registration Adjustments feature can be configured when Auto Registration Adjustment is set to Off. 

Values: 

Auto Correct Click Start to automatically perform color registration correction. 

Color Regi Chart	 Click Start to print a color registration chart. The color registration chart prints a lattice pattern of 
yellow, magenta, and cyan lines. On the chart, look at the values on the right side that are next to the 
line that is perfectly straight for each of the three colors. If the value for this line is 0, color registration 
adjustment is not required. If the value for this line is any value other than 0, specify the adjustment 
values under Color Registration Adjustments. 

Color Registration Sets lateral (perpendicular to paper feed direction) and process (paper feed direction) color 
Adjustments adjustment values individually for Yellow, Magenta, and Cyan within the range of -9 to 9. 

Reset Defaults 

Purpose: 

To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu 
parameters are reset to their default values. 

Reset Defaults and Click Start to reset the default setting and restart the printer. 
restart printer. 

Initialize PrintMeter 

Purpose: 

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to 0. 

Storage 

NOTE: Storage feature is available only when RAM Disk is enabled with the optional 512MB memory module installed or the 
optional hard disk is installed. 

Purpose: 

To clear all files stored in the optional 512MB memory module or the optional hard disk, or format the optional hard 
disk. 

Values: 

Clear Storage*1 All Clear Click Start to clear all files stored as Secure Print, Proof Print, Private Mail Box 
Print, and Public Mail Box Print in the optional 512MB memory module or the 
optional hard disk. 

Secure Document Click Start to clear all files stored as Secure Print, Proof Print, Private Mail Box 
Print, and Public Mail Box Print in the optional 512MB memory module or the 
optional hard disk. 

Stored Document Click Start to clear all files stored in the optional 512MB memory module or the 
optional hard disk. 
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Format Hard Disk*2 Format Hard Disk	 Click Start to format the optional hard disk. All fonts, forms and files for Secure 
Print, Proof Print, Private Mail Box Print, and Public Mail Box Print stored in the 
optional hard disk are cleared. 

*1	 This item is available only when RAM Disk is enabled with the optional 512MB memory module installed or the optional hard disk is 
installed. 

*2	 This item is available only when the optional hard disk is installed. 

Non-Dell Toner 

Purpose: 

To use toner cartridge of another manufacturer. 

WARNING: Using a non-Dell toner cartridge may severely damage your printer. The warranty does not cover damages caused 
by using non-Dell toner cartridges. 

Adjust Altitude 

Purpose: 

To specify the altitude of the location where the printer is installed. 


The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 

performed by specifying the altitude of the location where the printer is being used.
 

Clock Settings 

Purpose: 

To specify the clock settings. 

Values: 

Date Format Sets the date format; YYYY/MM/DD, MM/DD/YYYY, or DD/MM/YYYY. 

Time Format Sets the time format; 24 Hour Clock or 12 Hour Clock. 

Time Zone Sets the time zone. 

Set Date Sets the current date. 

Set Time Sets the current time. 

Web Link Customization 

Purpose:
 

To specify a link used for ordering consumables, which can be accessed from Order Supplies at: in the left frame.
 

Values:
 

Select Reorder URL Sets a URL to be linked to Order Supplies at: 

Regular Displays the regular URL (http://accessories.us.dell.com/sna) that can be linked to Order Supplies 
at:. 

Premier Displays the premier URL (http://premier.dell.com) that can be linked to Order Supplies at:. 

Print Server Settings 
Use the Print Server Settings menu to set the type of printer interface and the necessary conditions for 

communication.
 

The following tabbed pages are displayed in the top of the right frame.
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Print Server Reports 

The Print Server Reports tab includes the Print Server Setup Page and the E-Mail Alert Setup Page. 

Print Server Setup Page 

Purpose: 

To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol and printing 
ports. On this page, you can only verify the settings of items. If you want to change the settings, go to the pages in 
the Print Server Settings tab. 

Values: 

Ethernet*1 Ethernet Settings Displays the current settings of Ethernet transmission rate and the duplex 
settings. 

Current Ethernet Displays the current Ethernet settings. 
Settings 

MAC Address Displays the Media Access Control (MAC) address of the printer. 

Wireless Settings*2 SSID Displays the name that identifies the network. 

Network Type Displays the network type from either the Ad-Hoc or Infrastructure mode. 

MAC Address Displays the MAC address of the wireless adapter. 

Link Channel Displays the channel number of the connection. 

Link Quality Displays the quality of the connection. 

TCP/IP Settings IP Mode Displays the IP mode. 

Host Name Displays the host name. 

IPv4*3 IP Address Mode Displays the IP address mode. 

IP Address Displays the IP address. 

Subnet Mask Displays the subnet mask. 

Gateway Address Displays the gateway address. 

IPv6*4 Enable Stateless Address Displays whether to enable the stateless 
address. 

Use Manual Address Displays whether to set the IP address 
manually. 

Get IP Address from Displays whether to automatically set the IP 
DHCP address via DHCP. 

Manual Address*5 Displays the IP address. 

Stateless Address 1-3*6 Displays the stateless addresses. 

Stateful Address 1-3 Displays the stateful addresses. 

Link Local Address*6 Displays the link local address. 

Manual Gateway 
Address*5 

Displays the gateway address. 

Auto Configure Gateway 
Address*6 

Displays the gateway address. 
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DNS IPv4*3 Get DNS Server Address Displays whether to automatically set the 
from DHCP DNS server address via DHCP. 

Current DNS Server Displays the current DNS server address. 
Address 

IPv6*4 Get DNS Server Address Displays if the printer receives the DNS server 
from DHCPv6-lite address automatically from the DHCPv6-lite 

server. 

Current DNS Server Displays the current DNS server address. 
Address 

DNS Dynamic Update Displays the status of the DNS Dynamic 
(IPv4) Update feature. 

DNS Dynamic Update Displays the status of the DNS Dynamic 
(IPv6) Update feature. 

Auto Generate Search List Displays whether to automatically generate a 
search list. 

Search Domain Name Displays the search domain name. 

Time-out Displays the time-out period. 

Priority to IPv6 DNS 
Name Resolution*7 

Displays whether to use the DNS Name 
Resolution feature. 

WINS*3 WINS Mode Displays whether to automatically set the primary and secondary WINS 
server addresses via DHCP. 

WINS Primary Server Displays the primary WINS server address. 

WINS Secondary Server Displays the secondary WINS server address. 

LPD Port Status Displays the port status of the Line Printer Daemon (LPD) protocol. 

Connection Time-Out Displays the connection time-out period. 

Port9100 Port Status Displays the port status. 

Port Number Displays the port number. 

Connection Time-Out Displays the connection time-out period. 

IPP Port Status Displays the port status. 

Printer URI Displays the printer URI. 

Connection Time-Out Displays the connection time-out period. 

Port Number Displays the port number. 

Maximum Sessions Displays the maximum number of connections received simultaneously by 
the client. 

WSD WSD Print Displays whether to use WSD for printing. 

Port Number Displays the WSD port number. 

Receive Time-Out Displays the receive time-out period. 

Notification Time-Out Displays the notification time-out period. 

Maximum Number of Displays the maximum number of TTLs. 
TTL 

Maximum Number of Displays the maximum number of notifications. 
Notification 

FTP Port Status Displays the port status. 

Connection Time-Out Displays the connection time-out period. 
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HTTP Port Status Displays the port status. 

Port Number Displays the port number. 

Simultaneous Displays the maximum number of simultaneous connections. 
Connections 

Connection Time-Out Displays the connection time-out period. 

SMB Port Status Displays the port status. 

Host Name Displays the host name. 

Workgroup Displays the workgroup. 

Maximum Sessions Displays the maximum number of sessions. 

Unicode Support Displays whether to notify the host name and workgroup name in Unicode 
characters during SMB transmission. 

Auto Master Mode Displays whether to enable the Auto Master Mode. 

Encrypt Password Displays whether to encrypt the password during SMB transmission. 

Job Time-Out Displays the job time-out period. 

Connection Time-Out Displays the connection time-out period. 

Bonjour (mDNS) Port Status Displays the port status. 

Host Name Displays the host name. 

Printer Name Displays the printer name. 

Wide-Area Bonjour Displays the status of the Wide-Area Bonjour feature. 

Telnet Port Status Displays the port status. 

Connection Time-Out Displays the connection time-out period. 

SNMP Port Status Displays the port status. 

Enable SNMP v1/v2c Displays the status of the SNMP v1/v2c feature. 
Protocol 

Enable SNMP v3 Displays the status of the SNMP v3 feature. 
Protocol 

SNTP Port Status Displays the port status. 

IP Address / Host Name Displays the IP address or the host name of the SNTP server. 

Connection Time-Out Displays the connection time-out period. 

Time Synchronization Displays the interval for performing time synchronization using SNTP. 
Interval 

AirPrint Port Status Displays the port status. 

Name Displays the name of AirPrint. 

Location Displays the location of the printer. 

Geo-Location Displays the physical location of the printer. 

Google Cloud Print Port Status Displays the port status. 

Registration state Displays the registration state. 

Proxy Server Use Proxy Server Displays the status of proxy server. 

Address to Bypass Proxy Displays the address of the bypass proxy server. 
Server 

Server Name Displays the server name. 

Port Number Displays the port number. 

Authentication Displays the status of authentication feature. 
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Authentication System	 Authentication System Displays the authentication method. 
Settings(for ColorTrack 
PRO) 

SSL/TLS HTTP - SSL/TLS Displays the status of the HTTP - SSL/TLS Communication. 
Communication 

HTTP - SSL/TLS Displays HTTP - SSL/TLS Communication Port Number. 
Communication Port 
Number 

LDAP - SSL/TLS Displays the status of the LDAP - SSL/TLS Communication. 
Communication*8 

Verify Remote Server Displays the status of the Verify Remote Server Certificate. 
Certificate*8 

IPsec Settings Protocol Displays the protocol status. 

IKE	 Displays IKE authentication. 

802.1x*1 Enable IEEE 802.1x Displays the status of IEEE 802.1x. 

Authentication Method Displays the setting of authentication method for IEEE 802.1x. 

IP Filter (IPv4)*9 Access List Displays the list of IP addresses that are permitted or denied access to the 
printer. 

*1 This item is available only when the printer is connected using an Ethernet cable. 

*2 This item is available only when the printer is connected using the wireless network.
 
*3 This item is displayed when IPv4 Mode or Dual Stack in IP Mode is selected.
 
*4 This item is displayed when IPv6 Mode or Dual Stack in IP Mode is selected.
 
*5 This item is displayed only when Use Manual Address is set to Enable.
 
*6 This item is displayed only when an IP address has been assigned.
 
*7 This item is available only when using IPv6 dual mode.
 
*8 This item is displayed only when the optional hard disk is installed and is set to On for encryption.
 
*9 This item is available only for LPD or Port9100.
 

E-Mail Alert Setup Page 

Purpose: 

To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the E-
Mail Alert feature. In this page, you can only verify the settings of items. If you want to change the settings, go to the 
pages in the Print Server Settings tab. 

Values: 

E-Mail Server Settings Port Status Displays the port status. 

Primary SMTP Gateway Displays the primary SMTP (Simple Mail Transfer Protocol) gateway. 

SMTP Port Number Displays the SMTP port number. 

E-Mail Send Displays the authentication method for outgoing e-mail. 
Authentication 

POP3 Server Address Displays the POP3 (Post Office Protocol 3) server address. 

POP3 Port Number Displays the POP3 port number. 

Reply Address Displays the IP address of servers connected with SMTP protocol when data 
is incoming. 

SMTP Server Displays the status of the SMTP server connection. 
Connection 
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E-Mail Alert Settings E-Mail List 1 Displays the acceptable e-mail addresses for 
the E-Mail Alert feature specified in E-Mail 
List 1. 

Select Alerts for List 1 Supplies Alerts Displays the e-mail alert receive status for 
consumables. 

Paper Handling Alerts Displays the e-mail alert receive status for 
paper handling. 

Service Call Displays the e-mail alert receive status for 
service calls. 

E-Mail List 2 Displays the acceptable e-mail addresses for 
the E-Mail Alert feature specified in E-Mail 
List 2. 

Select Alerts for List 2 Supplies Alerts Displays the e-mail alert receive status for 
consumables. 

Paper Handling Alerts Displays the e-mail alert receive status for 
paper handling. 

Service Call Displays the e-mail alert receive status for 
service calls. 

Print Server Settings 

The Print Server Settings tab includes the Basic Information, Port Settings, TCP/IP, SMB, E-Mail Alert, Bonjour 
(mDNS), SNMP, SNTP, Wireless LAN, AirPrint, Google Cloud Print, Proxy Server, and Reset Print Server pages. 

Basic Information 

Purpose: 

To configure basic information of the printer. 

Values: 

System Settings Printer Name Sets the name of the printer. 

Location Sets the location of the printer. 

Contact Person Sets the contact name, number, and other information of the printer 
administrator and service center. 

Administrator E-Mail 
Address 

Sets the contact address of the printer administrator and service center. 

Asset Tag Number Enters the asset tag number for the printer. 

EWS Settings Auto Refresh Automatically refreshes the contents of the status display pages. 

Auto Refresh Interval Sets the time interval for refreshing the contents of the status display pages 
automatically from 15 to 600 seconds. 

NOTE: The Auto Refresh feature is effective for the contents of the top frame, Printer Status page, Job List page, and Completed 
Jobs page. 

Port Settings 

Purpose: 

To enable or disable printing ports and management protocol features. 
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Values: 

Ethernet*1 Ethernet Settings Auto Detects the Ethernet transmission rate and the 
duplex settings automatically. 

10Base-T Half-Duplex Selects 10Base-T Half-Duplex as the default 
value. 

10Base-T Full-Duplex Selects 10Base-T Full-Duplex as the default 
value. 

100Base-TX Half-Duplex Selects 100Base-TX Half-Duplex as the default 
value. 

100Base-TX Full-Duplex Selects 100Base-TX Full-Duplex as the default 
value. 

1000Base-T Full-Duplex Selects 1000Base-T Full-Duplex as the default 
value. 

Current Ethernet Settings Displays the current settings of the Ethernet. 

MAC Address Displays the MAC address of the printer. 

Port Status LPD Sets whether to enable LPD. 

Port9100 Sets whether to enable Port9100. 

IPP Sets whether to enable IPP. 

WSD Print Sets whether to enable WSD Print. 

FTP Sets whether to enable FTP. 

SMB Sets whether to enable SMB. 

Bonjour (mDNS) Sets whether to enable Bonjour (mDNS). 

E-Mail Alert Sets whether to enable E-Mail Alert. 

Telnet Sets whether to enable Telnet. 

SNMP Sets whether to enable SNMP. 

SNTP Sets whether to enable SNTP. 

Google Cloud Print Sets whether to enable Google Cloud Print. 
*1 This item is available only when the printer is connected using an Ethernet cable. 

NOTE: The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the 
settings, click the Apply New Settings button to apply the new settings. 

TCP/IP 

Purpose: 

To configure the IP address, subnet mask, and gateway address of the printer. 
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Values: 

TCP/IP IP Mode Sets the IP mode. 
Settings Host Name Sets the host name. 

IPv4 IP Address Mode Sets the method for acquiring the IP address. 

Manual IP Address When an IP address is being set manually, the IP is allocated to 
the printer using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 
127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address. 

Manual Subnet Mask When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 
255.255.255.255 cannot be specified as the subnet mask. 

Manual Gateway When an IP address is being set manually, the gateway address 
Address is specified using the format nnn.nnn.nnn.nnn. Each octet 

that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 
254. 127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address. 

IPv6 Enable Stateless Select the check box to enable the stateless address. 
Address 

Use Manual Address Select the check box to set the IP address manually. 

Get IP Address from Allows you to enable or disable the automatic setting of the IP 
DHCP address via DHCP. 

Manual Address Sets the IP address. To specify an IPv6 address, enter the 
address followed by a slash (/) and then "64". For details, 
consult your system administrator. 

Manual Gateway Sets the gateway address. 
Address 
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DNS DNS Domain Name Sets the DNS domain name. 

IPv4 Get DNS Server 
Address from DHCP 

Allows you to enable or disable the automatic setting of the 
DNS server address via DHCP. 

Manual DNS Server 
Address 

Manually sets the DNS server address in xxx.xxx.xxx.xxx 
format when Get DNS Server Address from DHCP is not 
selected. 

IPv6 Get DNS Server 
Address from DHCPv6­
lite 

Select the check box to get the DNS server address 
automatically from the DHCPv6-lite server. 

Manual DNS Server 
Address 

Sets the DNS server address. 

DNS Dynamic Update 
(IPv4) 

Select the check box to enable dynamic updates to DNS. 

DNS Dynamic Update 
(IPv6) 

Select the check box to enable dynamic updates to DNS. 

Auto Generate Search 
List 

Select the check box to automatically generate the search list. 

Search Domain Name Sets the search domain name. Up to 255 alphanumeric 
characters, periods, and hyphens can be used. If you need to 
specify more than one domain name, separate them using a 
comma or semicolon. 

Time-out Sets the time-out period between 1 and 60 seconds. 

Priority to IPv6 DNS 
Name Resolution 

Select the check box to enable the DNS Name Resolution 
feature. 

WINS WINS Mode Allows you to enable or disable the automatic setting of the primary and secondary 
WINS server addresses via DHCP. 

WINS Primary Server Manually sets the primary WINS server address in xxx.xxx.xxx.xxx format when WINS 
Mode is not selected. 

WINS Secondary 
Server 

Manually sets the secondary (backup) WINS server address in xxx.xxx.xxx.xxx format 
when WINS Mode is not selected. 

LPD Connection Time-
Out 

Sets the connection time-out period from 1 to 3,600 seconds. 

IP Filter (IPv4) Click IP Filter (IPv4) to set the IP Filter settings on the IP Filter (IPv4) page. 

Port9100 Port Number Sets the port number from 9,000 to 9,999. 

Connection Time-
Out 

Sets the connection time-out period between 1 and 1,000 seconds. 

IP Filter (IPv4) Click IP Filter (IPv4) to set the IP filter settings on the IP Filter (IPv4) page. 

IPP Printer URI Displays the printer URI. 

Connection Time-
Out 

Sets the connection time-out period from 1 to 1,000 seconds. 

Port Number Displays the port number for receiving requests from the client. 

Maximum Sessions Displays the maximum number of connections received simultaneously by the client. 
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WSD Port Number Sets the port number to 80 or from 8,000 to 9,999. 

Receive 
Time-Out 

Sets the receive time-out period from 1 to 65,535 seconds. 

Notification Time-
Out 

Sets the notification time-out period from 1 to 60 seconds. 

Maximum Number 
of TTL 

Sets the maximum number of TTL from 1 to 10. 

Maximum Number 
of Notification 

Sets the maximum number of notifications from 10 to 20. 

FTP Password Sets the password for FTP. 

Re-enter Password Enter the password again to confirm it. 

Connection Time-
Out 

Sets the connection time-out period from 1 to 1000 seconds. 

HTTP Port Number Sets the port number to 80 or from 8,000 to 9,999. 

Simultaneous 
Connections 

Displays the maximum number of simultaneous connections. 

Connection Time-
Out 

Sets the connection time-out period from 1 to 255 seconds. 

Telnet Password Sets the password for Telnet. 

Re-enter Password Confirms the set password. 

Connection Time-
Out 

Sets the connection time-out period from 1 to 1,000 seconds. 

To configure the IP Filter feature, enter an IP address to be filtered in the Address field and the subnet mask in the 
Address Mask field. Enter a numeric value between 0 and 255 in each field. "*" is appended to the current value. 

IP Filter Setup Procedure 

You can set up to a maximum of five items and the first item set takes priority. When setting multiple filters, enter 
the shortest address first followed by a slightly longer address, a longer address and so on. 

Enabling Printing From a Specified User 

The following describes the procedure to enable printing only from the "192.168.100.10" IP address. 

1 Click the first column of the Access List row 1. 

2 Enter "192.168.100.10" in the Address field and "255.255.255.255" in the Address Mask field. 

3 Select Accept. 

4 Click Apply New Settings. 

Disabling Printing From a Specified User 

The following describes the procedure to disable printing only from the "192.168.100.10" IP address. 

1 Click the first column of the Access List row 1. 

2 Enter "192.168.100.10" in the Address field and "255.255.255.255" in the Address Mask field. 

3 Select Reject. 

4 Click the first column of the Access List row 2. 

5 Enter "0.0.0.0" in the Address field and "0.0.0.0" in the Address Mask field. 

6 Select Accept. 

7 Click Apply New Settings. 

Dell™ Printer Configuration Web Tool 155 

http:192.168.100.10
http:192.168.100.10
http:192.168.100.10
http:192.168.100.10


 

  

 

  

   

 

 

 

Enabling and Disabling Printing from Network Addresses 

You can enable printing from the "192.168" network address and disable printing from the "192.168.200" 
network address. 

The example below describes how to enable printing from the "192.168.200.10" IP address. 

1 Click the first column of the Access List row 1. 

2 Enter "192.168.200.10" in the Address field and "255.255.255.255" in the Address Mask field. 

3 Select Accept. 

4 Click the first column of the Access List row 2. 

5 Enter "192.168.200.0" in the Address field and "255.255.255.0" in the Address Mask field. 

6 Select Reject. 

7 Click the first column of the Access List row 3. 

8 Enter "192.168.0.0" in the Address field and "255.255.0.0" in the Address Mask field. 

9 Select Accept. 

10 Click Apply New Settings. 

SMB 

Purpose: 

To specify the setting of the Server Message Block (SMB) protocol. 

Values: 

Host Name Sets the host name of the server computer. 

Workgroup Sets the workgroup. 

Maximum Sessions Sets the maximum number of sessions. 

Unicode Support Sets whether to notify the host name and workgroup name in Unicode characters during 
SMB transmission. 

Auto Master Mode Sets whether to enable the Auto Master Mode. 

Encrypt Password Sets whether to encrypt the password. 

Job Time-Out Sets the job time-out period between 60 and 3,600 seconds. 

Connection Time-Out Sets the connection time-out period between 60 and 3,600 seconds. 

E-Mail Alert 

Purpose: 

To configure detailed settings of E-Mail Alert. This page can also be displayed by clicking the E-Mail Alert in the 
left frame. 

Values: 

E-Mail Server Settings Primary SMTP Gateway Sets the primary SMTP gateway. 

SMTP Port Number Sets the SMTP port number. This must be 25, 587 or between 5,000 and 
65,535. 

E-Mail Send Sets the authentication method for outgoing e-mail. 
Authentication 
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SMTP Login User	 Sets the SMTP login user. Up to 63 alphanumeric characters, periods, 
hyphens, underscores, and at symbols (@) can be used. If specifying more 
than one address, separate them using commas. 

SMTP Login Password	 Sets the SMTP account password using up to 31 alphanumeric characters. 

Re-enter SMTP Login Confirms the set SMTP account password. 
Password 

POP3 Server Address*1 Sets the POP3 server address in IP address format of "aaa.bbb.ccc.ddd" or 
as a DNS host name using up to 63 characters. 

POP3 Port Number*1 Sets the POP3 server port number. This must be 110 or between 5,000 and 
65,535. 

POP User Name*1	 Sets the POP3 account user name. Up to 63 alphanumeric characters, 
periods, hyphens, underscores, and at symbols (@) can be used. If 
specifying more than one address, separate them using commas. 

POP User Password*1 Sets the POP3 account password using up to 31 alphanumeric characters. 

Re-enter POP User Confirms the set password. 
Password*1 

Reply Address Designates the reply e-mail address sent with each E-mail Alert. 

SMTP Server Displays the status of the SMTP server connection. 
Connection 

E-Mail Alert Settings E-Mail List 1	 Sets acceptable e-mail addresses for the E-
Mail Alert feature using up to 255 
alphanumeric characters. 

Select Alerts for List 1 Supplies Alerts Select the check box to receive an E-Mail 
Alert for consumables. 

Paper Handling Alerts Select the check box to receive an E-Mail 
Alert for paper handling. 

Service Call Select the check box to receive an E-Mail 
Alert for Service Calls. 

E-Mail List 2	 Sets acceptable e-mail addresses for the E-
Mail Alert feature using up to 255 
alphanumeric characters. 

Select Alerts for List 2 Supplies Alerts Select the check box to receive an E-Mail 
Alert for consumables. 

Paper Handling Alerts Select the check box to receive an E-Mail 
Alert for paper handling. 

Service Call Select the check box to receive an E-Mail 
Alert for Service Calls. 

*1 This item is available only when POP before SMTP (Plain) or POP before SMTP (APOP) for E-Mail Send Authentication is selected. 
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Bonjour (mDNS) 

Purpose: 

To configure the detailed settings of Bonjour. 

Values: 

Host Name Sets the host name up to 63 alphanumeric characters and "-" (dash). The original setting will remain 
valid if no input is made. 

Printer Name Sets the printer name up to 63 alphanumeric characters and symbol sets. The original setting will 
remain valid if no input is made. 

Wide-Area Bonjour Select the check box to enable the Wide-Area Bonjour protocol. 

SNMP 

Purpose: 

To configure the detailed settings of SNMP. 

Values: 

SNMP Configuration Enable SNMP v1/v2c 
Protocol 

Select the check box to enable the SNMP v1/v2c protocol. 

Edit SNMP v1/v2c 
Properties 

Click to display the SNMP v1/v2c page and to edit the setting of SNMP 
v1/v2c protocol from the page. 

Enable SNMP v3 
Protocol 

Select the check box to enable the SNMP v3 protocol. 

Edit SNMP v3 
Properties 

Click to display the SNMP v3 page and to edit the setting of SNMP v3 
protocol from the page. 

You can click this item only when SSL communication is enabled. 

SNMP v1/v2c 

Purpose: 

To edit the detailed settings of SNMP v1/v2 protocol.
 

To enter this page, click Edit SNMP v1/v2 Properties in the SNMP page.
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Values: 

Community Name Community Name 
(Read only)*1 

Sets the community name to access (read only) data using up to 31 
alphanumeric characters. 
The original setting will remain valid if no input is made. Characters 
entered for community name in the previous settings will not be displayed 
on the screen. The default Read Community is public. 

Re-enter Community 
Name (Read only)*1 

Enters the community name to access (read only) data again to confirm it. 

Community Name 
(Read/Write)*1 

Sets the community name to access (read and write) data using up to 31 
alphanumeric characters. 
The original setting will remain valid if no input is made. Characters 
entered for community name in the previous settings will not be displayed 
on the screen. The default Read/Write Community is private. 

Re-enter Community 
Name (Read/Write)*1 

Enters the community name to access (read and write) data again to 
confirm it. 

Community Name 
(Trap)*1 

Sets the community name used for trap up to 31 alphanumeric characters. 
The original setting will remain valid if no input is made. Characters 
entered for Community Name (Trap) in the previous settings will not be 
displayed on the screen. The default Trap Community is " " (NULL). 

Re-enter Community 
Name (Trap)*1 

Enters the community name used for trap again to confirm it. 

Trap Notification 1-4	 Trap Address Type 

Trap Address 

Port Number 

Notify 

Select the check boxes to notify trap occurrence. In this case, specify the IP 
address and IP socket in the following format: 

IPv4 

Specify the IP address and IP socket in the nnn.nnn.nnn.nnn:mmmmm 
format. Each section of "nnn" is a variable value between 0 and 255. Note 
that values 127 and 224-254 are not valid for the first three-digits only. IP 
socket mmmmm is a variable value between 0 and 65,535. 

IPv6 

Specify the IP address and IP socket in the 
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:mmmmm format. Each section 
of "xxxx" is a hexadecimal variable value between 0 and ffff. IP socket 
mmmmm is a variable value between 0 and 65,535. 

Authenticate Error Trap Select the check box to notify Authenticate Error Trap. 
*1 The default value can be changed by using Dell Printer Configuration Web Tool. 

SNMP v3 

Purpose: 

To edit the detailed settings of SNMP v3 protocol.
 

To enter this page, click Edit SNMP v3 Properties in the SNMP page.
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Values: 

Administrator Account Account Enabled Select the check box to enable the administrator account. 

User Name Enters the user name of the administrator account. 

Authentication 
Password 

Sets the authentication password of the administrator account using 8 to 32 
alphanumeric characters. 

Re-enter Authentication 
Password 

Confirms the set password. 

Privacy Password Sets the privacy password of the administrator account using 8 to 32 
alphanumeric characters. 

Re-enter Privacy 
Password 

Confirms the set password. 

Print Drivers / Remote 
Client Account 

Account Enabled 

Reset to default 
Password 

Select the check box to enable the print drivers and remote client account. 

Click to reset the password for the print drivers and remote client account 
to default. 

SNTP 

Purpose: 

To configure the SNTP server settings in order to perform time synchronization through SNTP. 

Values: 

SNTP IP Address / Host Name Sets the IP address or the host name of the SNTP server. 

Connection Time-Out Sets the connection time-out period from 1 to 120 seconds. 

Time Synchronization Sets the interval for performing time synchronization using SNTP. 
Interval 

Last Connection Time Displays the last date and time when your printer was connected to the 
SNTP server. 

Connection Status Displays the status of the connections between the SNTP server and your 
printer. 

Wireless LAN 

NOTE: Wireless LAN feature is available only when the printer is connected using the wireless network. 

Purpose: 

To configure the detailed setting for the wireless network. 


To use the wireless adapter, be sure to disconnect the Ethernet cable.
 

NOTE: Once wireless LAN is activated, wired LAN protocol will be disabled. 

Values: 

Wireless Settings SSID Sets the name that identifies the wireless network. Up to 32 alphanumeric 
characters can be entered. 

Network Type Sets the network type from either Ad-Hoc or Infrastructure. 

MAC Address Displays the MAC address of the wireless adapter for the printer. 

Link Channel Displays the channel number of the wireless connection for the printer. 

Link Quality Displays the quality of the wireless network connection for the printer. 

Security Settings Encryption Select the encryption type from the list. 
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No Security Sets No Security to configure the wireless 
setting without specifying an encryption type 
from WEP, WPA-PSK, and WPA-Enterprise. 

WEP Sets the WEP to use through the wireless 
network. 

WPA-PSK TKIP*1, 2 Sets the WPA-PSK TKIP to use through the 
wireless network. 

WPA-PSK AES/WPA2-PSK 
AES*1, 2 

Sets the WPA-PSK AES/WPA2-PSK AES to 
use through the wireless network. 

WPA-Enterprise 
TKIP*2, 3, 4 

Sets the WPA-Enterprise TKIP to use 
through the wireless network. 

WPA-Enterprise Sets the WPA-Enterprise AES/WPA2­
AES/WPA2-Enterprise 
AES*2, 3, 4 

Enterprise AES to use through the wireless 
network. 

Mixed Mode PSK*1, 2 Sets the Mixed Mode PSK to use through the 
wireless network. Mixed Mode PSK 
automatically selects the encryption type 
from either WPA-PSK TKIP, WPA-PSK AES, 
or WPA2-PSK AES. 

Mixed Mode 
Enterprise*2, 3, 4 

Sets the Mixed Mode Enterprise to use 
through the wireless network. Mixed Mode 
Enterprise automatically selects the 
encryption type from either WPA-Enterprise 
TKIP, WPA-Enterprise AES, or WPA2­
Enterprise AES. 

WEP Encryption Select the WEP key code from either Hex or Ascii. 

WEP Key 1 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption. 

Re-enter WEP Key 1 Enters the WEP key 1 again to confirm it. 

WEP Key 2 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption. 

Re-enter WEP Key 2 Enters the WEP key 2 again to confirm it. 

WEP Key 3 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption. 

Re-enter WEP Key 3 Enters the WEP key 3 again to confirm it. 

WEP Key 4 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption. 

Re-enter WEP Key 4 Enters the WEP key 4 again to confirm it. 

Transmit Key*6 Sets the transmit key type from the list. 

WPA-PSK Pass Phrase Sets the pass phrase. 

Re-enter Pass Phrase Enters the pass phrase again to confirm it. 

WPA-Enterprise*4, 5 EAP-Identity Sets the EAP-Identity for the authentication. 

Authentication Method Shows the authentication method. 

Login Name Sets the login name for the authentication. 

Password Sets the password. 

Re-enter Password Enters the password again to confirm it. 
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*1	 For encryption, AES or TKIP method is used. 
*2	 This item is available only when Infrastructure is selected for Network Type. 
*3	 For authentication and encryption by digital certificate, AES or TKIP method is used. 
*4	 This item is displayed only when the optional hard disk is installed and is set to On for encryption. 
*5	 To activate the setting, import a certificate which supports wireless LAN (server/client) on the SSL/TLS pages, and enable the relevant 

certificate in advance. 
*6	 When Auto is selected for Transmit Key, the key set specified for WEP Key 1 is used. 

AirPrint 

Purpose: 

To configure the detailed setting of AirPrint. 

Values: 

AirPrint Enable AirPrint Click to enable the printer for AirPrint. 

Name Enters the name that is to be displayed as an AirPrint printer. 

Location Sets the location of the printer. 

Geo-Location Sets the physical location of the printer. 

Supply Levels Cyan Toner Cartridge Displays the cyan toner level. 

Magenta Toner Displays the magenta toner level. 
Cartridge 

Yellow Toner Cartridge Displays the yellow toner level. 

Black Toner Cartridge Displays the black toner level. 

Google Cloud Print 

Purpose: 

To register the printer to Google Cloud Print. 

Values: 

Google Cloud Print*1 (Registration state) Displays the Google Cloud Print registration state. 

Register This Device to Click to register the printer to Google Cloud Print. 
Google Cloud Print 

*1 Google Cloud Print can only be used when the machine is using IPv4. 

Proxy Server 

Purpose: 

To configure the Proxy Server settings. 
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Values: 

Proxy Server Use Proxy Server Sets whether to enable the use of a proxy server. 

Address to Bypass Proxy Sets the address to bypass proxy server. 
Server 

Server Name Sets the name of the proxy server. 

Port Number Sets the port number from 1 to 65535. 

Authentication Sets whether to enable authentication. 

Login Name Sets the login name for the proxy server. 

Password Sets the login password for the proxy server. 

Retype Password Confirms the set password. 

Reset Print Server 

Purpose: 

To initialize NVRAM (non-volatile RAM) for the network feature and reboot the printer. You can also initialize 

NVRAM of the printer from Reset Defaults in the Printer Settings menu.
 

Values:
 

Initialize NIC NVRAM Memory Click Start to initialize NVRAM, revert network settings to the factory default settings, and 
and restart printer. reboot the network capability. 

Restart Printer	 Click Start to reboot the printer. 

Security 

The Security tab includes Set Password, Authentication System, Kerberos Server, LDAP Server, LDAP 
Authentication, SSL/TLS, IPsec, 802.1x, and IP Filter (IPv4). 

Set Password 

Purpose:
 

To set or change the password that is required to access the setup parameters of the printer from the Dell Printer
 
Configuration Web Tool. This page can also be displayed by clicking Set Password in the left frame.
 

NOTE: To restore the password to the default (NULL), initialize the non-volatile memory (NVM). 

NOTE: You can set the password for access to Admin Settings from Panel Lock in Printer Settings. 

Values: 

Administrator Password	 Sets the password using up to 128 alphanumeric characters (excluding spaces and 
colons). If more than 128 alphanumeric characters are specified, only the first 128 
alphanumeric characters will be valid. 

Re-enter Administrator Password Confirms the set password. 

Access denial by the authentication	 Sets the amount of time the administrator should wait for the access to the printer 
failure of the Administrator	 setup from Dell Printer Configuration Web Tool. Sets the time period from 5 to 255 

seconds. The access is denied if the time-out time is exceeded. If you set 0, this mode 
is disabled. 

Authentication System 

Purpose: 

To specify the server authentication type, the server response time-out, or the search time-out. 
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Values: 

Authentication Type 
(for ColorTrack PRO) 

Authentication System 
Settings 

Select the authentication system from the list. 

Optional Information Server Response Time-
Out 

Sets the amount of time the printer should wait for response from the 
server. Sets the time period from 1 to 75 seconds. 

Search Time-Out Sets the amount of time the printer should wait for searching for the 
server. Sets the time period from 5 to 120 seconds. 

Kerberos Server 

Purpose: 

To specify the settings for the Kerberos server. 

Values: 

Kerberos Server IP Address / Host Name Sets the IP address or host name, and the port address. The port address 
(for ColorTrack PRO) & Port must be 88 or between 5,000 and 65,535. 

Domain Name Enter the domain name. 

LDAP Server 

Purpose: 

To specify the settings of the LDAP server. 

Values: 

Server Information IP Address / Host Name Sets IP address or the host name, and the port address. The port address 
(for ColorTrack PRO) & Port must be 389, 3268, or between 5,000 and 65,535.*1 

LDAP Server Displays the current software information of the LDAP server. 

Optional Information Search Directory Root Enters the search directory root. 
(for ColorTrack PRO) Login Name Enters the login name. 

Password Enters the login password using 1 to 127 alphanumeric characters. If the 
password is left blank (NULL), you cannot log in to a server. 

Re-enter-Password Enters the login password again to confirm it. 

Search Select Wait LDAP Server Limit to follow the time specified by the LDAP 
Time-Out server. Select Wait to specify the time between 5 and 120 seconds. 

*1 When the optional hard disk is installed, 636 and 3269 also can be specified as the port address. 

LDAP Authentication 

Purpose: 

To specify the LDAP server authentication method. 

Values: 

LDAP Authentication Authentication Method Shows the authentication method. 
(for ColorTrack PRO) Use Added Text String Select whether to use the added text string from the list. 

Text String Added to Enter the added text string. 
User Name 
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SSL/TLS 

Purpose: 

To specify the settings for the SSL encryption communication to the printer, and set/delete the certificate used for 
IPsec, LDAPS, or Wireless LAN. 

Values: 

HTTP-SSL/TLS 
Communication*1 

Select the check box to enable the HTTP-SSL/TLS Communication. 

HTTP-SSL/TLS Sets the port number, which is not identical with that of HTTP for SSL/TLS. This must be 443 or 
Communication Port between 8000 and 9999. 
Number 

LDAP-SSL/TLS 
Communication*1, 2 

Select the check box to enable the LDAP, and access is established using SSL/TLS communication. 

Verify Remote Server 
Certificate*2 

Select the check box to enable the Verify Remote Server Certificate function. 

Generate Self-Signed 
Certificate*3 

Click to display the Generate Self-Signed Certificate page and to create a security certification from 
the page. The Generate Self-Signed Certificate button is available only when the self-signed 
certificate is not generated. 

Public Key Method Select the public key method of the self-signed certificate. 

Size of Public Key Select the size of public key. 

Issuer Sets the issuer of SSL self-signed certificate. 

Generate Signed Click to generate the SSL self-signed certificate. 
Certificate 

Upload Signed 
Certificate*3, 4 

Click to display the Upload Signed Certificate page and to upload the certificate file to the device 
from the page. 

Password Enter the password to upload the certificate file. 

Re-enter Password Enter the password again for confirmation. 

File Name Click Browse to browse the file name to upload to the device. 

Import Click Import to upload the certificate file to the device. 

Certificate 
Management*3, 4 

Click to display the Certificate Management page and to manage a security certification from the 
page. 

Category Select the device to certificate. 

Certificate Purpose Select the connection to certificate. 

Certificate Order Select the order to certificate. 

Display the List Click to display the Certificate List page. 

Certificate List*3 Category Displays the device to certificate selected at the Certificate Management 
page. 

Certificate Purpose Displays the connection to certificate selected at the Certificate 
Management page. 

Issued To Displays the list of certificate order. 

Validity Displays whether certificate is valid or not. 

Certificate Details Click to display the Certificate Details page. The SSL/TLS page is 
displayed when no item in the Issued To column is selected. 

Certificate Details*3 Category Displays the device to certificate selected at the Certificate Management 
page or SSL/TLS page. 

Issued To Displays the device to certificate. 
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Issuer Displays the issuer to certificate. 

Serial Number Displays the serial number of the device. 

Public Key Method Displays the public key method. 

Size of Public Key Displays the size of public key. 

Valid From Displays the time the certificate is valid. 

Valid Until Displays the time the certificate is invalid. 

Status Displays whether certificate is valid or not. 

Certificate Purpose Displays the purpose of certificate. 

Certificate Selection 
Status 

Displays the type of device certificate you selected. 

E-mail Address 

Use this certificate*2 

Displayed only when an e-mail address is specified in the certificate. 

Click to apply this certificate to the device. 

Delete Click to delete this certificate. 

Export This 
Certificate*2 

Click to export the certificate to the other device. 

*1 

*2 

*3 

*4 

This item is available only when the self-signed certificate has been generated. 
This item is displayed only when the optional hard disk is installed and is set to On for encryption. 
This item is effective only when connected via SSL/TLS (https). Only the administrator is allowed to display the pages. 
This item is displayed only when the optional hard disk is installed and is set to On for encryption. If not, Certificate Details is displayed. 

IPsec 

Purpose: 

To specify the Security Architecture settings for Internet Protocol (IPsec) for encrypted communication to the 
printer. 

Values: 

IPsec Settings Protocol Select the check box to enable the protocol. 

IKE Sets IKE authentication. Device Certificate is displayed on the list only 
when an effective digital signature is set up. 

Pre-Shared Key Sets a shared key. Up to 255 alphanumeric characters, periods, and 
hyphens can be used. 

Re-enter Pre-Shared Key Enters the shared key again to confirm it. 

Device Certificate*1 Displays the device certificate. 

IKE SA Lifetime Sets the lifetime for IKE SA from 5 to 28,800 minutes. 

IPsec SA Lifetime Sets the lifetime for IPsec SA from 5 to 2,880 minutes. 

DH Group Sets the DH group. 

PFS Select the check box to enable the PFS setting. 

Remote peers IPv4 address Sets the IP address to connect to. 

Remote peers IPv6 address Sets the IP address to connect to. 

Non IPsec communication Allows communication with a device which does not support IPsec. 
policy 

*1 This item is effective only when the optional hard disk is installed and is set to On for encryption. 

NOTE: If IPsec is enabled with incorrect settings, you must disable it using the IPsec menu on the operator panel. 
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802.1x 

Purpose: 

To specify the settings for IEEE 802.1x authentication for encrypted communication to the printer. 

Values: 

Configure 802.1x Enable IEEE 802.1x Select the check box to enable IEEE 802.1x authentication. 

Authentication Method EAP-MD5	 Selects the authentication method to use for IEEE 
802.1x authentication. EAP-MS­


CHAPv2
 

PEAP/MS­

CHAPv2
 

EAP-TLS*1, 2
 

Login Name: (Device Sets the login name (device name) for IEEE 802.1x authentication using 
Name) up to 128 alphanumeric characters. 

Password Sets the login password for IEEE 802.1x authentication using up to 128 
alphanumeric characters. 

Re-enter Password Confirms the set login password. 

Certificate Validation Select the check box to enable Certificate Validation. 
*1 This item is displayed only when the optional hard disk is installed and is set to On for encryption. 
*2  When this item is selected, Password and Re-enter Password need not to be specified. 

IP Filter (IPv4) 

Purpose: 

To specify the IP address and subnet mask to be permitted or denied access to the printer. 

Values: 

Access List Address Sets the IP addresses that are permitted or denied access to the printer. Enter a 
numeric value between 0 and 255 in each field. 

Address Mask Sets the subnet mask that are permitted or denied access to the printer. Enter a 
numeric value between 0 and 255 in each field. 

Active Mode Reject Rejects printing from specified network address. 

Accept Permits printing from specified network address. 

Off Disables the IP Filter feature for the specified IP address. 

Copy Printer Settings 
The Copy Printer Settings menu includes the Copy Printer Settings and Copy Printer Settings Report pages. 

Copy Printer Settings 

Purpose: 

To copy the printer settings to one or more of the same model of the printer. 

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are 
copied in the IP Address text box and Password text box. Then, click the Copy the settings to the Host in the above 
list button. Copying the settings is complete. The connection time-out period is 60 seconds. After that, you can 
check whether the settings were copied to this page. And you need to check the Copy the settings to the Host in the 
above list and reboot the printer menu of the Dell Printer Configuration Web Tool in the destination printer to 
verify if the settings were actually copied or not. 
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If the settings can be copied but the printer configuration is different, the settings of only the same items are copied. 
Printer settings are simultaneously copied to printers of up to 10 IP addresses. 

Copy Printer Settings Report 

Purpose: 

To verify whether the printer setting is copied to other printers successfully. 

NOTE: The history is cleared by turning off the printer. 

Print Volume 
The Printer Volume menu includes the Print Volume and Dell ColorTrack pages. 

Print Volume 

Purpose:
 

To verify the number of printed pages. This page can also be displayed by clicking Print Volume in the left frame.
 

Values:
 

Printer Page Count Displays the total number of pages printed since the printer was shipped from the factory. 

Paper Used Displays the number of pages printed for each paper size. 

Dell ColorTrack 

Purpose: 

To specify which users have access to color printing and to limit print volume per user. 

Values: 

ColorTrack Mode Off Enables to print the data with no authentication information. 

Internal Mode Restricts printing based on the print user information registered in the 
internal server. 

External Mode Restricts printing based on the print user information registered in the 
external server. 

Non Registered User Sets whether to permit the printing of data with no authentication information. To permit the 
printing for non-account user, select the check box. 

Non Registered User Sets the password to be used for non-account user using 1 to 127 alphanumeric characters. If the 
Password*1 password is left blank (NULL), you cannot log in to a server. 

Re-enter Non Registered Enter the password again to confirm it. 
User Password*1 

ColorTrack Error Report Sets whether to automatically print error-related information if printing using ColorTrack results in an 
error. 

Auto Color To Mono Sets whether to print all print jobs in black and white even when color print is specified. 
Print 

User Registration*2 Click Edit User Registration to display the Edit Print User Registration page. 

• To register a user, click Create to open the Print User Settings page. 

• To delete a user, click Delete to open the Delete User page. 
Clicking Back returns the screen to the status prior to deleting the user. 

• To confirm or change the registered user, click Confirm / Change to open the Print User Settings 
page. 
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User Registration No. Displays the user registration number. The Delete User button is displayed 
when the user is already registered. 

User Name Sets the user name. 

Password Sets the user password using 4 to 12 alphanumeric characters. 

Re-enter password Enter the password again to confirm it. 

Color Mode Limitation Sets whether to limit color printing. 

Upper Limit for Color 
Print 

Sets the maximum number of pages allowed for color printing. 

Cumulative Color Page 
Count 

Displays the cumulative number of pages printed for color printing. 

Upper Limit for 
Monochrome Print 

Sets the maximum number of pages allowed for monochrome printing. 

Cumulative 
Monochrome Page 
Count 

Displays the cumulative number of pages printed for monochrome printing. 

Setup Remote 
Authentication*3 

Click to display the Authentication System page. 

*1 

*2 

*3 

The password must be set when External Mode is selected for ColorTrack Mode and Non Registered User is set to on. 
This item is displayed only when ColorTrack Mode is Internal Mode. 
This item is displayed only when ColorTrack Mode is External Mode. 

Tray Settings 
Use the Tray Settings menu to set the size and type of paper loaded in each paper source and specify which paper 
source to use in what order. 

Values: 

MPF Mode Sets whether to use the printer driver settings for the size and type of paper loaded in the MPF. 

MPF Paper Size*1 Sets the size of paper loaded in the MPF. 

MPF Paper Type*1 Sets the type of paper loaded in the MPF. 

MPF Custom Paper 
Size - Y*1 

Sets the length of custom size paper loaded in the MPF. 

MPF Custom Paper 
Size - X*1 

Sets the width of custom size paper loaded in the MPF. 

MPF Display Popup*1 Sets whether to display a popup message that prompts the user to set the paper size and type when 
the paper is loaded in the MPF. 

Tray 1 Paper Size Sets the size of paper loaded in tray1. 

Tray 1 Paper Type Sets the type of paper loaded in tray1. 

Tray 1 Custom Paper Sets the length of custom size paper loaded in tray1. 
Size - Y 

Tray 1 Custom Paper Sets the width of custom size paper loaded in tray1. 
Size - X 

Tray 1 Display Popup Sets whether to display a popup message that prompts the user to set the paper size and type when 
the paper is loaded in tray1. 

Tray 2 Paper Size*2 Sets the size of paper loaded in the optional 550-sheet feeder. 

Tray 2 Paper Type*2 Sets the type of paper loaded in the optional 550-sheet feeder. 
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Tray 2 Custom Paper Sets the length of custom size paper loaded in the optional 550-sheet feeder. 
Size - Y*2 

Tray 2 Custom Paper Sets the width of custom size paper loaded in the optional 550-sheet feeder. 
Size - X*2 

Tray 2 Display Popup*2 Sets whether to display a popup message that prompts the user to set the paper size and type when 
the paper is loaded in the optional 550-sheet feeder. 

1st Priority Sets the paper source to be used as the first priority. 

2nd Priority Sets the paper source to be used as the second priority. 

3rd Priority*2 Sets the paper source to be used as the third priority. 
*1 This item is available only when Panel Specified in MPF Mode is selected. 
*2 This item is available only when the optional 550-sheet feeder is installed. 
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Understanding the Tool Box Menus 
The Tool Box allows you to view, specify, and diagnose the system settings. 

NOTE: A Password dialog box appears the first time you try to change settings on Tool Box when Panel Lock is set on the 
printer. In this case, input the password that you have already specified, and click OK to apply the settings. 

Starting the Tool Box 
1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer→ Tool Box.
 

The screen to select the printer appears.
 

2 Click Network Connection or USB Connection, and then select the printer listed in Select From the Found
 
Printers.
 

NOTE: If the printer is not listed in Select From the Found Printers when you click Network Connection, click Directly Input 
IP Address/Host Name and enter the IP address of the printer. For details about how to verify the IP address of the printer, 
see "Verifying the IP Settings." 

NOTE: On Microsoft® Windows® XP or Windows Server® 2003, printers using IPv6 addresses cannot be detected.
 

3 Click OK.
 

The Tool Box opens.
 

The Tool Box consists of the Printer Setting Reports, Printer Maintenance, and Diagnosis tabs.
 

Printer Setting Reports 
The Printer Setting Reports tab includes the Printer Information, Menu Settings, Reports, TCP/IP Settings, Tray 
Settings, Panel Language, and USB Direct Print Defaults pages. 

Printer Information 
Purpose: 

To display the system information of the printer. 

Values: 

Dell Service Tag Number Displays the service tag number of your printer. 

Express Service Code Displays the express service code number. 

Printer Serial Number Displays the serial number of your printer. 

Printer Type Displays the type of printing for the printer. Color Laser is displayed normally. 

Asset Tag Number Displays the asset tag number of your printer. 

Memory Capacity Displays the memory capacity. 

Processor Speed Displays the processing speed. 

Firmware Version Displays the version of the controller. 

Network Firmware Version Displays the NIC version. 

MCU Firmware Version Displays the version of the Machine Control Unit (MCU) firmware. 

Color Printing Speed Displays the speed for color printing. 

Monochrome Printing Speed Displays the speed for monochrome printing. 
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Menu Settings 
Purpose: 

To display the menu settings of the printer. 

Values: 

System Settings Power Saver Timer - Sleep Displays the amount of transition time to the Sleep mode 
after the printer finishes a job. 

Power Saver Timer - Deep Sleep Displays the amount of transition time between the Sleep 
mode and the Deep Sleep mode. 

Power Saver Timer - Auto-Off Timer*1 Displays the time it takes to automatically turn off the 
printer after the printer has entered the Deep Sleep mode. 

Auto Reset Displays the amount of time before the printer 
automatically resets the settings on the operator panel to 
the defaults when no additional settings are made. 

Fault Time-out Displays the amount of time the printer waits before 
canceling a job that stops abnormally. 

Job Time-out Displays the amount of time the printer waits for data to 
arrive from the computer. 

mm / inch Displays the measurement unit used on the operator 
panel. 

Default Paper Size Displays the default paper size. 

Enable A4<>Letter Switch Displays whether to print A4 size jobs on Letter size paper 
if A4 is not available in the paper trays and vice versa 
(Letter size job on A4 size paper). 

Auto Log Print Displays whether to automatically print a job history 
report after every 20 jobs. 

Report 2 Sided Print*2 Displays whether to print reports on both sides of a sheet 
of paper. 

Print ID Displays where to print a user ID on the output paper. 

Print Text Displays whether the printer outputs PDL (Page 
Description Language) data (which is not supported by 
the printer) as text when the printer receives it. 

Banner Sheet Insert Position*2 Displays where to insert the banner sheet. 

Banner Sheet Specify Tray*2 Displays the banner sheet tray. 

RAM Disk*3 Displays whether to allocate RAM for the disk file system 
for the Secure Print, Private Mail Box Print, Public Mail 
Box Print, and Proof Print features. 

Substitute Tray Displays an indication to use paper of a different size 
when the paper that is loaded in the specified tray does 
not match the paper size settings for the current job. 

Letterhead 2 Sided*2 Displays whether to print on both sides of a sheet of 
letterhead paper. 

Low Toner Alert Message Displays whether to show the alert message when the 
toner is low. 

Use Another Tray Displays whether to show a message to select another tray 
when the specified paper is not available in the paper tray. 
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Date & Time Time Zone	 Displays the selected time zone. 

Set Date	 Displays the date setting. 

Set Time	 Displays the time setting. 

Date Format	 Displays the selected date format. 

Time Format	 Displays the selected time format; 24 Hour or 12 Hour. 

Audio Tone Control Panel Tone Displays whether to emit a tone when the operator panel 
input is correct. Off indicates that the tone is disabled. 

Invalid Key Tone Displays whether to emit a tone when the operator panel 
input is incorrect. Off indicates that the tone is disabled. 

Machine Ready Tone Displays whether to emit a tone when the printer becomes 
ready. Off indicates that the tone is disabled. 

Job Completed Tone Displays whether to emit a tone when a print job is 
complete. Off indicates that the tone is disabled. 

Fault Tone Displays whether to emit a tone when a job ends 
abnormally. Off indicates that the tone is disabled. 

Alert Tone Displays whether to emit a tone when a problem occurs. 
Off indicates that the tone is disabled. 

Out of Paper Alert Tone Displays whether to emit a tone when the printer runs out 
of paper. Off indicates that the tone is disabled. 

Low Toner Alert Tone Displays whether to emit a tone when the toner is low. Off 
indicates that the tone is disabled. 

Auto Clear Alert Tone	 Displays whether to emit a tone 5 seconds before the 
printer performs auto clear. Off indicates that the tone is 
disabled. 

Paper Density Plain	 Displays the plain paper density settings. 

Label	 Displays the label paper density settings. 

Auto Registration Auto Registration Adjustment Displays whether to automatically adjust color 
Adjustment registration. 

Non-Dell Toner Non-Dell Toner Displays whether to use toner cartridge of another 
manufacturer. 

Adjust Altitude Adjust Altitude Displays the altitude of the location where the printer is 
installed. 

*1 Auto-Off Timer feature is available only in certain regions.
 
*2 This item is available only for Dell™ C3760dn Color Laser Printer.
 
*3 This item is available only when the optional 512MB memory module is installed, and also when the optional hard disk is not installed.
 

Reports 
Purpose: 

To print the settings and history information of the printer.
 

The reports are printed in the paper size specified in system settings.
 

Values: 

Printer Settings Click this button to print a detailed list of the printer settings. 

Panel Settings Click this button to print a detailed list of the panel settings. 

PCL Fonts List Click this button to print a list of the PCL (Hewlett-Packard Printer Control Language) fonts. 

PCL Macros List Click this button to print a list of the PCL Macro. 

Understanding the Tool Box Menus 173 



 

 

 

 

 

 

 

 

     

 

 

 

 

 

 

PS Fonts List Click this button to print a list of the PS fonts. 

PDF Fonts List Click this button to print a list of the PDF fonts. 

Job History Click this button to print the Completed Jobs history of the printer. 

Error History Click this button to print the error history of the printer. 

Print Meter Click this button to print the report for the total number of pages printed. 

Color Test Page Click this button to print a color test page. 

Stored Documents*1 Click this button to print a list of the Stored Documents. 
*1 You can print the list only when the RAM disk is enabled or the optional hard disk is installed. 

TCP/IP Settings 
Purpose: 

To display the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol). 

Values: 

IPv4 IP Address Mode Displays the method for acquiring the IP address. 

IP Address Displays the IP address of the printer. 

Subnet Mask Displays the subnet mask. 

Gateway Address Displays the gateway address. 

IPv6 Use Manual Address Displays whether to set the IP address manually. 

Manual Address Displays the IP address of the printer. 

Link Local Address Displays the link local address. 

Tray Settings 
Purpose: 

To display the tray settings of the printer. 

Values: 

Tray Settings MPF Mode Displays whether the paper size and paper type for the multipurpose feeder 
(MPF) are specified from the printer driver or the operator panel. 

MPF Display Popup Displays a popup menu that prompts to set the paper size and type when 
paper is loaded in the MPF. 

MPF Paper Size Displays the paper size setting of the MPF. 

MPF Custom Size - Y Displays the length of custom size paper loaded in the MPF. 

MPF Custom Size - X Displays the width of custom size paper loaded in the MPF. 

MPF Paper Type Displays the paper type setting of the MPF. 

Tray 1 Display Popup Displays a popup menu that prompts to set the paper size and type when 
paper is loaded in tray1. 

Tray 1 Paper Size Displays the paper size setting of tray1. 

Tray 1 Custom Size - Y Displays the length of custom size paper loaded in tray1. 

Tray 1 Custom Size - X Displays the width of custom size paper loaded in tray1. 

Tray 1 Paper Type Displays the paper type setting of tray1. 

Tray 2 Display Popup*1 Displays a popup menu that prompts to set the paper size and type when 
paper is loaded in the optional 550-sheet feeder (tray2). 
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Tray 2 Paper Size*1 Displays the paper size setting of the optional 550-sheet feeder. 

Tray 2 Custom Size - Y*1 Displays the length of custom size paper loaded in the optional 550-sheet 
feeder. 

Tray 2 Custom Size - X*1 Displays the width of custom size paper loaded in the optional 550-sheet 
feeder. 

Tray 2 Paper Type*1 Displays the paper type setting of the optional 550-sheet feeder. 

Tray Priority Tray Priority Displays the priority order of the paper trays. 
*1 This item is available only when the optional 550-sheet feeder is installed. 

Panel Language 
Purpose: 

To display the panel language setting of the printer. 

Values: 

Panel Language Displays the language that is used on the LCD panel. 

USB Direct Print Defaults 
Purpose: 

To display the default settings for the USB Direct Print function of the printer. 

Values: 

Output Color Displays the default color mode. 

Select Tray Displays the default tray. 

2 Sided Printing*1 Displays whether to print on both sides of a sheet of paper. 

Multiple-Up Displays the default paper layout when Multiple-Up is selected. 

Collation Displays whether to sort the print job. 
*1 This item is available only for Dell C3760dn Color Laser Printer. 
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Printer Maintenance 
The Printer Maintenance tab includes the System Settings, Maintenance, Tray Settings, Panel Language, TCP/IP 
Settings, Network Settings, and USB Direct Print Defaults pages. 

System Settings 
Purpose: 

To configure the power management of the printer, auto clear time, alarm tones, time-out time, date and time, 
mm/inch setting, job log auto print, Print ID, setting of the additional memory, and setting of the substitute tray. 

Values: 

Power Saver Timer Sleep*1 

Deep Sleep*1 

Auto-Off Timer*2 

Available Range: 
1–60 minutes 

Available Range: 
1–60 minutes 

0 

Available Range: 
60–1440 minutes 

Sets the amount of transition time to the Sleep mode 
after the printer finishes a job. 

Sets the amount of transition time between the Sleep 
mode and the Deep Sleep mode. 

Sets the time it takes to automatically turn off the printer 
after the printer has entered the Deep Sleep mode. 

Auto Reset 45 seconds 

1 minute 

2 minutes 

Sets the amount of time before the printer automatically 
resets the settings on the operator panel to the defaults 
when no additional settings are made. 

3 minutes 

4 minutes 

Fault Time-out 0 

Available Range: 3–300 seconds 

Sets the amount of time the printer waits before canceling 
a job when the job stops abnormally. 

Job Time-out 0 

Available Range: 5–300 seconds 

Sets the amount of time the printer waits for additional 
data from the computer before it cancels the job. 

Date & Time Time Zone Sets the time zone. 

Set Date Sets the date. 

Set Time Sets the time. You can select AM or PM when Time 
Format is set to 12 Hour. 

Date Format Sets the date format. 

Time Format Sets the time format in 24 Hour or 12 Hour. 

Audio Tone Control Panel Off Does not emit a tone when the operator panel input is 
Tone correct. 

On Emits a tone when the operator panel input is correct. 

Invalid Key Tone Off Does not emit a tone when the operator panel input is 
incorrect. 

On Emits a tone when the operator panel input is incorrect. 

Machine Ready Off Does not emit a tone when the printer becomes ready. 
Tone On Emits a tone when the printer becomes ready. 

Job Completed Off Does not emit a tone when a print job is complete. 
Tone On Emits a tone when a print job is complete. 

Fault Tone Off Does not emit a tone when a job ends abnormally. 

On Emits a tone when a job ends abnormally. 
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Alert Tone Off Does not emit a tone when a problem occurs. 

On Emits a tone when a problem occurs. 

Out of Paper Alert Off Does not emit a tone when the printer runs out of paper. 
Tone On Emits a tone when the printer runs out of paper. 

Low Toner Alert Off Does not emit a tone when the toner is low. 
Tone On Emits a tone when the toner is low. 

Auto Clear Alert Off Does not emit a tone before the printer performs auto 
Tone clear. 

On Emits a tone 5 seconds before the printer performs auto 
clear. 

mm / inch Millimeters(mm) Selects millimeter or inch as the default measurement 

Inches(") unit. 

Default Paper Size A4 (210x297mm) Sets the default paper size. 

Letter (8.5x11") 

Enable A4<>Letter On Prints A4 size jobs on Letter size paper if A4 is not 
Switch available in the paper trays and vice versa (Letter size job 

on A4 size paper). 

Off Does not print A4 size jobs on Letter size paper or Letter 
size jobs on A4 paper. 

Auto Log Print Off Does not automatically print a job history report after 
every 20 jobs. 

On Automatically prints a job history report after every 20 
jobs. 

Report 2 Sided Print*3 1 Sided Prints reports on one side of a sheet of paper. 

2 Sided Prints reports on both sides of a sheet of paper. 

Print ID Off Does not print the user ID. 

Top Left Prints the user ID on the specified location. 

Top Right 

Bottom Left 

Bottom Right 

Print Text Off Does not print the received PDL data as text data. 

On Prints the received PDL data as text data. 

Banner Sheet Insert Off Does not insert the banner sheet. 
Position*3 

Front Sets where to insert the banner sheet. 

Back 

Front & Back 

Banner Sheet Specify 
Tray*3 

MPF 

Tray 1 

Sets the tray for the banner sheet. 

Tray 2*4 

RAM Disk*5 Off Does not allocate RAM for the disk file system. Secure 
Print, Private Mail Box Print, Public Mail Box Print, and 
Proof Print jobs will abort and be recorded to the job log. 

Available Range: 50–450MBytes Allocates RAM for the disk file system automatically. 

(in 50 MB increments) 
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Substitute Tray Off	 No tray size substitute accepted. 

Larger Size	 Substitutes paper of next largest size. When there is no 
larger paper size, the printer substitutes paper of nearest 
size. 

Nearest Size	 Substitutes paper of nearest size. 

Use MPF	 Substitutes paper from the MPF. 

Letterhead 2 Sided*3 Disable	 Does not print on both sides of a sheet of letterhead paper. 

Enable	 Prints on both sides of a sheet of letterhead paper. 

Low Toner Alert Message On	 Shows the alert message when the toner is low. 

Off	 Does not show the alert message when the toner is low. 

Use Another Tray On Sets to show a message to select another tray when the 
specified paper is not available in the paper tray. 

Off Does not print on other paper sizes in other paper trays if 
the paper size specified in the job is not available. 

Apply New Settings After you change the settings, click this button to apply 
the changes. 

Restart printer to apply new settings	 Click this button to apply the changes. 
*1 When you specify 1 minute for Sleep, the printer enters  power saver mode 1 minute after it finishes a job. This uses much less energy, 

but requires more warm-up time for the printer. Specify 1 minute if your printer shares an electrical circuit with room lighting and you 
notice lights flickering. 
Select a high value if your printer is in constant use. Under most circumstances, this keeps the printer ready to operate with minimum 
warm-up time. 
Select a value between 1 and 60 minutes for the power saver mode if you want a balance between energy consumption and a shorter 
warm-up period. 
The printer automatically returns to the standby mode from the power saver mode when it receives data from the computer. You can 

also return the printer to the standby mode by pressing the (Power Saver) button on the operator panel.
 
*2 Auto-Off Timer feature is available only in certain regions.
 
*3 This item is available only for Dell C3760dn Color Laser Printer.
 
*4 This item is available only when the optional 550-sheet feeder is installed.
 
*5 This item is available only when the optional 512MB memory module is installed, and also when the optional hard disk is not installed.
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Maintenance 

CAUTION: Using a non-Dell toner cartridge may severely damage your printer. The warranty does not cover damages caused 
by using non-Dell toner cartridges. 

Purpose: 

To configure the paper density,  the color registration adjustments, the initialization of the printer, and other 
settings. 

Values: 

Paper Density Plain Light Sets plain paper density. 

Normal 

Label Light Sets label paper density. 

Normal 

Color Auto Correct Click Start to perform color registration 
Registration automatically. 
Adjustments Print Color Regi Chart Click Start to print a color registration chart. 

Registration LY(Left Yellow) Available Range: Sets lateral (perpendicular to paper feed 
Adjustments -9 to +9 direction) and process (paper feed direction) color 

LM(Left 
Magenta) 

LC(Left Cyan) 

Available Range: 
-9 to +9 

Available Range: 

adjustment values that are found in the color 
registration chart individually for Yellow, Magenta, 
and Cyan. 

-9 to +9 

RY(Right Available Range: 
Yellow) -9 to +9 

RM(Right Available Range: 
Magenta) -9 to +9 

RC(Right Cyan) Available Range: 
-9 to +9 

PY(Process Available Range: 
Yellow) -9 to +9 

PM(Process Available Range: 
Magenta) -9 to +9 

PC(Process Available Range: 
Cyan) -9 to +9 

Reset Defaults Initializes the system parameters. 

Initialize Print Meter Click Initialize Print Meter to initialize the Print 
Meter. 

Non-Dell Toner Off Disables the use of another manufacturer's toner 
cartridge. 

On Enables the use of another manufacturer's toner 
cartridge. 

Adjust Altitude 0 meter Sets the altitude of the location where the printer 

1000 meters is installed. 

2000 meters 

3000 meters 

Apply New Settings After you change the settings, click this button to 
apply the changes. 
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Restart printer to apply new settings Click this button to apply the changes. 

Tray Settings 
Purpose: 

To specify the paper types and sizes, and the tray priority for the MPF, tray1, and the optional 550-sheet feeder 
respectively. 

Values: 

Tray Settings MPF Mode Panel Specified Sets whether the paper size and paper type for the 

Driver Specified MPF are specified from the printer driver or the 
operator panel. 

MPF Display 
Popup*1 

On 

Off 

Displays a popup message that prompts the user to 
set Paper Type and Paper Size when the paper is 
loaded in the MPF. 

MPF Paper Size*1 Use Driver Settings Sets the size of paper loaded in the MPF. 

A4 (210x297mm) 

A5 (148x210mm) 

B5 (182x257mm) 

Letter (8.5x11") 

Folio (8.5x13") 

Legal (8.5x14") 

Executive (7.3x10.5") 

Envelope #10 (4.1x9.5") 

Monarch Env. (3.9x7.5") 

DL Env. (110x220mm) 

C5 Env. (162x229mm) 

Custom Size 

MPF Custom Size ­
Y*1 

Available Range: 
127–355 mm (5.0–14.0 inches) 

Sets the length of custom size paper loaded in the 
MPF. 

MPF Custom Size ­
X*1 

Available Range: 
77–215 mm (3.0–8.5 inches) 

Sets the width of custom size paper loaded in the 
MPF. 

MPF Paper Type*1 Plain Sets the type of paper loaded in the MPF. 

Plain Thick 

Covers(106–163g/m2) 

Covers Thick(164–216g/m2) 

Coated(106–163g/m2) 

Coated Thick(164–216g/m2) 

Label 

Envelope 

Recycled 

Letterhead 

Preprinted 

Prepunched 

Color 
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Plain - Side 2 

Color - Side 2 

Plain Thick - Side 2 

Recycled - Side 2 

Tray 1 Display 
Popup 

On 

Off 

Displays a popup message that prompts the user to 
set Paper Type and Paper Size when the paper is 
loaded in tray1. 

Tray 1 Paper Size A4 (210x297mm) Sets the size of paper loaded in tray1. 

A5 (148x210mm) 

B5 (182x257mm) 

Letter (8.5x11") 

Folio (8.5x13") 

Legal (8.5x14") 

Executive (7.3x10.5") 

Custom Size 

Tray 1 Custom Size ­
Y 

Available Range: 
210–355 mm (8.3–14.0 inches) 

Sets the length of custom size paper loaded in tray1. 

Tray 1 Custom Size ­
X 

Available Range: 
148–215 mm (5.8–8.5 inches) 

Sets the width of custom size paper loaded in tray1. 

Tray 1 Paper Type Plain Sets the type of paper loaded in tray1. 

Plain Thick 

Covers(106–163g/m2) 

Covers Thick(164–216g/m2) 

Coated(106–163g/m2) 

Coated Thick(164–216g/m2) 

Recycled 

Letterhead 

Preprinted 

Prepunched 

Color 

Plain - Side 2 

Color - Side 2 

Plain Thick - Side 2 

Recycled - Side 2 

Tray 2 Display 
Popup*2 

Tray 2 Paper Size*2 

On 

Off 

Auto 

Custom Size 

Displays a popup message that prompts the user to 
set Paper Type and Paper Size when the paper is 
loaded in the optional 550-sheet feeder. 

Sets the size of paper loaded in the optional 550­
sheet feeder. 

Tray 2 Custom Size ­
Y*2 

Available Range: 
210–355 mm (8.3–14.0 inches) 

Sets the length of custom size paper loaded in the 
optional 550-sheet feeder. 

Tray 2 Custom Size ­ Available Range: Sets the width of custom size paper loaded in the 
X*2 148–215 mm (5.8–8.5 inches) optional 550-sheet feeder. 
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Tray 2 Paper Type*2 Plain 

Plain Thick 

Covers(106–163g/m2) 

Covers Thick(164–216g/m2) 

Coated(106–163g/m2) 

Coated Thick(164–216g/m2) 

Recycled 

Letterhead 

Preprinted 

Prepunched 

Color 

Plain - Side 2 

Color - Side 2 

Plain Thick - Side 2 

Recycled - Side 2 

Tray Priority MPF->Tray1 Sets the priority order of the paper trays. 

Tray1->MPF 

MPF->Tray1->Tray2*2 

MPF->Tray2*2->Tray1 

Tray1->MPF->Tray2*2 

Tray1->Tray2*2->MPF 

Tray2*2->MPF->Tray1 

Tray2*2->Tray1->MPF 

Apply New Settings After you change the settings, click this button to 
apply the changes. 

Restart printer to apply new settings Click this button to restart the printer and apply the 
changes. 

*1 

*2 
This item is available only when MPF Mode is set to Panel Specified. 
This item is available only when the optional 550-sheet feeder is installed. 

Sets the type of paper loaded in the optional 550­
sheet feeder. 

NOTE: For details about the paper density for paper types, see "Paper Type Specifications." 
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Panel Language 
Purpose: 

To determine the language of the text on the LCD panel. 

Values: 

Panel Language English Sets the language to be used on the LCD panel. 

French 

Italian 

German 

Spanish 

Danish 

Dutch 

Norwegian 

Swedish 

Apply New Settings After you change the settings, click this button to apply the changes. 

Restart printer to apply new settings Click this button to apply the changes. 

TCP/IP Settings 

NOTE: TCP/IP Settings is not available when IP Mode of the printer is is set to IPv6 Mode. 

Purpose: 

To configure TCP/IP settings. 

Values: 

IP Address Mode AutoIP Automatically sets the IP address. 

A random value in the range of 169.254.1.0 to 169.254.254.255 that is not 
currently in use on the network is set as the IP address. The subnet mask is set as 
255.255.0.0. 

BOOTP Sets the IP address using BOOTP. 

RARP Sets the IP address using RARP. 

DHCP Sets the IP address using DHCP. 

Panel Manually sets the IP address. 

IP Address Manually sets the IP address allocated to the printer. 

It is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in 
the range of 224 to 254 cannot be specified for the first octet of a gateway address. 

Subnet Mask Manually sets the subnet mask. 

It is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up 
nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be 
specified as the subnet mask. 

Gateway Address Manually sets the gateway address. 

It is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up 
nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the range 
of 224 to 254 cannot be specified for the first octet of a gateway address. 

Apply New Settings After you change the settings, click this button to apply the changes. 
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Restart printer to apply new settings Click this button to restart the printer and apply the changes. 

Network Settings 

NOTE: Network Settings is not available when the printer is connected using a USB cable. 

Purpose: 

To configure the setup of the printer using your web browser. 

Values: 

Print Server 
Settings*1 

Display Click to display the Print Server Setup page on the Dell Printer Configuration 
Web Tool. 

Display of Dell Off Does not display the server settings for the Dell Printer Configuration Web Tool. 
Configuration Web 
Tool 

On Displays the server settings for the Dell Printer Configuration Web Tool. 

Apply New Settings After you change the settings, click this button to apply the changes. 

Restart printer to apply new settings Click this button to restart the printer and apply the changes. 
*1 This item is available only when Display of Dell Configuration Web Tool is set to On. 

USB Direct Print Defaults 
Purpose: 

To create your own settings for USB Direct Print Defaults. 

Values: 

Output Color Full Color Prints in color mode. 

Black & White Prints in black and white mode. 

Select Tray MPF The paper is fed from the MPF. 

Tray 1 The paper is fed from tray1. 

Tray 2*1 The paper is fed from the optional 550-sheet feeder. 

2 Sided Printing*2 1 -> 1 Sided Prints on one side of a sheet of paper. 

Long Edge Binding Prints on both sides of a sheet of paper to be bound by long edge. 

Short Edge Binding Prints on both sides of a sheet of paper to be bound by short edge. 

Multiple-Up Off Prints one page on one side of a sheet of paper. 

2-Up Prints two pages on one side of a sheet of paper. 

4-Up Prints four pages on one side of a sheet of paper. 

Collation Collated Sorts the print job. 

Uncollated Does not sort the print job. 

Apply New Settings After you change the settings, click this button to apply the changes. 

Restart printer to apply new settings Click this button to restart the printer and apply the changes. 
*1 This item is available only when the optional 550-sheet feeder is installed. 
*2 This item is available only for Dell C3760dn Color Laser Printer. 
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Diagnosis 
The Diagnosis tab includes the Chart Print and Environment Sensor Info pages. 

Chart Print 
Purpose: 

To print various charts that can be used for diagnosis of the printer. The chart is printed to A4 or letter size paper. 

Values: 

Pitch Configuration Chart Prints full halftone pages for yellow, magenta, cyan, and black. Also prints pages to 
check the pitch. A total of five pages are output. 

Ghost Configuration Chart Prints a chart to check for ghost printing. One page is printed. 

4 Colors Configuration Chart Bands of yellow, magenta, cyan, and black are printed with varying density. One 
page is printed. 

Banding Detection Chart Prints charts to check which color the banding occurred and the distance between 
each band. 

MQ Chart Prints charts to check for the banding in A4 or Letter. 

Alignment Chart Prints a chart to check for proper alignment of the print image on the paper. One 
page is printed. 

Environment Sensor Info 
Purpose:
 

To print the internal environment sensor information of the printer to Result.
 

Values:
 

Get Environment Sensor Click this button to confirm the internal environment sensor information of the printer such as 
Info temperature and humidity. 

Resetting Defaults 
After executing this function and rebooting the printer, the menu parameters are reset to their default values. 

The following menu parameters are exceptions and are not reset. 

• Network settings 

• Panel Lock settings and password 

• Function Enabled settings and passwords 

• Login Error settings 

• Set Available Time settings 

• Secure Job Expiration settings 

• USB Port settings 

• Data Encryption settings 

• Hard Disk Over write settings 

• ColorTrack Mode settings 

• ColorTrack Error Report settings 

• Non Registered User settings 
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When Using the Tool Box 
1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer→ Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box." 

The Tool Box opens. 

2	 Click the Printer Maintenance tab. 

3	 Select Maintenance from the list at the left side of the page.
 

The Maintenance page appears.
 

4	 Click Reset Default.
 

The printer restarts automatically to apply the settings.
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Understanding the Printer Menus 
When your printer is connected to a network and available to a number of users, the access to the Admin 
Settings can be limited. This prevents other users from using the operator panel to inadvertently change a user 
default that has been set by the administrator. 

However, you can use your printer driver to override user defaults and select settings for individual print jobs. 

Report / List 
Use the Report/List menu to print various types of reports and lists. 

Printer Settings 
Purpose: 

To print a list of the current user default values, the installed options, the amount of installed print memory, and the 
status of printer supplies. 

Panel Settings 
Purpose: 

To print a detailed list of all the settings of the printer menus. 

PCL Fonts List 
Purpose: 

To print a sample of the available PCL fonts. 

See also: 

"Understanding Fonts" 

PCL Macros List 
Purpose: 

To print the information on the downloaded PCL macro. 

PS Fonts List 
Purpose: 

To print a sample of the available PS fonts. 

See also: 

"Understanding Fonts" 

PDF Fonts List 
Purpose: 

To print a sample of the available PDF fonts. 

Job History 
Purpose: 

To print a detailed list of the print jobs that have been processed. This list contains the last 20 jobs. 
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Error History 
Purpose: 

To print a detailed list of paper jams and fatal errors. 

Print Meter 
Purpose: 

To print the reports for the total number of pages printed. 

Color Test Page 
Purpose: 

To print a page for testing colors. 

Stored Documents 

NOTE: Stored Documents feature is available only when the optional 512 MB memory module is installed on the printer and 
RAM Disk under System Settings is enabled or the optional hard disk is installed. 

Purpose: 

To print a list of all files stored for Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof Print in the 
RAM disk or the optional hard disk is installed. 

Printing a Report/List Using the Operator Panel 
1 Press the (Menu) button.
 

2 Press the 
 button until Report/List is highlighted, and then press the (Set) button.
 

3 Press the 
  button until the desired report or list is highlighted, and then press the (Set) button. 

The selected report or list is printed. 

Printing a Report/List Using the Tool Box 
1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer→ Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box." 

The Tool Box opens.
 

2 Ensure that the Printer Setting Reports tab is open.
 

3 Select Reports from the list at the left side of the page.
 

The Reports page appears.
 

4 Click the button for the desired report or list.
 

The report or list is printed.
 

Admin Settings 
Use the Admin Settings menu to configure a variety of printer features. 

PCL 
Use the PCL menu to change printer settings that only affect jobs using the PCL emulation printer language. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Understanding the Printer Menus 188 



 

 

 

Paper Tray 

Purpose: 

To specify the default paper tray. 

Values: 

Auto* 

MPF 

Tray1 

Tray2*1 

*1 	 This item is available only when the optional 550-sheet 

feeder is installed. 


Paper Size 

Purpose: 

To specify the default paper size. 

Values: 

mm series 

A4*1 

A5 

B5 

Letter 

Executive 

Folio 

Legal 

Envelope #10 

Monarch 

DL 

C5 

Custom Size 
*1 	 Denotes country-specific factory default value. 

inch series 

Letter*1 

Executive 

Folio 

Legal 

A4 

A5 

B5 

Envelope #10 

Monarch 
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DL 

C5 

Custom Size 
*1 Denotes country-specific factory default value. 

NOTE: Selecting a custom size for the paper size prompts you to enter a custom length and width. 

Orientation 

Purpose: 

To specify how text and graphics are oriented on the page. 

Values: 

Portrait* Prints text and graphics parallel to the short edge of the paper. 

Landscape Prints text and graphics parallel to the long edge of the paper. 

2 Sided 

NOTE: 2 Sided feature is available only for Dell C3760dn Color Laser Printer. 

Purpose: 

To specify whether to print on both sides of a sheet of paper. 

Values: 

2 Sided Print Off* Does not print on both sides of a sheet of paper. 

On Prints on both sides of a sheet of paper. 

Binding Edge Flip on Long Edge* Prints on both sides of a sheet of paper to be bound by long edge. 

Flip on Short Edge Prints on both sides of a sheet of paper to be bound by short edge. 

Font 

Purpose: 

To specify the default font from the fonts registered in the printer. 

Values: 

CG Times LetterGothic CourierPS 

CG Times It LetterGothic It CourierPS Ob 

CG Times Bd LetterGothic Bd CourierPS Bd 

CG Times BdIt Albertus Md CourierPS BdOb 

Univers Md Albertus XBd SymbolPS 

Univers MdIt Clarendon Cd Palatino Roman 

Univers Bd Coronet Palatino It 

Univers BdIt Marigold Palatino Bd 

Univers MdCd Arial Palatino BdIt 

Univers MdCdIt Arial It ITCBookman Lt 

Univers BdCd Arial Bd ITCBookman LtIt 

Univers BdCdIt Arial BdIt ITCBookmanDm 
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AntiqueOlv Times New ITCBookmanDm It 

AntiqueOlv It Times New It HelveticaNr 

AntiqueOlv Bd Times New Bd HelveticaNr Ob 

CG Omega Times New BdIt HelveticaNr Bd 

CG Omega It Symbol HelveticaNrBdOb 

CG Omega Bd Wingdings  N C Schbk Roman  

CG Omega BdIt Line Printer N C Schbk It 

GaramondAntiqua Times Roman N C Schbk Bd 

Garamond Krsv Times It N C Schbk BdIt 

Garamond Hlb Times Bd ITC A G Go Bk 

GaramondKrsvHlb Times BdIt ITC A G Go BkOb 

Courier* Helvetica ITC A G Go Dm 

Courier It Helvetica Ob ITC A G Go DmOb 

Courier Bd Helvetica Bd ZapfC MdIt 

Courier BdIt Helvetica BdOb ZapfDingbats 

Symbol Set 

Purpose: 

To specify a symbol set for a specified font. 

Values: 

ROMAN-8* WIN L1 ISO-6 

ISO L1 WIN L2 ISO-11 

ISO L2 WIN L5 ISO-15 

ISO L5 DESKTOP ISO-17 

ISO L6 PS TEXT ISO-21 

PC-8 MC TEXT ISO-60 

PC-8 DN MS PUB ISO-69 

PC-775 MATH-8 WIN 3.0 

PC-850 PS MATH WINBALT 

PC-852 PI FONT SYMBOL 

PC-1004 LEGAL WINGDINGS 

PC-8 TK ISO-4 DNGBTSMS 

Font Size 

Purpose: 

To specify the font size for scalable typographic fonts. 

Values: 

12.00* Sets the values in increments of 0.25. 

Available Range: 4.00 – 50.00 

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch. 
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NOTE: The Font Size menu is only displayed for typographic fonts. 

See also: 

"Pitch and Point Size" 

Font Pitch 

Purpose: 

To specify the font pitch for scalable mono spaced fonts. 

Values: 

10.00* Sets the value in increments of 0.01. 

Available Range: 6.00–24.00 

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For non-scalable mono spaced 
fonts, the pitch is displayed, but cannot be changed. 

NOTE: The Font Pitch menu is only displayed for fixed or mono spaced fonts. 

See also: 

"Pitch and Point Size" 

Form Line 

Purpose: 

To set the number of lines in a page. 

Values: 

mm series 

64 mm*1 Sets the value in increments of 1 mm. 

Available Range: 5–128 mm 
*1 Denotes country-specific factory default values. 

inch series 

60 inches*1 Sets the value in increments of 1 inch. 

Available Range: 5–128 inches 
*1 Denotes country-specific factory default values. 

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 
Orientation menu items. Select the correct Form Line and Orientation before changing Form Line. 

See also: 

"Orientation" 

Quantity 

Purpose: 

To set the default print quantity. (Set the number of copies required for a specific job from the printer driver. Values 
selected from the printer driver always override values selected from the operator panel.) 
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Values: 

1* Sets the value in increments of 1. 

Available Range: 1–999 

Image Enhance 

Purpose: 

To specify whether to enable the Image Enhance feature, which makes the boundary line between black and white 
smoother to decrease jagged edges and enhance the visual appearance. 

Values: 

Off Disables the Image Enhance feature. 

On* Enables the Image Enhance feature. 

Hex Dump 

Purpose: 

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in 
hexadecimal and character representation. Control codes are not executed. 

Values: 

Disable* Disables the Hex Dump feature. 

Enable Enables the Hex Dump feature. 

Draft Mode 

Purpose: 

To save toner by printing in the draft mode. The print quality is reduced when printing in the draft mode. 

Values: 

Disable* Does not print in the draft mode. 

Enable Prints in the draft mode. 

LineTermination 

Purpose: 

To add the line termination commands. 

Values: 

Off* The line termination command is not added. 

CR=CR, LF=LF, FF=FF 

Add-LF The LF command is added. 

CR=CR-LF, LF=LF, FF=FF 

Add-CR The CR command is added. 

CR=CR, LF=CR-LF, FF=CR-FF 

CR-XX The CR and LF commands are added. 

CR=CR-LF, LF=CR-LF, FF=CR-FF 
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Default Color 

Purpose: 

To specify the color mode to Color or Black. This setting is used for a print job that does not specify a print mode. 

Values: 

Black* Prints in the black and white mode. 

Color Prints in the color mode. 

Ignore FormFeed 

Purpose: 

To specify whether to ignore blank pages that only contain Form Feed control codes. 

Values: 

Off* Disables the Ignore Form Feed feature. 

On Enables the Ignore Form Feed feature. 

PDF 
Use the PDF menu to change printer settings that only affect the PDF jobs. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Quantity 

Purpose: 

To specify the number of copies to print. 

Values: 

1* Sets the value in increments of 1. 

Available Range: 1–999 

2 Sided Print 

NOTE: 2 Sided Print feature is available only for Dell C3760dn Color Laser Printer. 

Purpose: 

To specify whether to print on both sides of a sheet of paper. 

Value: 

1 Sided* Prints on one side of a sheet of paper. 

Flip on Long Edge Prints on both sides of a sheet of paper to be bound by long edge. 

Flip on Short Edge Prints on both sides of a sheet of paper to be bound by short edge. 

Print Mode 

Purpose: 

To specify the print mode. 
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Value: 

Normal* For documents with normal sized characters. 

High Quality For documents with small characters or thin lines, or documents printed using a dot-matrix printer. 

High Speed Prints with the higher speed than the Normal mode, but the quality is less. 

PDF Password 

Purpose: 

To specify the password to print the secure PDF. 

Value: 

Enter PDF Password Enter the password to print the secure PDF. 

Collation 

Purpose: 

To specify whether to sort the job. 

Value: 

Collated Sorts the job. 

Uncollated* Does not sort the job. 

Output Size 

Purpose: 

To specify the output paper size for PDF. 

Value: 

A4*1 

Letter*1 

Auto 
*1 The default paper size is displayed. 

Layout 

Purpose: 

To specify the output layout. 

Value: 

Auto %* 

100% (No Zoom) 

Booklet 

2 Pages Up 

4 Pages Up 
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Default Color 

Purpose: 

To specify the output color. 

Value: 

Color (Auto)* 

Black 

PostScript 
Use the PostScript menu to change printer settings that only affect jobs using the PostScript emulation printer 
language. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

PS Error Report 

Purpose: 

To specify whether the printer outputs error contents for a PostScript error. 

The change becomes effective after the printer is turned off and then on 

again. 

Values: 

Off Discards the print job without printing an error message. 

On* Prints an error message before it discards the job. 

NOTE: Instructions from the PS driver override the settings specified on the operator panel. 

PS Job Time-out 

Purpose: 

To specify the execution time for one PostScript job. The change becomes effective after the printer is turned off 
and then on again. 

Values: 

Off* Job time-out does not occur. 

On 1 minute* A PostScript error occurs if processing is not completed after the specified time. 

Available Range: 
1-900 minutes. 

Paper Select Mode 

Purpose: 

To specify the way to select the tray for PostScript mode. The change becomes effective after the printer is turned off 
and then on again. 

Values: 

Auto* The tray is selected as the same setting as in the PCL mode. 

Select from Tray The tray is selected in a method compatible with regular Post Script printers. 
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Default Color 

Purpose: 

To specify the color mode to Color or Black. This setting is used for a print job which does not specify a print mode. 

Values: 

Color* Prints in the color mode. 

Black Prints in the black and white mode. 

Network 
Use the Network menu to change the printer settings affecting jobs sent to the printer through the wired or 
wireless network. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Ethernet 

Purpose: 

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the 
printer is turned off and then on again. 

Values: 

Auto* Detects the Ethernet settings automatically. 

10BASE- T Half Uses 10BASE-T Half-duplex. 

10BASE- T Full Uses 10BASE-T Full-duplex. 

100BASE- TX Half Uses 100BASE-TX Half-duplex. 

100BASE- TX Full Uses 100BASE-TX Full-duplex. 

1000BASE- T Full Uses 1000BASE-T Full-duplex. 

Wireless Status 

NOTE: Wireless Status feature is available only when the printer is connected using the wireless network. 

Purpose: 

To confirm the wireless communication status. 

Values: 

Connection  (Good)

 (Acceptable)

 (Low)

 (No Reception) 

SSID Displays the name that identifies the wireless network. 

Enc. Displays the encryption type. 

Wireless Setup 

NOTE: Wireless Setup is available only when the printer is connected using the wireless network. 

Purpose: 

To configure the wireless network interface. 
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Values: 

Select access Select the access point from the list. 

WEP Key Entry When you select an access point using WEP as the security 
method, enter the WEP key. For 64bit keys, up to 10 
hexadecimal characters can be entered. For 128bit keys, up 
to 26 hexadecimal characters can be entered. 

PassPhrase Entry When you select an access point using WPA, WPA2, or 
Mixed as the encryption type, enter the passphrase of 8 to 
63 alphanumeric characters. 

Manual Setup Enter Network (SSID) Specifies a name to identify the wireless network. Up to 32 
alphanumeric characters can be entered. 

Infrastructure Select when you configure the wireless setting through the 
access point such as a wireless router. 

No Security Specifies No Security to configure the wireless setting 
without specifying a encryption type from WEP, WPA-PSK
TKIP, and WPA-PSK-AES. 

­

Mixed mode PSK* Select to configure the wireless setting with the encryption 
type of Mixed mode PSK. Mixed mode PSK automatically 
selects the encryption type from either WPA-PSK-TKIP, 
WPA-PSK-AES, or WPA2-PSK-AES. 

PassPhrase 
Entry 

Specifies the passphrase of 
alphanumeric characters from 8 to 63. 

WPA-PSK-TKIP Select to configure the wireless setting with the encryption 
type of WPA-PSK-TKIP. 

PassPhrase 
Entry 

Specifies the passphrase of 
alphanumeric characters from 8 to 63. 

WPA2-PSK-AES Select to configure the wireless setting with the encryption 
type of WPA2-PSK-AES. 

PassPhrase 
Entry 

Specifies the passphrase of 
alphanumeric characters from 8 to 63. 

WEP Specifies the WEP key to use through the wireless network. 
For 64bit keys, up to 10 hexadecimal characters can be 
entered. For 128bit keys, up to 26 hexadecimal characters 
can be entered. 

Transmit Key Specifies the transmit key from Auto* , 
WEP Key 1, WEP Key 2, WEP Key 3, 
and WEP Key 4. 

Ad-hoc Select to configure the wireless setting without the access 
point such as a wireless router. 

No Security* Select to configure the wireless setting without specifying 
the encryption type from WEP. 

WEP Specifies the WEP key to use through the wireless network. 
For 64bit keys, up to 10 hexadecimal characters can be 
entered. For 128bit keys, up to 26 hexadecimal characters 
can be entered. 

Transmit Key Specifies the transmit key from WEP 
Key 1* , WEP Key 2, WEP Key 3, and 
WEP Key 4. 
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WPS Setup 

NOTE: WPS Setup is available only when the printer is connected using the wireless network. 

Purpose: 

To configure the wireless network using WPS. 

Values: 

Push Button Control Cancel* Cancels the wireless setting with the encryption type of WPS-PBC. 

Start Configures the wireless setting with the encryption type of WPS-PBC. 

PIN Code Start Configuration Configures the wireless setting using the PIN code assigned automatically 
by the printer. 

Print PIN Code Prints the PIN code. Confirm it when entering PIN assigned to the printer 
into your computer. 

Reset Wireless 

NOTE: Reset Wireless feature is available only when the printer is connected using the wireless network. 

Purpose: 

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values. 

TCP/IP 

Purpose: 

To configure TCP/IP settings. 

Values: 

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address. 

IPv4 Mode Uses IPv4 to set the IP address. 

IPv6 Mode Uses IPv6 to set the IP address. 

IPv4 Get IP Address AutoIP* Sets the IP address automatically. A random value in the range of 
169.254.1.0 to 169.254.254.255 that is not currently in use on the 
network is set as the IP address. The subnet mask is set as 
255.255.0.0. 

BOOTP Sets the IP address using BOOTP. 

RARP Sets the IP address using RARP. 

DHCP Sets the IP address using DHCP. 

Panel Use this option when you want to set the IP address manually on 
the operator panel. 

IP Address When an IP address is being set manually, the IP is allocated to the 
printer using the format nnn.nnn.nnn.nnn. Each octet that makes 
up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and 
any value in the range of 224 to 254 cannot be specified for the 
first octet of a gateway address. 

Subnet Mask	 When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 
255.255.255.255 cannot be specified as the subnet mask. 
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Gateway Address	 When an IP address is being set manually, the gateway address is 
specified using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 
and any value in the range of 224 to 254 cannot be specified for 
the first octet of a gateway address. 

Ipsec Disable*	 Disables Ipsec. 
*1 Ipsec feature is available only when IPsec is enabled on the Dell Printer Configuration Web Tool. 

Protocols 

Purpose: 

To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again. 

Values: 

LPD Disable Disables the LPD port. 

Enable* Enables the Line Printer Daemon (LPD) port. 

Port9100 Disable Disables the Port9100 port. 

Enable* Enables the Port9100 port. 

FTP Disable Disables the FTP port. 

Enable* Enables the FTP port. 

IPP Disable Disables IPP port. 

Enable* Enables IPP port. 

SMB TCP/IP Disable Disables SMB TCP/IP port. 

Enable* Enables SMB TCP/IP port. 

SMB NetBEUI Disable Disables SMB NetBEUI port. 

Enable* Enables SMB NetBEUI port. 

WSD Print Disable Disables WSD port. 

Enable* Enables WSD port. 

SNMP UDP Disable Disables the SNMP UDP port. 

Enable* Enables the Simple Network Management Protocol (SNMP) UDP port. 

E-mail Alert Disable Disables the E-mail Alert feature. 

Enable* Enables the E-mail Alert feature. 

EWS Disable Disables access to the Dell Printer Configuration Web Tool embedded in the 
printer. 

Enable* Enables access to the Dell Printer Configuration Web Tool embedded in the 
printer. 

Bonjour(mDNS) Disable Disables Bonjour (mDNS). 

Enable* Enables Bonjour (mDNS). 

Telnet Disable Disables Telnet. 

Enable* Enables Telnet. 

HTTP-SSL/TLS*1 Disable* Disables HTTP-SSL/TLS. 

Enable Enables HTTP-SSL/TLS. 

Google Cloud Print Disable* Disables Google Cloud Print. 

Enable Enables Google Cloud Print. 
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*1 HTTP-SSL/TLS feature is available only when a digital certificate is set from the Dell Printer Configuration Web Tool. 

IP Filter 

NOTE: IP Filter feature is available only for LPD or Port9100. 

Purpose: 

To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP 
addresses. The change becomes effective after the printer is turned off and then on again. 

Values: 

No. n / IP Address (n is 1–5.) Sets the IP address for Filter n. 

No. n / Mask (n is 1–5.) Sets the address mask for Filter n. 

No. n / Mode (n is 1–5.) Off* Disables the IP Filter feature for Filter n. 

Accept Accepts an access from the specified IP address. 

Reject Rejects an access from the specified IP address. 

IEEE 802.1x 

NOTE: IEEE 802.1x feature is available only when the printer is connected using LAN cable and it is available only when the IEEE 
802.1x authentication is enabled. 

Purpose: 

To disable IEEE 802.1x authentication. The change becomes effective after the printer is turned off and then on 
again. 

Reset LAN 

Purpose: 

To initialize wired network data stored in non-volatile memory (NVM). After executing this function and rebooting 
the printer, all wired network settings are reset to their default values. 

Adobe Protocol 

Purpose: 

To specify PostScript communication protocol for a parallel interface, you can configure the Adobe Protocol 
settings for the wired network. The change becomes effective after the printer is turned off and then on again. 

Values: 

Auto Used when auto-detecting the PostScript communication protocol. 

Standard Used when the communication protocol is in ASCII interface. 

BCP Used when the communication protocol is in binary format. 

TBCP* Used when the communication protocol supports both ASCII and binary data to switch between them 
according to the specified control code. 

Binary Used when no special processing is required for data. 

USB Settings 
Use the USB Settings menu to change printer settings affecting a USB port. 

USB Port 

NOTE: USB Port feature is available only for the USB port on the rear of the printer. 
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Purpose: 

To specify whether to enable the USB port. The change becomes effective after the printer is turned off and then on 
again. 

Values: 

Disable Disables the USB interface. 

Enable* Enables the USB interface. 

Adobe Protocol 

Purpose: 

To specify PostScript communication protocol for a parallel interface, you can configure the Adobe Protocol 
settings for the wired network. The change becomes effective after the printer is turned off and then on again. 

Values: 

Auto Used when auto-detecting the PostScript communication protocol. 

Standard Used when the communication protocol is in ASCII interface. 

BCP Used when the communication protocol is in binary format. 

TBCP* Used when the communication protocol supports both ASCII and binary data to switch 
between them according to the specified control code. 

Binary Used when no special processing is required for data. 

System Settings 
Use System Settings to configure the power saving mode, warning tones, time-out duration, display language, 
and job log auto print settings. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Power Saver Timer 

CAUTION: If the Auto-Off Timer feature is set and the power is turned off, stored data in RAM Disk is cleared. 

Purpose: 

To specify the time for transition to power saver mode. 

Values: 

Sleep 6 minutes* Specifies the time taken by the printer to enter Sleep mode after it 

Available Range: 1–60 minutes finishes a job. 

Deep Sleep 8 minutes* Specifies the time taken by the printer to enter Deep Sleep mode 

Available Range: 1–60 minutes after it has entered Sleep mode. 

Auto-Off Timer*1 Off Disables the Auto-Off Timer. 

On* 180 minutes* Specifies the time it takes to automatically turn off the printer after 

Available Range: it has entered Deep Sleep mode. 

60–1440 minutes 
*1 Auto-Off Timer feature is available only in certain regions. 

When you specify 1 minute for Sleep,  the printer enters power saver mode 1 minute after it finishes a job. This 
uses much less energy, but requires more warm-up time for the printer. Specify 1 minute if your printer shares an 
electrical circuit with room lighting and you notice lights flickering. 
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Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate 

with minimum warm-up time. 


Select a value between 1 and 60 minutes for power saver mode if you want a balance between energy consumption 

and a shorter warm-up period.
 

The printer automatically returns to the standby mode from the power saver mode when it receives data from the 

computer. You can also change the status of the printer to the standby mode by pressing any button on the operator 

panel.
 

If the Auto-Off Timer feature turns off the printer, the printer cannot be turned back on automatically. To turn the 

printer back on, physically turn the power switch of the printer to On.
 

Auto Reset 

Purpose: 

To automatically reset the settings to the default settings and return to the standby mode after you do not specify 
any settings for the specified time. 

Values: 

45sec* 

1min 

2min 

3min 

4min 

Fault Time-out 

Purpose: 
To specify the amount of time the printer waits before canceling a job that stops abnormally. The print job is cancelled if the 
time-out time is exceeded. 

Values: 

Off Disables the fault time-out. 

On* 60 seconds* 

Available Range: 
3-300 seconds 

Sets the amount of time the printer waits before canceling a job that stops 
abnormally. 

Job Time-out 

Purpose: 
To specify the amount of time the printer waits for data to arrive from the computer. The print job is cancelled if the time-out 
time is exceeded. 

Values: 

Off Disables the job time-out. 

On* 30 seconds* Sets the time the printer waits for data to arrive from the computer. 

Available Range: 
5–300 seconds 
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Date & Time 

Purpose: 

To specify the date and time formats. 

Values: 

Set Date & Time Time Zone Sets the time zone. 

Date Sets the date depending on the Date Format settings. 

Time Sets the time. 

Date Format Sets the date format. 

Time Format 12H Sets the time in 12-hour format. 

24H* Sets the time in 24-hour format. 

Audio Tone 

Purpose: 

To configure settings for tones emitted by the printer during operation or when a warning message appears. 

Values: 

Control Panel Off* Does not emit a tone when the operator panel input is correct. 

On Emits a tone when the operator panel input is correct. 

Invalid Key Off* Does not emit a tone when the operator panel input is incorrect. 

On Emits a tone when the operator panel input is incorrect. 

Machine Ready Off Does not emit a tone when the printer is ready to process a job. 

On* Emits a tone when the printer is ready to process a job. 

Job Completed Off Does not emit a tone when a job is complete. 

On* Emits a tone when a job is complete. 

Fault Tone Off Does not emit a tone when a job ends abnormally. 

On* Emits a tone when a job ends abnormally. 

Alert Tone Off Does not emit a tone when a problem occurs. 

On* Emits a tone when a problem occurs. 

Out of Paper Off Does not emit a tone when the printer runs out of paper. 

On* Emits a tone when the printer runs out of paper. 

Low Toner Alert Off Does not emit a tone when a toner is low. 

On* Emits a tone when a toner is low. 

Auto Clear Alert Off* Does not emit a tone 5 seconds before the printer performs auto clear. 

On Emits a tone 5 seconds before the printer performs auto clear. 

All Tones Off* Disables all the alert tones. 

On Enables all the alert tones at once. 

mm / inch 

Purpose: 

To specify the default measurement unit displayed after the numeric value on the operator panel. 
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Values: 

Millimeters (mm)* Selects millimeter as the default measurement unit. 

Inches (")	 Selects inch as the default measurement unit. 

NOTE: The default for mm/inch varies depending on other settings, such as Country and Document Size. 

Default Paper Size 

Purpose: 

To specify the default paper size. 

Values: 

mm series 

A4*1 

Letter 
*1 Denotes country-specific factory default values. 

inch series 

A4 

Letter*1 

*1 Denotes country-specific factory default values. 

A4<>Letter Switch 

Purpose: 

To print A4 size jobs on Letter size paper if A4 is not available or to print Letter size jobs on A4 size paper if Letter 
size paper is not available. 

Values: 

Off*1	 Does not print A4 size jobs on Letter size paper or Letter size jobs on A4 paper. 

On* Prints A4 size jobs on Letter size paper if A4 size paper is not available in the paper trays 
and vice versa (Letter size job on A4 size paper). 

*1	 Depending on the printer setting, the printer will continue to print on existing media of a different size or prompt the user to select from 
the following: 
• Delete Job 
• Supply with correct media 

Auto Log Print 

Purpose: 

To automatically print a job history report after every 20 jobs. 

Values: 

Off*	 Does not automatically print a job history report. 

On	 Automatically prints a job history report. 

Print logs can also be printed using the Report / List menu. 
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Report 2 Sided Print 

NOTE: Report 2 Sided Print feature is available only for Dell C3760dn Color Laser Printer. 

Purpose: 

To specify to print reports on both sides a sheet of paper. 

Values: 

1 Sided* Prints reports on one side of a sheet of paper. 

2 Sided Prints reports on both side of a sheet of paper. 

Print ID 

Purpose: 

To specify a location where the user ID is printed. 

Values: 

Off* Does not print the user ID. 

Top Left Prints the user ID on the top left of the page. 

Top Right Prints the user ID on the top right of the page. 

Bottom Left Prints the user ID on the bottom left of the page. 

Bottom Right Prints the user ID on the bottom right of the page. 

NOTE: When printing on DL size paper, a part of the user ID may not be printed correctly. 

Print Text 

Purpose: 

To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer 
receives it. Text data is printed on A4 or Letter size paper. 

Values: 

Off Does not print the received data. 

On* Prints the received data as text data. 

Banner Sheet 

Purpose: 

To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. 

Values: 

Insert Position Off* Does not print the banner sheet. 

Front Inserted before the first page of every copy. 

Back Inserted after the last page of every copy. 

Front & Back Inserted before the first page of every copy and after the last page of every 
copy. 

Specify Tray MPF The banner sheet is loaded in the MPF. 

Tray 1* The banner sheet is loaded in tray1. 

Tray 2*1 The banner sheet is loaded in the optional 550-sheet feeder. 
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*1 This item is available only when the optional 550-sheet feeder is installed. 

RAM Disk 

NOTE: RAM Disk feature is available only when the optional 512 MB memory module is installed on the printer. 

NOTE: RAM Disk feature is not available when the optional hard disk is installed. 

Purpose: 

To allocate memory to the RAM disk file system for the Secure Print, Private Mail Box Print, Public Mail Box Print, 
and Proof Print features. The change becomes effective after the printer is turned off and then on again. 

Values: 

Off Does not allocate memory to the RAM disk file system. Secure Print, Private Mail Box Print, 
Public Mail Box Print, and Proof Print jobs will abort and be recorded to the job log. 

On 300 MB* Sets the allocation of memory to the RAM disk file system in increments of 50 MB. 

Available Range: 
50-450 MB 

NOTE: Restart your printer when you change the settings for the RAM Disk menu. 

Substitute Tray 

Purpose: 

Specifies whether to use paper of a different size when the paper that is loaded in the specified tray does not match 
the paper size settings for the current job. 

Values: 

Off No tray size substitute accepted. 

Larger Size Substitutes paper of next largest size. When there is no larger paper size, the printer substitutes paper of 
nearest size. 

Nearest Size* Substitutes paper of nearest size. 

Use MPF Substitutes paper from the MPF. 

Set Available Time 

Purpose: 

Sets the available time for the Print function. 

Values: 

Print Off* Does not set the time when printing is available. 

On Sets the time when printing is available. 

Start Time Sets the start time of the available time. 

End Time Sets the end time of the available time. 

Recurrence Sets the day of the week to repeat the setting. 

NOTE: Set Available Time can be configured when Print is set to On. 

Secure Job Expiration 

NOTE: Secure Job Expiration feature is available only when RAM Disk is set to Enable or when the optional hard disk is 
installed. 
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Purpose: 

To specify the date and time to delete the files stored as Secure Print in the RAM disk or the optional hard disk. 

Values: 

Expiration Mode Off* Does not set the date and time to delete the files stored as Secure Print in 
the RAM Disk or the optional hard disk. 

On Sets the date and time to delete the files stored as Secure Print in the RAM 
Disk or the optional hard disk. 

Expiration Time Sets the time to delete the files stored as Secure Print in the RAM Disk or 
the optional hard disk. 

Recurrence Daily Sets the recurrence to delete the files stored as Secure Print in the RAM Disk 
or the optional hard disk daily. 

Weekly* Sets the recurrence to delete the files stored as Secure Print in the RAM Disk 
or the optional hard disk weekly. 

Monthly Sets the recurrence to delete the files stored as Secure Print monthly. 

Weekly Setting Monday Sets the day of the week to delete the files stored as Secure Print. 

Tuesday 

Wednesday 

Thursday 

Friday 

Saturday 

Sunday* 

Monthly Setting 1 day* Sets the day of the month to delete the files stored as Secure Print in the 

Available Range: RAM Disk or the optional hard disk. 

1-28 days 

ColorTrack Mode 

Purpose: 

To specify who has access to color printing. 

Values: 

Off* Does not limit access to color printing. 

Internal Mode Limits access to color printing. Authentication is done using user information registered on the printer. 

External Mode Limits access to color printing. Authentication is done using an external authentication server. 

Non Registered User 

Purpose: 
To specify whether to permit the printing of data without authentication information. 

Values: 

Off* Does not permit non-account user to print the data. 

On*1 Permits non-account user to print the data. 
*1 Set Non Account User Password using the Dell Printer Configuration Web Tool. 
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Auto Color To Mono Print 

NOTE: Auto Color To Mono Print feature is available when Dell ColorTrack is disabled. 

Purpose: 

To specify whether to print all print jobs in black and white even when color print is specified. 

Values: 

Off* Prints according to the specified color mode. 

On Prints all print jobs in black and white even when color print is specified. 

ColorTrack Error Report 

Purpose: 
To specify whether to automatically print error-related information if printing with ColorTrack results in an error. 

Values: 

Off* Does not print the error report when printing with ColorTrack results in an error. 

On Prints the error report when printing with ColorTrack results in an error. 

Letterhead 2 Sided 

NOTE: Letterhead 2 Sided Mode feature is available only for Dell C3760dn Color Laser Printer. 

Purpose: 

To specify whether to print on both sides when using letterhead. 

Values: 

Disable* Does not print on both sides of letterhead. 

Enable Prints on both sides of letterhead. 

Low Toner Alert Msg 

Purpose: 

To specify whether to show the alert message when the toner is low. 

Values: 

Off Does not show the alert message when the toner is low. 

On* Shows the alert message when the toner is low. 

S/W Download 

Purpose: 

To enable or disable download of firmware updates. 

Values: 

Disable Disables firmware updates. 

Enable* Enables firmware updates. 
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Use Another Tray 

Purpose: 

To change to another paper tray when a paper size runs out in the specified paper tray. 

Values: 

Off Does not print on other paper sizes in other paper trays if the paper size specified in the job runs out. 

On* Shows a message to select another tray when the specified paper runs out in the paper tray. 

NOTE: If you select another paper tray with paper size smaller than the paper size specified in the job, the parts that do not fit 
are not printed (print size is not adjusted automatically). 

Power On Wizard 

Purpose: 

To perform initial setup for the printer. 

Maintenance 
Use the Maintenance menu to initialize the NV (non-volatile) memory, configure the plain paper quality 
adjustment settings, and configure the security settings. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

F/W Version 

Purpose: 

To confirm the current F/W version. 

Service Tag 

Purpose: 

To confirm the service tag. 

Express Code 

Purpose: 

To confirm the express service code. 

Paper Density 

Purpose: 

To specify paper density settings. 

Values: 

Plain Light 

Normal* 

Label Light 

Normal* 
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Adjust Transfer Belt Unit 

Purpose: 

To adjust the transfer bias when ghosting occur. (The ghost image may be the image of the previous page, or a part of 
the page currently printing) 

Values: 

K Offset 0* If faint black colored ghosts appear, try to decrease the value. 

Available Range:  -5 to  +5 

YMC Offset 0* 

Available Range:  -5 to  +5 

If faint ghosts in color (yellow, magenta, or cyan) appear, try to decrease 
the value. 

Adjust 2nd BTR 

NOTE: The print quality changes depending on the setting values you select for this item. 

Purpose: 

To specify the transfer roller voltage adjustment for each paper type. 

Values: 

Plain 

Plain Thick 

0* 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Sets the transfer roller voltage in increments of 1. The default 
settings may not give the best output on all paper types. If you see 
mottles on the print output, try to increase the voltage. If you see 
white spots on the print output, try to decrease the voltage. 

Covers 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Covers Thick 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Coated 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Coated Thick 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Label 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Envelope 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Recycled 

Available Range: 
(Lighten) -5 to (Darken) +10 

0* 

Available Range: 
(Lighten) -5 to (Darken) +10 
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Adjust Fusing Unit 

NOTE: The print quality changes depending on the setting values you select for this item. 

Purpose: 

To adjust the temperature setting of the fusing unit for each paper type. 

Values: 

Plain 

Plain Thick 

Covers 

0* 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Sets the fusing unit temperature in increments of 1. The default 
settings may not give the best output on all paper types. When the 
printed paper has curled, try to lower the temperature. When the 
toner does not fuse on the paper properly, try to increase the 
temperature. 

Covers Thick 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Coated 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Coated Thick 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Label 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Envelope 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Recycled 

Available Range: 
(Lighten) -3 to (Darken) +3 

0* 

Available Range: 
(Lighten) -3 to (Darken) +3 

Auto Reg Adjust 

Purpose: 

To specify whether to automatically perform color registration adjustment. 

Values: 

Off Does not automatically perform color registration adjustment. 

On* Automatically performs color registration adjustment. 
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Color Reg Adjust 

Purpose: 

To manually perform color registration adjustment. 

Manual Color Registration Adjustments are required when the printer is initially installed and after the printer is 
moved. 

NOTE: The Color Reg Adjust feature can be configured when Auto Reg Adjust is set to Off. 

Values: 

Auto Correct Cancel* Does not perform color registration correction. 

Start Automatically performs color registration correction. 

Color Regi Chart Yes Prints a color registration chart. The color registration chart prints a lattice pattern of 
yellow, magenta, and cyan lines. On the chart, find the values on the right side that are 
next to the line that is perfectly straight for each of the three colors. If the value for this 
line is 0, color registration adjustment is not required. If the value for this line is any 
value other than 0, specify the adjustment values under lateral adjustment and process 
adjustment in Enter Number. 

No* Does not print a color registration chart. 

Enter Number LY 

LM 

LC 

RY 

RM 

Available Range: 
-9 to +9 

Available Range: 
-9 to +9 

Sets lateral (perpendicular to paper feed direction) and process 
(paper feed direction) color adjustment values individually for 
Yellow, Magenta, and Cyan. Enter a number in order of lateral 
adjustment (left), lateral adjustment (right), and process 
adjustment. Press the (Set) button to save all the settings. 

RC 

PY 

PM 

Available Range: 
-9 to +9 

PC 

Reset Defaults 

Purpose: 

To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu 
parameters are reset to their default values. 

Initialize Print Meter 

Purpose: 

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero. 

Reset Fusing Unit 

Purpose: 

To initialize the life counter of the fusing unit. After replacing the fusing unit, be sure to initialize its life counter. 

Reset Transfer Belt Unit 

Purpose: 

To initialize the life counter of the transfer belt unit. After replacing the transfer belt unit, be sure to initialize its life 
counter. 
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Clear Job History 

Purpose: 

To clear the job history of all finished jobs. 

Clear Storage 

NOTE: Clear Storage feature is available only when the additional 512 MB memory module is installed and RAM Disk is set to 
On or when the optional hard disk is installed. 

Purpose: 

To clear all files stored as Secure Print, Private Mail Box Print, Public Mail Box Print, Proof Print, and Stored Print in 
the Ram disk or the optional hard disk. 

Values: 

All Clear Deletes all files stored as Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof 
Print in the Ram disk or the optional hard disk. 

Secure Document Deletes all files stored as Secure Print in the Ram disk or the optional hard disk. 

Stored Document Deletes all files stored as Stored Print in the Ram disk or the optional hard disk. 

Format Hard Disk 

NOTE: Format Hard Disk feature is available only when the optional hard disk is installed. 

Purpose: 

To initialize the optional hard disk. 

Non-Dell Toner 

Purpose: 

To use toner cartridge of another manufacturer. 

CAUTION: Using a non-Dell toner cartridge may severely damage your printer. The warranty does not cover damages caused 
by using non-Dell toner cartridges. 

Values: 

Off* Does not use toner cartridge of another manufacturer. 
On Uses toner cartridge of another manufacturer. 

Adjust Altitude 

Purpose: 

To specify the altitude of the location where the printer is installed. 


The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 

performed by specifying the altitude of the location where the printer is being used. 


NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner, etc. 

Values: 

0m* Sets the altitude of the location where the printer is installed. 

1000m 

2000m 

3000m 
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Secure Settings 
Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

See also: 

"Panel Lock" 

Panel Lock 

Purpose: 

To set a limited access to Admin Settings with a password, and to set or change the password. 

Values: 

Panel Lock Control Disable* Disables password protection for Admin Settings. 

Enable Enables password protection for Admin Settings. 

Change Password*1 0000–9999 Sets or changes the password required to access Admin Settings. 
*1 This item is available only when Panel Lock Control is set to Enable. 

Function Enabled 

NOTE: Function Enabled feature is available only when Panel Lock Control is set to Enable. 

Purpose: 

To specify whether to enable or disable each of the printer functions, or to require a password to use the functions. 

Values: 

USB Direct Print On* Enables the USB Direct Print function. 

On (Password) Enables the USB Direct Print function, but requires a password. 

On (Color 
Password) 

Enables the USB Direct Print function with a color mode, but requires a 
password. 

Off Disables the USB Direct Print function. 

Change Password*1 Changes the password that is set under the Function Enabled menu. 
*1 This item is available only when On (Password) or On (Color Password) is enabled. 

Data Encryption 

NOTE: Data Encryption feature is available only when the optional hard disk is installed. 

Purpose: 

To disable or enable data encryption when using the printer. 

Values: 

Encryption Off* Disables encryption of the data. 

On Enables encryption of the data. 

Encryption Key Sets a key that is required for encryption. 
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Hard Disk Over write 

NOTE: Hard Disk Over write feature is available only when the optional hard disk is installed. 

NOTE: Overwrite of the hard disk may take several hours. When overwriting the hard disk, all functions of the printer are 
inoperable. 

Purpose: 

To erase the contents of the entire hard disk by overwriting the hard disk with meaningless data. 

Values: 

Off* Disables overwrite of the hard disk. 

Single Pass Overwrites the hard disk once. 

3 Pass Overwrites the hard disk three times. 

Login Error 

NOTE: Login Error feature is available only when Panel Lock Control is set to Enable. 

Purpose: 

To specify the number of error entry attempts allowed when you log in as an administrator in the Admin 
Settings and Report/List menu. 

Values: 

Off* Does not allow an administrator to log in after one error entry attempt. 

On 5* Sets the number of error entry attempts allowed when an administrator logs in. 

Available Range: 1-10 

Defaults Settings 
Use Defaults Settings to modify the USB Direct Print menu defaults. 

USB Direct Print Defaults 
Purpose: 

To modify the defaults for the USB Direct Print Defaults menu. See "USB Direct Print" for more details. 

Tray Settings 
Use the Tray Settings menu to define the print media loaded in tray1 and the optional 550-sheet feeder. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

MPF 
Purpose: 

To specify the paper loaded in the MPF. 

Values: 

Paper Size*1 Use Driver Settings* 

mm series A4 

A5 
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B5 

Letter 

Executive 

Folio 

Legal 

Envelope #10 

Monarch 

DL 

C5 

Custom Size 

inch series Use Driver Settings* 

Letter 

Executive 

Folio 

Legal 

A4 

A5 

B5 

Envelope #10 

Monarch 

DL 

C5 

Custom Size 

Paper Type*1 Plain* 

Plain Thick 

Covers 

Covers Thick 

Coated 

Coated Thick 

Label 

Envelope 

Recycled 

Letterhead 

Preprinted 

Prepunched 

Color 

Plain S2 

Color S2 

Plain Thick S2 

Recycled S2 

MPF Mode Panel Specified Uses the paper size and paper type set from the operator panel. 

DriverSpecified* Uses the paper size and paper type set on the printer driver. 
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Display Popup*1 Off	 Does not display a popup message that prompts to set Paper Type
and Paper Size when paper is loaded in the MPF. 

On*	 Displays a popup message that prompts to set Paper Type and 
Paper Size when paper is loaded in the MPF. 

*1 This item is available only when MPF Mode is set to Panel Specified. 

Tray 1 
Purpose: 

To specify the paper loaded in tray1. 

Values: 

A4*1Paper Size 

mm series A5 

B5 

Letter 

Executive 

Folio 

Legal 

Custom Size 

inch series Letter*1 

Executive 

Folio 

Legal 

A4 

A5 

B5 

Custom Size 

Paper Type Plain* 

Plain Thick 

Covers 

Covers Thick 

Coated 

Coated Thick 

Recycled 

Letterhead 

Preprinted 

Prepunched 

Color 

Plain S2 

Color S2 

Plain Thick S2 

Recycled S2 
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Display Popup Off	 Does not display a popup message that prompts 
to set Paper Type and Paper Size when 
paper is loaded in tray1. 

On*	 Displays a popup message that prompts to set 
Paper Type and Paper Size when paper 
is loaded in tray1. 

*1 Denotes country-specific factory default value. 

NOTE: For more information on supported paper sizes, see "Supported Paper Sizes." 

Tray 2 

NOTE: Tray 2 feature is available only when the optional 550-sheet feeder is installed. 

Purpose: 

To specify the paper loaded in the optional 550-sheet feeder. 

Values: 

Paper Size Auto* 

Custom Size 

Paper Type	 Plain* 

Plain Thick 

Covers 

Covers Thick 

Coated 

Coated Thick 

Recycled 

Letterhead 

Preprinted 

Prepunched 

Color 

Plain S2 

Color S2 

Plain Thick S2 

Recycled S2 

Display Popup Off	 Does not display a popup message that prompts to set Paper Type 
and Paper Size when paper is loaded in the optional 550-sheet 
feeder. 

On*	 Displays a popup message that prompts to set Paper Type and 
Paper Size when paper is loaded in the optional 550-sheet feeder. 

*1 Denotes country-specific factory default value. 
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Tray Priority 
Purpose: 

To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with the same paper size 
and type exists, the paper tray is selected according to this priority order. 

Values: 

1st Priority MPF* Sets the MPF as the first priority. 

Tray 1 Sets tray1 as the first priority. 

Tray 2 Sets the optional 550-sheet feeder as the first priority. 

2nd Priority*1 MPF Sets the MPF as the second priority. 

Tray 1* Sets tray1 as the second priority. 

Tray 2 Sets the optional 550-sheet feeder as the second priority. 

3rd Priority*2 MPF Sets the MPF as the third priority. 

Tray 1 Sets tray1 as the third priority. 

Tray 2* Sets the optional 550-sheet feeder as the third priority. 
*1 The tray selected in 1st Priority is not displayed. 
*2 The trays selected in 1st Priority and 2nd Priority are not displayed. 

Panel Language 
Purpose: 

To determine the language of the text on the LCD panel. 

Values: 

English* 

Français 

Italiano 

Deutsch 

Español 

Dansk 

Nederlands 

Norsk 

Svenska 
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Print Menu 
Use the Print Menu to print a job using the Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof 
Print features. 

NOTE: Values marked by an asterisk (*) are the factory default menu settings. 

Secure Print 

NOTE: Secure Print feature is available only when RAM disk is set to On or the optional hard disk is installed. 

Purpose: 

To print confidential jobs. The printer can hold the job in memory until you arrive at the printer and type the 
password on the operator panel. 

Values: 

Select User ID Enter the password you specified on the printer driver. 

All Documents*1 Print and Delete Deletes all documents from print memory after 
printing them. 

Delete Deletes all documents from print memory. 

document n*2 Print and Delete Deletes the specified document from print memory 
after printing it. 

Delete Deletes the specified document from print memory. 

*1 This item is available only when the multiple print jobs are stored. 
*2 The document name is displayed. The save date and time are displayed if the document name is not specified. 

Private Mail Box 

NOTE: Private Mail Box feature is available only when RAM disk is set to On or the optional hard disk is installed. 

Purpose: 

To specify whether and how to print the job stored in the Private Mail Box. 

Values: 

Select User ID Enter the password you specified on the printer 
driver. 

All Documents*1 Print Prints all documents and saves them in memory. 

Use PC Settings Sets the number of copies specified on the 
printer driver. 

Input Number of Sets the number of copies. 
Copies 

Print and Delete Deletes all documents from print memory after 
printing them. 

Use PC Settings Sets the number of copies specified on the 
printer driver. 

Input Number of Sets the number of copies. 
Copies 

Delete Deletes all documents from print memory. 

document n*2 Print Prints all documents and saves them in memory. 
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Input Number of Sets the number of copies. 
Copies 

Print and Delete Deletes all documents from print memory after 
printing them. 

Input Number of Sets the number of copies. 
Copies 

Delete Deletes all documents from print memory. 

*1 This item is available only when the multiple print jobs are stored. 
*2 The document name is displayed. The save date and time are displayed if the document name is not specified. 

Public Mail Box 

NOTE: Public Mail Box feature is available only when RAM disk is set to On or the optional hard disk is installed. 

Purpose: 

To specify whether and how to print the job stored in the Public Mail Box. 

Values: 

Select User ID All Documents*1 Print Prints all documents and saves them in memory. 

Use PC Settings Sets the number of copies specified on the 
printer driver. 

Input Number of Sets the number of copies. 
Copies 

Print and Delete Deletes all documents from print memory after 
printing them. 

Use PC Settings Sets the number of copies specified on the 
printer driver. 

Input Number of Sets the number of copies. 
Copies 

Delete Deletes all documents from print memory. 

document n*2 Print Prints all documents and saves them in memory. 

Input Number of Sets the number of copies. 
Copies 

Print and Delete Deletes all documents from print memory after 
printing them. 

Input Number of Sets the number of copies. 
Copies 

Delete Deletes all documents from print memory. 

*1 This item is available only when the multiple print jobs are stored. 
*2 The document name is displayed. The save date and time are displayed if the document name is not specified. 
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Proof Print 

NOTE: Proof Print feature is available only when RAM disk is set to Enable. 

Purpose: 

To specify whether and how to print the job stored in the Proof Print. When the print job is sent from the printer 
driver on the computer, a single copy is printed for you to check the print result. If you do not have problems with 
the print result, you can choose to print more copies. This prevents a large number of misprinted copies from being 
printed at one time. 

Values: 

Select User ID All Documents*1 Print Prints all documents and saves them in memory. 

Use PC Settings Sets the number of copies specified on the 
printer driver. 

Input Number of Sets the number of copies. 
Copies 

Print and Delete Deletes all documents from print memory after 
printing them. 

Use PC Settings Sets the number of copies specified on the 
printer driver. 

Input Number of Sets the number of copies. 
Copies 

Delete Deletes all documents from print memory. 

document n*2 Print Prints all documents and saves them in memory. 

Input Number of Sets the number of copies. 
Copies 

Print and Delete Deletes all documents from print memory after 
printing them. 

Input Number of Sets the number of copies. 
Copies 

Delete Deletes all documents from print memory. 

*1 This item is available only when the multiple print jobs are stored. 
*2 The document name is displayed. The save date and time are displayed if the document name is not specified. 

USB Direct Print 

NOTE: USB Direct Print feature is available only when a USB memory is inserted in the USB port. 

Select Document 

Purpose: 

To specify the document stored in the root, file, or folder in a USB memory. 

Print Start 

Purpose: 

To start printing the selected file. 

Document 

Purpose: 

To change the file you want to print. 
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Output Color 

Purpose: 

To specify whether to print in black and white or in color. 

Values: 

Full Color* Prints in color. 

Black & White Prints in black and white. 

Select Tray 

Purpose: 

To specify the input tray. 

Values: 

MPF 

Tray 1* 

Tray 2*1 

*1 This item is available only when the optional 550-sheet 
feeder is installed. 

MPF Paper Size 

NOTE: MPF Paper Size feature is available only when MPF: Any is selected in Select Tray. 

Purpose: 

To specify the paper size for the MPF. 

Values: 

mm series 

A4*1 

A5 

B5 

Letter 

Folio 

Legal 
*1 Denotes country-specific factory default values. 

inch series 

Letter*1 

Folio 

Legal 

A4 

A5 

B5 
*1 Denotes country-specific factory default values. 
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MPF Paper Type 

NOTE: MPF Paper Type feature is available only when MPF: Any is selected in Select Tray. 

Purpose: 

To specify the paper type for the MPF. 

Values: 

Plain* 

Plain Thick 

Covers 

Covers Thick 

Coated 

Coated Thick 

Envelope 

Recycled 

Letterhead 

Prepunched 

Color 

2 Sided Printing 

NOTE: 2 Sided Printing feature is available only for Dell C3760dn Color Laser Printer. 

Purpose: 

To print on both sides of a sheet of paper. 

Values: 

1 -> 1Sided* Prints on one side of a sheet of paper. 

Long Edge Binding Prints on both sides of a sheet of paper to be bound by long edge. 

Short Edge Binding Prints on both sides of a sheet of paper to be bound by short edge. 

Multiple-Up 

Purpose: 

To specify the output layout. 

Values: 

Off* Prints one page on one side of a sheet of paper. 

2-Up Prints two pages on one side of a sheet of paper. 

4-Up Prints four pages on one side of a sheet of paper. 

Collation 

Purpose: 

To specify whether to sort the job. 

Values: 

Collated Sorts a job. 
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Uncollated Does not sort a job. 

PDF Password 

Purpose: 

To enter the password when you print a PDF file secured with a document open password (password to open the 
PDF file). 

Values: 

Enter PDF Password Enter the document open password to print the secure PDF job. 

Panel Lock 
This feature prevents unauthorized personnel from changing the settings made by the administrator. For regular 
printing, items can be selected from the menu and printer settings remain unchanged. For regular printing, items 
can be configured using the printer driver. 

NOTE: Disabling the operator panel menus does not prevent access to the Stored Print and Tray Settings menus. 

Enabling the Panel Lock 
1 Press the (Menu) button. 

2 Press the button until Admin Settings is highlighted, and then press the (Set) button. 

3 Press the button until Secure Settings is highlighted, and then press the  (Set) button. 

4 Ensure that Panel Lock is highlighted, and then press the  (Set) button. 

5 Ensure that Panel Lock Control is highlighted, and then press the  (Set) button. 

6 Press the button until Enable is highlighted, and then press the (Set) button. 

7 Enter the new password, and then press the (Set) button. 

CAUTION: Be sure to remember the password. The procedure described below allows you to reset the password. 

• Turn off the printer. Then, while holding the (Menu) button, turn on the printer. Perform steps 7 and 8. 

8 Re-enter the password to confirm the password that you entered, and then press the  (Set) button. 

The password has been changed. 

NOTE: If you change the password while Panel Lock is Enable, perform steps 1 to 4 above. Press the button until 
Change Password is highlighted, and then press the 
password. This will change the password. 

(Set) button. Perform steps 7 and 8 above to change the 

Disabling the Panel Lock 
1 Press the (Menu) button. 

2 Press the button until Admin Settings is highlighted, and then press the (Set) button. 

3 Press the button until Secure Settings is highlighted, and then press the  (Set) button. 

4 Ensure that Panel Lock is highlighted, and then press the (Set) button. 

5 Ensure that Panel Lock Control is highlighted, and then press the (Set) button. 

6 Ensure that Disable is highlighted, and then press the (Set) button. 

7 Enter the current password, and then press the  (Set) button. 

The setting has been changed. 
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Resetting Defaults 
After executing this function and rebooting the printer, all the menu parameters are reset to their default values. 

The following menu parameters are exceptions and are not reset. 

• Network settings 

• Panel Lock settings and password 

• Function Enabled settings and passwords 

• Login Error settings 

• Set Available Time settings 

• Secure Job Expiration settings 

• USB Port settings 

• Data Encryption settings 

• Hard Disk Over write settings 

• ColorTrack Mode settings 

• ColorTrack Error Report settings 

• Non Registered User settings 

When Using the Operator Panel 
1 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Maintenance is highlighted, and then press the (Set) button.
 

4 Press the 
 button until Reset Defaults is highlighted, and then press the (Set) button.
 

5 Press the 
 button until Yes is highlighted, and then press the (Set) button.
 

The printer is restarted automatically.
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Print Media Guidelines 
Print media refers to paper, labels, envelopes, and coated paper among others. Your printer provides high-quality 
printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing 
troubles. This section describes selecting and caring for print media. 

NOTE: Use only laser print media. Do not use ink jet paper in your printer. 

Paper 
For the best print quality in color, use 75 g/m2 (20 lb) xerographic, grain long paper. For the best print quality in 
black and white, use 90 g/m2 (24 lb) xerographic, grain long paper. It is recommended that you try a sample first 
before buying large quantities of any print media. 

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See 
"Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" and "Loading Print Media in the MPF" for 
detailed loading instructions. 

Paper Characteristics 
The following paper characteristics affect print quality and reliability. It is recommended that you follow these 
guidelines when evaluating new paper stock. 

Weight 

The tray automatically feeds paper weights from 60 g/m2 to 216 g/m2 (16 lb to 80 lb bond) grain long. The 
multipurpose feeder (MPF) automatically feeds paper weights from 60 g/m2 to 216 g/m2 (16 lb to 80 lb bond) grain 
long. Paper lighter than 60 g/m2 (16 lb) may not feed properly, and could cause paper jams. For best performance, 
use 75 g/m2 (20 lb bond) grain long paper. 

Curl 

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl 
usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper 
unwrapped, even in the paper tray, can contribute to paper curling prior to printing and cause feeding problems 
regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the MPF. 

Smoothness 

The degree of paper smoothness directly affects the print quality. If the paper is too rough, the toner does not fuse 
on to the paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding 
problems. Smoothness between 150 and 250 Sheffield points produces the best print quality. 

Moisture Content 

The amount of moisture in the paper affects both the print quality and the ability of the printer to feed the paper 
properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper 
to moisture changes that can degrade its performance. 

Grain Direction 

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of 
the paper, or grain short, running the width of the paper. For 60 g/m2 to 135 g/m2 (16 lb to 36 lb bond) paper, grain 
long fibers are recommended. For paper heavier than 135 g/m2 (36 lb bond), grain short is preferred. 
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Fiber Content 

Most high-quality xerographic paper is made from 100 % chemically pulped wood. Paper containing fibers such as 
cotton may lead to degraded paper handling. 

Recommended Paper 
To ensure the best print quality and feed reliability, use 75 g/m2 (20 lb) xerographic paper. Business paper designed 
for general business use also provides acceptable print quality. Only use paper able to withstand high temperatures 
without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper to high 
temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is 
acceptable for laser printers. 

It is recommended that you try a sample first before buying large quantities of any print media. When choosing any 
print media, you should consider the weight, fiber content, and color. 

Unacceptable Paper 
The following paper types are not recommended for use with the printer: 

•	 Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, carbonless
 
copy paper (CCP), or no carbon required (NCR) paper.
 

•	 Preprinted paper with chemicals that may contaminate the printer. 

•	 Preprinted paper that can be affected by the temperature in the fusing unit. 

•	 Preprinted paper that requires a registration (the precise print location on the page) greater than ±0.09 inches, 
such as optical character recognition (OCR) forms.
 

In some cases, you can adjust registration with your software program to successfully print on these forms.
 

•	 Coated paper (erasable bond), synthetic paper, and thermal paper. 

•	 Rough-edged, rough or heavily textured surface paper, or curled paper. 

•	 Recycled paper containing more than 25 % post-consumer waste that does not meet DIN 19 309. 

•	 Multiple-part forms or documents. 

•	 Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper. 

Selecting Paper 
Proper paper selection helps prevent jams and ensures trouble-free printing. 

To help avoid jams or poor print quality: 

•	 Always use new, undamaged paper. 

•	 Before loading the paper, identify the recommended print side of the paper. This information is usually indicated 
on the paper package. 

•	 Do not use paper that you have cut or trimmed. 

•	 Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam. 

•	 Do not remove the tray while printing is in progress. 

•	 Ensure that the paper is properly loaded in the tray. 

•	 Flex the paper back and forth, and then fan them. Straighten the edges of the stack on a level surface. 
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Selecting Pre-Printed Media and Letterheads 
When selecting pre-printed and letterhead paper for the printer: 

•	 Use grain long paper for best results. 

•	 Use only forms and letterheads printed using an offset lithographic or engraved printing process. 

•	 Select paper that absorb ink, but does not bleed. 

•	 Avoid paper with rough or heavily textured surfaces. 

•	 Use paper printed with heat-resistant inks designed for use in xerographic copiers. The ink must withstand 

temperatures of 225 °C (437 °F) without melting or releasing hazardous emissions.
 

•	 Use inks that are not affected by the resin in the toner or the silicone in the fusing unit. Inks that are oxidation-set 
or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier. 

Selecting Pre-Punched Paper 
When selecting pre-punched paper for the printer: 

•	 Test paper from several manufacturers before ordering and using large quantities of pre-punched paper. 

•	 Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled 
paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam. 

•	 Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent 

cleaning and feed reliability may not be as good as standard paper.
 

•	 Weight guidelines for pre-punched paper are the same as non-punched paper. 

Envelopes 
Depending on the envelopes, it is possible to expect variable levels of wrinkling. It is recommended that you try a 
sample first before buying large quantities of any print media. See "Loading an Envelope in the MPF" for 
instructions on loading an envelope. 

When printing on envelopes: 

•	 Use only high-quality envelopes that are designed for use in laser printers. 

•	 Set the print media source to the MPF. Set the paper type to Envelope, and select the correct size of envelope from 
the printer driver. 

•	 Use envelopes made from 75 g/m2 (20 lb bond) paper. You can use up to 105 g/m2 (28 lb bond) weight for the 
envelope feeder as long as the cotton content is 25 % or less. Envelopes with 100 % cotton content must not exceed 
90 g/m2 (24 lb bond) weight. 

•	 Use only freshly unpackaged, undamaged envelopes. 

•	 Use envelopes that can withstand temperatures of 205 °C (401 °F) without sealing, excessive curling, wrinkling, or 
releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the 
envelope supplier. 
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•	 Adjust the guide to fit the width of the envelopes. 

•	 To load an envelope into the MPF, insert the envelope with the flaps closed or open and the short-edge of the 

envelope facing into the printer. The print side must be facing up.
 

•	 See "Loading an Envelope in the MPF" for instructions on loading an envelope. 

•	 Use one envelope size during a print job. 

•	 Ensure that the humidity is low because high humidity (more than 60 %) and the high printing temperatures may 
seal the envelopes. 

•	 For best performance, do not use envelopes that: 

–	 Have excessive curl or twist 

–	 Are stuck together or damaged in any way 

–	 Contain windows, holes, perforations, cutouts, or embossing 

–	 Use metal clasps, string ties, or metal folding bars 

–	 Have an interlocking design 

–	 Have postage stamps attached 

–	 Have any exposed adhesive when the flap is in the sealed or closed position 

–	 Have nicked edges or bent corners 

–	 Have rough, cockle, or laid finishes 

Labels 
Your printer can print on many labels designed only for use with laser printers. 

When selecting labels: 

•	 Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205 °C (401 
°F) and pressure of 25 pounds per square inch (psi). 

•	 Use labels that can be without sealing, excessive curling, wrinkling, or releasing hazardous emissions. 

•	 Do not use label sheets with a slick backing material. 

CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first. 

When printing on labels: 

•	 Use labels that can withstand temperatures of 205 °C (401 °F) without sealing, excessive curling, wrinkling, or
 
releasing hazardous emissions.
 

•	 Set the paper type to Label from the printer driver. 

•	 Load labels in the MPF. Tray1 and the optional 550-sheet feeder do not support labels. 

•	 Do not load labels together with paper in the MPF. 

•	 Do not print within 1 mm (0.04 inches) of the die-cut. 

•	 Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the
 
label.
 

•	 Do not print a label through the printer more than once. 

•	 Portrait orientation is preferred, especially when printing bar codes. 

•	 Do not use labels that have exposed adhesive. 

•	 Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. 
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•	 Do not use label sheets that have adhesive to the edge of the sheet. It is recommended that zone coating of the 

adhesive is done at least 1 mm (0.04 inches) away from edges. Adhesive material contaminates your printer and 

could void your warranty.
 

WARNING: Otherwise a jam occurs in the printer and contaminate your printer and your cartridges with adhesive. As a result, 
could void your printer and cartridge warranties. 

Storing Print Media 
For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print 
quality. 

•	 Store print media in an environment where the temperature is approximately 21 °C (70 °F) and the relative 

humidity is 40 %.
 

•	 Store cartons of print media on a pallet or shelf, rather than directly on the floor. 

•	 If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
that the edges do not buckle or curl. 

•	 Do not place anything on top of the print media packages. 

Identifying Print Media and Specifications 
The following tables show print media information. 

Supported Paper Sizes 

Paper size MPF Tray1 Optional 550-sheet Duplex unit 
feeder 

Side 1 Side 2 Side 1 Side 2 Side 1 Side 2 

A4 (210 x 297 mm) Y Y Y Y Y Y Y 

B5 (182 x 257 mm) Y Y Y Y Y Y Y 

A5 (148 x 210 mm) Y Y Y Y Y Y Y 

Letter (8.5 x 11 in) Y Y Y Y Y Y Y 

Folio (8.5 x 13 in) Y Y Y Y Y Y Y 

Legal (8.5 x 14 in) Y Y Y Y Y Y Y 

Executive (7.25 x 10.5 in) Y Y Y Y Y Y Y 

Envelope #10 (4.125 x 9.5 in) Y N N N N N N 

Monarch (3.875 x 7.5 in) Y N N N N N N 

DL (110 x 220mm) Y N N N N N N 

C5 (162 x 229mm) Y N N N N N N 

Custom*1, 2 Y Y Y Y Y Y Y 
*1 Custom: width: 76.2 mm (3.0 inches) to 215.9 mm (8.5 inches) for the MPF; 148 mm (5.83 inches) to 215.9 mm (8.5 inches) for tray1 and the 

optional 550-sheet feeder 
length: 127.0 mm (5.0 inches) to 355.6 mm (14.00 inches) for the MPF; 210 mm (8.27 inches) to 355.6 mm (14.00 inches) for tray1 
and the optional 550-sheet feeder 

*2 XPS driver does not support custom size paper. 
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Supported Paper Types 

Paper type MPF Tray1 Optional 550-sheet Duplex unit 
feeder 

Side 1 Side 2 Side 1 Side 2 Side 1 Side 2 Side 1 Side 2 

Plain Light Y Y Y Y Y Y Y N 

Normal Y Y Y Y Y Y Y N 

Thick Y Y Y Y Y Y Y N 

Covers Normal Y N Y N Y N Y N 

Thick Y N Y N Y N N N 

Coated Normal Y N Y N Y N Y N 

Thick Y N Y N Y N N N 

Label Normal Y N N N N N N N 

Light Y N N N N N N N 

Envelope Y N N N N N N N 

Recycled Y Y Y Y Y Y Y N 

Letterhead Y N Y N Y N Y N 

Preprinted Y N Y N Y N Y N 

Prepunched Y N Y N Y N Y N 

Color Y Y Y Y Y Y Y N 

NOTE: For Plain and Label paper, you can set the paper density by selecting the Paper Density (Light or Normal) under 
Maintenance from the operator panel, Tool Box, or Dell™ Printer Configuration Web Tool. Once you set the Paper Density 
settings, the printer uses the settings for Plain and Label paper. 

Paper Type Specifications 

Paper type Weight (g/m2) Remarks 

Plain 60–90 -

Plain Thick 80/90–105 -

Recycled 60–105 -

Labels - Inkjet printer paper cannot be used. 

Covers 106–163 -

Covers Thick 164–216 -

Envelope - -

Coated 106–163 Inkjet printer paper cannot be used. 

Coated Thick 164–216 Inkjet printer paper cannot be used. 

Letterhead 60–90 -

Preprinted 60–90 -

Prepunched 60–90 -

Color 60–90 -
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Loading Print Media 
Loading print media properly helps prevent jams and ensures trouble-free printing.
 

Before loading any print media, identify the recommended print side of the print media. This information is usually 

indicated on the print media package.
 

NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

Capacity 
Tray1 and the optional 550-sheet feeder (tray2) can hold: 

• 550 sheets of the standard paper. 

The multipurpose feeder (MPF) can hold: 

• 150 sheets of the standard paper. 

Print Media Dimensions 
The maximum dimensions of print media that tray1 and the optional 550-sheet feeder can handle are: 

• Width — 148 mm (5.83 inches) to 215.9 mm (8.5 inches) 

• Length — 210 mm (8.27 inches) to 355.6 mm (14.00 inches) 

The maximum dimensions of print media that the MPF can handle are: 

• Width — 76.2 mm (3.00 inches) to 215.9 mm (8.5 inches) 

• Length — 127 mm (5.00 inches) to 355.6 mm (14.00 inches) 

Loading Print Media in Tray1 and the Optional 550-Sheet Feeder 
This section describes how to load letterhead. For details about loading print media other than letterhead, see 
"Loading Paper." 

NOTE: To avoid paper jams, do not remove the tray while printing is in progress. 

NOTE: Use only laser print media. Do not use ink jet paper in the printer. 

Loading Letterhead (Pre-Printed and Pre-Punched Paper) 
The pre-printed paper such as letterhead and pre-punched paper must be inserted top edge first with the print side 
facing up for Dell C3760n Color Laser Printer. As for Dell C3760dn Color Laser Printer, the pre-printed paper such 
as letterhead and pre-punched paper must be inserted bottom edge first with the print side facing down as shown 
below. 

NOTE: For Dell C3760dn Color Laser Printer, set Letterhead 2 Sided or Letterhead Duplex Mode to Enable 
and Paper Type to Letterhead, Preprinted, or Prepunched from the operator panel or the printer driver even when 
you print on a single side of letterhead, pre-printed, or pre-punched paper. 

Loading Print Media 235 



 

	 

	 

LETTERHEAD 

LETTERHEAD 

LETTERHEAD 

Print media source Print side Page orientation 

Tray1 and optional 550-sheet Dell C3760n Color Laser Printer Letterhead enters the printer 
feeder Face up first 

Dell C3760dn Color Laser Printer	 Letterhead enters the printer 
lastFace down 

MPF Dell C3760n Color Laser Printer	 Letterhead enters the printer 
firstFace up 
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Print media source Print side  Page orientation 

Dell C3760dn Color Laser Printer Letterhead enters the printer 
last Face down 

LETTERHEAD 

Loading Print Media in the MPF 
1 Gently pull open the MPF cover. 

2 Extend the extension tray as necessary. 
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3 Slide the width guides to the edge of the tray. The width guides should be fully extended. 

4 Insert all media facing up and top edge first into the  MPF. 

 NOTE:  Do not force the print media into the MPF. 

5 Slide both width guides until they rest lightly against the edge of the print media stack. 

 NOTE:  Do not force the print media into the MPF .

6 On the operator panel, press the or button until the desired paper size is highlighted, and then press the 
(Set) button. 

7 Press the or button until the desired paper type is highlighted, and then press the (Set) button. 
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Loading an Envelope in the MPF 
Use the following guidelines when loading envelopes in the MPF: 

CAUTION: Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can 
cause damage to the printer. 

NOTE: If you do not load envelopes in the MPF right after they have been removed from the packaging, they may bulge. To avoid 
jams, press firmly across the whole envelopes to flatten them as shown below before loading the envelopes in the MPF. 

NOTE: The maximum height (quantity) of envelopes that can be loaded in the MPF is approximately 15 mm (0.59 inches) (15 
envelopes). 

Envelope #10, Monarch, or DL 
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the left 
when you face towards the printer. 
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C5 
Load the envelopes short edge feed with the flaps open or closed and the print side up.
 

Ensure that the flaps come at the bottom with the flaps open or at the top with the flaps closed when you face 

towards the printer.
 

Using the MPF 
•	 Load only one size and type of print media during a single print job. 

•	 To achieve the best possible print quality, use only high-quality print media that is designed for use in laser printer. 
For more guidelines on print media, see "Print Media Guidelines." 

•	 Do not add or remove print media when there is still print media in the MPF or when the printer is printing from 
the MPF. This may result in a paper jam. 

•	 Print media should be loaded with the recommended print side up and the top of the print media going into the 
MPF first. 

•	 Do not place objects on the MPF. Also, avoid pressing down or apply excessive force on it. 

•	 The icons on the MPF show how to load the MPF with paper, and how to turn an envelope for printing. 

Linking Trays 
The printer automatically links the trays when you load the same size and type of print media in them. The first tray 
will be utilized until the media runs out after which the next tray will be used. 

NOTE: The print media should be the same size and type in each tray. 

The MPF cannot be linked to any of the tray sources. 


After loading the selected trays with the same size and type of print media, select the Paper Type setting in the Tray 

Settings component for each source (tray). 


To disable tray linking change the paper type in one of the sources (trays) to a unique value.
 

NOTE: If different types of print media of the same size are loaded in each tray, the printer will automatically link them if the 
paper type is not specified in the printer driver properties/preferences. 
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Printing 
This chapter covers tips for printing, how to print certain information from your printer, and how to cancel a job. 

NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

Tips for Successful Printing 

Tips on Storing Print Media 
Store your print media properly. For more information, see "Storing Print Media." 

Avoiding Paper Jams 

CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first. 

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions 
on loading print media: 

•  "Loading Paper"  

• "Loading Print Media in the MPF" 

• "Avoiding Jams" 

If you encounter a paper jam, see "Clearing Jams." 

Sending a Job to Print 
To support all of the printer features, use the printer driver. When you choose Print from an application, a window 
representing the printer driver opens. Select the appropriate settings for the specific job that you are sending to 
print. Print settings selected from the driver override the default menu settings selected from the operator panel or 
Tool Box. 

You may need to click Preferences from the initial Print box to see all of the available system settings you can 
change. If you are not familiar with a feature in the printer driver window, open the online Help for more 
information. 

To print a job from a typical Microsoft® Windows® application: 

1 Open the file you want to print. 

2 From the File menu, select Print. 

3 Verify that the correct printer is selected in the dialog box. Modify the print settings as appropriate (such as the 
pages you want to print or the number of copies).
 

4 Click Preferences to adjust system settings that are not available from the first screen, and then click OK. 


5 Click OK or Print to send the job to the selected printer.
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Canceling a Print Job 
There are several methods for canceling a job. 

•	 Canceling a Job From the Operator Panel 

•	 Canceling a Job From a Computer Running Windows 

Canceling a Job From the Operator Panel 
To cancel a job after it has started printing: 

1 Press the (Cancel) button.
 

Printing is canceled only for the current job. All the following jobs will continue to print.
 

Canceling a Job From a Computer Running Windows 

Canceling a Job From the Taskbar 

When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar. 

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.
 

2 Select the job you want to cancel.
 

3 Press the <Delete> key.
 

Canceling a Job From the Desktop 

1	 Click Start→ Devices and Printers. 

For Windows XP: Click start→ Printers and Faxes. 

For Windows Vista®: Click Start→ Control Panel→ Hardware and Sound→ Printers. 

For Windows Server® 2008: Click Start→ Control Panel→ Printers. 

For Windows Server 2008 R2: Click Start→ Devices and Printers. 

For Windows 8: Under Desktop mode, right-click the bottom left corner of the screen, and then click Control 
Panel → Hardware and Sound → Devices and Printers. 

For Windows Server 2012: Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware → Devices and Printers. 

A list of available printers appears. 

2 Right-click the printer that you selected when you sent the job for print, and then select See what's printing. 

3 Select the printer driver. 

A list of print jobs appears in the printer window.
 

4 Select the job you want to cancel.
 

5 Press the <Delete> key.
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Duplex Printing 
Duplex printing (or two-sided printing) allows you to print on both sides of a sheet of paper. For sizes that are 
acceptable for duplex printing, see "Supported Paper Sizes." 

Duplex Printing With Duplex Unit (Dell C3760dn Color Laser Printer Only) 
1	 Click Start→ Devices and Printers. 

For Windows XP: Click start→ Printers and Faxes. 

For Windows Vista: Click Start→ Control Panel→ Hardware and Sound→ Printers. 

For Windows Server 2008: Click Start→ Control Panel→ Printers. 

For Windows Server 2008 R2: Click Start→ Devices and Printers. 

For Windows 8: Under Desktop mode, right-click the bottom left corner of the screen, and then click Control 
Panel → Hardware and Sound → Devices and Printers. 

For Windows Server 2012: Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware → Devices and Printers. 

2 Right-click the printer and select Printing Preferences. 

The General tab appears. 

3 From Paper Source, select the paper tray. 

For PCL driver: 

Select from Auto, Tray1, Tray2, or MPF. 

For PS driver: 

Select from Automatically Select, Tray1, Tray2, or MPF. 

4 From Duplex, select Flip on Short Edge or Flip on Long Edge. 

NOTE: For details on the Flip on Short Edge and Flip on Long Edge options, see "Flip on Short Edge" and "Flip on Long Edge." 

5 Click OK. 

Duplex Printing Without Duplex Unit (Dell C3760n Color Laser Printer Only) 
Manual duplex printing (or two-sided printing) allows you to manually print on both sides of the paper. For 
information on the paper sizes that support manual duplex printing, see "Supported Paper Sizes." 

NOTE: You can use the manual duplex feature using PCL 6 printer driver. 

NOTE: To use the manual duplex feature, select Paper Source other than Auto. 

1 Click Start→Devices and Printers. 

For Windows XP: Click start→ Printers and Faxes. 

For Windows Vista: Click Start→ Control Panel→ Hardware and Sound→ Printers. 

For Windows Server 2008: Click Start→ Control Panel→ Printers. 

For Windows Server 2008 R2: Click Start→ Devices and Printers. 

For Windows 8: Under Desktop mode, right-click the bottom left corner of the screen, and then click Control 
Panel → Hardware and Sound → Devices and Printers. 

For Windows Server 2012: Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware → Devices and Printers. 
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2	 Right-click the printer and select Printing Preferences. 

The General tab appears. 

3 From Paper Source, select Tray1, Tray2, or MPF. 

4 From Duplex, select Flip on Short Edge or Flip on Long Edge. 

NOTE: For details on the Flip on Short Edge and Flip on Long Edge options, see "Flip on Short Edge" and "Flip on Long Edge." 

5 Click OK. 

When you click the Print button on your printer driver,  a window that shows the instructions for manual duplex 
printing appears and the even-numbered pages of your document are printed from the printer. If your document 
consists of six pages, its even-numbered pages are printed in the order of page 6, 4, and then 2. After the 
even-numbered pages are printed, a message Insert Output to Tray 1 (Tray 2 or MPF) (071-920, 
072-920, or 075-920) appears on the operator panel. 

6	 Remove the stack of output from the output tray. Load the stack back into the tray without turning it over (with 
the blank side face up). 

A message Press  to Continue Printing (071-921, 072-921, or 075-921) appears on the 
operator panel. Press the (Set) button.
 

The odd-numbered pages are printed in the order of page 1, 3, and then 5.
 

NOTE: You cannot duplex print mix-sized documents. 

Using Booklet Print (Dell C3760n and Dell C3760dn Models) 
To use the booklet print feature, select the Enable check box of the Booklet Printing in the Layout tab. 

NOTE: When the XPS or PS driver is used, booklet print is not available.
 

NOTE: When using the Booklet Print feature on the Dell C3760n Color Laser Printer, Auto in Paper Source is not available.
 

NOTE: You must select Flip on Long Edge in the Duplex when using the Booklet Print feature.
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Flip on Long Edge	 Assumes binding along the long edge of the page (left edge for portrait orientation and top edge 
for landscape orientation). The following illustration shows long-edge binding for portrait and 
landscape pages: 

Portrait	 Landscape 

Flip on Short Edge 	 Assumes binding along the short edge of the page (top edge for portrait orientation and left 
edge for landscape orientation). The following illustration shows short-edge binding for portrait 
and landscape pages: 

Portrait	 Landscape 

Using the Stored Print Feature 
When you send a job to the printer, you can specify in the printer driver to store the job in the memory or hard disk. 
When you are ready to print the job, go to the printer and use the operator panel to identify which job in the 
memory or hard disk you want to print. 

NOTE: The data in the memory is cleared when the printer is turned off. The data on the optional hard disk is not cleared even 
when the printer is turned off. 

NOTE: Stored Print feature is available when: 

•	 The optional 512MB memory module is installed. 

•	 The RAM disk is enabled in the printer menu. 

•	 RAM Disk is set to Available in the printer driver.
 

OR
 

•	 The optional hard disk is installed. 

Printing 247 



 

 

  

  
   

  

 
 

• Hard Disk is set to Available in the printer driver. 

Overview 
The stored printing feature includes the following job types. 

Secure Print 

You can temporarily store print jobs secured with a password in the memory or hard disk. Users with the password 
can print them from the operator panel. This feature can be used to print confidential documents. A stored print job 
will be deleted after you print it or at a designated time. 


 

 
 

Enter the password from Print data.
 
the operator panel.
 Send confidential data.
 

Confidential 

Data is deleted at a 
designated time. 

Private Mail Box Print 

You can store print jobs secured with a password in the memory or hard disk. Users with the password can print them 
at a more convenient time from the operator panel. This feature can be used to print confidential documents. The 
stored jobs remain in the memory or hard disk until you delete them from the operator panel. 

Enter the password from Print data. 
the operator panel. Send data. 

Public Mail Box Print 

You can store print jobs without a password in the memory or hard disk. Any user can print them at a more 
convenient time from the operator panel. The stored jobs remain in the memory or hard disk until you delete them 
from the operator panel. 

Print data. 

Send data. 
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Proof Print 

The collated print job is stored in the memory or hard disk, but a single copy is printed automatically so you can 
check the print result. If you do not have problems with the print result, you can choose to print more copies. This 
prevents large number of misprinted copies from being printed at one time. 

One set is 
printed. Print the rest of sets 

Send data. 

from the operator panel. 
Check if the print result 
is OK. 

The difference between each of the job types are listed below. If you want to set the password for confidentiality, 
store the jobs in the Secure Print or Private Mail Box Print. 

Job types Password Differences 

Secure Print Y • The stored jobs will be deleted at a designated time. 

• You cannot specify the quantity of copies from the operator panel. The 
quantity of copies depends on the number you specified on the printer 
driver. 

Private Mail Box Print Y • The stored jobs remain until you delete them from the operator panel. 

Public Mail Box Print N • You can specify the quantity of copies from the operator panel. 

Proof Print N • The print job is set to collate. 

• A single copy is printed automatically. 

• The stored jobs remain until you delete them from the operator panel. 

• You can specify the quantity of copies from the operator panel. 

NOTE: If a print job is too large for the memory available, the printer may display an error message. 

Procedures for Printing Stored Print 

NOTE: The stored print feature is available when using the PCL or PS driver. 

When you select a job type in the printer driver, the job will be stored in the memory or hard disk until you request 
to print it from the operator panel. The following are procedures for storing and printing jobs. 

Storing Print Jobs 

To use the stored print feature, you need to select a job type other than Normal Print in the General tab of the 
printer driver. The job will be stored in the memory or hard disk until you request to print it from the operator panel. 

NOTE: Secure Print and Private Mail Box Print require specifying a password for confidentiality. 

NOTE: If a document name is not assigned to your print job in the printer driver, the job's name will be identified using the 
printer's time and date of submission to distinguish it from other jobs you have stored under your name. 

Printing the Stored Jobs 

1 Press the (Menu) button. 

2 Press the button until Print Menu is highlighted, and then press the (Set) button. 

3 Press the  button until the desired job type is highlighted, and then press the (Set) button. 
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4 Press the  button until the desired user ID is highlighted, and then press the (Set) button. 

NOTE: Secure Print and Private Mail Box Print require specifying a password for confidentiality. If you select Public 
Mail Box Print or Proof Print, proceed to step 6. 

5 Enter the password using the number pad, and then press the (Set) button.
 

For details about specifying the password, see "Specifying your password on the operator panel (Secure 

Print/Private Mail Box Print)."
 

6 Press the 
  button until the desired document is highlighted, and then press the (Set) button.
 

7 Press the 
  button until the desired print menu is highlighted, and then press the (Set) button. 

NOTE: If you want to keep the data in the memory or hard disk for the time being, select Print. For Secure Print, only 
Print and Delete is available. 

8 Press the  button until the desired quantity menu is highlighted, and then press the (Set) button. 

NOTE: If you select Input Number of Copies, enter the number using the number pad, and then press the 
(Set) button. 

The stored document will be printed. 

Specifying your password on the operator panel (Secure Print/Private Mail Box Print) 

When you select Secure Print or Private Mail Box from Print Menu, a screen to enter the password 
appears after selecting your user ID. 

Use the number pad to enter the numeric password you specified in the printer driver. The password you entered will 
appear as asterisks (*******) to ensure confidentiality. 

If you enter an invalid password, the message Wrong Password Re-enter appears. Wait 3 seconds, or press the 
(Set) button or (Cancel) button to return to the screen for entering the password. 

When you enter a valid password, you have access to all print jobs matching the user ID and password you entered. 
The print jobs matching the password you entered appear on the screen. You can then choose to print or delete jobs 
matching the password you entered. (See "Printing the Stored Jobs" for more information.) 

Deleting Stored Jobs 

With Secure Print, a job that has been stored will be deleted after printing or deleted at a designated time entered on 

the operator panel.
 

For other jobs, these jobs remain stored until you delete them from the operator panel.
 

Printing from USB Memory 
The USB Direct Print feature allows you to print files stored in a USB memory by operating from the operator panel. 

CAUTION: To prevent damage to your printer, do not connect any device other than USB memory to the front USB port of the 
printer. 

CAUTION: Do not remove the USB memory from the front USB port until the printer has finished printing. 

NOTE: If the Function Enabled setting for USB Direct Print is set to On (Password), you need to enter the four 
digit password to use the print function. If the Function Enabled setting for USB Direct Print is set to Off, the print 
function is disabled. For details, see "Function Enabled." 

The front USB port of the printer is designed for USB 2.0 devices. You must use only an authorized USB memory 
with an A plug type connector. Use only a metal shielded USB memory. 
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A plug type 

Supported File Formats 
Files in the following file formats can be printed directly from a USB memory. 

• 	  PDF  

• 	  TIFF  

• 	  JPEG  

Inserting and Removing a USB Memory 
You can insert the USB memory before printing.
 

Before removing the USB memory, ensure that the printer is not accessing the USB memory.
 

CAUTION: If you remove the USB memory while the printer is accessing, the data in the USB memory or the USB memory 

NOTE: Color printing is secured with a password if the Function Enabled setting for USB Direct Print is set to 
On (Color Password). If you set Output Color to Full Color and the Function Enabled setting for USB 
Direct Print to On (Color Password), you will need to enter the four digit password after selecting Print 

NOTE: Depending on how the PDF, TIFF, or JPEG file is created, the file may not be printed directly from a USB memory. In this 

device itself may be destroyed. 

Printing a File in a USB Memory 

Start. 

case, open the file on a computer, and print using the printer driver. 

1	 Insert a USB memory to the front USB port of the printer. 

For details about inserting a USB memory, see "Inserting and Removing a USB Memory." 

If a USB memory is already inserted into the front USB port of the printer: 

a Press the (Menu) button.
 

b Press the 
 button until Print Menu is highlighted, and then press the  (Set) button. 

c Press the button until USB Direct Print is highlighted. 

2 Ensure that USB Direct Print is highlighted, and then press the  (Set) button. 
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3 Press the  button until the desired file is highlighted, and then press the (Set) button. 

NOTE: Only the following characters are displayed on the LCD panel:
 
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 0 1 2 3 4 5 6 7 8 9 $ % ’ ‘ - @ {} ~ ! # ( ) & _ ^
 

4 Specify print options such as Output Color, Select Tray, 2 Sided Printing, Multiple-Up, 
Collation, and PDF Password. For details, see "USB Direct Print." 

5 Press the or button until Print Start is highlighted, and then press the (Set) button. 

6 Ensure that Yes is highlighted, and then press the (Set) button. 

Printing With Web Services on Devices (WSD) 
This section provides information for network printing with WSD, the protocol of Microsoft for Windows Vista, 
Windows 7, Windows 8, Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012. 

Adding Roles of Printer Services 
When you use Windows Server 2008, Windows Server 2008 R2 or Windows Server 2012, you need to add the roles 
of print services to the Windows Server 2008, Windows Server 2008 R2 or Windows Server 2012 client. 

For Windows Server 2008: 

1 Click Start→ Administrative Tools→ Server Manager. 

2 Select Add Roles from the Action menu. 

3 Check the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click Next. 

4 Check the Print Server check box, and then click Next. 

5 Click Install. 

For Windows Server 2008 R2: 

1 Click Start→ Administrative Tools→ Server Manager. 

2 Select Add Roles from the Action menu. 

3 Check the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next. 

4 Click Next. 

5 Check the Print Server check box, and then click Next. 

6 Click Install. 

For Windows Server 2012: 

1 Click Server Manager of the Start screen. 

2 Select Add Roles and Features from the Manage menu. 

3 Click Next on the Before You Begin window → Select installation type on the Installation Type window → Select 
destination server on the Server Selection window in the Add Roles and Features Wizard. 

4 Check the Print and Document Services check box on the Server Roles window, and then click Next. 

5 Select features on the Features window → Confirm installation selections on the Confirmation window. 

6 Click Install. 
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Printer Setup 
You can install your new printer on the network using the Software and Documentation disc that shipped with your 
printer, or using Microsoft Windows’ Add Printer wizard. 

Installing a Printer Driver Using the Add Printer Wizard 
1	 Click Start→ Devices and Printers (Start→ Control Panel→ Hardware and Sound→ Printers for Windows Vista 

and Windows Server 2008). 

For Windows 8 and Windows Server 2012: 

Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → Hardware 
and Sound (Hardware for Windows Server 2012)→ Devices and Printers. 

2 Click Add a printer to launch the Add Printer wizard. 

3 Select Add a network, wireless or Bluetooth printer. 

4 In the list of available printers, select the one you want to use, and then click Next. 

NOTE: In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/. 

NOTE: If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter 

the printer's IP address manually, follow the instructions below.
 
For Windows Server 2008 R2, to create a WSD printer, you must be a member of Administrators group. 

1. Click The printer that I want isn't listed. 
2. Select Add a printer using a TCP/IP address or hostname and click Next. 
3. Select Web Services Device from Device type. 
4. Enter the printer's IP address in the Hostname or IP address text box and click Next. 

NOTE: Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of 
the following: 

•	 Establish the Internet connection so that Windows Update can scan your computer. 

• Add the printer driver to your computer.
 

5 If prompted, install the printer driver on your computer. If you are prompted for an administrator password or 

confirmation, type the password or provide confirmation.
 

6 Complete the additional steps in the wizard, and then click Finish.
 

7 Print a test page to verify print installation.
 

a	 Click Start→ Devices and Printers (Start→ Control Panel→ Hardware and Sound→ Printers for Windows 
Vista and Windows Server 2008). 

For Windows 8 and Windows Server 2012: 

Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012)→ Devices and Printers. 

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista and 
Windows Server 2008). 

c On the General tab, click Print Test Page. When a test page prints successfully, installation is complete. 
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Printing With AirPrint 
This section provides information for printing with AirPrint. AirPrint allows you to print through a 
network with iPad (all models), iPhone (3GS or  later), and iPod touch (3rd generation or later) running 
the latest version of iOS. AirPrint also allows you to accomplish basic network printing with Macintosh 
(Mac OS X 10.7 or later) without installing additional drivers. 

Setting Up AirPrint on Your Printer 
To use AirPrint, Bonjour (mDNS) and IPP protocols are required on your printer. Make sure that Bonjour(mDNS) 
and IPP are set to Enable on the operator panel menu. See "Protocols" for details. Bonjour(mDNS) and IPP can 
also be enabled by clicking Turn on AirPrint from the Dell™ Printer Configuration Web Tool. Follow the procedure 
below to configure the environment settings for AirPrint from the Dell Printer Configuration Web Tool. 

1 Ensure that the printer is connected to the network. 

2	 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser. 
For more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer 
Configuration Web Tool." 

3	 When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click 
Turn on AirPrint in Enable AirPrint. The printer is ready for AirPrint. 

NOTE: If the Turn on AirPrint button is not active, it means that both Bonjour (mDNS) and IPP are already set to 
Enable on the operator panel menu and the printer is ready for AirPrint. 

Printing via AirPrint 
The following procedure uses the iPhone running iOS5 as an example. 

1 Open your email, photo, web page, or document you want to print. 

2 Tap the action icon .
 

3 Tap Print.
 

4 Select your printer and set printer options.
 

5 Tap Print.
 

NOTE: To cancel the printing job, double click the Home button, tap the Print Center icon  . If there are more than one 
job in the queue, select the job you want to cancel, then tap Cancel Printing. 

Printing With Google Cloud Print™ 
This section provides information for Google Cloud Print service with your smart phone, tablet, or any other device. 
By registering the printer to your GoogleTM account, you can use the Google Cloud Print service to print from 
various devices connected to the Internet. You can print documents, photos or e-mails using the Google ChromeTM 

browser or applications such as Google DriveTM on your mobile device. For more information about Google Cloud 
Print, visit the Google web site. 

Preparing to Use the Printer with Google Cloud Print 
To use Google Cloud Print, you need to prepare the following in advance: 

•	 Connect the printer to a network that has access to the Internet. 

NOTE: Google Cloud Print supports only IPv4 connection. 

NOTE: If the printer is connected to a network that uses a proxy server, you need to specify the settings in Proxy Server 
from the Dell Printer Configuration Web Tool. For more information, see "Proxy Server." 

•	 Acquire a Google account and a GmailTM address. 
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• 	  Set  Google Cloud Print to Enable from the operator panel menu, or set Google Cloud Print to On from 
the Dell Printer Configuration Web Tool. 

When using the operator panel 

1 Press the (Menu) button. 

2 Press the button until Admin Settings is highlighted, and then press the (Set) button. 

3 Press the button until Network is highlighted, and then press the (Set) button. 

4 Press the button until Protocols is highlighted, and then press the (Set) button. 

5 Press the button until Google Cloud Print is highlighted, and then press the (Set) button. 

6 Press the button until Enable is highlighted, and then press the (Set) button. 

7 Turn off the printer, and turn it on again to apply the settings. 

When using the Dell Printer Configuration Web Tool 

1 Launch the Dell Printer Configuration Web Tool by entering IP address of the printer in your web browser. For 
more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer 
Configuration Web Tool." 

2 When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click Port 
Settings. In Port Status, select the On check box for Google Cloud Print. 

Registering the Printer to Your Google Account 
To register the printer to your Google account, follow the procedure below. 

1 Launch the Dell Printer Configuration Web Tool by entering IP address of the printer in your web browser. For 
more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer 
Configuration Web Tool." 

2 When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click 
Register This Device to Google Cloud Print in Google Cloud Print. A sheet with a URL for the Google Cloud 
Print printer registration web site is printed. 

3 From the web browser of your computer, visit the Google web site and sign in with your Google account. Visit the 
Google Cloud Print registration web site by entering the URL on the printout into your web browser. You can also 
visit the site by scanning the QR code with your mobile device. 

4 On the Google Cloud Print registration web site, click Finish printer registration. 

5 Click Manage your printers. Your printer will be listed in the Printers list and will be ready for use with the Google 
Cloud Print service. 

Printing via Google Cloud Print 
The printing procedure varies depending on the application or the device you are using. You can see the application 
list that supports Google Cloud Print service on the Google web site. 

Printing From an Application on a Mobile Device 

The following procedure uses the Google Drive application on an Android mobile device as an example. 

1 Install the Google Drive application on your mobile device. 

NOTE: You can download the application from Google Play. 

2 Access the Google Drive application from your mobile device and tap to select the document. 

3 Tap and then tap Print. 

4 Select your printer from the list. 
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5 Select printer options and then tap Print. 

Printing From Google Chrome 

The following procedure uses the Google Chrome browser on a Windows PC as an example. 

1 Open the Google Chrome browser. 

2 Open the web page or e-mail that you want to print. 

3 Click or (varies depending on the version of the Google Chrome browser) in the top right corner and then 
click Print. 

4 Click Change in the Destination area. 

5 Choose your printer from the Google Cloud Print area.
 

6 Click Print.
 

Printing a Report Page 
You can print a variety of settings for your printer including printer settings, panel setting, and font list. For details about 
how to print reports or lists, see "Report / List." 

Printer Settings 
You can change most of the print settings from the application you are printing from. If your printer is attached to 

the network, you can also change settings from the Dell Printer Configuration Web Tool. To launch the Dell 

Printer Configuration Web Tool, type the printer's IP address in your web browser. To find your printer's IP address, 

see "Verifying the IP Settings."
 

Settings from the application update the default system settings for the printer. Settings from the printer driver only 

apply to the job that you are currently sending to the printer.
 

If you cannot change a setting from the application, use the operator panel, Tool Box or the Dell Printer
 
Configuration Web Tool. Changing a system setting from the operator panel, Tool Box or from the Dell Printer 

Configuration Web Tool makes that setting the user default. 


You can verify the detailed system settings by printing a printer settings report. For details about how to print a 

printer settings report, see "Report / List."
 

You can reset settings to their default values from the Tool Box or the operator panel. For details, see "When Using 

the Tool Box" or "When Using the Operator Panel."
 

Using the Operator Panel to Change the Printer Settings 
You can select menu items and corresponding values from the operator panel.
 

When you first browse through the menus from the operator panel, you see some menu items are highlighted.
 

These highlighted items are the factory default and original system settings.
 

NOTE: Factory defaults may vary for different countries. 

When you select a new setting from the operator panel, the item selected is highlighted to identify it as the current 

user default menu setting.
 

These settings are active until new ones are selected or the factory defaults are restored.
 

Driver settings may override changes previously made and may require you to change the operator panel defaults.
 

Using the Dell Printer Configuration Web Tool to Change the Printer Settings 
If your printer is connected to the network, you can change the printer settings from your web browser. If you are a 
network administrator, you can clone the system settings of one printer to one or all the printers on the network. 
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Type the IP address of your printer in your web browser. Choose Printer Settings from the topics list. From the 

Printer Settings tab, select the System Settings to change the printer settings.
 

To change the paper type and size, choose Tray Settings from the topics list. To change the ColorTrack settings,
 
choose Print Volume from the topics list, and then select the Dell ColorTrack tab.
 

To copy your system settings to another printer on the network, choose Copy Printer Settings from the topics list, 

and then type the other printer's IP address.
 

If you do not know your printer's IP address, see the printer settings report or display the TCP/IP settings. For details 

about how to find your printer's IP address, see "Verifying the IP Settings."
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Understanding Your Printer Software
 
Use the Software and Documentation disc that shipped with your printer to install a combination of software 
programs, depending on your operating system. 

NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

Printer Status Window 

The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper 

jam occurs or toner is running low.
 

By default, the Printer Status window launches only when an error occurs. When an error occurs, the error message 

appears on the Printer Status window. You can set the Printer Status window to always launch when printing in 

Printing Status Window Properties.
 

You can also check toner level, quantity of paper remaining or the configuration of options for the printer.
 

Status Monitor Console 

Use the Status Monitor Console to manage multiple instances of the Status Window for a particular printer. 

Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window for a 
particular printer. 

Dell Supplies Management System 

You can launch the Dell Supplies Management System dialog box from the All Programs menu or the desktop icon. 

You can order consumables by phone or from the web. 

1	 Click Start→ All Programs→ Dell Printers→ Additional Color Laser Software→ Dell Supplies Management 
System. 

The Dell Supplies Management System window appears. 

2 Select your printer from the Select Printer Model list. 

3 If you are ordering from the web: 

a	 Select a URL from the Select Reorder URL list. 

b	 Click Visit Dell printer supplies ordering web site. 

NOTE: When you cannot get information from the printer automatically by two-way communication, a window prompting 

you to type the Service Tag appears. Type the Service Tag of your Dell printer in the field provided. 

Your Service Tag is located inside the front cover of your printer.
 

4 If you order by phone, call the number that appears in the Order by Phone section. 

User Setup Disk Creating Tool 

The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on the Software 
and Documentation disc and the printer drivers located on the Software and Documentation disc are used to create 
driver installation packages that contain custom driver settings. A driver installation package can contain a group of 
saved printer driver settings and other data for things such as: 

•	 Print orientation and Multiple Up (document settings) 

• 	  Watermarks  

• 	  Font references  
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If you want to install the printer driver with the same settings on multiple computers running the same operating 
system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created 
will reduce the amount of work required when installing the printer driver. 

•	 Install the printer driver in the computer on which the setup disk is to be created. 

•	 The setup disk can only be used on the operating system on which the disk was created or computers running the 
same operating system. Create a separate setup disk for each of the operating systems. 

Software Update 

The firmware and/or driver updates can be downloaded from the Dell Support web site located at support.dell.com. 

Printer Utility Software 
You can open the Status Window, Tool Box, Updater, and Troubleshooting using the Quick Launch Utility window. 

NOTE: Quick Launch Utility is only supported on Microsoft® Windows®. 

To use the Quick Launch Utility, select to install the Quick Launch Utility when you install the Dell software. 

To install the Dell software, follow the instructions below. 

1 Insert the Software and Documentation disc into your computer and click setup_assist.exe to start Easy Setup 
Navigator.
 

2 Click Installing Driver and Software.
 

3 Follow the on-screen instructions.
 

To open the Quick Launch Utility window: 

1 Click Start→ All Programs→ Dell Printers→ Additional Color Laser Software→ Quick Launch Utility. 

The Quick Launch Utility window provides four buttons: Status Window, Tool Box, Updater, and Troubleshooting. 

To exit the Quick Launch Utility window: 

1 Click the Close (x) button at the top-right of the window. 

For details, click Help of each application. 

Status Window 
The Status Window button opens the Printer Status window. For more information about using Status Window, 
refer to "Printer Status Window." 

Tool Box 
The Tool Box button opens the Tool Box. For more information about using Tool Box, refer to "Understanding the 
Tool Box Menus." 
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Updater 
The Updater button updates the Dell software and printer firmware. 

Troubleshooting 
The Troubleshooting button opens the Troubleshooting Guide, which allows you to solve problems by yourself. 

Status Monitor Widget for Macintosh 
Status Monitor Widget is a printer utility that promotes efficient use of the printer through the exchange of 
information between the Macintosh and the printer. 

Status Monitor Widget Feature 
•	 Monitoring Dell Printers
 

Allows you to check the status of Dell printers currently connected to your Macintosh
 

•	 Receiving Alerts
 

Alerts you to problems, such as paper jams or low toner
 

•	 Ordering Supplies
 

Allows you to access the web site to order supplies
 

Before Installing the Status Monitor Widget 

Operating systems 

•	 Mac OS X 10.4.11 

• 	  Mac OS X  10.5  

• 	  Mac OS X  10.6  

• 	  Mac OS X  10.7  

• 	  Mac OS X  10.8  

Network protocols and interfaces 

• 	  LPR  

•	 Socket 9100 

• 	  Bonjour  

•	 USB 2.0 and 1.1 (When connecting with multiple printers of the same model via USB cables, only the printer 
recognized first can be monitored in the Status Monitor Widget.) 

Installing the Status Monitor Widget 
1 Double-click the Status Monitor Installer icon in the Finder window. 

2 Follow the on-screen instructions. 

When the Install Succeeded screen appears, the installation is complete. 

NOTE: Entering the administrative login name and password are required during the installation process. 
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Opening and Closing the Status Monitor Widget 

Opening the Status Monitor Widget 

Click the Dashboard icon in the Dock to launch Dashboard. 

Click the Plus (+) sign to display the Widget Bar. 

Click the icon of Status Monitor in the Widget Bar. The Printer Status window appears. 

NOTE: If the message Select a printer is displayed, select your printer in Preferences. (For more information on 
Preferences, see "Preferences.") 

Closing the Status Monitor Widget 

1 Click the Close (x) button in the upper-left corner of the Printer Status window. 

Printer Status Window 
When the Status Monitor Widget is activated, the Printer Status window appears on Dashboard. 

Printer Status Message Area 

Displays a message of the current printer status. 

NOTE: The Status Monitor Widget automatically obtains the printer information at the updated interval that can be specified in 
Preferences. Also, the printer status is refreshed when Dashboard is launched or Preferences is closed. 

NOTE: If the Status Monitor Widget receives no response from the printer, the message Cannot get printer information is 
displayed. 

NOTE: When the printer is connected via USB cable, you cannot check the status of the printer during a print job. 
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Printer Status Image Area 

Displays the image of printer condition. 

•	 Estimated Toner Level image 

Displays the estimated toner level of each color if the printer is functioning properly. 

NOTE: If the utility does not receive a response from the printer, the Unknown toner image is displayed. 

•	 Printer error image 

Displays an indication image when an error occurs. 

An error has occurred and the printer cannot be used. 

Order Supplies button 

Click this button to display the Order window. 

To hide the Order window, click Order Supplies again.
 

Info (i) button 

Click this button to open Preferences. 

NOTE: The info (i) button appears on the lower-right corner of the window when the cursor is over the Printer Status window. 
The info (i) button is a standard used across all widgets. 

Order Window 
This window provides you with the information for ordering printer supplies by telephone or from the web site. 

To open the Order window: 

1 Click Order Supplies in the Printer Status window. 

The Order window appears. 

NOTE: The Order window appears when low toner is detected. 
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Order Online 

•	 Visit Dell printer supplies ordering web site hyperlink 

Click the Visit Dell printer supplies ordering web site hyperlink to access the web site for ordering Dell printer 
supplies. 

•	 URL list 

Displays a list of available URLs where you can order Dell printer supplies. 


Select a URL address to use when the Visit Dell printer supplies ordering web site hyperlink is clicked.
 

Order By Phone 

•	 Phone number list
 

Displays a list of available phone numbers that you can call to order Dell printer supplies.
 

•	 Update phone contacts when rebooting check box
 

Select this check box to regularly update the phone number list. 


Dell and the Environment 

Click the hyperlink to access the web site about recycling. 

Preferences 
To open Preferences: 

1 Click the info (i) button in the Printer Status window. 

Preferences appears. 

NOTE: The info (i) button appears on the lower-right corner of the window when the cursor is over the Printer Status 
window. The info (i) button is a standard used across all widgets. 

Printer 

Displays a list of available printer names in the pull down menu. The first printer displayed in this list is set as 
default. 

Status Update Interval 

You can specify the update interval of the printer status. By default, it is set to obtain the printer information every 
10 seconds. It can be set from 0 second to 600 seconds. 

SNMP Community Name 

You can change the SNMP (Simple Network Management Protocol) community name if using default community 
name (public). Up to 31 characters can be entered. 
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Service Tag button 

Click this button to obtain the service tag. 

NOTE: You cannot retrieve the service tag when the printer is connected via USB cable. 

done button 

Click this button to return to the Printer Status window. 

Status Monitor Console for Linux 
Status Monitor Console is a printer utility that promotes efficient use of the printer through the exchange of 
information between the Linux and the printer. 

Status Monitor Console Feature 
•	 Monitoring Dell Printers
 

Allows you to check the status of Dell printers currently connected to your Linux.
 

•	 Receiving Alerts
 

Alerts you to problems, such as paper jams or low toner.
 

•	 Ordering Supplies
 

Allows you to access the web site to order supplies.
 

Before Installing the Status Monitor Console 

NOTE: The Status Monitor Console requires the following modules installed. 

- Python, PyGTK, Net-SNMP, cups-libs, and xdg-open
 

Please confirm that these modules are installed before you install the Status Monitor Console.
 

NOTE: The Status Monitor Console is available when the printer is connected to a network (LPR or Socket 9100). USB 
connection is not supported. 

Distributions 

•  Red Hat® Enterprise Linux® 5 Desktop 

•	 Red Hat Enterprise Linux 6 Desktop 

•  SUSE® Linux Enterprise Desktop 10 

•	 SUSE Linux Enterprise Desktop 11 

Printing system 

•	 CUPS (Common Unix Printing System) 

Installing the Status Monitor Console 
1 Activate the terminal, and log in as a super user. 

2 Type the following rpm command in the terminal window. 

# rpm -ivh (Type the package file name) 
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Starting the Status Monitor Console 
1 Click Dell Printers→ Status Monitor Console 

The Printer Selection window appears. 

For more information on Printer Selection window, see "Printer Selection Window." 

2 Select your printer. 

The Printer Status window appears. 

For more information on Printer Status window, see "Printer Status Window." 

•	 You can order supplies from the Dell Supplies Management System window. See "Dell Supplies Management 
System Window." 

Printer Selection Window 

Printers list 

All the printers registered in the CUPS (Common UNIX Printing System) are displayed in a list. 

•	 Status icons:


 Ready


 Unknown/Offline/Toner Low/Paper Low


 Door Open/Paper Jam/No Toner/Out Of Paper
 

Settings button 

Click this button to open the Settings window. 

Details button 

Click this button to open the Printer Status window. If a non-supported printer is selected, it opens the Dell Printer 
Configuration Web Tool. For details on the Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration 
Web Tool." 

Refresh button 

Click this button to update the information of printers. 

Close button 

Click this button to close the Printer Selection window. 
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Printer Status Window 
When the printer is specified in the Printer Selection window, the Printer Status window appears. 

Printer Status Message Area 

Displays a message of the current printer status. 

NOTE: The Status Monitor Console automatically obtains the printer information at the updated interval that can be specified in 
the Settings window. Also, the printer status is refreshed when the Refresh is clicked. 

NOTE: If the Status Monitor Console receives no response from the printer, the message Cannot get printer information is 
displayed. 

Printer Status Image Area 

•	 Current Toner Status icons
 

Displays icons of the current status of each toner.
 

The toner level is more than 30%.
 

The toner level is less than 29%.
 

The toner level is less than 9%.
 

The toner level is unknown.
 

•	 Estimated Toner Level images
 

Keeps you informed about the amount of toner that remains for each color.
 

Toner Alert 

Displays an alert message when any remaining toner is low, empty, or unknown. 

Order Online 

•	 Order Supplies Online button 

Click this button to access the web site for ordering Dell printer supplies. This button appears when the amount 
of toners becomes less than 30%. 

Refresh button 

Click this button to update the status of the printer. 

Close button 

Click this button to close the Printer Status window. 
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Dell Supplies Management System Window 
This window provides you with the information for ordering printer supplies by telephone or from the web site. 

To open the Dell Supplies Management System window: 

Click Order Supplies Online button in the Printer Status window. 

OR 

Click Dell Printers→ Dell Supplies Management System. 

Select Printer Model 

Select your printer model name. 

Order Online 

•	 Order Supplies Online button 

•	 When the Regular URL is selected in the Select Reorder URL:
 

Click this button to open the Service Tag window.
 

•	 When the Premier URL is selected in the Select Reorder URL:
 

Click this button to open the procurement and support web site.
 

•	 Select Reorder URL 

Displays a list of available URLs where you can order Dell printer supplies. Select a URL address to use when the 
Order Supplies Online button is clicked. 

•	 Regular URL: http://accessories.us.dell.com/sna/printerseg.aspx 

•	 Premier URL: http://premier.dell.com 

Order by Phone 

•	 To order Dell printer supplies by phone, call the following 

Select your country with phone number from the list, and call the displayed telephone number to order supplies. 

•	 Update phone contacts when rebooting check box
 

Select this check box to regularly update the phone number list. 
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Dell and the Environment 

Click the hyperlink to access the web site about recycling. 

Close button 

Click this button to close the Dell Supplies Management System window. 

Service Tag Window 

1 Enter the Dell printer service tag. 

NOTE: For information on the service tag, see "Express Service Code and Service Tag." 

Settings Window 
To open the Settings window: 

1 Click Settings in the Printer Selection window. 

The Settings window appears. 

Update of status 

•	 Printer Status is regularly updated check box
 

Select the check box to enable/disable the printer status to be updated by the specified interval.
 

•	 Update interval text box
 

Specify the update interval of the printer status.
 

Port Number Settings 

•	 Port Number 

Specify the port number in the Port Number text box to open the setting page of your printer in a web browser. 
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Protocol Settings - SNMP 

•	 Community Name
 

Enter the Community name of SNMP in the Community Name text box.
 

Order URL 

•	 Select Reorder URL 

The selected URL address is set as default web site for the Select Reorder URL in the Dell Supplies Management 
System window. 
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Printing Using ColorTrack (External Authentication) 
With ColorTrack, you can restrict the number of pages that can be printed per user, specify the users who can print 
in color, and restrict the users who can access the printer, based on the user information registered on the external 
authentication server or the printer. 

To print using ColorTrack, you must set ColorTrack Settings and the printer driver. Also, you must set the external 
server with ColorTrack for using an external authentication server. To set the external server, consult your system 
administrator. 

NOTE: To restrict color printing when ColorTrack is disabled, set Auto Color To Mono Print to On.  All print jobs 
are printed in black and white even when color is specified. For details, see "Auto Color To Mono Print." 

ColorTrack Settings 
To print using Dell™ ColorTrack, configure the following settings. 

•	 "Dell ColorTrack" 

•	 "Authentication System" 

•	 "Kerberos Server" 

•	 "LDAP Server" 

•	 "LDAP Authentication" 

Dell ColorTrack 
Specify the authentication method. 

When Using the Dell Printer Configuration Web Tool 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Volume.
 

3 Click the Dell ColorTrack tab.
 

•	 Select External Mode for ColorTrack Mode. 

•	 Select the On check box for Non Registered User when you permit the printing of data with no authentication 
information. If not, clear the On check box. 

•	 Enter the password when External Mode is selected for ColorTrack Mode and On is selected for Non 
Registered User. Then, re-enter the password to confirm the password that you entered. 

•	 Select the On check box for ColorTrack Error Report, if necessary. 

4 Click Apply New settings.
 

5 Turn off the printer, and turn it on again to apply the settings.
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When Using the Operator Panel 

You can specify only the settings of ColorTrack Mode, Non Registered User, and ColorTrack Error Report using the 
operator Panel. 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until System Settings is highlighted, and then press the (Set) button.
 

4 Press the 
 button until ColorTrack Mode is highlighted, and then press the (Set) button.
 

5 Press the 
 button until External Mode is highlighted, and then press the (Set) button.
 

6 When the Restart System screen appears, press the 
 button, and then press the (Back) button.
 

7 Press the 
 button until Non Registered User is highlighted, and then press the (Set) button.
 

8 Press the 
 button until Off or On is highlighted, and then press the (Set) button.
 

9 When the Restart System screen appears, press the 
 button, and then press the (Back) button.
 

10 Press the 
 button until ColorTrack ErrRep is highlighted, and then press the (Set) button.
 

11 Press the 
 button until Off or On is highlighted, and then press the (Set) button. 

12 Turn off the printer, and turn it on again to apply the settings. 

ColorTrack Mode 

The following two authentication modes are available: the Internal Mode using user information registered on the 
printer, and the External Mode using user information registered on an external server. To authenticate on the 
external authentication server with External Mode, you need not register user information on the printer. The 
change becomes effective after the printer is turned off and then on again. 

Non Registered User 

Specify whether to permit the printing of data with no authentication information. This setting is enabled when the 
printer is restarted. The change becomes effective after the printer is turned off and then on again. 

Non Registered User Password 

Specify the password to be used for non-account user using 1 to 127 alphanumeric characters. If the password is left 
blank (NULL), you cannot log in to a server. The change becomes effective after the printer is turned off and then 
on again. 

NOTE: When External Mode is specified and Non Registered User is set to On, you must set a password. 

NOTE: When using an LDAP server, you also must set the same password on the server. 

Re-enter Non Registered User Password 

Enter the Non Registered user password again to confirm it. 

ColorTrack Error Report 

Specify whether to automatically print error-related information if printing using ColorTrack results in an error. 

Setup Remote Authentication 

Click Setup Remote Authentication Page to display the Authentication System page. 

NOTE: This item is displayed only when External Mode is specified. 
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Authentication System 
Specify the server authentication type, the server response time-out, or the search time-out. 

When Using the Dell Printer Configuration Web Tool 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select Authentication System.
 

Authentication System page is displayed. 

•	 Select the authentication system for Authentication System Settings. 

•	 Specify the time-out period for Server Response Time-Out. 

•	 Specify the time-out period for Search Time-Out. 

5 Click Apply New settings.
 

6 Turn off the printer, and turn it on again to apply the settings.
 

Authentication System Settings 

Select the authentication system from the list. The change becomes effective after the printer is turned off and then 
on again. 

Server Response Time-Out 

Specify the amount of time the printer should wait for response from the server. Set the time period from 1 up to 75 
seconds. The change becomes effective after the printer is turned off and then on again. 

Search Time-Out 

Specify the amount of time the printer should wait for searching for the server. Set the time period from 5 up to 120 
seconds. The change becomes effective after the printer is turned off and then on again. 

Kerberos Server 
Specify the settings for the Kerberos Server. 

When Using the Dell Printer Configuration Web Tool 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select Kerberos Server.
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5 Enter the IP address or host name, and the port address in IP Address / Host Name & Port of Kerberos Server (for 
ColorTrack PRO). 

6 Enter the domain name in Domain Name. 

7 Click Apply New settings. 

8 Turn off the printer, and turn it on again to apply the settings. 

IP Address / Host Name & Port 

Specify the IP address or host name, and the port address. The change becomes effective after the printer is turned 
off and then on again. 

CAUTION: Do not use the same port address as that of another port. 

NOTE: The port address must be 88 or between 5,000 and 65,535. The default value is 88. 

NOTE: Specify the IP address in the nnn.nnn.nnn.nnn format for IPv4. Each section of "nnn" is a variable value between 0 and 
255. 

NOTE: Specify the IP address in the xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx format for IPv6. Each section of "xxxx" is a 
hexadecimal variable value. 

Domain Name 

Specify the domain name of the Active Directory® in Domain Name (Realm Name). The change becomes effective 
after the printer is turned off and then on again. 

NOTE: Specify the domain name with uppercase characters. Depending on your server, an error may occur if you specify the 
domain name with lowercase characters. 

LDAP Server 
Specify the directory server and the authentication method to execute LDAP authentication or to acquire 
information using LDAP, and specify the range and attributes for searching. 

NOTE: When using LDAPS or certificate verification, you must set the LDAP server or import an external certificate. For more 
information, see "Using Digital Certificates." 

When Using the Dell Printer Configuration Web Tool 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select LDAP Server.
 

Server Information (for ColorTrack PRO): 

•	 Enter the IP address or the host name, and the port address in IP Address / Host Name & Port. 

• Confirm the software information for LDAP Server.
 

Optional Information (for ColorTrack PRO):
 

•	 Enter a text string in Search Directory Root. 

•	 Enter the login name in Login Name. 

•	 Enter the password in Password. Then, re-enter the password to confirm the password that you entered. 
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• Specify the time-out period for Search Time-Out. 

5 Click Apply New settings.
 

6 Turn off the printer, and turn it on again to apply the settings.
 

Server Information (for ColorTrack PRO) 

IP Address / Host Name & Port 

Specify the IP address or the host name, and the port address. The change becomes effective after the printer is 
turned off and then on again. 

CAUTION: Do not use the same port address as that of another port. 

NOTE: The port address must be 389, 636 or between 5,000 and 65,535. The default value is 389. When using LDAPS, normally 
specify 636. 

NOTE: Specify the IP address in the nnn.nnn.nnn.nnn format for IPv4. Each section of "nnn" is a variable value between 0 and 
255. 

NOTE: Specify the IP address in the xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx format for IPv6. Each section of "xxxx" is a 
hexadecimal variable value. 

LDAP Server 

Displays the current software information of the LDAP server. 

Optional Information (for ColorTrack PRO) 

Search Directory Root 

Specify a text string as the origin of the search when using LDAP communication. The change becomes effective 
after the printer is turned off and then on again. 

For example: ou=colortrackv3,dc=win2003ad,dc=colortrack.dc=net 

Login Name 

Specify the login name for accessing the directory server with LDAP authentication. Specify the name of a user with 
the authority to update the LDAP server. The change becomes effective after the printer is turned off and then on 
again. 

Password 

Specify the password for accessing the directory server with LDAP authentication. Specify the password of a user 
with the authority to update the LDAP server using 1 to 127 alphanumeric characters. If the password is left blank 
(NULL), you cannot log in to a server. The change becomes effective after the printer is turned off and then on 
again. 

Re-enter Password 

Enter the password again to confirm it. 

Search Time-Out 

Specify the amount of time the printer should wait for searching for the server. To specify a time-out period for 
searching, select Wait, and set the time period from 5 up to 120 seconds. To not specify a time-out period, select the 
Wait LDAP Server Limit. The change becomes effective after the printer is turned off and then on again. 
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LDAP Authentication 
Specify the LDAP server authentication method. 

When Using the Dell Printer Configuration Web Tool 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select LDAP Authentication.
 

LDAP Authentication (for ColorTrack PRO): 

•	 Confirm the authentication method. 

•	 When adding a text string to the UserID, select Enable for Use Added Text String. 

• 	  When  Enable is selected for Use Added Text String, enter the additional text string in Text String Added to 
User Name. 

5 Click Apply New settings.
 

6 Turn off the printer, and turn it on again to apply the settings.
 

Authentication Method 

Displays the current LDAP authentication method. Direct Authentication executes server authentication with the 
UserID and password entered. 

Use Added Text String 

Specify whether to add a text string to the UserID. The change becomes effective after the printer is turned off and 
then on again. 

Text String Added to User Name 

When using an added string for the user name, specify the text string to be added.
 

For example: if the user name is "abcde@myhost.example.com", normally you must enter 

"abcde@myhost.example.com". 

However if Use Added Text String is set to Enable, and "@myhost.example.com" is specified in Text String Added 

to User Name, only the data "abcde" must be entered with the printer driver, thus simplifying the entry task.
 

The change becomes effective after the printer is turned off and then on again.
 

Setting the Printer Driver 
To print using ColorTrack, set the printer driver. Once set, the settings of the printer driver are enabled until they are 
changed. 

1 Open Properties of the printer driver. 

2 Configure the following settings from the Configuration tab. 
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Dell ColorTrack Mode 
Specify whether to allow general users to change settings related to authentication or whether general users must use 
the settings configured by the Administrator. 

Specify Group Name 
Specify the name of the belonging group to use when authenticating. If you specify a group that does not belong, 
authentication fails and the data is not printed. Also, the default group is set if Specify Group Name is not specified. 

Specify Job Owner 
Select Use Login Name to use the user information logged into your PC, and select Enter ID to enter the user name 
yourself. 

Job Owner Name 
Specify the user name to use when authenticating with an external server. You can enter this only when selecting 
Enter ID for Specify Job Owner. 

Password 
Specify the user password to use when authenticating with an external server. 
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Using Digital Certificates 
The authentication feature using digital certificates upgrades security when sending print data or setting data. 

This chapter describes how to manage digital certificates. 

NOTE: For information about digital certificate error, see "Understanding Printer Messages" and "Digital Certificate Problem." 

The following is a typical setup flow for using digital certificates. 

Prepare to manage digital certificates. 

• Change the Encryption Setting of the Hard Disk 

• Set HTTPS Communication 

Import and set digital certificates. 

• Import a Digital Certificate 

• Set a Digital Certificate 

• Confirm the Settings of a Digital Certificate 

Set various security features using digital certificates. 

Managing Certificates 
This section describes how to manage digital certificates as follows. 

• "Preparing to Manage Certificates" 

• "Importing a Digital Certificate" 

• "Setting a Digital Certificate" 

• "Confirming the Settings of a Digital Certificate" 

• "Deleting a Digital Certificate" 

• "Exporting a Digital Certificate" 

NOTE: The external certificate management described above is enabled only when the optional hard disk is installed and is set 
to On for encryption. 

Preparing to Manage Certificates 
Before managing digital certificates, the following settings must be applied. 

• "Changing the Encryption Setting of the Hard Disk" 

• "Setting HTTPS Communication" 

Changing the Encryption Setting of the Hard Disk 

Some items are effective only when encryption of the optional hard disk is set to On. Change the encryption setting 
to On and set a key that is required to encrypt, if necessary. 

CAUTION: All files stored on the optional hard disk are cleared when changing the encryption setting. 

NOTE: You can enter only characters from 0 to 9, a to z, A to Z, and NULL values for encryption key. 
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When Using the Operator Panel 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Secure Settings is highlighted, and then press the (Set) button.
 

4 Press the 
 button until Data Encryption is highlighted, and then press the (Set) button.
 

5 Press the 
 button until Encryption is highlighted, and then press the (Set) button.
 

6 Press the 
 button until On is highlighted, and then press the (Set) button.
 

7 Use the number pad to enter the passphrase for the encryption key, and then press the 
 (Set) button. 

8	 The Encryption (All stored documents will be deleted. Are you sure) screen appears. When you confirm that all 
stored documents will be deleted to change the encryption setting, press the (Set) button. When you want to 
quit changing the encryption setting, press the (Back) button. 

When Using the Dell™ Printer Configuration Web Tool 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Printer Settings.
 

3 Click the Printer Settings tab.
 

4 Select Secure Settings.
 

5 Check that the Enable check box of Panel Lock Control of Panel Lock is selected. 


If Enable is selected, proceed to step 10. If not, perform the following steps. 

6 Select the Enable check box of Panel Lock Control of Panel Lock. 

7 Enter a four digit password in New Password. 

8 Re-enter the password in Re-enter Password. 

9 Click Apply New Settings. 

For details about Panel Lock, see "Panel Lock." 

10 Click Data Encryption. 

The Data Encryption page is displayed. 

11 Select the Encryption check box. 

12 Enter a key that is required to encrypt. 

13 Re-enter the key again to confirm it. 

14 Click Apply New Settings. 

Setting HTTPS Communication 

Before managing certificates, set HTTPS communication with a self-signed certificate. 

NOTE: Set HTTPS communication after changing the Encryption setting to On. 

Using Digital Certificates 282 



 

 

 

  

  

  

  

  

   

 

  

 


 


 


 


 

	 
 


 


 


 


 


 


 


 


 


 


 


 

When Using the Dell Printer Configuration Web Tool 

1 Launch Dell Printer Configuration Web Tool. 

a Open the web browser. 

b Enter the IP address of your printer in the web browser. 

See "Dell™ Printer Configuration Web Tool." 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select SSL/TLS.
 

5 Click Generate Self-Signed Certificate of Machine Digital Certificate. The Generate Self-Signed Certificate
 
page is displayed. 

6 Select the size of public key from the list of Size of Public Key. 

7 Specifies the issuer of SSL self-signed certificate. 

8 Click Generate Signed Certificate. 

9 The Restart Printer button is displayed after generating the self-signed certificate, and then click Restart Printer. 

10 Repeat steps 2 to 4 to display the SSL/TLS page after restarting the printer. 

11 If the self-signed certificate is set correctly, since the HTTP- SSL/TLS Communication column is set to Enable 
and a check box is displayed, select Enable. 

Importing a Digital Certificate 

CAUTION: Before importing a certificate file, back up the certificate file. 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

NOTE: Be sure to import the certificate with Internet Explorer. 

NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting. 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select SSL/TLS.
 

5 Click Upload Signed Certificate of Machine Digital Certificate.
 

The Upload Signed Certificate page is displayed. 

NOTE: The Upload Signed Certificate button is displayed only when the optional hard disk is installed and is set to On for 
encryption. 

6 Enter a password.
 

7 Re-enter the password again to confirm it.
 

8 Click Browse of File Name, and select the file to be imported.
 

9 Click Import to import the certificate.
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Setting a Digital Certificate 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

1 Launch Dell Printer Configuration Web Tool. 

a Open the web browser. 

b Enter the IP address of your printer in the web browser. 

See "Dell™ Printer Configuration Web Tool." 

2 Select Print Server Settings. 

3 Click the Security tab. 

4 Select SSL/TLS. 

5 Click Certificate Management to display the Certificate Management page. 

NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption. 

6 When setting a Wireless LAN (Server) certificate, select Trusted Certificate Authorities within Category. 
When setting a certificate of SSL Server, SSL Client, IPsec, or Wireless LAN (Client), select Local Device. 

7 Select the purpose of use from the Certificate Purpose list. 

8 Click Display the List to display the Certificate List page. 

NOTE: If the list includes more than 20 certificates, click Next to display the next page. 

9 Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid. 

10 Click Certificate Details to display the Certificate Details page. 

11 Confirm the content, and click Use This Certificate at the upper-right corner. 

Confirming the Settings of a Digital Certificate 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

1	 Launch Dell Printer Configuration Web Tool. 

a Open the web browser. 

b Enter the IP address of your printer in the web browser. 

See "Dell™ Printer Configuration Web Tool." 

2 Select Print Server Settings. 

3 Click the Security tab. 

4 Select SSL/TLS. 

5 Click Certificate Management to display the Certificate Management page. 

NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption. 

6 Select the category from the Category list. 

7 Select the purpose of use from the Certificate Purpose list. 

8 Click Display the List to display the Certificate List page. 

NOTE: If the list includes more than 20 certificates, click Next to display the next page. 

9	 The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with the 
use purpose and actually used. 
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Deleting a Digital Certificate 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select SSL/TLS.
 

5 Click Certificate Management to display the Certificate Management page.
 

NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption. 

6 Select the category from the Category list.
 

7 Select the purpose of use from the Certificate Purpose list.
 

8 Click Display the List to display the Certificate List page.
 

NOTE: If the list includes more than 20 certificates, click Next to display the next page.
 

9	 Select the certificate to be deleted. 

10 Click Certificate Details to display the Certificate Details page. 

11 To delete the selected certificate, click Delete at the upper-right corner. 

NOTE: When a certificate is deleted, the features associated with the deleted certificate are disabled. To delete a 
certificate being used, either set the feature to OFF in advance or switch the association to another certificate, and then 
switch to another operation mode if possible before deleting the certificate. 

•	 For an SSL Server, switch to another certificate such as a self-signed certificate. 

•	 For an SSL Client, set the LDAP-SSL/TLS and IEEE 802.1x (EAP-TLS) setting to OFF. 

•	 For IPsec, change the IKE setting to Pre-Shared Key or set the feature to OFF. 

•	 For Wireless LAN, change the Wireless Security setting to other than WPA-Enterprise before deleting the 
certificate. 

Exporting a Digital Certificate 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

NOTE: Since the secret key is not exported, an imported PKCS#12 format certificate can be exported only as a PKCS#7 
certificate. 

1	 Launch Dell Printer Configuration Web Tool.
 

a Open the web browser.
 

b Enter the IP address of your printer in the web browser.
 

See "Dell™ Printer Configuration Web Tool."
 

2 Select Print Server Settings.
 

3 Click the Security tab.
 

4 Select SSL/TLS.
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5 Click Certificate Management to display the Certificate Management page. 

NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption. 

6 Select the category from the Category list.
 

7 Select the purpose of use from the Certificate Purpose list.
 

Click Display the List to display the Certificate List page.
 

NOTE: If the list includes more than 20 certificates, click Next to display the next page.
 

8 Select the certificate to be exported.
 

9 Click Certificate Details to display the Certificate Details page.
 

10 To export the selected certificate, click Export This Certificate. 

Setting the Features 
You can set various security features using digital certificates. 

See the following for details: 

• "Setting the Certificate in the IPsec Digital Signature Mode" 

• "Setting the SSL-use Server Certificate (HTTP/IPP)" 

• "Setting LDAP-SSL/TLS Communication" 

• "Setting Server Certificate Verification for LDAP-SSL/TLS Communication" 

• "Setting Client Certificate for LDAP-SSL/TLS Communication" 

• "Setting for Wireless LAN WPA-Enterprise (EAP-TLS)" 

• "Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, EAP-TTLS CHAP)" 

• "Setting Client Certificate for IEEE 802.1x (EAP-TLS)" 

Setting the Certificate in the IPsec Digital Signature Mode 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

1 Import the certificate to be used with IPsec. For more information, see "Importing a Digital Certificate."
 

2 Set the certificate to be used with IPsec. For more information, see "Setting a Digital Certificate."
 

3 Confirm whether the certificate is set correctly in IPsec. For more information, see "Confirming the Settings of a 

Digital Certificate."
 

4 Select Print Server Settings from the left side of the page.
 

5 Click the Security tab.
 

6 Select IPsec.
 

7 Select the Enable check box for Protocol.
 

8 Select Digital Signature from the IKE list.
 

9 Set each item, as necessary.
 

10 Click Apply New Settings. 

11 After restarting the printer, IPsec communication using digital signatures is enabled. You can execute IPsec 
communication (Digital Signature Mode) between the printer and the network device (such as PC) on which the 
certificate and IPsec are set identically as on this device. 
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Setting the SSL-use Server Certificate (HTTP/IPP) 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

1 Import the certificate to be used with the SSL-use server. For more information, see "Importing a Digital 
Certificate." 

2 Set the certificate to be used with the SSL-use server. For more information, see "Setting a Digital Certificate." 

3	 Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital 
Certificate." 

NOTE: Confirm whether the newly set certificate, not the self-signed certificate, is associated. 

4	 After restarting the printer, the certificate set as described above is used as the server certificate when executing 
communication with HTTP/IPP-SSL/TLS. 

Setting LDAP-SSL/TLS Communication 

NOTE: This setting is available only when the optional hard disk is installed and is set to On for encryption.
 

1 Select Print Server Settings from the left side of the page.
 

2 Click the Security tab.
 

3 Select SSL/TLS.
 

4 Select the Enable check box for LDAP-SSL/TLS Communication.
 

5 Click Apply New Settings.
 

6 After restarting the printer, LDAP-SSL/TLS Communication is enabled.
 

NOTE: When executing the certificate validity of the server and the presentation of the client certificate, see "Setting Server 
Certificate Verification for LDAP-SSL/TLS Communication" and "Setting Client Certificate for LDAP-SSL/TLS Communication." 

Setting Server Certificate Verification for LDAP-SSL/TLS Communication 

NOTE: This setting is available only when the optional hard disk is installed and is set to On for encryption. 

NOTE: This feature is enabled only when Enable is set for LDAP-SSL/TLS Communication. 

1 Import the root certificate (including intermediate certificate) for the LDAP server certificate. For more 
information, see "Importing a Digital Certificate." 

NOTE: In the verification of a certificate of the connected server, to automatically search for an imported certificate and 
verify the path, the certificate does not need to be associated. 

2 Confirm whether the root certificate is correctly imported to the LDAP server. For more information, see 

"Confirming the Settings of a Digital Certificate."
 

3 Select Print Server Settings.
 

4 Click the Security tab.
 

5 Select SSL/TLS.
 

6 Select the Enable check box for Verify Remote Server Certificate.
 

7 Click Apply New Settings.
 

8 After restarting the printer, the certificate presented by the LDAP server is verified when LDAP-SSL/TLS 

communication starts with the LDAP server.
 

NOTE: When the result of verification is NG, communication is not established and an error results. 
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Setting Client Certificate for LDAP-SSL/TLS Communication 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

NOTE: This feature is enabled only when Enable is set for LDAP-SSL/TLS Communication. 

1 Import a certificate to be used with SSL Client. For more information, see "Importing a Digital Certificate." 

2 Set a certificate to be used with SSL Client. For more information, see "Setting a Digital Certificate." 

3 Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital 
Certificate." 

4 After restarting the printer, the LDAP client certificate is presented when LDAP-SSL/TLS communication with 
the LDAP server starts. When the LDAP server is set to require a client certificate, the client certificate provided 
by the printer is verified by the LDAP server. 

Setting for Wireless LAN WPA-Enterprise (EAP-TLS) 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

NOTE: WPA-Enterprise is available only when infrastructure is selected as the network type. 

NOTE: Be sure to import the certificate with Internet Explorer. 

NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting. 

1 Import the certificate to be used with Wireless LAN (server or root certificate). For details, see "Importing a Digital 
Certificate." 

2	 Set the digital certificate for wireless LAN (server or root certificate). 

a Launch Dell Printer Configuration Web Tool. 

b Select Print Server Settings. 

c Click the Security tab. 

d Select SSL/TLS. 

e Click Certificate Management to display the Certificate Management page. 

f Select Trusted Certificate Authorities within Category. 

g Select the Wireless LAN (Server) of use from the Certificate Purpose list. 

h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary 
if you do not need to specify the order for the certificates. 

i Click Display the List to display the Certificate List page. 

j Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid. 

k Click Certificate Details to display the Certificate Details page. 

l Confirm the content, and click Use This Certificate at the upper-right corner. 

3 Confirm whether the certificate is set correctly. For details, see "Confirming the Settings of a Digital Certificate." 

4 Import the certificate to be used with Wireless LAN (client or client certificate). For details, see "Importing a 
Digital Certificate." 

5	 Set the digital certificate for wireless LAN (client or client certificate).
 

a Launch Dell Printer Configuration Web Tool.
 

b Select Print Server Settings.
 

c Click the Security tab.
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d Select SSL/TLS. 

e Click Certificate Management to display the Certificate Management page. 

f Select Local Device within Category. 

g Select the Wireless LAN (Server) of use from the Certificate Purpose list. 

h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary 
if you do not need to specify the order for the certificates. 

i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid. 

j Click Certificate Details to display the Certificate Details page. 

k Confirm the content, and click Use This Certificate at the upper-right corner. 

6 Confirm whether the certificate is set correctly. For details, see "Confirming the Settings of a Digital Certificate." 

7 Set WPA-Enterprise for EAP-TLS. 

a Launch Dell Printer Configuration Web Tool. 

b Click the Print Server Settings tab. 

c Select Wireless LAN. 

NOTE: This setting is available only when the optional wireless adapter is installed.
 

d Select either of the following from the Encryption list of Secure Settings.
 

•	 WPA-Enterprise-AES/WPA2-Enterprise-AES 

• 	  WPA-Enterprise-TKIP  

NOTE: WPA-Enterprise-AES/WPA2-Enterprise-AES or WPA-Enterprise-TKIP becomes available only when the 
following steps are set correctly. 

•	 Importing a Digital Certificate 

•	 Setting a Digital Certificate 

• Confirming the Settings of a Digital Certificate
 

e Set EAP-Identity of WPA-Enterprise.
 

f Select EAP-TLS from the Authentication Method list of WPA-Enterprise.
 

g Click Apply New Settings.
 

Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, EAP-TTLS CHAP) 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

NOTE: WPA-Enterprise is available only when infrastructure is selected as the network type. 

NOTE: Be sure to import the certificate with Internet Explorer. 

NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting. 

1 Import the certificate to be used with Wireless LAN (server or root certificate). For details, see "Importing a Digital 
Certificate." 

2	 Set the digital certificate for wireless LAN (server or root certificate).
 

a Launch Dell Printer Configuration Web Tool.
 

b Select Print Server Settings.
 

c Click the Security tab.
 

d Select SSL/TLS.
 

e Click Certificate Management to display the Certificate Management page.
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f Select Trusted Certificate Authorities within Category. 

g Select the purpose of use from the Certificate Purpose list. 

h Click Display the List to display the Certificate List page. 

i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid. 

j Click Certificate Details to display the Certificate Details page. 

k Confirm the content, and click Use This Certificate at the upper-right corner. 

3 Confirm whether the certificate is set correctly. 

a Launch Dell Printer Configuration Web Tool. 

b Select Print Server Settings. 

c Click the Security tab. 

d Select SSL/TLS. 

e Click Certificate Management to display the Certificate Management page. 

f Select the category from the Category list. 

g Select the Wireless LAN (Server) of use from the Certificate Purpose list. 

h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary 
if you do not need to specify the order for the certificates. 

i Click Display the List to display the Certificate List page. 

j The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with 
the use purpose and actually used. 

4 Set WPA-Enterprise for PEAPV0-MS-CHAPV2, EAP-TTLS PAP, or EAP-TTLS CHAP. 

a Launch Dell Printer Configuration Web Tool. 

b Click the Print Server Settings tab. 

c Select Wireless LAN. 

NOTE: This setting is available only when the optional wireless adapter is installed.
 

d Select either of the following from the Encryption list of Secure Settings.
 

• WPA-Enterprise-AES/WPA2-Enterprise-AES 

•  WPA-Enterprise-TKIP  

NOTE: WPA-Enterprise-AES/WPA2-Enterprise-AES or WPA-Enterprise-TKIP becomes available only when the 
following steps are set correctly. 

• Importing a Digital Certificate 

• Setting a Digital Certificate 

• Confirming the Settings of a Digital Certificate
 

e Set EAP-Identity, Login Name, and Password of WPA-Enterprise.
 

f Select either of the following from the Authentication Method list of WPA-Enterprise:
 

•  PEAPV0 MS-CHAPV2  

•  EAP-TTLS PAP  

•  EAP-TTLS CHAP 
  

g Click Apply New Settings.
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Setting Client Certificate for IEEE 802.1x (EAP-TLS) 

NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates." 

NOTE: This feature is enabled only when Enable is set for IEEE 802.1x (EAP-TLS). 

1 Import a certificate to be used with SSL Client. For more information, see "Importing a Digital Certificate." 

2 Set a certificate to be used with SSL Client. For more information, see "Setting a Digital Certificate." 

3 Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital 
Certificate." 

4	 After restarting the printer, the IEEE 802.1x (EAP-TLS) certificate is presented when IEEE 802.1x communication 
with the RADIUS server starts. When the RADIUS server is set to require a client certificate, the client certificate 
provided by the printer is verified by the RADIUS server. 

Using Digital Certificates 291 



292 Using Digital Certificates 



 
 

 

  

 
     

  

   

 
 


 







 




 




 







 

 


 







 

23
 
Understanding Fonts 

Typefaces and Fonts 
A font is a set of characters and symbols created with a distinct design. The distinct design is called a typeface. The 
typefaces you select add personality to a document. Well-chosen typefaces make a document easier to read. 

The printer has numerous resident fonts in PCL 5/PCL 6 and PostScript 3. See "Resident Fonts" for a listing of all 
resident fonts. 

Weight and Style 
Typefaces are often available in different weights and styles. These variations modify the original typeface so you can, 

for example, emphasize important words in text or highlight book titles. The different weights and styles are 

designed to complement the original typeface.
 

Weight refers to the thickness of the lines that form the characters. Thicker lines result in darker characters. Some 

words commonly used to describe the weight of a typeface are bold, medium, light, black, and heavy.
 

Style refers to other typeface modifications, such as tilt or character width. Italic and oblique are styles where the 

characters are tilted. Narrow, condensed, and extended are three common styles that modify the character widths.
 

Some fonts combine several weight and style modifications; for example, Helvetica BdOb. A group of several weight 

and style variations of a single typeface is called a typeface family. Most typeface families have four variations: 

regular, italic (oblique), bold, and bold italic (bold oblique). Some families have more variations, as the following
 
illustration for the Helvetica typeface family shows:
 

Pitch and Point Size 
The size of a font is specified as either a pitch or point size, depending on whether the font is fixed space or 
proportional.
 

In fixed space fonts, each character has the same width. Pitch is used to specify the size of fixed space fonts. It is a 

measure of the number of characters that will print in one horizontal inch of type. For example, all 10-pitch fonts 

print 10 characters per inch (cpi) and all 12-pitch fonts print 12 cpi:
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In proportional (or typographic) fonts, every character can have a different width. Since proportional fonts have 
characters with different widths, the font size is specified in point size, not pitch. Point size refers to the height of 
the characters in the font. A point is defined as 1/72 inch. The characters in a font printed at 24 point will be twice as 
large as the characters in the same font printed at 12 point. 

The following illustration shows samples of a font printed in different point sizes: 

The point size of a font is defined as the distance from the top of the tallest character in the font to the bottom of 
the lowest character in the font. Due to the definition of point size, different fonts printed at the same point size 
may appear quite different in size. This is because there are other font parameters that affect how the font looks. 
However, the point size of a font is an excellent specification of the relative size of a font. The following examples 
illustrate two very different proportional fonts at 14 point: 

Bitmapped and Scalable Fonts 
The printer uses both bitmapped and scalable fonts. 

Bitmapped fonts are stored in print memory as predefined patterns of bits that represent a typeface at a specific size, 
style, and resolution. The following illustration shows an example of a character from a bitmapped font. 

Bitmapped fonts are available in different type styles and point sizes as downloadable fonts.
 

Scalable fonts (also called outline fonts) are stored as computer programs that define the outlines of the characters 

in the font. Each time you print characters from a scalable font, the printer creates a bitmap of the characters at the 

point size you choose and saves it temporarily in print memory.
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These temporary bitmapped fonts are deleted when you turn off or reset the printer. Scalable fonts provide the 

flexibility of printing in many different point sizes.
 

Your printer uses different scalable font formats for downloading fonts to the printer. PCL 5/PCL 6 uses Intellifont 

and TrueType scalable fonts. PostScript 3 uses Type 1 and TrueType scalable fonts. There are thousands of different 

scalable fonts available in these different font formats from numerous font suppliers.
 

If you plan to use many downloadable bitmapped or scalable fonts or if you plan to use many different sizes of 

scalable fonts, you may need to purchase additional memory for your printer.
 

Resident Fonts 
Your printer is equipped with resident fonts stored permanently in print memory. Different fonts are available in 
PCL 5/PCL 6 and PostScript 3. Some of the most popular typefaces, like Courier and TimesNew (PCL 5/PCL 
6)/Times New Roman (PostScript 3), are available for all printer languages. 

The following table lists all the fonts resident in your printer. See "Report / List" for instructions on how to print 
samples of the fonts. You can select the resident fonts from your software program. You can also select the fonts from 
the operator panel if you are using PCL 5/PCL 6. 

Resident bitmapped and scalable fonts 

PCL 5/PCL 6 PostScript 3 

CG Times Albertus 

CG Times It Albertus Italic 

CG Times Bd Albertus Light 

CG Times BdIt 

Antique Olive Roman 

Univers Md Antique Olive Italic 

Univers MdIt Antique Olive Bold 

Univers Bd Antique Olive Compact 

Univers BdIt Apple Chancery 

Univers MdCd Arial 

Univers MdCdIt Arial Italic 

Univers BdCd Arial Bold 

Univers BdCdIt Arial Bold Italic 

ITC Avant Garde Gothic Book 

AntiqueOlv ITC Avant Garde Gothic Book Oblique 

AntiqueOlv It ITC Avant Garde Gothic Demi 

AntiqueOlv Bd ITC AvantGarde Gothic Demi Oblique 

Bodoni Roman 
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Resident bitmapped and scalable fonts 

PCL 5/PCL 6 PostScript 3 

CG Omega Bodoni Italic 

CG Omega It Bodoni Bold 

CG Omega Bd Bodoni Bold Italic 

CG Omega BdIt Bodoni Poster 

Bodoni Poster Compressed 

Garamond Antiqua ITC Bookman Light 

Garamond Krsv ITC Bookman Light Italic 

Garamond Hlb ITC Bookman Demi 

Garamond KrsvHlb ITC Bookman Demi Italic 

Carta 

Courier Chicago 

Courier It Clarendon Roman 

Courier Bd Clarendon Bold 

Courier BdIt Clarendon Light 

Cooper Black 

LetterGothic Cooper Black Italic 

LetterGothic It Cooper Gothic 32BC 

LetterGothic Bd Cooper Gothic 33BC 

Coronet 

Albertus Md Courier 

Albertus XBd Courier Oblique 

Courier Bold 

Clarendon Cd Courier Bold Oblique 

Eurostile Medium 

Coronet Eurostile Bold 

Eurostile Extended No. 2 

Marigold Eurostile Bold Extended No. 2 

Geneva 

Arial Gill Sans 

Arial It Gill Sans Italic 

Arial Bd Gill Sans Bold 

Arial BdIt Gill Sans Bold Italic 

Gill Sans Light 

TimesNew Gill Sans Light Italic 

TimesNew It Gill Sans Extra Bold 

TimesNew Bd Gill Sans Condensed 

TimesNew BdIt Gill Sans Condensed Bold 

Goudy Oldstyle 

Symbol Goudy Oldstyle Italic 

Goudy Bold 
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Resident bitmapped and scalable fonts 

PCL 5/PCL 6 PostScript 3 

Wingdings Goudy Bold Italic 

Goudy Extra Bold 

Line Printer Helvetica 

Helvetica Oblique 

Times Roman Helvetica Bold 

Times It Helvetica Bold Oblique 

Times Bd Helvetica Narrow 

Times BdIt Helvetica Narrow Oblique 

Helvetica Narrow Bold 

Helvetica Helvetica Narrow Bold Oblique 

Helvetica Ob Helvetica Condensed 

Helvetica Bd Helvetica Condensed Oblique 

Helvetica BdOb Helvetica Condensed Bold 

Helvetica Condensed Bold Oblique 

CourierPS Hoefler Text 

CourierPS Ob Hoefler Text Italic 

CourierPS Bd Hoefler Text Black 

CourierPS BdOb Hoefler Text Black Italic 

Hoefler Ornaments 

SymbolPS Joanna 

Joanna Italic 

Palatino Roman Joanna Bold 

Palatino It Joanna Bold Italic 

Palatino Bd Letter Gothic 

Palatino BdIt Letter Gothic Slanted 

Letter Gothic Bold 

ITCBookman Lt Letter Gothic Bold Slanted 

ITCBookman LtIt ITC Lubalin Graph Book 

ITCBookmanDm ITC Lubalin Graph Book Oblique 

ITCBookmanDm It ITC Lubalin Graph Demi 

ITC Lubalin Graph Demi Oblique 

HelveticaNr Marigold 

HelveticaNr Ob Monaco 

HelveticaNr Bd ITC Mona Lisa Recut 

HelveticaNr BdOb New Century Schoolbook Roman 

New Century Schoolbook Italic 

N C Schbk Roman New Century Schoolbook Bold 

N C Schbk It New Century Schoolbook Bold Italic 

N C Schbk Bd NewYork 

N C Schbk BdIt Optima Roman 
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Resident bitmapped and scalable fonts 

PCL 5/PCL 6 PostScript 3 

Optima Italic 

ITC A G Go Bk Optima Bold 

ITC A G Go BkOb Optima Bold Italic 

ITC A G Go Dm Oxford 

ITC A G Go DmOb Palatino Roman 

Palatino Italic 

ZapfC MdIt Palatino Bold 

Palatino Bold Italic 

ZapfDingbats Stempel Garamond Roman 

Stempel Garamond Italic 

Stempel Garamond Bold 

Stempel Garamond Bold Italic 

Symbol 

Tekton Regular 

Times Roman 

Times Italic 

Times Bold 

Times Bold Italic 

Times New Roman 

Times New Roman Italic 

Times New Roman Bold 

Times New Roman Bold Italic 

Univers 45 Light 

Univers 45 Light Oblique 

Univers 55 

Univers 55 Oblique 

Univers 65 Bold 

Univers 65 Bold Oblique 

Univers 57 Condensed 

Univers 57 Condensed Oblique 

Univers 67 Condensed Bold 

Univers 67 Condensed Bold Oblique 

Univers 53 Extended 

Univers 53 Extended Oblique 

Univers 63 Extended Bold 

Univers 63 Extended Bold Oblique 

Wingdings 

ITC Zapf Chancery Medium Italic 

ITC Zapf Dingbats 
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Symbol Sets 
A symbol set is the collection of alphabetic and numeric characters, punctuation, and special characters available in 
the font you select. Symbol sets support the requirements for different languages or specific applications, such as 
math symbols used for scientific text. 

In PCL 5/PCL 6, a symbol set also defines which character will print for each key on the keyboard (or more 
specifically, for each code point). Some applications require different characters at some code points. To support 
multiple applications and languages, your printer has 36 symbol sets for the resident PCL 5/PCL 6 fonts. 

Symbol Sets for PCL 5/PCL 6 
Not all font names support all of the symbol sets listed. 

Roman 8 (Default) ISO 8859-1 Latin 1 ISO 8859-2 Latin 2 

ISO 8859-9 Latin 5 ISO 8859-10 Latin 6 PC-8 

PC-8 DN PC-775 Baltic PC-850 Multilingual 

PC-852 Latin 2 PC-1004 OS/2 PC Turkish 

Windows 3.1 Latin 1 Windows 3.1 Latin 2 Windows 3.1 Latin 5 

DeskTop PS Text MC Text 

Microsoft Publishing Math 8 PS Math 

Pi Font Legal ISO 4 United Kingdom 

ISO 6 ASCII ISO 11 Swedish:names ISO 15 Italian 

ISO 17 Spanish ISO 21 German ISO 60 Norwegian v1 

ISO 69 French Windows 3.0 Latin 1 Windows Baltic 

Symbol Wingdings ITC ZapfDingbats MS 
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Understanding Printer Messages 
The LCD panel displays error messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This chapter provides a list of error codes and informs you what you can do to clear error 
messages. When you contact customer support about an error, have the error codes and messages ready. 

CAUTION: When an error occurs, the print data remaining on the printer and the information accumulated in the memory of 
the printer may be corrupted. 

NOTE: An error code is listed in an error message. 

NOTE: For error codes that are not listed in this chapter, refer to instructions in each error messages. 

Error Codes 

Error-Code What you can do 

004-310 Turn off the printer. Make sure that the tray is correctly installed, and turn on the printer. Contact customer 
support if this failure is repeated. 

009-340 Turn off the printer. Clean the CTD sensor with a clean dry cotton swab, and turn on the printer. Contact 
customer support if this failure is repeated. For more information about cleaning the CTD sensor, see 
"Cleaning the CTD Sensor." 

009-360 Turn off the printer. Make sure that the yellow toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-361 Turn off the printer. Make sure that the magenta toner cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-362 Turn off the printer. Make sure that the cyan toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-363 Turn off the printer. Make sure that the black toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-367 Turn off the printer. Make sure that the yellow toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-368 Turn off the printer. Make sure that the magenta toner cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-369 Turn off the printer. Make sure that the cyan toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

009-370 Turn off the printer. Make sure that the black toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

010-317 Turn off the printer, wait for 30 minutes to let the fusing unit cool, and then make sure that the fusing unit 
is fully installed. For more information about installing the fusing unit, see "Replacing the Fusing Unit." 

010-351 Turn off the printer. Remove the used fusing unit, and install a new fusing unit. For more information about 
replacing the fusing unit, see "Replacing the Fusing Unit." 
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Error-Code What you can do 

010-377 Turn off the printer. Confirm that the fusing unit is correctly installed, and turn on the printer. Contact 
customer support if this failure is repeated. For more information about installing the fusing unit, see 
"Replacing the Fusing Unit." 

016-316 Turn off the printer. Remove the optional 512MB memory module from the slot, and then reattach it firmly. 
Turn on the printer. Contact customer support if this failure is repeated. 

016-318 Remove the unsupported memory module. Contact customer support if this failure is repeated. 

016-338 Turn off the printer, and turn it on again. If the error message remains on the LCD panel, confirm that the 
wireless adapter is securely inserted. Contact customer support if this failure is repeated. 

016-404 Contact your system administrator. For more information about digital certificate problems, see "Digital 
Certificate Problem." 

016-405 Security setting mismatch. Initialize the security setting, and then restart the printer. Contact your system 
administrator for the security resetting. 

016-520 IPsec certificate error. (Certificate error of the printer.) The certificate of the printer is invalid. Contact your 
system administrator. Reset the certificate from other connectable clients with Dell™ Printer 
Configuration Web Tool. If no device can be connected, disconnect Ethernet cable, turn off the IPsec, and 
then reset the certificate with Dell Printer Configuration Web Tool. 

016-521 IPsec certificate error. (Remote device certification verification error.) The certificate of the destination 
client is invalid. Contact your system administrator. Confirm the certificate of the destination client and 
reset. 

016-522 LDAP certificate error. (No client certificate exists.) The SSL client certificate is requested by the LDAP 
server.  Set the SSL client certificate to the device. Contact your system administrator. 

016-523 LDAP certificate error. (Server certificate verification error.) The SSL certificate of the LDAP server is not 
trusted by the device. Register the root certificate of the SSL certificate of the LDAP server with the device. 

016-524 LDAP certificate error. (No server certificate exists.) Change the SSL certificate of the LDAP server to a 
valid SSL certificate. 

016-527 LDAP certificate error. (SSL authentication internal error.) The error has occurred inside the program. 
Contact your system administrator. 

016-534 The LDAP server information setting for ColorTrack PRO is invalid. Check the LDAP server setting of the 
printer. 

016-541 A wireless certificate (server or client) cannot be correctly referenced while using Wireless LAN 
WPA-Enterprise or WPA2-Enterprise. Ask your system administrator to connect the printer with a wired 
network, initialize the wireless settings, import the wireless certificate, and set WPA-Enterprise or 
WPA2-Enterprise again. 

016-542 A server certificate error has occurred when acquiring the certificate with the operation of WPA-Enterprise 
or WPA2-Enterprise. This is a problem in the server certificate, such as the validity period has expired for 
the server certificate being used with the Radius server. Ask your system administrator to confirm the server 
certificate being used with the Radius server. 

016-543 A wireless certificate (server or client) corruption error has occurred while using the Wireless LAN 
WPA-Enterprise or WPA2-Enterprise. Ask your system administrator to connect the printer with a wired 
network, initialize the wireless settings, import the wireless certificate, and set WPA-Enterprise or 
WPA2-Enterprise again. 

016-720 Error relating to PDL emulation problems has occurred. Change the Print Mode setting in the Graphics tab 
of the printer driver. Contact customer support if this failure is repeated. 

016-756 Printing in the prohibited time. Contact your system administrator. 

016-757 The account is not registered. Contact your system administrator. 

016-758 The function cannot be used. Contact your system administrator. 

016-759 Printable page limit is exceeded. Contact your system administrator. 
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Error-Code	 What you can do 

016-799	 Press the (Set) button to clear the message and cancel the current print job. Confirm the 
configuration of the printer on the printer driver. 

016-930 The device is not supported. Remove it from the front USB port. 

016-931 The USB hub is not supported. Remove it from the front USB port. 

024-920 Remove the paper from the output tray. 

024-927 Remove the empty toner cartridge, and install a new cartridge. For more information about replacing the 
toner cartridge, see "Replacing the Toner Cartridges." 

024-965	 Confirm that the size and type specified in the tray settings matches the size and type of paper loaded in the 
tray. 024-966 

024-969 

027-446 Change the IPv6 address to avoid duplication. Turn off the printer, and turn it on again. 

027-452 Change the IPv4 address to avoid duplication. Turn off the printer, and turn it on again. 

042-700 Wait for a while until the printer cools down. Contact customer support if this failure is repeated. 

075-910 Make sure that the multipurpose feeder (MPF) is fully installed. 

077-300 Close the front cover. 

077-301 Close the right side cover. 

077-302 Close the rear cover. 

091-911 Remove the used waste toner box, and install a new toner box. For more information about replacing the 
waste toner box, see "Replacing the Waste Toner Box." 

091-914 Reinsert the black drum cartridge. If the message remains, replace the cartridge. For more information 
about reinserting the drum cartridge, see "Replacing the Drum Cartridges." 

091-917 Reinsert the yellow drum cartridge. If the message remains, replace the cartridge. For more information 
about reinserting the drum cartridge, see "Replacing the Drum Cartridges." 

091-918 Reinsert the magenta drum cartridge. If the message remains, replace the cartridge. For more information 
about reinserting the drum cartridge, see "Replacing the Drum Cartridges." 

091-919 Reinsert the cyan drum cartridge. If the message remains, replace the cartridge. For more information about 
reinserting the drum cartridge, see "Replacing the Drum Cartridges." 

091-921 Make sure that the black drum cartridge is fully installed. For more information about installing the drum 
cartridge, see "Replacing the Drum Cartridges." 

091-922 Make sure that the yellow drum cartridge is fully installed. For more information about installing the drum 
cartridge, see "Replacing the Drum Cartridges." 

091-923 Make sure that the magenta drum cartridge is fully installed. For more information about installing the 
drum cartridge, see "Replacing the Drum Cartridges." 

091-924 Make sure that the cyan drum cartridge is fully installed. For more information about installing the drum 
cartridge, see "Replacing the Drum Cartridges." 

091-931 Remove the used black drum cartridge, and install a new cartridge. For more information about replacing 
the drum cartridge, see "Replacing the Drum Cartridges." 

091-932 Remove the used yellow drum cartridge, and install a new cartridge. For more information about replacing 
the drum cartridge, see "Replacing the Drum Cartridges." 

091-933 Remove the used magenta drum cartridge, and install a new cartridge. For more information about replacing 
the drum cartridge, see "Replacing the Drum Cartridges." 

091-934 Remove the used cyan drum cartridge, and install a new cartridge. For more information about replacing the 
drum cartridge, see "Replacing the Drum Cartridges." 

091-942 Reinsert the black drum cartridge. If the message remains, replace the cartridge. For more information 
about replacing the drum cartridge, see "Replacing the Drum Cartridges." 
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Error-Code	 What you can do 

091-943 Reinsert the yellow drum cartridge. If the message remains, replace the cartridge. For more information 
about replacing the drum cartridge, see "Replacing the Drum Cartridges." 

091-944 Reinsert the magenta drum cartridge. If the message remains, replace the cartridge. For more information 
about replacing the drum cartridge, see "Replacing the Drum Cartridges." 

091-945 Reinsert the cyan drum cartridge. If the message remains, replace the cartridge. For more information about 
replacing the drum cartridge, see "Replacing the Drum Cartridges." 

091-960 Remove the unsupported yellow drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges." 

091-961 Remove the unsupported magenta drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges." 

091-962 Remove the unsupported cyan drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges." 

091-963 Remove the unsupported black drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges." 

092-651 Clean the CTD sensor with a clean dry cotton swab. For more information about cleaning the CTD sensor, 
see "Cleaning the CTD Sensor." 

093-930 Remove the used yellow toner cartridge, and install a new cartridge. For more information about replacing 
the toner cartridge, see "Replacing the Toner Cartridges." 

093-931 Remove the used magenta toner cartridge, and install a new cartridge. For more information about replacing 
the toner cartridge, see "Replacing the Toner Cartridges." 

093-932 Remove the used cyan toner cartridge, and install a new cartridge. For more information about replacing the 
toner cartridge, see "Replacing the Toner Cartridges." 

093-933 Remove the used black toner cartridge, and install a new cartridge. For more information about replacing 
the toner cartridge, see "Replacing the Toner Cartridges." 

093-960 Remove the unsupported yellow toner cartridge, and install a supported toner cartridge. For more 
information about installing the toner cartridge, see "Replacing the Toner Cartridges." 

093-961 Remove the unsupported magenta toner cartridge, and install a supported toner cartridge. For more 
information about installing the toner cartridge, see "Replacing the Toner Cartridges." 

093-962 Remove the unsupported cyan toner cartridge, and install a supported toner cartridge. For more information 
about installing the toner cartridge, see "Replacing the Toner Cartridges." 

093-963 Remove the unsupported black toner cartridge, and install a supported toner cartridge. For more 
information about installing the toner cartridge, see "Replacing the Toner Cartridges." 

093-970 Make sure that the yellow toner cartridge is fully installed. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

093-971 Make sure that the magenta toner cartridge is fully installed. For more information about installing the 
toner cartridge, see "Replacing the Toner Cartridges." 

093-972 Make sure that the cyan toner cartridge is fully installed. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

093-973 Make sure that the black toner cartridge is fully installed. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges." 

094-422	 Remove the used transfer belt unit, and install a new transfer belt unit. For more information about 
replacing the transfer belt unit, see "Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

094-910 Make sure that the transfer belt unit is fully installed. For more information about installing the transfer belt 
unit, see "Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd BTR), and the Retard Roller." 
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Error-Code What you can do 

094-911 Remove the used transfer belt unit, and install a new transfer belt unit. For more information about 
replacing the transfer belt unit, see "Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

193-700 When genuine toner cartridges are installed, change the Non-Dell Toner setting to disable using the Dell 
Printer Configuration Web Tool or the Tool Box. 
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Specifications 

Operating System Compatibility 
Your Dell™ C3760n/C3760dn Color Laser Printer is compatible with Microsoft® Windows® XP, Windows XP 64-bit 
Edition, Windows Server® 2003, Windows Server 2003 x64 Edition, Windows Server 2008, Windows Server 2008 
64-bit Edition, Windows Server 2008 R2 64-bit Edition, Windows Vista®, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2012, Mac OS X 10.3.9, 
10.4.11, 10.5, 10.6, 10.7, 10.8, Red Hat® Enterprise Linux® 5/6 Desktop (x86), and SUSE® Linux Enterprise 
Desktop 10/11 (x86). 

Power Supply 

Rated voltage 220 VAC - 240 VAC 110 VAC - 127 VAC 

Frequency 50/60 Hz 50/60 Hz 

Current 5 A or less 9 A or less 

Power consumption 65.0 W (Ready) 76.0 W (Ready) 

13.5 W (Sleep) 13.5 W (Sleep) 

4.5 W (Deep Sleep) 4.5 W (Deep Sleep) 

0 W (Offline) 0 W (Offline) 

TEC value 3.1 kWh 3.1 kWh 

Dimensions 
Height: 379 mm (14.92 inches) Width: 439 mm (17.28 inches) Depth: 485 mm (19.09 inches) 

Weight (including toner cartridges and drum cartridges): 25.7 kg (56.66 lb) 

Memory 

Base memory 256 MB 

Maximum memory 768 MB (256 MB + 512 MB) 

Connector 144 pin EP2-2100 DDR2 SDRAM 
32b-SO-DIMM 

DIMM size 512 MB 

Speed EP2-2100 

Page Description Language (PDL)/Emulation, Operating System, and 
Interface 

PDL/Emulations PCL 6, PCL5e, PostScript, HBPL, XPS (Host Based) 
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Operating systems	 Microsoft Windows XP/XP x64/Server 2003/Server 2003 x64/Server 2008/Server 2008 x64/Server 2008 
R2 x64/Vista/Vista x64/7/7 x64/8/8 x64/Server 2012, Mac OS X (10.3.9/10.4.11/10.5/10.6/10.7/10.8), 
Red Hat Enterprise Linux 5/6 Desktop (x86), and SUSE Linux Enterprise Desktop 10/11 (x86) 

Interfaces Standard local: USB 2.0 

Standard network: 10Base-T/100Base-TX/ 
1000Base-T Ethernet 

Optional network: IEEE 802.11b/802.11g/802.11n (Wireless) 

MIB Compatibility 
Management Information Base (MIB) is a database containing information about network devices (such as adapters, 
bridges, routers, or computers). This information helps network administrators manage the network (analyze 
performance, traffic, errors, and so on). Dell C3760n/C3760dn Color Laser Printer complies with standard industry 
MIB specifications, allowing the printer to be recognized and managed by various printer and network management 
software systems. 

Environment 

Operation 

Temperature 

Relative humidity 

10 °C - 32 °C 

10 % - 85 % RH (no condensation) 

Print Quality Guarantee 

Temperature 

Relative humidity 

15 °C - 28 °C 

20 % - 70 % RH (no condensation) 

Storage 

Temperature range 

Storage humidity range 

-20 °C to 40 °C (0 °F to 104 °F) 

5 % - 85 % RH (no condensation) 

Altitude 

Operating	 Up to 3,100 m (10,170 feet) 

Storage 	 Up to 3,100 m (10,170 feet) 
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Cables 
Your interconnection cable must meet the following requirements: 

Connection type Connection specifications and symbols 

1 Ethernet 10Base-T/100Base-TX/ 
1000Base-T 

2 Wireless adapter socket IEEE 802.11b/802.11g/802.11n 

3 USB 	 USB 2.0 

1 

2 

3 

Optional Wireless Adapter 

Item 	 Description 

Connectivity technology 	 Wireless 

Compliant standards 	 IEEE 802.11b, 802.11g, and 802.11n 

Bandwidth 	 2.4 GHz 

Data transfer rate 	 IEEE 802.11n: 65 Mbps 
IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps 
IEEE 802.11b: 11, 5.5, 2, and 1 Mbps 

Security 	 64 (40-bit key)/128 (104-bit key) WEP, 
WPA- PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES)*1*2 , 
WPA2-Enterprise (AES)*1*2 

Wi-Fi Protected Setup® (WPS)*3 Push-Button Configuration (PBC), 
Personal Identification Number (PIN) 

*1: This item is available only when the optional hard disk is installed. 
*2: EAP method supports PEAPv0, EAP-TLS, EAP-TTLS PAP, and EAP-TTLS CHAP. 
*3: WPS 2.0 compliant. 
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Maintaining Your Printer 
You need to complete certain tasks to maintain optimum print quality. 

NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

Determining the Status of Supplies 
If your printer is connected to the network, the Dell Printer Configuration Web Tool can provide instant feedback 
on remaining toner levels. Type the printer's IP address in your web browser to view this information. To use the E-
Mail Alert Setup feature that notifies you when the printer requires new supplies, type the desired e-mail address in 
the e-mail list box. 

On the LCD panel screen, you can also confirm the following: 

•	 Any supply or maintenance items that require attention replacing (However, the printer can only display 

information about one item at a time).
 

•	 Amount of toner remaining in each toner cartridge. 

Conserving Supplies 
You can change several settings in your printer driver to conserve toner cartridge and paper. 

Supply Setting Function 

Toner cartridge Toner Saver in the Others tab This check box allows the users to select a print mode that uses less 
toner. The image quality will be lower when this feature is used. 

Print media Multiple Up in the Layout tab The printer prints two or more pages on one side of a sheet. 

Print media Duplex in the General tab The printer prints on both sides of a sheet of paper. 

Ordering Supplies 
You can order consumables (toner cartridges, drum cartridges, and waste toner box) from Dell on the Internet when 
using a networked printer. Type the IP address of your printer in your web browser, launch the Dell Printer 
Configuration Web Tool, and click the Order Supplies at: to order consumables for your printer. 

You can also order consumables by the following method. 

1	 Click Start→ All Programs→ Dell Printers→ Additional Color Laser Software→ Dell Supplies Management 
System. 

The Dell Supplies Management System window appears. 

2 Select your printer from the Select Printer Model list. 

3	 If ordering from the web:
 

a Select a URL from the Select Reorder URL list.
 

b Click Visit Dell printer supplies ordering web site.
 

NOTE: When you cannot get information from the printer automatically by two-way communication, a window that 

prompts you to type the Service Tag appears. Type your Dell printer Service Tag in the field provided. 

Your Service Tag number is located inside the front cover of your printer.
 

4 If ordering by phone, call the number that appears under the Order by Phone heading. 
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Storing Print Media 
To avoid potential paper feeding problems and uneven print quality, there are several things you can do: 

•	 To achieve the best possible print quality, store print media in an environment where the temperature is 

approximately 21 °C (70 °F) and the relative humidity is 40 %.
 

•	 Store cartons of print media on a pallet or shelf, rather than directly on the floor. 

•	 If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
the edges do not buckle or curl. 

•	 Do not place anything on top of the print media packages. 

Storing Consumables 
Store consumables in their original packaging until you need to use them. Do not store consumables in: 

•	 Temperatures greater than 40 °C (104 °F). 

•	 An environment with extreme changes in humidity or temperature. 

•	 Direct sunlight. 

•	 Dusty places. 

•	 A car for a long period of time. 

•	 An environment where corrosive gases are present. 

•	 A humid environment. 
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Replacing the Toner Cartridges 
WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 
Information Guide. 

Dell toner cartridges are available only through Dell. You can order cartridges online at http://www.dell.com/supplies
 
or by phone. To order by phone, see "Contacting Dell."
 

It is recommended to use Dell toner cartridges for your printer. Dell does not provide warranty coverage for problems 

caused by using accessories, parts, or components not supplied by Dell.
 

WARNING: Never throw used toner cartridges into fire. The residual toner could explode resulting in burns and injuries. 

WARNING: Do not shake the used toner cartridge. This may cause toner spills. 

Removing the Toner Cartridge 

NOTE: Ensure that you remove all the paper from the MPF and close the MPF cover before removing the toner cartridge. 

1 Grasp the grips on both sides of the front cover, and then pull it down to open. 

2 Grasp the handle on the toner cartridge that you want to replace, and then pull it out. 

WARNING: Do not shake the toner cartridge as it may cause toner spills. 

Maintaining Your Printer 315 

http://www.dell.com/supplies


Installing a Toner Cartridge 
1 Unpack a new toner cartridge of the desired color. 

2 Shake the new toner cartridge five or six times to distribute the toner evenly. 

3 Insert the toner cartridge into the associated cartridge slot, and then push until it stops. 

4 Close the front cover. 
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Replacing the Drum Cartridges 
You need to replace all drum cartridges (yellow, magenta, cyan, and black) at a time. 

WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 
Information Guide. 

CAUTION: Protect the drum cartridges against bright light. If the right side cover remains open for more than three minutes, 
print quality may deteriorate. 

Removing the Drum Cartridge 
1 Open the right side cover. 

2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box. 
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4 

Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out. 

CAUTION: Take care not to drop the waste toner box while you are removing it. 

CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands. 

Stand the removed waste toner box upright on a level surface. 

WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills. 
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5 Slightly pressing down the tab on the drum cartridge that you want to replace, pull it out halfway with one hand. 

6 Support the drum cartridge with the other hand from underneath, and then pull it out completely. 

7 Repeat the steps 5 and 6 to remove the other three cartridges. 

Installing a Drum Cartridge 
1 Unpack a new drum cartridge of the desired color. 

2 Remove the orange protective cover from the drum cartridge. 

3 Insert the drum cartridge into the associated cartridge slot, and then push until it stops. 

4 Repeat the steps 1 to 3 to insert the other three cartridges. 
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5 Remove the cleaning rod from inside the printer. 

6 Remove the cleaning pad by pressing the white tabs between your thumb and index finger.
 

7 Unpack a new cleaning pad.
 

8 Attach the new cleaning pad to the cleaning rod.
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9 Insert the cleaning rod fully into one of the four holes until it clicks into the interior of the printer as illustrated 
below, and then pull it out. 

10 Repeat step 9 also on the other three holes. One time insertion is enough for each hole. 

11 Return the cleaning rod to its original location. 

12 Reinsert the removed waste toner box.

 CAUTION: If the waste toner box does not fit into place properly, make sure that the drum cartridge is fully inserted in 
the previous step. 
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13 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box. 

14 Close the right side cover. 

Replacing the Fusing Unit
 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 

Information Guide. 

Removing the Fusing Unit 
1 Turn off the printer and wait for 30 minutes. 

2 Push down the latch to open the rear cover. 
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3 Grasp the grips on both sides of the fusing unit squeezing the lever under the left side grip, and then pull out the 
unit. 

Installing a Fusing Unit 
1 Unpack a new fusing unit. 

2 Make sure that the two tabs of the fusing unit align with the grooves on the printer, and then insert it into the 
printer until it clicks. 

3 Close the rear cover.

 NOTE: After replacing the fusing unit, be sure to initialize its life counter by following the instructions in the accompanying 
manual. 
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Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd BTR), 
and the Retard Roller 
You need to replace all three parts (transfer belt unit, 2nd BTR, and retard roller) at a time. Both the 2nd BTR and 
the retard roller for replacement come with a new transfer belt unit.

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 
Information Guide.

 CAUTION: Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil 
from your hands on the film of the transfer belt unit may reduce print quality. 

Removing the Transfer Belt Unit 
1 Push down the latch to open the rear cover. 

2 Open the right side cover. 

3 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box. 

Maintaining Your Printer 324 



   

  

   

4 

5 

Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out. 

CAUTION: Take care not to drop the waste toner box while you are removing it. 

CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands. 

Stand the removed waste toner box upright on a level surface. 

WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills. 

Maintaining Your Printer 325 



6 Open the top cover. 

7 Put your fingers through the loops on both sides of the transfer belt unit, and then pull it out.

 CAUTION: If you cannot pull out the unit from the printer, make sure that all of the above procedures are performed 
properly. 

8 Clean the CTD sensor (as shown) with a clean, dry cotton swab. 
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Installing a Transfer Belt Unit 
1 Unpack a new transfer belt unit. 

2 Remove the two orange packing materials first, and then the protective sheet from the transfer belt unit. 

CAUTION: Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, 
or oil from your hands on the film of the transfer belt unit may reduce print quality. 

3 Make sure that the arrow marks on the transfer belt unit and the printer face each other, and then insert the unit 
into the printer until it clicks. 

4 Close the top cover. 
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5 Reinsert the removed waste toner box. 

CAUTION: If the waste toner box does not fit into place properly, make sure that the transfer belt unit is fully inserted. 

6 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box. 

7 Close the right side cover. 

NOTE: After replacing the transfer belt unit, be sure to initialize its life counter by following the instructions in the 
accompanying manual. 
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Removing the 2nd BTR 
Pinching the tabs on both sides of the 2nd BTR, lift it out of the printer. 

Installing a 2nd BTR 
1 Unpack a new 2nd BTR. 

2 Hold the 2nd BTR by both its ends. 

3	 Make sure that the arrow marks on the 2nd BTR and the printer face each other, and then press down the 2nd BTR 
until it clicks. 

4	 Close the rear cover. 
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Removing the Retard Roller in Tray1 
Pull tray1 out of the printer about 200 mm. 

2 Hold tray1 with both hands, and remove it from the printer. 

NOTE: Ensure that you remove all the paper from tray1 before removing the retard roller. 

3 Slightly pressing down the lock lever on tray1 to the right with one hand, raise the retard roller with the other hand. 
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4 Slide the retard roller to the left to remove it from tray1. 

Installing a Retard Roller in Tray1 
1 Slide the two axles of the retard roller into the holes on tray1. 

2 Press down the retard roller until it snaps. 

3 Load paper in tray1, and then insert the tray into the printer and push until it stops. 
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Replacing the Waste Toner Box 
WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 
Information Guide. 

Removing the Waste Toner Box 
Open the right side cover. 

2	 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box. 

3	 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out. 

CAUTION: Take care not to drop the waste toner box while you are removing it. 

CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands. 
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4 Insert the used waste toner box into the plastic bag that came with the new waste toner box and seal the bag. 

Installing a Waste Toner Box 
1 Unpack a new waste toner box. 

2 Insert the waste toner box. 

3 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box. 

4 Close the right side cover. 
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Cleaning Inside the Printer 

Cleaning the CTD Sensor 
Clean the Color Toner Density (CTD) sensor only when an alert for the CTD sensor is shown on the Status Monitor 
or LCD panel screen. 

1 Ensure that the printer is turned off. 

2 Push down the latch to open the rear cover. 

3 Open the right side cover. 

4 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box. 
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6 

Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out. 

CAUTION: Take care not to drop the waste toner box while you are removing it. 

CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands. 

Stand the removed waste toner box upright on a level surface. 

WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills. 
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Open the top cover. 

8 Put your fingers through the loops on both sides of the transfer belt unit, and then pull it out. 

9 Clean the CTD sensor (as shown) with a clean, dry cotton swab. 

7 
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10 Make sure that the arrow marks on the transfer belt unit and the printer face each other, and then insert the unit 
into the printer until it clicks. 

11 Close the top cover. 

12 Reinsert the removed waste toner box. 

CAUTION: If the waste toner box does not fit into place properly, make sure that the transfer belt unit is fully inserted. 
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13 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box. 

14 Close the right side cover. 

15 Close the rear cover. 

Cleaning the Raster Optical Scanner (ROS) Window 
To prevent deterioration of printing quality due to stains inside the printer, clean inside the printer regularly by using 
the cleaning rod whenever you replace drum cartridges. 

1 Open the right side cover. 
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Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box. 

3	 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out. 

CAUTION: Take care not to drop the waste toner box while you are removing it. 

CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands. 

4	 Stand the removed waste toner box upright on a level surface. 

2 

WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills. 
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5	 Remove the cleaning rod from inside the printer. 

6	 Insert the cleaning rod fully into one of the four holes until it clicks into the interior of the printer as illustrated 
below, and then pull it out. 

7	 Repeat step 6 also on the other three holes. One time insertion is enough for each hole. 
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Return the cleaning rod to its original location. 

9 Reinsert the removed waste toner box. 

10 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box. 

11 Close the right side cover. 

8 
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Adjusting Color Registration 
To adjust the color registration when you first install the printer or after moving it to a new location, follow the 
procedure below. 

• Printing the Color Registration Chart 

• Determining Values 

• Entering Values 

NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu. 

Printing the Color Registration Chart 

When Using the Operator Panel 

1 Press the (Menu) button.
 

2 Press the 
 button until Admin Settings is highlighted, and then press the (Set) button.
 

3 Press the 
 button until Maintenance is highlighted, and then press the (Set) button.
 

4 Press the 
 button until Color Reg Adjust is highlighted, and then press the (Set) button.
 

5 Press the 
 button until Color Regi Chart is highlighted, and then press the (Set) button.
 

6 Press the 
 button until Yes is highlighted, and then press the (Set) button.
 

The color registration chart is printed.
 

When Using the Tool Box 

1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer → Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box." 

The Tool Box opens.
 

2 Click the Printer Maintenance tab.
 

3 Select Maintenance from the list at the left side of the page.
 

The Maintenance page is displayed.
 

4 Click Start next to Print Color Regi Chart under Color Registration Adjustments.
 

The color registration chart is printed.
 

Determining Values 
On the color registration chart, there are two types of charts: Chart 1 (fast scan) and Chart 2 (slow scan). 
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Chart 1 (fast scan) 

Chart 2 (slow scan) 

The Chart 1 is used to adjust the color registration for the fast scan direction, which is vertical to paper feed 
direction. The Chart 2 is used to adjust the color registration for the slow scan direction, which is horizontal to paper 
feed direction. 

The following sections explain how to determine the adjustment values for the fast scan and the slow scan using 
Chart 1 and Chart 2. 

Fast Scan 

On the Chart 1 of the color registration chart, find the straightest lines where the two black lines and the colored line 
are most closely aligned for each color (LY, LM, LC, RY, RM, and RC). If you find the straightest line, make a note 
of the value (-8 to +8) indicated by the straightest line for each color. 

When the value is 0 for each color, you do not need to adjust the color registration for the fast scan. 

When the value is not 0, enter the value using the procedure in "Entering Values." 

Straightest line 
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NOTE: If it is difficult to choose only one value, as in the case that there seem to be two values closest to a straight line, take the 
value between the two. For example, in the figure above, -6 and -8 are the values closest to a straight line, so you would enter the 
value -7. 

Slow Scan 

On the Chart 2 of the color registration chart, find the medium line within the range of white area for each color 
pattern (PY, PM, and PC). If you find the medium line, make a note of the value (-9 to +9) indicated by the 
medium line for each color. 

When the value is 0 for each color, you do not need to adjust the color registration for the slow scan. 

When the value is not 0, enter the value using the procedure in "Entering Values." 

Lattice pattern 

Entering Values 

When Using the Operator Panel 

Using the operator panel, enter the values found in the color registration chart to make adjustments. 

1 Press the (Menu) button. 

2 Press the button until Admin Settings is highlighted, and then press the (Set) button. 

3 Press the button until Maintenance is highlighted, and then press the (Set) button. 

4 Press the button until Color Reg Adjust is highlighted, and then press the (Set) button. 

5 Press the button until Enter Number is highlighted, and then press the (Set) button. 

6 Ensure that LY is highlighted and press the or  button to specify the values. 

7 Press the button to move the highlight to the next value. 

8 Press the (Set) button. 

RY is highlighted. 

9 Repeat steps 6 to 8 to enter the desired values, and then press the (Set) button. 
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NOTE: You can specify each value for process, left, and right colors (LY, LM, LC, RY, RM, RC, PY, PM, and PC) by repeating the 
steps 6 to 8. 

NOTE: The registration values are always shown as 0 the next time you enter the menu.
 

10 Press the 
 button until Color Regi Chart is highlighted, and then press the (Set) button.
 

11 Press the 
 button until Yes is highlighted, and then press the (Set) button.
 

The color registration chart with the new values is printed.
 

If the straightest line is not at the value of 0, adjust the values again. Checking the charts before and after the 
adjustments will help you to determine the values to enter. 

When Using the Tool Box 

Using the Tool Box, enter the values that you found in the color registration chart to make adjustments. 

1 Click Start→ All Programs→ Dell Printers→ Dell C3760 Color Laser Printer→ Tool Box. 

NOTE: For details about starting the Tool Box, see "Starting the Tool Box." 

The Tool Box opens. 

2 Click the Printer Maintenance tab. 

3 Select Maintenance from the list at the left side of the page. 

The Maintenance page is displayed. 

4 Specify each value for process, left, and right colors in Registration Adjustments under Manual Registration 
Adjustments, and then click Apply New Settings. 

5 Click Start next to Print Color Regi Chart under Color Registration Adjustments. 

The color registration chart is printed with the new values. 

6 Adjust till all straight lines are at the value of 0. Show image of before and after adjustment will help. 

After printing the color registration chart, do not turn off the printer until the printer motor has stopped running. 

NOTE: If 0 is not next to the straightest lines, determine the values and adjust the printer again. 
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Removing Options 
If the printer location needs to change or the printer and print media handling options need to be shipped to a new 
location, all print media handling options must be removed from the printer. For shipping, pack the printer and print 
media handling options securely to avoid damage.

 NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

Removing the Optional Memory Module
 WARNING: When you remove the optional memory module, be sure to turn off the printer, unplug the power cable, and 


disconnect all cables from the back of the printer before starting these tasks.


1 Ensure that the printer is turned off.


2 Turn the screw on the left side cover counterclockwise.


3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 

27
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Push the clips on both sides of the slot outward to raise the memory module up. 

6 Hold the memory module and pull it straight out. 

7 Close the left side cover, and then slide it towards the front of the printer. 

8 Turn the screw clockwise. 

5 

9 Turn on the printer. 
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Removing the Optional 550-Sheet Feeder
 WARNING: When you remove the optional 550-sheet feeder (Tray2), be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks. 

1 Ensure that the printer is turned off, and then disconnect all cables from the back of the printer. 

2 Pull the tray1 out of the printer about 200 mm. 

3	 Hold tray1 with both hands, and remove it from the printer. 

4	 Remove the two screws joining the printer and the optional 550-sheet feeder by unscrewing them with a coin or 
similar object. 
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Gently lift the printer off the optional 550-sheet feeder, and place it on a level surface. 

WARNING: Two people are required to lift the printer. 

6 Insert the tray1 into the printer, and push until it stops. 

5 

CAUTION: Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer. 

7 Re-connect all cables into the back of the printer and turn on the printer. 
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Removing the Optional Wireless Adapter
 WARNING: When you remove the optional wireless adapter, be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks. 

1 Ensure that the printer is turned off. 

2 Turn the screw on the left side cover counterclockwise to remove it. 

3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 
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Remove the wireless adapter from the printer by releasing the adapter's hook while pushing the wireless adapter 
towards the front of the printer. 

6 Close the left side cover, and then slide it towards the front of the printer. 

7 Turn the screw clockwise. 

5 

8 Turn on the printer. 
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Removing the Optional Hard Disk 
 WARNING: When you remove the optional wireless adapter, be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks. 

1 Ensure that the printer is turned off. 

2 Turn the screw on the control board counterclockwise 

3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 
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Remove the hard disk from the printer by releasing the hook of hard disk. 

6 Close the left side cover, and then slide it towards the front of the printer. 

7 Turn the screw clockwise. 

5 

8 Turn on the printer. 
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Clearing Jams
 
Careful selection of appropriate print media and proper loading allow you to avoid paper jams. See "Print Media 
Guidelines" for more information. 

NOTE: The images used in this manual are those of the Dell™ C3760dn Color Laser Printer unless otherwise mentioned. 

NOTE: Before buying large quantities of any print media, it is recommended to try a sample first. 

Avoiding Jams 
•	 Use only recommended print media. See "Print Media Guidelines" for more information. 

•	 See "Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" and "Loading Print Media in the MPF" to 
load print media properly. 

•	 Do not overload the print media sources. Ensure that the print media stack height does not exceed the maximum 
height indicated by the load-line labels in the tray. 

•	 Do not load wrinkled, creased, damp, or curled print media. 

•	 Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a 
time through the multipurpose feeder (MPF). 

•	 Do not use print media that you have cut or trimmed yourself. 

•	 Do not mix print media sizes, weights, or types in the same print media source. 

•	 Ensure that the recommended print side is face up when you insert the print media. 

•	 Keep print media stored in an acceptable environment. For more information, see "Storing Print Media." 

•	 Do not remove the feeding tray during a print job. 

•	 Push tray1 or the optional 550-sheet feeder (tray2) in firmly after loading. 

•	 Ensure that all cables that connect to the printer are correctly attached. 

•	 Overtightening the guides may cause jams. 

•	 Wipe the retard rollers in the tray or MPF with a cloth that is slightly dampened with water if jams caused by 

misfeeding paper occur frequently.
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Identifying the Location of Paper Jams 
WARNING: Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path. 

1 

4 3 2 

1 Fusing Unit 

2 Tray1 

3 MPF 

4 Optional 550-Sheet Feeder 

Clearing Paper Jams From the MPF 
NOTE: To resolve the error displayed on the LCD panel, you must clear all print media from the print media path. 

If error code: 050-112 appears: 
1 Remove any paper loaded on the MPF 
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Grasp both sides of the MPF, and then pull it out of the printer. 

3 Pull tray1 out of the printer about 200 mm. 

4 Hold tray1 with both hands, and remove it from the printer. 

2 
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Remove the jammed paper. 

6 Insert tray1 into the printer, and push until it stops. 

7 Insert the MPF into the printer. 

5 

If error code: 050-129 appears: 
Follow the instructions in "If error code: 050-129 appears:" to clear paper jams. 
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Clearing Paper Jams From Tray1 
NOTE: To resolve the error displayed on the LCD panel, you must clear all print media from the print media path. 

Pull tray1 out of the printer about 200 mm. 

2 Hold tray1 with both hands, and remove it from the printer. 

3 Remove the jammed paper. 

1 
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Insert tray1 into the printer, and push until it stops. 

5 Press the (Set) button. 

Clearing Paper Jams From the Fusing Unit
 NOTE: To resolve the error displayed on the LCD panel, you must clear all print media from the print media path. 

If error code: 050-111 appears: 
1 Push down the latch to open the rear cover. 

2 Lift the levers on both sides of the fusing unit. 

4 
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Hold and lower the tab to open the inner part. 

4 Remove the jammed paper. 

5 Replace the inner part. 

6 Press down the levers on both sides of the fusing unit, and then close the rear cover. 

3 
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If error code: 050-129 appears: 
Remove any paper loaded on the MPF 

2 Grasp both sides of the MPF, and then pull it out of the printer. 

3 Pull tray1 out of the printer about 200 mm. 

1 
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 Hold tray1 with both hands, and remove it from the printer. 

If you can see the jammed paper: 

a Remove the jammed paper. 

b Reinsert tray1 and the MPF into the printer. 

4 

If you cannot see the jammed paper: 

a Go to the next step. 
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Push down the latch to open the rear cover. 

6 Lift the levers on both sides of the fusing unit. 

7 Hold and lower the tab to open the inner part. 

5 
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Remove the jammed paper. 

9 Replace the inner part. 

10 Press down the levers on both sides of the fusing unit, and then close the rear cover. 

11 Insert tray1 into the printer, and push until it stops. 

8 
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12 Insert the MPF into the printer. 

Clearing Paper Jams From the Optional 550-Sheet Feeder 
NOTE: To resolve the error displayed on the LCD panel, you must clear all print media from the print media path. 

1 Pull the optional 550-sheet feeder out of the printer about 200 mm. 

2 Hold the optional 550-sheet feeder with both hands, and remove it from the printer. 
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Remove the jammed paper. 3 

4 Insert the optional 550-sheet feeder into the printer, and push until it stops. 
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Troubleshooting Guide 

Basic Printer Problems 
Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following: 

• The power cable is plugged into the printer and a properly grounded electrical outlet. 

• The printer is turned on. 

• The electrical outlet is not turned off at any switch or breaker. 

• Other electrical equipment plugged into the outlet is working. 

• All options are properly installed. 

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem. 

NOTE: If error messages are displayed on the LCD panel or on your computer screen, follow the on-screen instructions to 
resolve the printer problems. For details about error messages and error codes, see "Understanding Printer Messages." 

Display Problems 

Problem Action 

Menu settings changed from the operator Settings in the software program, the printer driver, or the printer utilities are 
panel have no effect. overriding the settings made on the operator panel. 

Printing Problems 
NOTE: If Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu. 

Problem Action 

Job did not print or incorrect characters Ensure that the top menu appears on the LCD panel before you send a job to 
printed. print. Press the (Menu) button to return to the top menu. 

Ensure that the print media is loaded in the printer. Press the (Menu) button 
to return to the top menu. 

Verify that the printer is using the correct page description language (PDL). 

Verify that you are using the correct printer driver. 

Ensure that the correct USB or Ethernet cable is securely connected to the printer. 

Verify that the correct print media size is selected. 

If you are using a print spooler, verify that the spooler has not stalled. 

Check the printer's interface from the Admin Settings. 

Determine the host interface you are using. Print a panel settings report to verify 
that the current interface settings are correct. 
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Problem Action 

Print media misfeeds or multiple feeds Ensure that the print media you are using meets the specifications for your printer. 
occur. See "Supported Paper Types" for more information. 

Fan the print media before loading it. 

Ensure that the print media is loaded correctly. 

Ensure that the width and length guides of the print media sources are adjusted 
correctly. 

Ensure that tray1, the optional 550-sheet feeder (tray2), or the multi-purpose 
feeder (MPF) unit is securely inserted. 

Do not overload tray1, the optional 550-sheet feeder, or the MPF. 

Do not force print media into the MPF when you load it; otherwise, it may skew or 
buckle. 

Ensure that the print media is not curled. 

Face the recommended print side up. See "Loading Print Media in Tray1 and the 
Optional 550-Sheet Feeder" for more information. 

Turn the print media over or around and try printing again to see if feeding 
improves. 

Do not mix print media types. 

Do not mix reams of print media. 

Remove the top and bottom curled sheets of a ream before loading the print 
media. 

Load print media only when tray1, the optional 550-sheet feeder, or the MPF is 
empty. 

Wipe the retard rollers in tray1, the optional 550-sheet feeder, or the MPF with a 
cloth moistened with water. 

The envelope is creased after printed. Make sure that the envelope is loaded in the MPF as instructed in "Loading an 
Envelope in the MPF." 

Page breaks in unexpected places. Increase the value for Time-Out using the operator panel, the Tool Box, or Dell™ 
Printer Configuration Web Tool. 

Print media does not stack neatly in the Turn the print media stack over in tray1 or the MPF. 
output tray. 

Cannot perform manual duplex printing. Select Flip on Short Edge or Flip on Long Edge from the Duplex drop-down 
menu on the General tab in the printer driver. 

Cannot print from tray1 or the optional 550- Load the print media into the MPF.
 
sheet feeder because the print media in 

tray1 or the optional 550-sheet feeder is 

curled.
 

Print Quality Problems 
NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer 
Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, see 
"Understanding the Printer Menus" and "Dell™ Printer Configuration Web Tool." 

• The output is too light 

• Toner smears or print comes off 

• Random spots/Blurred images 

• The entire output is blank 
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• Streaks appear on the output 

• Part or the entire output is black 

•  Pitched color dots  

•  Vertical blanks  

•  Ghosting  

• Light-induced fatigue 

•  Fog  

• Bead-Carry-Out (BCO) 

• Jagged characters 

•  Banding  

•  Auger mark  

• Wrinkled/Stained paper 

• Damage on the leading edge of paper 

The output is too light 

Action Yes No 

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner left in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor. 

The task is complete. Go to action 2. 

b Replace the toner cartridges as necessary. 

Does this solve your problem? 

2 If you are using non-Dell brand toner cartridges, enable the Non-Dell 
Toner option. 

a Launch the Tool Box, and click Maintenance on the Printer 
Maintenance tab. 

The task is complete. Go to action 3. 

b Ensure that the On check box under Non-Dell Toner is selected. 

Does this solve your problem? 

3 Disable the Toner Saver in the printer driver. 
a On the Others tab, ensure that Off is selected in the Toner Saver 

drop-down menu. 

The task is complete. Go to action 4. 

Does this solve your problem? 
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Action Yes No 

4 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick. 

The task is complete. Go to action 5. 

a On the General tab, change the Paper Type setting. 

Does this solve your problem? 

5 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer. 

The task is complete. Go to action 6. 

Does this solve your problem? 

6 Clean inside the printer by using the cleaning rod. See "Cleaning the 
Raster Optical Scanner (ROS) Window." 

a After the cleaning is completed, click Chart Print on the Diagnosis 
tab. 

The task is complete. Go to action 7. 

b Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

7 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click 4 Colors Configuration Chart. 

The task is complete. Contact Dell. 

The 4 Colors Configuration Chart is printed. 

Does this solve your problem? 

Toner smears or print comes off 

Action Yes No 

1 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick. 

The task is complete. Go to action 2. 

a On the General tab, change the Paper Type setting. 

Does this solve your problem? 

2 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer. 

The task is complete. Go to action 3. 

Does this solve your problem? 
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Action Yes No 

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, test print your document 

again. 

The task is complete. Go to action 4. 

Does this solve your problem? 

4 Replace the fusing unit. 
a Replace the fusing unit. See "Replacing the Fusing Unit." 
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab. 

The task is complete. Go to action 5. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

5 Replace the transfer belt unit, the 2nd Belt Transfer Roller (2nd BTR), 
and the retard roller. 

The task is complete. Contact Dell. 

a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 
"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Random spots/Blurred images 

Action Yes No 

1 Ensure that the toner cartridges are installed correctly. See "Installing a 
Toner Cartridge." 

The task is complete. Go to action 2. 

Does this solve your problem? 

2 Ensure that the drum cartridges are installed correctly. See "Installing a 
Drum Cartridge." 

The task is complete. Go to action 3. 

Does this solve your problem? 

Troubleshooting Guide 375 



 

   
   

 

 

  
 

 

 

   
 

  

     

 
  

 

   

Action Yes No 

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

The entire output is blank 

Action Yes No 

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner left in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor. 

The task is complete. Go to action 2. 

b Replace the toner cartridges as necessary. 

Does this solve your problem? 

2 If you are using non-Dell brand toner cartridges, enable the Non-Dell 
Toner option. 

a Launch the Tool Box, and click Maintenance on the Printer 
Maintenance tab. 

The task is complete. Go to action 3. 

b Ensure that the On check box under Non-Dell Toner is selected. 

Does this solve your problem? 

3 Disable the Toner Saver in the printer driver. 
a On the Others tab, ensure that Off is selected in the Toner Saver 

drop-down menu. 

The task is complete. Go to action 4. 

Does this solve your problem? 

4 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick. 

The task is complete. Go to action 5. 

a On the General tab, change the Paper Type setting. 

Does this solve your problem? 

5 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer. 

The task is complete. Go to action 6. 

Does this solve your problem? 
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Action Yes No 

6 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click 4 Colors Configuration Chart. 

The task is complete. Contact Dell. 

The 4 Colors Configuration Chart is printed. 

Does this solve your problem? 

Streaks appear on the output 

Action Yes No 

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner left in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor. 

The task is complete. Go to action 2. 

b Replace the toner cartridges as necessary. 

Does this solve your problem? 

2 If you are using non-Dell brand toner cartridges, enable the Non-Dell 
Toner option. 

a Launch the Tool Box, and click Maintenance on the Printer 
Maintenance tab. 

The task is complete. Go to action 3. 

b Ensure that the On check box under Non-Dell Toner is selected. 

Does this solve your problem? 

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click 4 Colors Configuration Chart. 

The task is complete. Contact Dell. 

The 4 Colors Configuration Chart is printed. 

Does this solve your problem? 
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Part or the entire output is black 

Action Yes No 

1 Ensure that the drum cartridges are installed correctly. See "Installing a 
Drum Cartridge." 

The task is complete. Go to action 2. 

Does this solve your problem? 

2 Ensure Output Color is set to Color in the printer driver. 
a On the Graphics tab, ensure that Output Color is set to Color. 

The task is complete. Go to action 3. 

Does this solve your problem? 

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click 4 Colors Configuration Chart. 

The task is complete. Contact Dell. 

The 4 Colors Configuration Chart is printed. 

Does this solve your problem? 

Pitched color dots 

Action Yes No 

Locate the cause of the problem using the Pitch Configuration Chart. 
a Launch the Tool Box, and click Chart Print on the Diagnosis tab. 
b Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 
c Compare the pitch of the color spots on your output with that on the 

Pitch Configuration Chart, and locate the cause of the problem. 

Is the cause of the problem located? 

Proceed to the action Contact Dell.
 
corresponding to the 

location of the 

problem:
 

• Drum cartridge - 2 

• Fusing unit - 3 

• Transfer belt unit - 4 
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Action Yes No 

2 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

3 Replace the fusing unit. 
a Replace the fusing unit. See "Replacing the Fusing Unit." 
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab. 

The task is complete. Contact Dell. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

4 Replace the transfer belt unit, the 2nd BTR, and the retard roller. 
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab. 

c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Vertical blanks 

Action Yes No 

1 Clean inside the printer by using the cleaning rod. See "Cleaning the 
Raster Optical Scanner (ROS) Window." 

a After the cleaning is completed, click Chart Print on the Diagnosis 
tab. 

The task is complete. Go to action 2. 

b Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 
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Action Yes No 

2 Ensure the light path is not covered. 
a Remove the drum cartridges, and keep them in the dark place. See 

"Removing the Drum Cartridge." 
b Check the light path, and then remove the shielding. 
c Re-install the drum cartridges. See "Installing a Drum Cartridge." 
d Launch the Tool Box, and click Chart Print on the Diagnosis tab. 
e Click Pitch Configuration Chart. 

The task is complete. Go to action 3. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Ghosting 

Action Yes No 

1 Locate the cause of the problem using the Ghost Configuration Chart. Proceed to the action Contact Dell. 
a Launch the Tool Box, and click Chart Print on the Diagnosis tab. corresponding to the 

b Click Ghost Configuration Chart. type of ghosting. 

The Ghost Configuration Chart is printed. Positive ghost - 2a 

Is the type of the problem identified? Negative ghost - 2b 

2a Replace the drum cartridges. The task is complete. Contact Dell. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click Ghost Configuration Chart. 

The Ghost Configuration Chart is printed. 

Does this solve your problem? 

2b If you are using non-recommended print media, use the print media The task is complete. Go to action 3. 
recommended for the printer. 

Does this solve your problem? 
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3 

Action Yes No 

Adjust the transfer bias. The task is complete. Contact Dell. 
a On the operator panel, press the (Menu) button and select 
Admin Settings→ Maintenance→ Adjust Transfer 

Belt Unit. 


b Select K Offset or YMC Offset, and then decrease the value.
 
c Launch the Tool Box, and click Chart Print on the Diagnosis tab.
 
d Click Ghost Configuration Chart.
 

The Ghost Configuration Chart is printed.
 

Does this solve your problem?
 

Light-induced fatigue 

Action Yes No 

1 Check the light fatigue pattern using the Pitch Configuration Chart. 
a Launch the Tool Box, and click Chart Print on the Diagnosis tab. 
b Click Pitch Configuration Chart. 

Go to action 2. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does the pattern on the output match with that on the Pitch 
Configuration Chart? 

2 Replace the drum cartridges. See "Replacing the Drum Cartridges." The task is complete. Contact Dell. 

Does this solve your problem? 

Troubleshooting Guide 381 



   
   

 

 

 

  

  
  

 

 

Fog 

Action Yes No 

1 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click 4 Colors Configuration Chart. 

The task is complete. Contact Dell. 

The 4 Colors Configuration Chart is printed. 

Does this solve your problem? 

Bead-Carry-Out (BCO) 

Action Yes No 

1 If the printer is installed in a high altitude location, set the altitude of 
the location. 

The task is complete. Go to action 2. 

a Launch the Tool Box, and click Maintenance on the Printer 
Maintenance tab. 

b Under Adjust Altitude, select the value close to the altitude of the 
location where the printer is installed. 

Does this solve your problem? 

2 Replace the drum cartridges. See "Replacing the Drum Cartridges." The task is complete. Contact Dell. 

Does this solve your problem? 
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Jagged characters 

Action Yes No 

1 Set Screen to Fineness in the printer driver. 
a On the Others tab, set Screen under Items: to Fineness. 

The task is complete. Go to action 2. 

Does this solve your problem? 

2 Set Print Mode to High Quality in the printer driver. 
a On the Graphics tab, select High Quality from Print Mode. 

The task is complete. Go to action 3. 

Does this solve your problem? 

3 Enable Bitmap Smoothing in the printer driver. 
a On the Others tab, set Bitmap Smoothing under Items: to On. 

The task is complete. Go to action 4. 

Does this solve your problem? 

4 Enable Print Page Mode in the printer driver. 
a On the Others tab, set Print Page Mode under Items: to On. 

The task is complete. Go to action 5. 

Does this solve your problem? 

5 If using a downloaded font, ensure that the font is recommended for the 
printer, operating system, and the application being used. 

The task is complete. Contact Dell. 

Does this solve your problem? 

Banding 

Action Yes No 

1 Locate the cause of the problem using the Pitch Configuration Chart. Proceed to the action Contact Dell. 
a Launch the Tool Box, and click Chart Print on the Diagnosis tab. 
b Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Is the cause of the problem located? 

corresponding to the 
location of the 
problem: 

• Drum cartridge - 2 

• Fusing unit - 3  

• Transfer belt unit - 4  
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Action Yes No 

2 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab. 
c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

3 Replace the fusing unit. 
a Replace the fusing unit. See "Replacing the Fusing Unit." 
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab. 

The task is complete. Contact Dell. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

4 Replace the transfer belt unit, the 2nd BTR, and the retard roller. 
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab. 

c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Auger mark 

Action Yes No 

1 Locate the cause of the problem using the Pitch Configuration Chart. 
a Launch the Tool Box, and click Chart Print on the Diagnosis tab. 
b Click Pitch Configuration Chart. 

Go to action 2. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does the output match with the pattern for auger mark? 

2 Replace the drum cartridges. See "Replacing the Drum Cartridges." The task is complete. Contact Dell. 

Does this solve your problem? 

Troubleshooting Guide 384 



  

   

    

 

  

  

Wrinkled/Stained paper 

Action Yes No 

1 Verify that the correct print media is being used. See "Supported Paper The task is complete. If printing on an 
Types." If not, use the print media recommended for the printer. envelope, go to action 

Does this solve your problem? 2. 

If printing on print 
media other than 
envelopes, contact Dell. 

2 Check the wrinkle. Is the wrinkle within 30 mm of the four edges of the This type of wrinkle is Go to action 3. 
envelope? considered normal. 

Your printer is not at 
fault. 

3 Load the envelopes in the MPF properly. For details, see "Loading an The task is complete. Contact Dell. 
Envelope in the MPF." 

Does this solve your problem? 

Damage on the leading edge of paper 

Action Yes No 

1 When you use the MPF, reverse the paper and then try again. 

When you use any of the trays, change the paper and then try again. 

Does this solve your problem? 

The task is complete. (MPF) 
Go to action 2. 

(trays) 
Contact Dell. 

2 Change the paper with another one and then try again. The task is complete. Go to action 3. 

Does this solve your problem? 

3 Use any of the trays in place of the MPF. The task is complete. Contact Dell. 

Does this solve your problem? 
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Jam/Alignment Problems 
NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer 
Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, see 
"Understanding the Printer Menus" and "Dell™ Printer Configuration Web Tool." 

• The top and side margins are incorrect 

• Color registration is out of alignment 

• Images are skewed 

• Tray1/Optional 550-Sheet Feeder Misfeed Jam 

• MPF Misfeed Jam 

•  Regi  Jam (Exit Sensor On JAM)  

• Exit Jam (Exit Sensor Off JAM) 

• Tray1/Optional 550-Sheet Feeder Multi-feed Jam 

•  MPF Multi-feed Jam  

The top and side margins are incorrect 

Action Yes No 

1 Ensure that the margins are set correctly on the application being used. The task is complete. Contact Dell. 

Does this solve your problem? 

Color registration is out of alignment 

Action Yes No 

1 Adjust the settings of the paper type on the printer driver to those of the 
tray. 

The task is complete. Go to action 2. 

Does this solve your problem? 
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2 

Action Yes No 

Execute auto color registration adjustment. The task is complete. Go to action 3. 
a On the operator panel, press the (Menu) button and select 
Admin Settings→ Maintenance→ Color Reg 

Adjust→ Auto Correct→ Start.
 

OR
 
a Launch the Tool Box, and click Maintenance on the Printer
 

Maintenance tab.
 
b Click Start under Auto Correct in Color Registration Adjustments.
 

Does this solve your problem?
 

3 Do you have spare drum cartridges? Go to action 4a. Go to action 4b. 

4a Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges." 
b Launch the Tool Box, and click Maintenance on the Printer 

Maintenance tab. 

The task is complete. Contact Dell. 

c Click Start under Print Color Regi Chart in Color Registration 
Adjustments. 

The Color Regi Configuration Chart is printed. 

Does this solve your problem? 

4b Print the Color Regi Configuration Chart and manually correct the color 
registration. 

a Launch the Tool Box, and click Maintenance on the Printer 
Maintenance tab. 

The task is complete. Contact Dell. 

b Click Start under Print Color Regi Chart in Color Registration 
Adjustments. 

The Color Regi Configuration Chart is printed. 
c Identify the offset values from the chart and specify each value for 

process, left, and right colors in Registration Adjustments. See 
"Adjusting Color Registration" for details. 

d Click Apply New Settings. 
e Click Start under Print Color Regi Chart to print the Color Regi 

Configuration Chart again. 

Does this solve your problem? 

Images are skewed 

Action Yes No 

1 Adjust the paper guides properly. The task is complete. Go to action 2. 

Does this solve your problem? 
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Action Yes No 

2 Install the transfer belt unit according to an appropriate procedure. See The task is complete. Contact Dell. 
"Installing a Transfer Belt Unit." 

Does this solve your problem? 

Tray1/Optional 550-Sheet Feeder Misfeed Jam 

Action Yes No 

1 Ensure that tray1 or the optional 550-sheet feeder is properly inserted. The task is complete. Proceed to the action 

Does this solve your problem? corresponding to the 
type of the print media 
being used: 

• Thick - 2a  

• Thin - 2b 

• Coated - 2c  

If using paper other 
than the above, go to 
action 2d. 

2a Use thick paper that is 216 g/m2 or less. The task is complete. Go to action 3a. 

Does this solve your problem? 

2b Use thin paper that is 60 g/m2 or more. The task is complete. Go to action 3a. 

Does this solve your problem? 

2c Load coated paper one sheet at a time. The task is complete. Go to action 3b. 

Does this solve your problem? 

2d Ensure that the print media is not curled. The task is complete. Go to action 3a. 

Does this solve your problem? 

2e Is the print media damp? Go to action 3c. Go to action 3a. 

3a Fan the print media. The task is complete. Go to action 3b. 

Does this solve your problem? 

3b Wipe the retard roller in tray1 or the optional 550-sheet feeder with a The task is complete. Go to action 4b. 
cloth moistened with water. 

Does this solve your problem? 

3c Turn over the print media. The task is complete. Go to action 4a. 

Does this solve your problem? 

4a Use print media that is not damp. The task is complete. Go to action 3a. 

Does this solve your problem? 

4b Replace the drum cartridges. The task is complete. Contact Dell. 

Does this solve your problem? 
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MPF Misfeed Jam 

Action Yes No 

1 Ensure that the MPF is properly inserted. The task is complete. Proceed to the action 

Does this solve your problem? corresponding to the 
type of the print media 
being used: 

• Thick - 2a  

• Thin - 2b 

• Coated - 2c  

• Envelope - 2d  

If performing manual 
duplex printing, go to 
action 2e. 

If using paper other 
than the above or if not 
performing manual 
duplex printing, go to 
action 2f. 

2a Use thick paper that is 216 g/m2 or less. The task is complete. Go to action 3a. 

Does this solve your problem? 

2b Use thin paper that is 60 g/m2 or more. The task is complete. Go to action 3a. 

Does this solve your problem? 

2c Load coated paper one sheet at a time. The task is complete. Go to action 3b. 

Does this solve your problem? 

2d Ensure that the envelope is properly loaded in the MPF as instructed in The task is complete. Go to action 3c. 
"Loading an Envelope in the MPF." 

Does this solve your problem? 

2e Ensure that the print media is not curled. The task is complete. Go to action 3a. 

2f Is the print media damp? Go to action 3d. Go to action 3a. 

3a Fan the print media. The task is complete. Go to action 3b. 

Does this solve your problem? 

3b Wipe the retard roller in the MPF with a cloth moistened with water. The task is complete. Go to action 4b. 

Does this solve your problem? 

3c If the envelope is deformed, correct it or use another envelope. The task is complete. Go to action 3a. 

Does this solve your problem? 

3d Turn over the print media. The task is complete. Go to action 4a. 

Does this solve your problem? 

4a Use print media that is not damp. The task is complete. Go to action 3a. 

Does this solve your problem? 

4b Replace the drum cartridges. The task is complete. Contact Dell. 

Does this solve your problem? 
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Regi Jam (Exit Sensor On JAM) 

Action Yes No 

1 Ensure that the drum cartridges are installed correctly. The task is complete. Go to action 2. 

Does this solve your problem? 

2 Replace the drum cartridges. See "Replacing the Drum Cartridges." The task is complete. Go to action 3. 

Does this solve your problem? 

3 Ensure that the fusing unit is set properly. The task is complete. Go to action 4. 

Does this solve your problem? 

4 Replace the fusing unit. 
a Replace the fusing unit. See "Removing the Fusing Unit." 
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab. 

The task is complete. Go to action 5. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

5 Ensure that the transfer belt unit is installed correctly. The task is complete. Go to action 6. 

Does this solve your problem? 

6 Replace the transfer belt unit, the 2nd BTR, and the retard roller. 
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab. 

c Click Pitch Configuration Chart. 

The task is complete. Contact Dell. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Exit Jam (Exit Sensor Off JAM) 

Action Yes No 

1 Ensure the fusing unit is installed correctly. The task is complete. Go to action 2. 

Does this solve your problem? 

2 Replace the fusing unit. 
a Replace the fusing unit. See "Replacing the Fusing Unit." 
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab. 

The task is complete. Contact Dell. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 
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1 

2 

3 

4 

5 

Tray1/Optional 550-Sheet Feeder Multi-feed Jam 

Action	 Yes No 

Ensure that tray1 or the optional 550-sheet feeder is properly inserted. The task is complete.	 If using coated paper, 
go to action 2.Does this solve your problem? 
If using other type of 
print media, go to 
action 3. 

Load coated paper one sheet at a time. The task is complete. Go to action 4. 

Does this solve your problem? 

Use print media that is not damp. The task is complete. Go to action 4. 

Does this solve your problem? 

Fan the print media. The task is complete. Go to action 5. 

Does this solve your problem? 

Wipe the retard roller in tray1 or the optional 550-sheet feeder where the The task is complete. Contact Dell. 
multi-feed occurred with a cloth moistened with water. 

Does this solve your problem? 

MPF Multi-feed Jam 

1 Ensure the media type you are using. - -

If using coated paper, go to action 2. 

If using other type of print media, go to action 3. 

2 Load coated paper one sheet at a time. The task is complete. Go to action 4. 

Does this solve your problem? 

3 Use print media that is not damp. The task is complete. Go to action 4. 

Does this solve your problem? 

4 Fan the print media. The task is complete. Go to action 5. 

Does this solve your problem? 

5 Wipe the retard roller in the MPF where the multi-feed occurred with a 
cloth moistened with water. 

The task is complete. Contact Dell. 

Does this solve your problem? 

Noise
 

Action Yes No 

1 To specify the cause of the noise, perform the Auto Registration 
Adjustment. 

The task is complete. Go to action 2. 

Does this solve your problem? 
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2 

3 

4 

5 

6 

Replace the transfer belt unit, the 2nd BTR, and the retard roller. 
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller." 

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab. 

c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Replace the fusing unit. 
a Replace the fusing unit. See "Replacing the Fusing Unit." 
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab. 
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed. 

Does this solve your problem? 

Replace the waste toner box. 

Does this solve your problem? 

Replace the drum cartridges. 

Does this solve your problem? 

Replace the toner cartridge (K). See "Replacing the Toner Cartridges." 

The task is complete. Go to action 3. 

The task is complete. Go to action 4. 

The task is complete. Go to action 5. 

The task is complete. Go to action 6. 

The task is complete. 
(The toner cartridge 
(K) you are using has 
been damaged. Replace 
it with a new one.) 

Go to action 7. 

7 Replace the toner cartridge (Y). See "Replacing the Toner Cartridges." The task is complete. 
(The toner cartridge 
(Y) you are using has 
been damaged. Replace 
it with a new one.) 

Go to action 8. 

8 Replace the toner cartridge (M). See "Replacing the Toner Cartridges." The task is complete. 
(The toner cartridge 
(M) you are using has 
been damaged. Replace 
it with a new one.) 

Go to action 9. 
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9 Replace the toner cartridge (C). See "Replacing the Toner Cartridges."	 The task is complete. Contact Dell. 
(The toner cartridge 
(C) you are using has 
been damaged. Replace 
it with a new one.) 

Digital Certificate Problem
 

Symptom Cause	 Action 

The LDAP-SSL/TLS The optional hard disk installed in Confirm whether the optional hard disk is 
Communication setting and the the printer is not encrypted. connected correctly, and confirm whether Data 
Upload Signed Certificate button Encryption is enabled from the operator panel or 
are not displayed. Dell Printer Configuration Web Tool. 

The certificate import button is SSL communication is disabled. Create a self-signed certificate and enable SSL. 
disabled. 

The certificate details button is 
disabled. 

The certificate cannot be imported. The time setting is incorrect. Confirm validity period of the certificate as well as 
the time setting of the device. 

The certificate file is incorrect. Confirm whether the password is correct. 

Confirm whether the file type is PKCS#7/#12 or 
x509CACert (extension: p7b/p12/pfx/cer/crt). 

Confirm whether the attribute information (key 
Usage/Extended key usage) of the certificate to be 
imported is set correctly. 

The browser is incorrect. Use Internet Explorer. 

016-404 is displayed when setting 
the encryption of the optional hard 
disk to Off. 

016-404 is displayed when 
formatting the optional hard disk. 

Security is set to Off when setting 
encryption of the optional hard disk 
to Off. 

Security is set to Off when 
formatting the optional hard disk. 

A certificate is deleted when setting 
encryption of the optional hard disk 
to Off. 

A certificate is deleted when 
formatting the optional hard disk. 

The optional hard disk is formatted 
and the certificate data is deleted 
when setting encryption of the 
optional hard disk to Off. Since a 
certificate is required and the 
security function cannot be enabled 
when restarting the device afterward, 
016-404 is displayed and the security 
setting must be initialized. The 
cause is the same when formatting or 
removing the optional hard disk. 

After initializing, import the certificate and enable 
the security settings again. The action is the same 
when formatting the optional hard disk. 
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Symptom Cause Action 

A certificate cannot be set with 
"Certificate Details". 

The validity period is invalid. The validity period of the certificate is invalid. 
Confirm whether the time setting of the machine is 
correct, and whether the validity period of the 
certificate has expired. 

The certificate path is invalid. The certificate chain (path validation) of the 
imported certificate may not be correctly validated. 
Confirm whether all of the high-level certificates 

(Trusted/Intermediate) have been imported and are 
not deleted, and whether the validity period has 
expired. 

Although a certificate was imported, 
it is not displayed when selecting 
with "Local Device". 

The type of the certificate is 
incorrect. 

To import a certificate for use with the device (own 
device), import the secret key and a certificate of 
the PKCS#12 (p12/pfx) format as a pair. 

Server validation is not operating 
correctly. 

The certificate chain is incorrect 
when importing. 

Although importing a root certificate (Trusted) to 
use for server authentication, an Intermediate 
certificate may be required when validating the 
path. 

When executing a certificate file with the 
certification authority, create the certificate with a 
format including all paths and then import that 
certificate. 

Digital Signature cannot be selected The certificate cannot be associated. Either the certificate has not been imported or the 
with the IPsec setting.	 certificate has not been associated for use with 

Digital Signature of IPsec. Refer to "Setting the 
Certificate in the IPsec Digital Signature Mode" to 
set a certificate of IPsec. 
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Problems With Installed Optional Accessories 
If an option does not operate correctly following installation or stops working: 

•	 Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the 
printer, and check the connection between the option and the printer. 

•	 Print the printer settings report to see if the option is listed in the Installed Options list. If the option is not listed, 
re-install it. See "Report / List." 

•	 Ensure the option is selected in the printer driver you are using. 

The following table lists printer's option and corrective action for related problem. If the suggested corrective action 
does not correct the problem, call customer service. 

Problem	 Action 

550-sheet feeder • Ensure the 550-sheet feeder is correctly installed on the printer. Re-install the 
feeder. See "Removing the Optional 550-Sheet Feeder" and "Installing the 
Optional 550-Sheet Feeder." 

• Ensure the print media is loaded correctly. See "Loading Print Media in Tray1 and 
the Optional 550-Sheet Feeder" for more information. 

Memory module	 • Ensure the memory module is securely connected to the memory connector. 

Hard disk	 • Ensure the hard disk is securely inserted to the correct slot. 

Wireless adapter	 • Ensure the wireless adapter is securely inserted to the correct slot. 

Other Problems
 

Problem	 Action 

Condensation has occurred inside the 	 This usually occurs within several hours after you heat the room in winter. This 
printer.	 also occurs when the printer is operating in a location where relative humidity 

reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment. 

Contacting Service 
When you call for printer service, be prepared to describe the problem you are experiencing or the error message that
 
appears.
 

You need to know the model type and service tag of your printer. See the label located inside the front cover of your 

printer.
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Appendix 

Dell™ Technical Support Policy 
Technician-assisted technical support requires the cooperation and participation of the customer in the 
troubleshooting process and provides for restoration of the operating system, software program and hardware drivers 
to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of 
the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical 
support is available at Dell Support. Additional technical support options may be available for purchase. 

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for 
third-party software and peripherals is provided by the original manufacturer, including those purchased and/or 
installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus). 

Online Services 
You can learn about Dell products and services on the following websites: 

www.dell.com
 

www.dell.com/ap (Asian/Pacific countries only)
 

www.dell.com/jp (Japan only)
 

www.euro.dell.com (Europe only)
 

www.dell.com/la (Latin American and Caribbean countries)
 

www.dell.ca (Canada only)
 

You can access Dell Support through the following websites and e-mail addresses: 

•	 Dell Support websites 

support.dell.com
 

support.jp.dell.com (Japan only)
 

support.euro.dell.com (Europe only)
 

•	 Dell Support e-mail addresses
 

mobile_support@us.dell.com
 

support@us.dell.com 


la-techsupport@dell.com (Latin America and Caribbean countries only)
 

apsupport@dell.com (Asian/Pacific countries only)
 

•	 Dell Marketing and Sales e-mail addresses 

apmarketing@dell.com (Asian/Pacific countries only)
 

sales_canada@dell.com (Canada only)
 

•	 Anonymous file transfer protocol (FTP) 

ftp.dell.com 

Log in as user: anonymous, and use your e-mail address as your password. 
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Warranty and Return Policy 
Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or 
equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your 
printer, see support.dell.com. 

Recycling Information 
It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally 
sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. 

For specific information on Dell’s worldwide recycling programs, see www.dell.com/recyclingworldwide. 

Contacting Dell 
You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, 

and fill in the requested details to access help tools and information.
 

You can contact Dell electronically using the following addresses:
 

• 	  World Wide Web  

www.dell.com
 

www.dell.com/ap (Asian/Pacific countries only)
 

www.dell.com/jp (Japan only)
 

www.euro.dell.com (Europe only)
 

www.dell.com/la (Latin American and Caribbean countries)
 

www.dell.ca (Canada only)
 

•	 Anonymous file transfer protocol (FTP) 

ftp.dell.com 

Log in as user: anonymous, and use your email address as your password. 

•	 Electronic Support Service
 

mobile_support@us.dell.com
 

support@us.dell.com
 

la-techsupport@dell.com (Latin America and Caribbean countries only)
 

apsupport@dell.com (Asian/Pacific countries only)
 

support.jp.dell.com (Japan only)
 

support.euro.dell.com (Europe only)
 

•	 Electronic Quote Service 

apmarketing@dell.com (Asian/Pacific countries only)
 

sales_canada@dell.com (Canada only)
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Index 

Symbols 
(Back) button, 118
 

(Cancel) button, 117
 

(Menu) button, 118
 

(Power Saver) button, 117
 

(Set) button, 118
 

Numerics 
1000Base-T Full-Duplex, 152
 

100Base-TX Full-Duplex, 152
 

100Base-TX Half-Duplex, 152
 

10Base-T Full-Duplex, 152
 

10Base-T Half-Duplex, 152
 

2 Sided Print, 134
 

2 Sided Printing, 135, 175, 184
 

2nd BTR, 28, 324
 

4 Colors Configuration Chart, 185
 

802.1x, 150, 167
 

A 
A4, 233
 

A4<>Letter Switch, 172, 177, 205
 

A5, 233
 

About printer, 27
 

Access List, 167
 

Ad-Hoc, 160
 

Adjust 2nd BTR, 135, 143, 211
 

Adjust Altitude, 136, 146, 173, 179
 

Adjust Fusing Unit, 136, 144, 212
 

Adjust Transfer Belt Unit, 143
 

Adjusting color registration, 342
 

Admin Settings, 188
 

Administrator Account, 160
 

AirPrint, 149, 162, 254
 

Alert Tone, 133, 138, 173, 177
 

Alignment Chart, 185
 

All Tones, 133, 139
 

Altitude, 308
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Apply New Settings, 128
 

Asset Tag Number, 121, 131
 

Assigning IP address, 71
 

Audio Tone, 173, 176
 

Authenticate Error Trap, 159
 

Authentication System, 275
 

Auto Clear Alert Tone, 133, 138, 173, 177
 

Auto Color To Mono Print, 209
 

Auto Correct, 145, 179
 

Auto Log Print, 133, 139, 172, 177, 205
 

Auto Reg Adjust, 212
 

Auto Registration Adjustment, 136, 144, 173
 

Auto Reset, 133, 139, 172, 176
 

AutoIP, 199
 

Avoiding paper jams, 243, 355
 

B 
B5, 233
 

Banding Detection Chart, 185
 

Banner Sheet Insert Position, 133, 139, 172, 177
 

Banner Sheet Specify Tray, 133, 139, 172, 177
 

Base memory, 307
 

Basic Information, 151
 

Basic printer problems, 371
 

Bitmapped font, 294
 

Bonjour (mDNS), 149, 152
 

BOOTP, 199
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C 
C5, 233
 

Cable, 309
 

Canceling a print job, 244
 

Canceling print job
 
From your computer, 244
 

Carbonless copy paper, 230
 

CCP, 230
 

Changing printer settings, 128, 256
 

Changing the Language, 119
 

Clear Storage, 145
 

Clearing paper jams, 355
 
From fusing unit, 360
 
From MPF, 356
 
From optional 550-sheet feeder, 366
 
From tray1, 359
 

Clock Settings, 136
 

Coated, 135-136, 144, 211-212
 

Coated Thick, 135-136, 144, 211-212
 

Collation, 134, 175, 184
 

Color Reg Adjust, 213
 

Color Regi Chart, 145
 

Color Registration Adjustments, 145, 179
 

Color registration chart, 342
 

Color Test Page, 138, 174, 188
 

ColorTrack, 273
 

ColorTrack Error Report, 136, 274
 

ColorTrack Mode, 136, 274
 

ColorTrack Settings, 273
 

Community Name, 159
 

Completed Jobs, 124, 132
 

Configure 802.1x, 167
 

Configuring wireless adapter, 51
 

Connecting local printer, 66
 

Connecting printer, 65
 

Connecting to the network, 67
 

Connection specification, 65, 309
 

Connection Time-Out, 154
 

Connection type, 65, 309
 

Conserving supplies, 313
 

Contact Dell Support at, 125, 127
 

Contact Person, 126
 

Contacting service, 395
 

Control board, 28
 

Control Panel Tone, 138, 173, 176
 

Copy Printer Settings, 125, 127, 167
 

Copy Printer Settings Report, 168
 

Cover, 131
 

Covers, 135-136, 144, 211-212
 

Covers Thick, 135-136, 144, 211-212
 

Custom Paper Size - X, 134, 140
 

Custom Paper Size - Y, 134, 140
 

D 
Data Encryption, 281
 

Date & Time, 173, 176
 

Date Format, 136, 173, 176
 

Default Color, 134, 140, 194
 

Default Paper Size, 133, 139, 172, 177
 

Dell ColorTrack, 136, 168, 273
 

Dell Printer Configuration Web Tool, 121
 
Page display format, 126
 

Dell Service Tag Number, 131
 

Dell Supplies Management System, 261
 

Dell support website, 22
 

Dell technical support policy, 399
 

Details, 131
 

Determining Values, 342
 

DHCP, 199
 

Digital Certificates, 281
 

Dimensions, 307
 

DIMM size, 307
 

Direct connection setup, 80
 

Disabling Panel Lock, 226
 

Display of Dell Configuration Web Tool, 184
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Display problems, 371
 

DL, 233
 

DNS, 148, 154
 

Draft Mode, 134, 140, 193
 

Driver, 21
 

Drum cartridge, 27, 317
 

Duplex unit, 28
 

E 
E-Mail Alert, 125, 127, 152, 156, 200
 

E-Mail Alert Settings, 151, 157
 

E-Mail Alert Setup, 121
 

E-Mail Alert Setup Page, 150
 

E-Mail Server Settings, 150, 156
 

Emulations, 307
 

Encryption, 160-161
 

End Time, 142
 

Entering Values, 344
 

Envelope, 135-136, 144, 211-212, 231
 

Envelope #10, 233
 

Environment, 308
 

Error codes, 301
 

Error History, 138, 174, 188
 

Ethernet, 147, 152, 309
 

Ethernet port, 28, 65, 67
 

Event Panel, 126
 

EWS, 200
 

EWS Settings, 151
 

Executive, 233
 

Expiration Mode, 142
 

Expiration Time, 143
 

Express Service Code, 131
 

External Authentication, 273
 

F 
Fast scan, 343
 

Fault Time-out, 133, 139, 172, 176
 

Fault Tone, 133, 138, 173, 176
 

Finding information, 21
 

Firmware Version, 131
 

Flip on Long Edge, 247
 

Flip on Short Edge, 247
 

Folio, 233
 

Font, 134, 140, 293
 
PCL 5/PCL 6, 295
 
Pitch, 293
 
Point size, 293
 
PostScript 3, 295
 
Style, 293
 
Typefaces and fonts, 293
 
Weight, 293
 

Font Pitch, 134, 140, 192
 

Font Size, 134, 140, 191
 

Form Line, 134, 140, 192
 

Front cover, 27
 

Front USB port, 27
 

Function Enabled, 141, 215
 

Fusing unit, 28, 322, 356, 360
 

G 
Gateway Address, 153, 174, 183, 200
 

Get Environment Sensor Info, 185
 

Ghost Configuration Chart, 185
 

Google Cloud Print, 149, 162, 254
 

H 
Hard disk, 58
 

Hex Dump, 134, 140, 193
 

Host I/F, 132
 

Host Name, 132, 158, 164
 

How to install option, 37
 

How to remove option, 347
 

How to set up, 22
 

How to use printer, 21
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I 

HTTP, 149, 155
 

HTTP-SSL/TLS Communication, 283
 

ID, 131-132
 

Identifying print media, 233
 

Image Enhance, 134, 140
 

Impression Number, 132
 

Infrastructure, 160
 

Initialize NIC NVRAM Memory and restart 

printer, 163
 

Initialize Print Meter, 179, 213
 

Installing optional 550-Sheet Feeder, 42
 

Installing optional accessories, 37
 

Installing optional hard disk, 58
 

Installing optional memory module, 37
 

Installing optional wireless adapter, 47
 

Interfaces, 308
 

Invalid Key Tone, 133, 138, 173, 176
 

IP Address, 71, 121, 124, 126, 147, 153, 159, 164, 

166-167, 174, 183, 199, 276-277
 

IP Address Mode, 174, 183
 

IP Filter (IPv4), 150, 167
 

IP filter setup, 155
 

IPP, 148, 152, 154
 

IPsec, 166, 286
 

IPsec Settings, 150, 166
 

IPv4, 159, 166
 

IPv6, 126, 148, 154, 159, 166
 

J 
Job Completed Tone, 133, 138, 173, 176
 

Job History, 138, 174, 187
 

Job List, 124, 131
 

Job Name, 132
 

Job Status, 132
 

Job Submitted Time, 132
 

Job Time-out, 133, 139, 172, 176, 203
 

K 
Kerberos Server, 275
 

L 
Label, 135-136, 144, 173, 179, 211-212, 232
 

Landscape, 190
 

Layout, 134
 

LCD panel, 117
 

LDAP Authentication, 278
 

LDAP Server, 164, 276-277
 

LDAP-SSL/TLS Communication, 287-288
 

Left frame, 127
 

Left side cover, 28
 

Legal, 233
 

Letter, 233
 

Letterhead 2 Sided, 133, 139, 172, 178
 

Line Termination, 134, 140, 193
 

Link Channel, 160
 

Link Local Address, 174
 

Link Quality, 160
 

Loading letterhead, 235
 

Loading paper, 75
 

Loading print media, 235
 
MPF, 237
 
Tray1 and optional 550-sheet feeder, 235
 

Location, 126, 131
 

Login Error, 142
 

Low Toner Alert Message, 133, 139, 172, 178
 

Low Toner Alert Tone, 133, 138, 173, 177
 

LPD, 148, 152, 154, 200
 

M 
MAC Address, 160
 

Machine Ready Tone, 133, 138, 173, 176
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Maintenance, 313
 

Manual Address, 174
 

Maximum memory, 307
 

Memory, 307
 

Memory Capacity, 131
 

Memory connector, 307
 

Memory module, 37, 347
 

Memory speed, 307
 

Menu item, 128
 

Menu Settings, 132
 

MIB compatibility, 308
 

mm / inch, 132, 138, 172, 177
 

Monarch, 233
 

Monthly Settings, 143
 

MPF, 356
 

MPF Custom Paper Size - X, 137, 169
 

MPF Custom Paper Size - Y, 137, 169
 

MPF Custom Size - X, 174, 180
 

MPF Custom Size - Y, 174, 180
 

MPF Display Popup, 137, 169, 174, 180
 

MPF Mode, 174, 180
 

MPF Paper Size, 137, 169, 174, 180
 

MPF Paper Type, 137, 169, 174, 180
 

MQ Chart, 185
 

Multiple Up, 313
 

Multiple-Up, 135, 175, 184, 225
 

Multipurpose feeder (MPF), 27, 356
 

N 
NCR, 230
 

Network, 67
 

Network connection setup, 82
 

Network Firmware Version, 131
 

Network Type, 160
 

New Password, 141
 

No carbon required paper, 230
 

No. of Sheets, 132
 

Non Registered User, 136, 274
 

Non-Dell Toner, 136, 173, 179, 214
 

Number pad, 117-118
 

O 
OCR, 230
 

Online Help, 125, 127
 

Operation, 308
 

Operator panel, 27, 29
 

Operator Panel Buttons, 117
 

Optical character recognition, 230
 

Optional 550-sheet feeder, 27, 356, 366
 

Order Supplies at, 125, 127
 

Ordering supplies, 31, 313
 

Orientation, 134, 140, 190
 

OS, 308
 

OS compatibility, 307
 

Other problems, 395
 

Out of Paper Alert Tone, 173, 177
 

Out of Paper Tone, 133, 138
 

Output Color, 135, 175, 184
 

Output Result, 132
 

Output Size, 134
 

Output Tray, 131
 

Output tray extension, 27
 

Owner, 132
 

P 
Page display format, 126
 

Page orientation, 236
 

Panel, 199
 

Panel Language, 133, 139, 175, 183, 220
 

Panel Lock Control, 134, 141, 215
 

Panel Settings, 137, 173, 187
 

Panel Settings Report, 119, 137
 

Paper, 229
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Characteristics, 229
 
Curl, 229
 
Fiber content, 230
 
Grain direction, 229
 
Moisture content, 229
 
Smoothness, 229
 
Weight, 229
 

Paper Density, 135, 143, 173, 179, 210
 

Paper jam location, 356
 

Paper Size, 134, 140, 189
 

Paper Tray, 134
 

Paper Used, 168
 

Parts name, 27
 

Password, 155, 160, 163-164, 167, 274, 277, 279
 

PCL, 188
 
Font, 190
 

PCL 5/PCL 6, 295
 

PCL Fonts List, 138, 173, 187
 

PCL Macros List, 138, 173, 187
 

PCL printer driver, 80, 82
 

PCL Settings, 134, 140
 

PDF Fonts List, 138, 174
 

PDL, 307
 

Peer-to-Peer, 95
 

Pitch Configuration Chart, 185
 

Plain, 135-136, 144, 173, 179, 211-212
 

Plain Thick, 135-136, 144, 211-212
 

Point and Print, 92
 

Port Settings, 151
 

Port Status, 152
 

Port9100, 148, 152, 154, 200
 

Portrait, 190
 

Power connector, 28
 

Power Saver Time - Deep Sleep, 132, 138
 

Power Saver Time - Sleep, 132, 138
 

Power Saver Timer, 176, 202
 

Power Saver Timer - Auto-Off Timer, 172, 202
 

Power Saver Timer - Deep Sleep, 172
 

Power Saver Timer - Sleep, 172
 

Power supply, 307
 

Power switch, 27
 

Premier, 136
 

Print Color Regi Chart, 179
 

Print Drivers / Remote Client Account, 160
 

Print ID, 133, 139, 172, 177, 206
 

Print media, 229, 313
 
Source, 236
 

Print Meter, 138, 174
 

Print Mode, 134
 

Print quality guarantee, 308
 

Print Server Reports, 147
 

Print Server Settings, 124, 127, 146, 151, 184
 

Print Server Setup Page, 147
 

Print side, 236
 

Print Text, 133, 139, 172, 177, 206
 

Print Volume, 125, 127, 168
 

Printer driver, 105, 107, 278
 

Printer Events, 131
 

Printer Information, 125, 127, 131
 

Printer Jobs, 124, 127, 131
 

Printer Maintenance, 143
 

Printer Page Count, 168
 

Printer paper, 229
 

Printer Revision Levels, 131
 

Printer Serial Number, 131
 

Printer Settings, 124, 132, 137-138, 173, 187
 

Printer Settings page, 137
 

Printer software, 261
 

Printer specification, 307
 

Printer Status, 124, 127, 130
 

Printer Status Window, 261
 

Printer Type, 131
 

Printer utility software, 262
 

Printing, 243
 

Printing problems, 371
 

Printing Speed, 131
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Private Mail Box Print, 221, 248-249
 

Problems with Optional Accessories, 395
 

Processor Speed, 131
 

Product Information Guide, 22
 

Proof Print, 223, 249
 

Proxy Server, 149, 162
 

PS Fonts List, 138, 174
 

PS printer driver, 80, 82
 

Public Mail Box Print, 222, 248-249
 

Q 
Quantity, 134, 140, 192
 

Quick Launch Utility, 262
 

Quick Reference Guide, 21
 

R 
RAM Disk, 133, 139, 172, 177, 207
 

RARP, 199
 

Rear cover, 28
 

Recommended paper, 230
 

Recurrence, 142-143
 

Recycled, 136, 144, 211-212
 

Red Hat, 105
 

Red Hat Enterprise Linux, 105, 307
 

Re-enter Password, 141
 

Refresh, 128
 

Registration Adjustments, 179
 

Regular, 136
 

Relative humidity, 308
 

Remote Authentication, 274
 

Removing optional 550-sheet feeder, 349
 

Removing optional hard disk, 353
 

Removing optional memory module, 347
 

Removing optional wireless adapter, 351
 

Removing options, 347
 

Report 2 Sided Print, 172, 177
 

Reports, 137, 188
 

Reset Defaults, 179
 

Reset Defaults and restart printer, 145
 

Reset Print Server, 163
 

Resident fonts, 295
 

Resident scalable fonts, 295
 

Restore Settings, 128
 

Retard roller, 324
 

Return policy, 400
 

Right frame, 128
 

Right side cover, 27
 

RSA BSAFE, 17
 

S 
Safety information, 22
 

Scalable fonts, 294
 

Search Time-Out, 164, 277
 

Secure Print, 221, 248-249
 

Secure Settings, 134, 141
 

Security, 163
 

Security Settings, 160
 

Select Reorder URL, 136
 

Select Tray, 135, 175, 184, 224
 

Selecting letterhead, 231
 

Selecting paper, 230
 

Selecting preprinted form, 231
 

Selecting pre-punched paper, 231
 

Sending print job, 243
 

Server Response Time-Out, 275
 

Service code, 22
 

Service tag, 22
 

Set Available Time, 142
 

Set Date, 136, 173, 176
 

Set Password, 125, 127, 163
 

Set Time, 136, 173, 176
 

Shared printing, 91
 

Slow scan, 342, 344
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SMB, 149, 152 

SNMP, 149, 152 

SNMP Configuration, 158 

SNMP UDP, 200 

Software and Documentation disc, 21 

Software update, 262 

SSID, 160 

SSL/TLS, 150, 165, 287 

Start Time, 142 

Status LED, 117 

Status Monitor Console, 261 

Status Monitor Console for Linux, 267 

Status Monitor Widget for Macintosh, 263 

Status of printer supplies, 313 

Status Window, 262 

Storage, 308 

Storage humidity range, 308 

Stored Documents, 138, 174, 188 

Storing consumables, 314 

Storing print media, 233, 243, 314 

Straightest lines, 343 

Subnet Mask, 174, 183, 199 

Substitute Tray, 133, 139, 172, 178, 207 

Supported paper sizes, 233 

Supported paper types, 234 

SUSE, 307 

SUSE Linux Enterprise Desktop 10, 108 

SUSE Linux Enterprise Desktop 11, 110 

Symbol Set, 134, 140, 191, 299 

System Settings, 132, 138, 151, 172 

T 
TCP/IP, 152 

TCP/IP Settings, 147, 153 

Telnet, 149, 152, 155 

Temperature, 308 

Time Format, 136, 173, 176 

Time Zone, 136, 173, 176 

Toner cartridge, 27, 315 

Toner cartridge level, 130 

Tool Box, 171, 262 

Top cover, 27 

Top frame, 126 

Transfer belt unit, 27, 324 

Trap Notification, 159 

Tray 1 Custom Paper Size - X, 137, 169 

Tray 1 Custom Paper Size - Y, 137, 169 

Tray 1 Custom Size - X, 174, 181 

Tray 1 Custom Size - Y, 174, 181 

Tray 1 Display Popup, 137, 169, 174, 181 

Tray 1 Paper Size, 137, 169, 174, 181 

Tray 1 Paper Type, 137, 169, 174, 181 

Tray 2 Custom Paper Size - X, 137, 170 

Tray 2 Custom Paper Size - Y, 137, 170 

Tray 2 Custom Size - X, 175, 181 

Tray 2 Custom Size - Y, 175, 181 

Tray 2 Display Popup, 137, 170, 174, 181 

Tray 2 Paper Size, 137, 169, 175, 181 

Tray 2 Paper Type, 137, 169, 175, 182 

Tray Priority, 175, 182 

Tray Settings, 125, 127, 137, 169, 174, 180, 216 

Tray1, 27, 356, 359 

Troubleshooting, 263, 371 

Typeface, 293 

U 
Unacceptable paper, 230 

UNITED STATES GOVERNMENT 
RESTRICTED RIGHTS, 17 

Updater, 263 

USB, 309 

USB Direct Print, 141 

USB Direct Print Defaults, 135 

USB port, 28, 65-66, 134, 139 

Appendix 408 




 

 


 

 


 

USB printing, 80 

Use Another Tray, 172, 178 

Use Manual Address, 174 

User Setup Disk Creating Tool, 261 

Using Dell Printer Configuration Web Tool, 124 

V 
Verifying IP settings, 73 

W 
Warranty, 400 

Warranty information, 22 

Waste toner box, 27, 332 

Web Link Customization, 136, 146 

Web services on devices, 252 

Weekly Settings, 143 

WEP, 161 

Width guide, 76 

WINS, 148, 154 

Wired Network 
Ethernet, 197
 
IP Filter, 201
 
Protocols, 200
 
Reset LAN, 201
 
TCP/IP, 199
 

Wireless Adapter, 47 

Wireless adapter socket, 28 

Wireless Settings, 147, 160 

WPA-Enterprise, 288-289 

WPA-PSK, 161 

WPS-PBC, 55 

WPS-PIN, 54 

WSD, 148, 155, 252 

X 
XPS printer driver, 80, 83 
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